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Welcome to NetObjects Fusion1
NetObjects Fusion™ 4.0 is the essential tool for building dynamic business Web 
sites. You can use NetObjects Fusion to create and maintain an entire site whether 
or not you know HTML. NetObjects Fusion’s Everywhere HTML™ eliminates the 
problems and confusion caused by browser differences. Because NetObjects Fusion 
generates HTML pages based on page layout and publish settings you control, you 
can build your site once and publish it everywhere.

In NetObjects Fusion’s open site environment you can work the way you want to. 
You can design pages using NetObjects Fusion’s position-based editor, its text-based 
editor, an external HTML editor, or a combination of all three. Powerful message-
based animation and interactive authoring features included in NetObjects Fusion 
make it easy for you to create sophisticated effects. You’ll also find it easy to add 
scripts, Java applets and servlets, Shockwave Flash, Headspace RMF, ActiveX 
controls, and more.

You can also add NetObjects Fusion Components, pre-built mini-applications that 
add interactivity to your site without custom programming. Internal improvements 
in NetObjects Fusion 4.0 make it easy for third-party publishers to build powerful 
components. Several of these components are included with NetObjects Fusion 4.0, 
so you can quickly create pages that dynamically interact with a database, build an 
online store, and more.

Work in an Open Environment
NetObjects Fusion provides an open site-building environment. You can use a 
variety of other tools for specialized purposes and then return to NetObjects Fusion 
to integrate the content into one cohesive site. Think of NetObjects Fusion as the 
control center where you create and manage all of the site’s resources.

Depending on your preference, you can lay out pages in graphical mode, text mode, 
or using an HTML editor. In graphical mode, you can place objects anywhere on the 
page and see exactly how they will look when you publish the site. In text mode, you 
can work on a page as if you were working in a word processor. You draw a text box 
and then use it to contain graphics, Java applets and servlets, components, and 
other objects, as well as text. This design method keeps your HTML code lean. If 
xxi



   

Generate HTML That Works Everywhere

   
you want more control over HTML, you can use your favorite HTML editor for all 
or part of a page, for as many pages as you want.

Generate HTML That Works Everywhere
A major challenge when building sites today is overcoming browser disparity 
problems. If you use the wrong site-building tool, you can waste time and energy 
building and maintaining several versions of a site, each one targeting a different 
browser. When you use NetObjects Fusion these problems disappear. You can 
depend on the NetObjects Fusion HTML generation capability to provide 
Everywhere HTML. Whether you’re designing for a 2.0 browser or for the latest 
DHTML-capable browser, NetObjects Fusion generates HTML that works.

Add Dynamic Content
NetObjects Fusion makes it easy for you to add dynamic content to your site 
whether you want simple object animation or custom JavaScript actions. You can 
have objects fly across the screen as the result of a site visitor’s action. Or you can 
launch a sequence of animations at any given time. You can also reduce your 
visitors’ download time by having text, graphics, or other objects appear as needed. 
NetObjects Fusion contains powerful message-based animation and interactive 
authoring capabilities that you can use to achieve these effects.

About This User Guide
This book explains how to build a site using NetObjects Fusion. In addition to the 
basics of designing with text and graphics, creating links, and so on, you’ll find 
chapters that elaborate on special topics, including data publishing and using 
NetObjects Fusion Components.

Before you begin your projects, refer to Building Business Web Sites and work 
through the lessons. This is the most efficient way to learn NetObjects Fusion. If you 
are already familiar with an earlier version of NetObjects Fusion, read “If You Are 
Upgrading...” in Building Business Web Sites.

The manuals and online help assume you are proficient with Windows 95, Windows 
98, or Windows NT. If you need help using these systems, consult their respective 
user guides.
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This guide also assumes you are familiar with the World Wide Web and its 
terminology. For general advice about the Web and examples of how to use 
NetObjects™ products, visit the NetObjects Web site, www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com.

For readability, this manual presents all file names, paths, file extensions, HTML 
tags, and URLs in boldface boldface boldface boldface. Example names that you should replace with your own 
names appear in bold italic.

NetObjects Fusion often provides multiple ways to accomplish a task. For example, 
to display a page in Page view, you can click the Page button on the control bar, 
choose Page from the View menu, or press Ctrl+2. Procedures in this guide 
generally include the most convenient method, but other methods are usually 
available. If you are most comfortable using menu commands, you will probably 
find the item you are looking for on a menu even if it is not explicitly included in the 
steps. If you prefer using shortcut keys, check the NetObjects Fusion Quick Reference 
card.

Getting Help
NetObjects Fusion offers several options for getting online help:

✦ Select Help Topics from the Help menu to launch the help system and display 
the table of contents.

✦ Right-click an object in any NetObjects Fusion window or a control in a dialog 
or palette, then select What’s This? from the shortcut menu.

✦ Click the question mark icon in the title bar of a dialog or palette, then click the 
item you want to learn about.

✦ Highlight a menu command, then press F1.

✦ Select one of the Web options from the Help menu—for example NetObjects 
Web Site—to open your browser and display the NetObjects Home page, which 
contains links to information about NetObjects Fusion. You must be connected 
to the Internet for this to work.
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NetObjects Fusion Basics 1
NetObjects Fusion 4.0 incorporates new technologies with the current browser 
environment to help you meet today’s site building challenges. Using NetObjects 
Fusion you’ll find it easy to build dynamic, content-rich sites that use the latest 
interactive technologies, including CSS Positioning and Dynamic HTML. You don’t 
need to build multiple versions of your site; you can depend on NetObjects Fusion’s 
Everywhere HTML to generate HTML that works on all browsers.

This chapter introduces NetObjects Fusion, including information about:

✦ NetObjects Fusion views

✦ NetObjects Fusion window

✦ Navigating in NetObjects Fusion

✦ Choosing colors and working with color palettes

✦ NetObjects Fusion folder structure
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NetObjects Fusion Views
NetObjects Fusion provides five views that correspond to the tasks you complete 
when you design and build a site. Changes you make in one view are reflected in the 
others. You can go to any view at any time by clicking a button on the control bar at 
the top of the NetObjects Fusion window.

✦ Start with Site view to create the hierarchical structure of a site or to import an 
existing site. You can see a structural map of the site, which is a graphical view 
that shows how the pages relate to each other, or an outline view similar to the 
Windows Explorer. You can quickly rearrange your site by dragging and 
dropping pages and sections. See Chapter 3, “Creating and Managing Sites.”

✦ Use Page view to design pages and add content. In Page view you see the Layout 
area and MasterBorder of each page. The Layout area displays objects that are 
unique to that page. The MasterBorder contains objects that repeat on a set of 
pages, much as headers and footers appear in a word processing document. See 
Chapter 6, “Page View Basics.”

✦ A SiteStyle consists of a variety of elements, including navigation buttons, 
banners, lines, and text color. In Style view you can create your own SiteStyle, or 
choose from more than 50 pre-built SiteStyles to give your entire site a 
consistent look and feel. See Chapter 16, “Using SiteStyles.”

✦ Assets include the files, links, data objects, and variables that you reference in 
your site. Assets view gives you centralized control over all these referenced 
entities. When you change an asset, NetObjects Fusion updates every reference 
to that asset throughout the site. See Chapter 27, “Managing Assets.”

✦ When you are ready to publish the completed site, go to Publish view to 
configure file transfer settings, generate the HTML for your site, and transfer 
your site to a local or remote server. See Chapter 28, “Publishing Your Site.”

Site, Page, Style, Assets, and Publish view buttons are always available

Site view
is selected

These buttons change 
depending on the view
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NetObjects Fusion Window
When you start NetObjects Fusion and create a new blank site, you see a window 
containing a Home page icon, a Standard toolbar docked at the left side of the 
window, and a Properties palette.

The title bar, menu bar, and control bar are at the top of the NetObjects Fusion 
window. The title bar shows the name of the current site.

About the Properties Palette
When you click an object in Site or Page view, the properties palette changes to 
display the properties available for that object. Properties appear on tabs that also 
might change when the selected object changes. For example, when you select a text 
box in Page view, the Text Properties palette includes Text Box and Actions tabs. 

Toolbar

Page icon in Site view

Control bar

Title bar
Menu bar

Properties palette
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When you double-click in the text box to edit the text, the Format tab is added to 
the display.

To shrink the properties palette to display just its title bar, double-click the title bar 
or click the minimize button; do the same thing again to restore the full display. To 
completely hide the properties palette, click its close box. To show the palette again, 
from the View menu, select Properties Palette. A check mark on the menu indicates 
the palette is displayed.

About Toolbars
When you initially open NetObjects Fusion, the Standard toolbar is docked at the 
left side of the Site view window. Additional toolbars are available in Page view.

You can move a toolbar by positioning the pointer over the double line at its top and 
dragging it anywhere in the window. To dock the toolbar, double-click its title bar or 
drag it to the left side or top of the window.

A small triangle in the lower right corner of a tool button indicates the tool is one of 
a group. To see the entire group, point to the tool and hold down the left mouse 
button. A flyout containing the other tools in the group appears. As you move the 
pointer over each tool, a ToolTip identifies the tool group and the name of the 
specific tool.

Position the pointer here and drag to move the toolbar

Triangle indicates tool is one of a group
1-4 NetObjects Fusion BasicsNetObjects Fusion BasicsNetObjects Fusion BasicsNetObjects Fusion Basics



 

Navigating in NetObjects Fusion

       
Draw tool flyoutDraw tool flyoutDraw tool flyoutDraw tool flyout

To select a tool from a flyout, position the pointer over the tool and release the 
mouse button. The tool you select is displayed on the toolbar. For example, if you 
point to the Draw tool on the Page view Standard toolbar and hold down the left 
mouse button, you can draw a Rectangle, Rounded Rectangle, Ellipse, or Polygon.

To hide and show toolbars, from the View menu choose Toolbars, Name of toolbar. 
A check mark on the menu indicates a toolbar is displayed.

Using the Zoom ToolsUsing the Zoom ToolsUsing the Zoom ToolsUsing the Zoom Tools

Zoom toolsZoom toolsZoom toolsZoom tools

You can select the Zoom In or Zoom Out tool from the Standard toolbar in Site and 
Page views. The Zoom In tool is a magnifying glass with a plus sign; the Zoom Out 
tool has a minus sign.

You can reverse the function of the current Zoom tool by holding down the Alt key. 
For example, if the selected Zoom tool is Zoom In, pressing Alt changes it to Zoom 
Out. When you release the Alt key, it becomes Zoom In again.

Navigating in NetObjects Fusion
NetObjects Fusion provides several navigation tools, including buttons on the 
control bar and the Go menu.

Using the Control Bar Buttons
You use the buttons on the left side of the control bar to move between views. See 
“NetObjects Fusion Views” on page 1-2.

The buttons on the right side of the control bar provide shortcuts you can use to 
move from page to page and preview your site.

To see how the site will appear a browser with options you specify in the Preferences 
dialog, click the Preview button.

To create a new page in Site view or Page view, click the New button. In Style view, 
you use this button to create a new SiteStyle; in Assets view, to create a new file, link, 
data object, or variable; and in Publish view to create a new folder.

To search the entire site for any named NetObjects Fusion item (a page, layout, style, 
data list, and so on), click the Go to button, enter the name, or partial name, of the 
item you want to locate, and click OK. If only one object meets your criteria, 
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NetObjects Fusion opens the appropriate view or dialog to display the object. If 
several objects meet your criteria, NetObjects Fusion lists them so you can pick one.

To return to the previous page or view, click the Last button. Click the button again 
to redisplay the current page or view. Use this button to quickly switch back and 
forth between the current and last page or view.

Using the Go Menu
The Go menu provides all the navigation features in one place and shows equivalent 
keyboard shortcuts. A dot to the left of a command indicates the current view.

The Go menu commands vary slightly from view to view.

✦ From all views you can go to any other view. From Site view and Assets view you 
can also navigate to the subviews; from Page view you can go to other pages.

✦ Use the Go To command the same way you use the Go to button on the control 
bar to find any named object in your site.

✦ Use the Last command to go to the last page or view you were working on.

✦ Use the Recent command to select from a list of the views and pages you 
displayed during the current session.

✦ Use the Preview command to launch your browser and display a preview of your 
site.

Go menu presents 
navigation commands 
and keyboard navigation 
shortcuts
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Using Shortcut Menus
NetObjects Fusion provides shortcut menus you open by right-clicking an item in 
Site, Page, and Publish views. The menu lists the commands you can use on the 
selected item. In all views, and in dialogs and properties palettes, you can right-click 
an item and select What’s This? from the shortcut menu to display context-sensitive 
help for the item.

Choosing Colors
In NetObjects Fusion, whenever the properties palette includes a Color button, you 
can change the color of the selected object. For example, you can change the color of 
the page icons or the background in Site view, objects in Page view, or link text color 
in Style view.

To choose a color for a selected object:

1. Click the Color button in any properties palette where it is offered or double-
click a text style element in Style view.

The Color Picker appears.

Right-click a page icon 
in Site view to see this 
shortcut menu

Current palette

Colors you used recently
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The name of the current palette is shown above the color display. The last eight 
colors you selected from the palette are displayed in the Recent Colors boxes.

2. Click the color you want to assign to the object.

The Original and New boxes show the original color and the color you just 
selected. RGB and HTML hexadecimal values are also displayed.

You might see a warning that the selected color is not Web safe. To avoid 
unexpected results for your site visitors, choose colors that are Web safe.

3. Click OK.

The new color appears in the selected object.

Working with Color Palettes
When you choose colors for the objects in your site, you select from the palette 
offered in the Color Picker. You can use the Browser Safe Palette, which contains 
colors that are Web safe, the palette used by Windows, a palette you import from 
another application such as Adobe Photoshop, or a custom palette you create.

Choosing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears.

2. Select a palette from the drop-down list at the top of the dialog. If you choose 
Custom Palette and want to load an existing custom palette, see “Loading a 
Custom Color Palette.” To create your own custom palette, see “Creating or 
Editing a Color Palette.”

The palette is displayed in the Color Picker until you change it.

3. Click OK.

Loading a Custom Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears.

2. Select Custom Palette from the drop-down list at the top of the dialog.

A blank palette appears.
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3. Click Load.

4. In the Open dialog, navigate to the palette you want to use, then click Open.

This palette is displayed in the Color Picker until you change it.

5. Click OK to close the Color Picker.

Creating or Editing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears.

2. Select Custom Palette from the drop-down list at the top of the dialog.

A blank palette appears.

3. Click a box in the palette area.

4. Set the RGB values for the color you want to add to the palette, type the 
hexadecimal (HTML) value for the color, or double-click the blank box and 
choose or create a color in the Color dialog.

5. Repeat step 4 for each color you want to add to the palette.

6. Click Save.

7. In the Save As dialog, type a file name for the palette and click Save.

The new palette is displayed in the Color Picker until you change it.

NetObjects Fusion Folder Structure
The NetObjects Fusion 4.0NetObjects Fusion 4.0NetObjects Fusion 4.0NetObjects Fusion 4.0 folder contains all the files you need to use NetObjects 
Fusion.

Do not move or rename the NetObjects Fusion 4.0NetObjects Fusion 4.0NetObjects Fusion 4.0NetObjects Fusion 4.0 folder or any folders within it. 
NetObjects Fusion performs best when the application and its parts remain in the 
folder recommended during installation. This is especially true with the \User Sites\User Sites\User Sites\User Sites 
folder. Since NetObjects Fusion keeps track of assets and links, folder names and 
locations are very important. If you change names and/or locations using Windows 
Explorer or File Manager, Net Objects Fusion might not be able to track assets and 
links properly. 

The subfolders organize files according to their use:
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✦ \Components contains the NetObjects Fusion Components, mini-applications 
that can add sophisticated functions to your site. See Chapter 24, “Using 
NetObjects Fusion Components” for information.

✦ \Java contains Java applets and beans.

✦ \NetObjects System contains files used by the program; do not delete or remove 
these files.

✦ \Samples contains design parts such as picture files and animated .gifs.gifs.gifs.gifs, plug-in 
parts such as media files and Java applets, as well as sample sites that 
demonstrate NetObjects Fusion 4.0 features.

✦ \Styles contains a separate folder for each SiteStyle, including the ones you 
create. NetObjects Fusion style files have an .ssf.ssf.ssf.ssf extension. See Chapter 16, 
“Using SiteStyles” for information.

✦ \Templates contains AutoSites™, Forms, and Page templates. A NetObjects 
Fusion Template file has an .nft.nft.nft.nft extension and its own Assets folder. See 
Chapter 4, “Working with Templates” for information about templates.

✦ \Tutorial contains the assets you need for the lessons in Building Business Web 
Sites.

✦ \User Sites contains all the sites you create. NetObjects Fusion automatically 
creates a new subfolder within \User Sites\User Sites\User Sites\User Sites to keep your projects organized. Each 
NetObjects Fusion site is saved with a .nod.nod.nod.nod extension. The site folder also 
includes an \Assets\Assets\Assets\Assets folder where the assets originally included in the site 
template are saved, a \Preview\Preview\Preview\Preview folder where HTML sufficient for previewing but 
not for publishing is stored, and a \Backups\Backups\Backups\Backups folders where backup .nod.nod.nod.nod files are 
saved. You can also save sites in other locations.
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Setting Preferences 2
You can change your preferences from any view. Changes take place as soon as you 
click OK to close the Preferences dialog. Most General and International preferences 
apply throughout NetObjects Fusion and affect all sites; Page and Backup 
preferences affect the current site only and are saved with the site.

This chapter explains how to set:

✦ General preferences

✦ Page preferences

✦ Backup preferences

✦ International preferences
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Setting General Preferences
➲ From the Edit menu, choose Preferences.

The General tab of the Preferences dialog appears.

✦ Auto Save. When this option is selected, your site is saved each time you change 
views or pages. If you clear the Auto Save check box, be sure to save your site 
periodically by choosing Save Site from the File menu.

✦ Application window maximized at startup. If you clear the check box for this 
option, the NetObjects Fusion window opens in the last size you set, rather than 
full screen size.

✦ Open to most recently used file at startup. If you select this option, when you start 
NetObjects Fusion, the last site you worked on opens automatically, displayed in 
the last view you worked in.

✦ Use Small Fonts in Properties Palette. If you clear this check box, you see larger 
properties palettes in Page view. To maximize the area available for your page 
Layout, leave this option selected.

✦ Preview. Choose the Web browser you want to use for previewing sites by 
selecting it from the Browser drop-down list.
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If you have more than one version of a browser installed, when you select 
Preview, NetObjects Fusion launches the version that was most recently opened. 
To use other versions, you must launch them manually from the Windows Start 
menu. For example, suppose you have both Netscape Navigator 3.0 and 4.0 
installed. You open Navigator 4.0 to check your stock portfolio, then close it and 
begin working on a site in NetObjects Fusion. When you preview the site, 
NetObjects Fusion launches Navigator 4.0 because it was the last version 
opened. To preview in Netscape Navigator 3.0, you must launch it manually. 
Once you open Navigator 3.0, NetObjects Fusion uses it for previews until you 
manually launch another version.

Also choose whether you want to preview only the Current Page or the Entire 
Site for the site you are working on. Previewing the entire site takes longer, but 
you can move from page to page in the browser to test your site’s navigation 
buttons. Select the Current Page option to preview only the current page or the 
current section of pages.

You can also use keyboard shortcuts to preview either the whole site or just the 
current page or section:

✧ If Entire Site is selected in Preferences, pressing Alt+P or clicking the Preview 
button previews the entire site; pressing Ctrl+Alt+P or clicking the Preview 
button while pressing Ctrl previews just the current page or section.

✧ If Current Page is selected in Preferences, pressing Alt+P or clicking the 
Preview button previews the current page or section; pressing Ctrl+Alt+P or 
clicking the Preview button while pressing Ctrl previews the entire site.

✦ WYSIWYG Optimization. Choose whether Page view should display text spacing as 
it will appear in Netscape Navigator or in Microsoft Internet Explorer in the site 
you are working on. 

✦ HTML editor. Click Browse and find the file that launches your editor. For 
example, you can install Allaire HomeSite, which is included with NetObjects 
Fusion 4.0, and select it here to make it the default HTML editor. When you 
want to edit the HTML of an External HTML object, double-click the External 
HTML’s X in Page view to launch the selected editor. See Chapter 26, “Working 
with HTML Directly.”
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Setting Page Preferences
➲ From the Edit menu, choose Preferences and click the Page tab.

✦ Browser Font Settings. Choose Proportional and Fixed Width font settings. To 
ensure that your pages appear in your browser the way you design them in 
NetObjects Fusion, choose the same font settings in your browser. For example, 
if you use Times, size 12, and Courier, size 10, for your browser proportional 
and fixed width fonts, choose the same fonts and sizes in NetObjects Fusion. 
Note that the suggested settings are the defaults used by the browser when it was 
installed.

This setting does not add <FONT> tags to the text. To do this, you must modify 
the Normal paragraph style. See “Modifying a Text Style” on page 12-7.

Be aware that NetObjects Fusion sizes text boxes based on the expected font size, 
so when you change sizes, you change the Layout of the page slightly.

✦ General. Choose the measurement unit you want to use as you build your site. 
Then specify a width and height in this unit of measurement for your default 
page and grid sizes. When you add a new page to your site, it will have this size. 
Changing this option does not change the size of existing pages in your site. 
However, if you change the Grid Size setting, it will change the size of the grid on 
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both new and existing pages. For more information about page size, see 
“Displaying Pages in Page View” on page 6-3.

✦ Background Image (pixels). Most Web browsers add a margin at the top and left of 
the page; this margin can vary from 6 to 16 pixels. However, no margin is added 
for background images; a background image is aligned at the top and left edges 
of the page. If you need to match a background pattern to objects on the page, 
use this setting to compensate for the shift of your content in the browser.

If Offset is not selected, NetObjects Fusion uses Left 0, Top 0 as the settings. 
With Offset selected, Left set to 10, and Top set to 16, the settings are optimized 
for Netscape Navigator 3.0 and Microsoft Internet Explorer 3.0 and 4.0 running 
on Windows. However, not all browsers on all platforms use the same margin. 
For example, Netscape Navigator 4.0 for Windows and 3.0 for Macintosh use 
Offset selected, Left 8, Top 8. These settings also do not apply if you use frames; 
in that case the settings are always Left 2, Top 1. If you set the Background Image 
Offset, be sure to test your pages using the browsers you want to support.

Setting Backup Preferences
➲ From the Edit menu, choose Preferences and click the Backup tab.
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✦ Automatic Backup. This option is selected by default. When you close NetObjects 
Fusion, the program automatically backs up your .nod.nod.nod.nod file and saves it in the 
\Backups\Backups\Backups\Backups subfolder under the \User Sites\User Sites\User Sites\User Sites\sitename folder. If you need to use one of 
these backup files, copy it from the \Backups\Backups\Backups\Backups folder into the \User Sites\\User Sites\\User Sites\\User Sites\sitename 
folder before you open it so the asset paths will be correct.

If you do not want NetObjects Fusion to automatically back up your sites, clear 
the check box.

✦ Backup Settings. NetObjects Fusion saves backup files in the \User Sites\\User Sites\\User Sites\\User Sites\sitename 
folder by default. To change the location of the backup files, type a new path 
name in the Backup location field, or click Browse and select a new location.

Select a backup file name convention from the drop-down list: you can choose a 
plain format or one that includes the date and time.

Indicate the number of backups you want NetObjects Fusion to keep. The oldest 
backups are overwritten as newer backups are created. The default is 2 backups; 
if you have adequate disk space, change this setting to 5.

✦ Compact database upon exit. This option is selected by default. Compacting the 
files can save you substantial hard disk space. In addition, when this option is 
selected, NetObjects Fusion performs an error-checking procedure to verify 
your database as it compacts the files. It is recommended that you do not change 
this setting. 

Warning: Do not shut down Windows while the file is being compacted. This could 
cause your .nod.nod.nod.nod file to become unstable.
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Setting International Preferences
➲ From the Edit menu, choose Preferences and click the International tab.

✦ Date, Time, and Decimal Formats. The date, time, and decimal formats you select 
affect how these items are displayed wherever they appear in NetObjects Fusion; 
for example, the last published date of items in Publish view and the size of the 
page in Page view. These settings do not affect generated HTML or text you 
enter on Web pages. 

Select a format from the Date/Time drop-down list. A sample of the format is 
shown next to each language. To determine the decimal point character, select a 
format from the Decimal drop-down list. If you choose Use System Setting for 
either option, NetObjects Fusion uses the setting in the Windows Regional 
Settings Properties dialog.

✦ Spelling Dictionary. Select the dictionary you want to use when checking spelling.

✦ Sort Order. Character variations between languages result in variations in sorting 
priorities. To ensure that items in Assets view and Publish view are sorted 
correctly, you can choose the appropriate sort order. This affects only how the 
items are displayed in NetObjects Fusion; it does not affect the generated 
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HTML. If you choose Use System Setting, NetObjects Fusion uses the current 
system sort setting.

✦ Imported text uses character set. For information about character sets, see 
Appendix B, “Working with Character Sets.”
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Creating and Managing Sites 3
Site view is where you create, view, and maintain the architecture of your site. Site 
view frees you from the details of file and link management, so you can focus on 
organizing and updating your site. For example, you can drag a page or section to 
any location in Site view, and NetObjects Fusion updates the links to other pages 
automatically.

This chapter describes Site view and its automated site-building capabilities, 
including:

✦ Starting NetObjects Fusion

✦ Starting with a blank site

✦ Opening an existing site

✦ Working with the SiteStructure

✦ Selecting and creating sections

✦ Setting page and section properties

✦ Adding, deleting, and moving pages

✦ Renaming pages

✦ Printing the SiteStructure

✦ Working with the site outline

✦ Saving and backing up your site
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Starting NetObjects Fusion
When you install NetObjects Fusion, it is added to your Windows Start menu.

➲ From the Start menu, choose Programs, NetObjects, NetObjects Fusion 4.0.

When NetObjects Fusion starts, the Welcome dialog appears.

✦ Creating a blank site and opening an existing site are described “Creating and 
Opening Sites” on page 3-3.

✦ Creating a new site based on a NetObjects Fusion AutoSite™ or template file is 
described in Chapter 4, “Working with Templates.”

✦ Creating a site from an existing Web site is described in Chapter 5, “Importing 
Existing Sites.”

You can set preferences so NetObjects Fusion automatically opens your last file each 
time you start the program. See “Setting General Preferences” on page 2-2.

Working with Site Files
A NetObjects Fusion site file is a database of information about your site. Site files 
have a .nod .nod .nod .nod extension.

Site files are stored in a folder that has the same name you give the site. For example, 
if you name the site FruitFruitFruitFruit, the site’s folder is called FruitFruitFruitFruit, and the site file—Fruit.nodFruit.nodFruit.nodFruit.nod—
is saved inside the folder. The site folder contains a folder with the assets included in 
the original template as well as a \Backups\Backups\Backups\Backups folder. Once you preview or publish the 
site, a \Preview\Preview\Preview\Preview folder is added.
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By default your site folder is saved inside the \User Sites \User Sites \User Sites \User Sites folder, but you can store the 
site in any location on your local computer. Because the paths to the assets in a site 
file are absolute—they include the drive and folder names—you cannot save the site 
file on another computer on a network. To do that, you must export the site as a 
template, as described in Chapter 4, “Working with Templates.”

Creating and Opening Sites
When you create a site, you always begin with a template, ranging from the simple 
Blank Site template to the professionally designed templates provided with 
NetObjects Fusion. You can also derive templates from sites you create.

A template is a fully designed page or site that you can use as a starting point for 
your own pages or sites. A typical template might include a banner and navigation 
buttons, an assigned SiteStyle, and text or other content. You can start a new site 
from a template or insert one into your current site. Once inserted into a site, you 
can modify template pages any way you like. Templates are described in detail in 
Chapter 4, “Working with Templates.” 

You can also open an existing site and add to it, change its style, or modify it.

Starting with a Blank Site
You can build a new site from a blank site, which is a template that consists of a 
Home page with a banner and navigation buttons.

To start with a blank site:

1. From the File menu, choose New Site, Blank Site.

The New Blank Site dialog appears.

You can also start a blank site by selecting the Blank Site option in the Welcome 
To NetObjects Fusion dialog.

2. Enter a site name in the dialog.
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For cross-platform compatibility, do not give your site a name with more than 
26 characters.

3. Click Save.

Site view opens and displays a Home page. You can begin developing the 
SiteStructure, as described on page 3-9.

Starting with a Site Wizard
You can also start a new site by installing and using a Site wizard. For example, you 
can install iCat E-Commerce Wizard 1.0, which you use to set up an e-commerce 
site using the service available on the iCat Web site. Or you can install Allaire Cold 
Fusion Data Entry, which helps you to build a data entry application so site visitors 
can enter records into a database. Several components are included with NetObjects 
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Fusion 4.0. See Building Business Web Sites for information about these components 
and also refer to the documentation provided by the component publisher, which is 
included on your NetObjects Fusion 4.0 CD. For information about the latest 
components, check www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com. You can purchase components at the 
NetObjects online store at www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com.

To start with a Site wizard:

1. In Site view, from the File menu, select Launch Site Wizard.

The Select Site Wizard dialog appears.

2. Select an item from the list and click OK.

3. Follow the instructions appropriate for the individual component.

Opening an Existing Site
1. From the File menu, choose Open Site.

The Open dialog appears.

2. Open the folder that contains the site you want to open.

3. Select the site’s .nod.nod.nod.nod file and click Open.

You can also open an existing site by:

✦ Selecting it in the Welcome To NetObjects Fusion dialog.

✦ Choosing it from the list of recently used files on the File menu.

✦ Double-clicking the .nod.nod.nod.nod file in Windows Explorer.

✦ Dragging the .nod.nod.nod.nod file from Windows Explorer to the NetObjects Fusion 
window.
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Working with the SiteStructure
In Site view, the structure of your site is represented by page icons. As in a family 
tree, pages have parent, child, and sibling relationships.

In Site view you can add pages to the site, rename pages, move them, delete them, 
and complete other site-oriented actions. To add content to a particular page—for 
example, to add text or pictures—use Page view. As you construct a site, you 
typically go back and forth between Site view and Page view.

Selecting a Page
Before you can add, rename, or move pages, or set page properties, you must first 
select a page. By selecting a page, you identify it as the one you will work with. 
NetObjects Fusion places a blue border around the selected page.

The pages named Apples, Oranges, and 
Grapes are children of the Home page and 
siblings of each other. The Grapes page is 
the parent of Raisins and Wine

Selected page has a 
blue border
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To select a page:

✦ Click the Selection tool on the toolbar and then click the icon for the page you 
want to select. Don’t click the page’s name unless you want to rename the page.

✦ Press the arrow keys to select the current page’s parent, child, or sibling pages.

Working with a Group of Pages
In addition to selecting individual pages, you can select sections of your site. A 
section is any page and all its children, their children, and so on.

To select a section:

✦ Hold down the Shift key and click the parent page of the section.

✦ Select the parent page of the section and press Shift+Enter.

NetObjects Fusion places a blue border around the pages in the section.

Sections are not permanent entities. You can deselect the section by clicking any 
page in the site, or by clicking the Site view background.

This page and its children are a 
section, as indicated by the border
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Setting Page and Section Properties
Pages and sections have properties. Some properties affect the published site; others 
are for your information only. For example, you can assign colors to the page icons 
to create visual groups that indicate which pages are finished or which are assigned 
to a particular developer. You can instruct NetObjects Fusion not to publish a 
particular page, note if a page is done, and enter comments about the selected page.

You can set the following page properties:

✦ Name. The name assigned to the page. See “Renaming Pages” on page 3-11.

✦ Custom Names. See “Using Custom Page Names and Extensions” on page 3-11.

✦ Page Type. Shows whether the page is a normal page or a stacked page. You 
cannot change this setting; it is determined by how the page was created. For 
information about stacked pages, see Chapter 25, “Data Publishing.”

✦ Color. Sets the color of individual page icons in Site view. The page icon’s color 
has no effect on the published site.

✦ Status. Marks pages as Done or Not done, a convenient way to manage 
individual pages in a large site. This setting has no effect on the functioning of 
the site. The page icon displays a check mark when you select Done.

✦ Publish/Don’t publish. Makes it possible to publish some pages while not 
publishing others that might be under construction or private. The page icon 
displays a red indicator when you select Don’t publish.

Page properties Section properties
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NetObjects Fusion removes pages marked Don’t publish from the navigation 
bars of other pages in the site, disables manually created links to such pages, and 
does not produce HTML for these pages during publishing. However, you can 
preview a page that is designated Don’t publish as an individual page.

Do not use the Don't publish setting in an attempt to publish only changed 
pages to an already-published site. Doing so causes broken links and other 
undesirable results. Instead, you can publish a section of the site to update it. See 
Chapter 28, “Publishing Your Site.”

✦ Comments. Enter notes about the status or content of individual pages.

You can set the following section properties:

✦ MasterBorder. Sets the MasterBorder for all pages in the section. See “Applying a 
MasterBorder to a Section” on page 10-6.

✦ Custom names. You can only set a custom file extension. See “Using Custom Page 
Names and Extensions” on page 3-11.

✦ Color. Applies a color to the page icons included in the section.

✦ Status. Marks all page icons in the section as Done or Not done.

✦ Publish/Don’t publish. Sets the publication flag for all page icons in the section.

Adding a Page
1. In Site view, select the page you want to be the parent of the new page.

2. Click the New button on the control bar.

In Site view, the new page appears beneath the selected page. The new page is 
named Untitled.
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Deleting a Page
1. In Site view, select the page you want to delete, right-click the page icon, and 

choose Delete Page from the shortcut menu.

2. Click Yes to confirm the deletion.

Note: Deleting a page removes all its child pages and cannot be undone. You cannot 
delete the Home page.

Moving a Page
When you move pages in Site view, NetObjects Fusion updates all affected links 
within the site.

1. In Site view, select the page you want to move. You cannot move the Home page.

2. Drag the page to the target page, where it becomes either a sibling or a child in 
its new location.

As you drag the page, a colored outline highlights the target page. A triangle to 
the left or right of the target page’s border indicates the moved page will be a 
sibling; a triangle below the target page’s border indicates the moved page will be 
a child.

If you want to move a page so it will be the child of a page that already has 
children, target the sibling page.

A triangle on the side of the target page icon 
shows that the moved page will be a sibling

A triangle on the bottom of the target page icon 
shows that the moved page will be a child
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Renaming Pages
By default, NetObjects Fusion uses the page name on banners and navigation 
buttons that identify the page. When you publish your site, NetObjects Fusion uses 
the page name as the HTML file name for the page. It also uses the page name when 
it creates links to the page.

NetObjects Fusion converts spaces and non-alphanumeric characters except 
periods (.) and hyphens (-) in the page name to underscores (_) in the HTML file 
name. To change this default, see “Defining Server Profiles” on page 28-11.

If you give two pages the same name, NetObjects Fusion adds a numeral to the file 
name when it creates the HTML files for the second and any additional pages. For 
example, if you have two pages named Great, NetObjects Fusion creates great.htmlgreat.htmlgreat.htmlgreat.html 
and great1.htmlgreat1.htmlgreat1.htmlgreat1.html.

You can change the name directly on the page icon or in the Name field on the Page 
tab of the Properties palette. For cross-platform compatibility, do not give your page 
a name with more than 26 characters.

To rename a page on the page icon:

1. In Site view, click the page name text and type a new name.

2. Press Enter or click outside the page icon to enter the name.

Once in this edit mode, you can tab between sibling pages to edit their names. 
NetObjects Fusion remains in edit mode until you press Enter. If a page has no 
siblings, pressing Tab moves the text edit selection to the page’s parent.

To rename a page on the Properties palette:

1. Select the page you want to rename.

2. Edit the text in the Name field on the Page tab of the Properties palette.

3. Press Tab or click outside the palette to enter the new name.

Using Custom Page Names and Extensions
By default, the browser window title bar, banners, and navigation buttons use the 
page name. If you prefer, you can specify different names. If you have a long page 
name, you can break it into two lines so it fits on the banner and buttons.

To specify custom page names:
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1. In Site view, select the page you want to name.

2. On the Page tab of the Properties palette, click the Custom Names button.

3. In the Custom Names dialog, type the custom names you want to use.

✦ Page Title. Appears in the title bar of the browser window when it displays 
this page. When site visitors bookmark this page, the page title is used. The 
title is also emphasized in search engine queries.

✦ Navigation Button. Appears on navigation buttons leading to this page. To 
add a second line of text, press Enter after the first line.

✦ Banner. Appears in the page’s banner. To add a second line of text, press Enter 
after the first line.

✦ File Extension. Page files usually have an .htm.htm.htm.htm or .html.html.html.html extension. A page 
sometimes requires a different extension to function with specific server 
software. For example, pages for secure locations use the extension .shtml.shtml.shtml.shtml.

The extension you choose for this page overrides the extension you specify in 
Publish view, which applies to all pages in the site.

4. When you finish entering names, click OK.
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Setting Site View Properties
The Site tab of the Properties palette displays site information. When you enter an 
author name, NetObjects Fusion includes it in a META tag that appears in each 
page’s HTML file header when the site is published. If you do not fill in this field, 
the META tag is not generated. See “Setting Advanced HTML Options” on 
page 28-9.

On the View tab of the Properties palette, you can change the Site view orientation 
and background color. The orientation and background color are strictly for 
working in Site view. They have no effect on the published site.

To change orientation, click the button for the orientation you want. To change 
background color, click the Color button and select a new color from the Color 
Picker. 

Click here to change the orientation in Site view

Click here to change the background color in Site view
Creating and Managing SitesCreating and Managing SitesCreating and Managing SitesCreating and Managing Sites 3-13



   

Collapsing the SiteStructure Display

     
Collapsing the SiteStructure Display
By collapsing the display of the SiteStructure, you hide the child pages of a selected 
page, displaying only the page icons you want to see. A page with hidden child pages 
displays a plus symbol beneath its icon.

To collapse the display of child pages, click the triangle beneath the parent’s page 
icon. To expand the display to see child pages again, click the plus sign.

You can also collapse the display by selecting a parent page and pressing Tab. To 
expand the display, press Tab again.

The Structure and Outline views display the same expanded and collapsed pages. If 
you change the child pages hidden and shown in one view, the other view reflects 
your changes.

Printing the SiteStructure
In Site view, you use the Print command on the File menu to print the SiteStructure 
view of your site or of a section. You cannot print the Site Outline view. The printed 
structure shows the same magnification, colors, orientation, and expanded or 
collapsed child pages that you see on the screen. The printout shows the site name 
in the header and the number of site pages in the footer.

✦ To print the entire site, select the Home page, or click All in the Print dialog.

✦ To print a specific page and its children, select the top-level page or a section, or 
click Selected page and its children in the Print dialog.

Click here to collapse 
the SiteStructure

Click here to expand 
the SiteStructure
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✦ To view what will be printed, select Print Preview from the File menu. Select 
Close to return to Site view.

✦ To fit a large site on a single page, from the File menu, choose Print Setup, and 
select the Print to fit option in the Print Setup dialog.

Working in Site Outline View
Site Outline view displays the SiteStructure in outline format, including a table of 
the properties—child name, page type, status, publishing status, and comments—
of the child pages of the currently selected page. If the selected page has no children, 
the table describes the selected page itself.

To switch to Outline view:

➲ In Site view, click the Outline tab.

Like SiteStructure view, Site Outline view shows if a branch of the site is collapsed. A 
collapsed branch is indicated by a plus sign to the left of the page icon; an expanded 
branch is indicated by a minus sign.

✦ To expand a branch, click the plus sign to the left of a page.

✦ To collapse a branch, click the minus sign to the left of a page.

Sorting the Display in Outline View
In Outline view you can sort the child pages by their properties so you can quickly 
identify pages with common characteristics.

➲ Click the heading of the column you want to use to sort the list.

NetObjects Fusion sorts the list in ascending (A-Z) order. To sort the list in 
descending (Z-A) order, point to the column heading and press Shift+Click.

Click the minus sign 
to collapse this 
branch of the site

This branch of the site is 
collapsed. Click the plus 
sign to expand it
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Saving Your Work
To save your work, choose Save Site from the File menu. NetObjects Fusion also has 
an auto save feature that saves your work each time you change views. See “Setting 
Backup Preferences” on page 2-5.

Backing Up Your Site
You can back up your site manually or automatically.

To make a manual backup:

1. From the File menu, choose Save Site As.

The Save Site As dialog appears.

2. Type a descriptive file name for your backup file and select a location.

3. Click Save.

NetObjects Fusion creates a copy of the .nod.nod.nod.nod file in the location you specified and 

automatically opens that file.

Note: The backup you make with the Save Site As command does not collect all assets and 
make all links relative. Your backup will still refer to assets and components in the 
original site file folder. To make a backup with assets and relative links, export your site 
file as a template, as described in Chapter 4, “Working with Templates.”

For information on automatic site file backups, see “Setting Backup Preferences” on 
page 2-5. 
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Working with Templates 4
A template is a predefined set of pages and assets that you can modify to meet your 
needs. Templates can contain a single page, a site section, or an entire site. You can 
create a new site from a template or add a template to an existing site. 

You can export your NetObjects Fusion site as a template, so you can share your 
work with other NetObjects Fusion developers or move your site to another 
computer system.

This chapter describes:

✦ Creating new sites from templates

✦ Using templates to expand sites

✦ Exporting sites

✦ Sharing NetObjects Fusion site files
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NetObjects Fusion Templates and Sample Sites
NetObjects Fusion includes templates that can save you hours of work by giving you 
a jump start on designing pages, sections, or whole sites. Choose among three types 
of templates that you can use as a starting point for your site or insert as a section or 
page that you add to your current site:

✦ AutoSite templates provide a complete site with predesigned pages, a suggested 
SiteStructure, and placeholder content. AutoSite templates are stored in 
NetObjects Fusion 4.0\Templates\AutoSitesNetObjects Fusion 4.0\Templates\AutoSitesNetObjects Fusion 4.0\Templates\AutoSitesNetObjects Fusion 4.0\Templates\AutoSites. There are two AutoSite templates:

✧ Company Internet

✧ Department Intranet

✦ Page templates are professionally designed pages containing generic content that 
you can replace with your own information. Page templates include special-use 
pages, such as a calendar, an FAQ page, and a “what’s new” page.

✦ Form templates are predesigned form pages containing generic or placeholder 
content for typical forms, including a billing form, guestbook, order form, and 
product support form.

In addition to AutoSites, page, and form templates, NetObjects Fusion comes with 
sample sites, which are templates with content designed to showcase NetObjects 
Fusion features. Sample site templates are stored in the NetObjects Fusion NetObjects Fusion NetObjects Fusion NetObjects Fusion 
4.0\Samples\Sites4.0\Samples\Sites4.0\Samples\Sites4.0\Samples\Sites folder.
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Creating a Site from a Template
AutoSite templates provide a complete SiteStructure with predesigned pages and 
suggested content. You can also use templates that you or your colleagues create and 
templates created in previous versions of NetObjects Fusion.

1. To create a new site based on an AutoSite or other template:

✦ Open NetObjects Fusion, select From AutoSite or Template File in the Create 
a New Site section of the Welcome dialog, and click OK.

✦ If NetObjects Fusion is already running, from the File menu of any view, 
select New Site, From Template.

The Select a Template File dialog appears.

2. Open the folder containing the template you want, select the appropriate 
TemplateName.nft.nft.nft.nft file, and click Open.
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The Save Site As dialog appears.

3. Enter a name for the new site in the File name field. To ensure cross-platform 
compatibility, limit the name to a maximum of 26 characters.

4. Select the location where you want to save the site. By default, NetObjects 
Fusion saves your site in the NetObjects Fusion 4.0\User SitesNetObjects Fusion 4.0\User SitesNetObjects Fusion 4.0\User SitesNetObjects Fusion 4.0\User Sites folder, but you can 
store it in the location of your choice.

5. Click Save.

NetObjects Fusion opens in Site view and displays the page icons of the site you 
created. You can modify the SiteStructure as described in “Working with the 
SiteStructure” on page 3-6.

The first time you work with an AutoSite or page template, explore the individual 
pages in Page view before you delete or rearrange them.

Using Templates to Expand a Site
One way to expand a site is to append NetObjects Fusion templates to a specific 
location in your site. Appending templates is especially helpful if you have standard 
boilerplate sections or pages that you want to add to multiple sites. This is also a 
great way to share with other developers who use NetObjects Fusion. You can save 
sections or pages as templates and then incorporate them anywhere in your site. See 
“Exporting a Site” on page 4-6.

When you append a template, follow these guidelines:

Type a site name 
here
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✦ Before you insert the template, select the location in Site view where you want to 
append it. The inserted site, page, or section becomes a child of the selected 
page. You can move the pages once they are inserted.

✦ All inserted pages take on the SiteStyle of the current site. For example, if several 
developers separately create parts of a site, export their work as templates, and 
insert the templates into a single master site for publishing, the master site’s 
SiteStyle ensures that the compiled site has a consistent look and feel. If you save 
the site as a template, the SiteStyle is saved as well. See Chapter 16, “Using 
SiteStyles.”

✦ When NetObjects Fusion inserts a template, if the MasterBorder names 
duplicate those already in the site, it prefixes the template’s MasterBorders with 
Inserted and adds them to the current site’s library of MasterBorders. You can 
rename, manipulate, or delete these extra MasterBorders. See Chapter 10, 
“Managing MasterBorders.”

✦ Every template begins with a single root page, which is helpful if you are adding 
the template to your site. However, if you want the root page of your template to 
be the Home page of your site, you must create a new site based on the template, 
rather than inserting it. See “NetObjects Fusion Templates and Sample Sites” on 
page 4-2.

To insert a site or page template:

1. In Site view, right-click the page under which you want to insert the template. 
This page becomes the parent of the inserted page or pages.

2. Select Insert Template from the shortcut menu.

The Insert Template dialog appears.
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3. Navigate to the template you want to insert and select the TemplateName.nftnftnftnft file.

4. Click Open.

NetObjects Fusion inserts the template and appends it under the page you 
selected. The page data and all assets are stored in your current site folder. The 
original template is still available.

Exporting a Site
You can export any site as a template to use its style or content in another site. When 
you export a site as a template, NetObjects Fusion copies all assets into the \AssetsAssetsAssetsAssets 
folder of the template in the location you select, and converts absolute paths to 
relative paths. NetObjects Fusion includes the SiteStyle files and resources for any 
SiteStyle in use by the source site in the exported template. Exporting a site as a 
template (.nft.nft.nft.nft) is the only way to share sites with other NetObjects Fusion 
developers or to combine sites.

To create a template:

1. In Site view, from the File menu, choose Export as Template.

The Browse for Folder dialog appears.

2. Select the folder where you want to store the template and click OK.

NetObjects Fusion creates the template and stores it in a subfolder of the folder 
you selected. The current site remains open.
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Changing an Existing Template
You can change or customize any NetObjects Fusion template. For example:

✦ You can customize a standard company template so it contains your department 
name, location, and personnel information.

✦ If your company develops custom sites, you can add your company name, 
contact information, and default links to the templates you use most often.

✦ If you often create new pages or sites with the same look and feel, you can add 
standard objects to the NetObjects Blank site template.

To preserve the original template, copy the entire template folder, including the 
TemplateName\Assets\Assets\Assets\Assets subfolder, before you edit or modify a default template. If you 
need to undo changes to a default NetObjects Fusion template, you can re-install it. 
If your modified template includes a custom SiteStyle, see “Customizing a Template 
by Changing the SiteStyle” on page 4-8.

Customizing a Template
1. From the File menu, choose Open Site.

2. In the Open dialog, make sure NetObjects Fusion Template Files (*.nft*.nft*.nft*.nft) is 
selected on the Files of type drop-down list.

3. Select the template and click Open.

4. Using Windows Explorer or NT File Manager, copy assets you want to add to the 
template to the template’s \Assets\Assets\Assets\Assets folder.

5. Modify the template page(s) as needed.

6. To record the changes as part of the original template, choose File, Save Site.

To rename or move the template to a different folder, choose File, Save Site As. 
Select a new parent folder or enter a new name for the site. 

7. Click OK.

8. Insert the customized template as needed.
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Customizing a Template by Changing the SiteStyle

1. From the File menu, choose New Site, From Template. 

The Select a Template File dialog appears.

2. Select the template you want to customize and click Open. 

3. In the Save Site As dialog, enter a new name for the template, set the location 
where you want to save it, and click Save.

If you want to replace the original template with the new template, use the 
template name for the site.

NetObjects Fusion creates a site based on the selected template.

4. Change the template’s content, structure, or properties as necessary.

5. Go to Style view.

6. From the Style menu, choose Add Style To List.

The Open dialog appears.

7. Select the Stylename.ssf.ssf.ssf.ssf file for the SiteStyle you want to apply to the template, 
and click Open.

NetObjects Fusion adds the SiteStyle to the list.

8. Go to Site view. Click Yes to apply the new SiteStyle to the site.

9. From the File menu, choose Export as Template.

The Browse for Folder dialog appears.

10. Select a folder and save the custom template.

NetObjects Fusion creates the template and stores it in a subfolder of the folder 
you selected. If the site has the same name as the original template and you 
choose the location where the original template is stored, the new template 
replaces it. To create a new template, export the site to a new location.
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Sharing NetObjects Fusion Site Files
Templates are the only effective way to share NetObjects Fusion site files among 
several developers or across platforms. You cannot copy a Sitename.nod.nod.nod.nod file to 
another computer and open it, because the file refers to files and styles that are not 
contained in the Sitename.nod.nod.nod.nod file itself.

Note: If most of your sites involve the efforts of three or more developers using NetObjects 
Fusion, you should consider using NetObjects Authoring Server Suite, which uses 
client-server technology to manage, integrate, and safeguard the contributions of each 
team member. See www.netobjects.com www.netobjects.com www.netobjects.com www.netobjects.com for information.

To distribute or move a NetObjects Fusion site:

1. Export the site as a template according to the information in “Exporting a Site” 
on page 4-6.

2. Copy the new template folder to the target computer via network, diskette, or 
other storage media. Locate the template so you do not have to move it after you 
create the site. This ensures that the assets are mapped correctly. Also make sure 
the folder and file names are not truncated or changed in the process. 

3. Start NetObjects Fusion on the destination computer.

4. From the File menu, choose New Site, From Template.

The Select a Template File dialog appears.

5. Open the template’s folder, select the TemplateName.nft.nft.nft.nft file, and click Open. 

6. In the Save Site As dialog, enter a name for the new site in the File name field, 
select the location where you want to save the site, and click Save.

The site that was created in NetObjects Fusion on the source computer is now 
the active site, with its own Sitename.nod.nod.nod.nod file, on the destination computer.
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Importing Existing Sites 5
You can create a site or expand a site you are working on by importing a site that was 
created using a different site or page development tool. When you import an 
existing site, NetObjects Fusion duplicates the SiteStructure, page content, and 
links. It lays out content in a design as close as possible to the original.

This chapter describes:

✦ Creating new sites from existing sites

✦ Using existing sites to expand sites
5-1
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Importing Existing Sites
When you create or expand a site by using an existing site, follow these guidelines:

✦ Importing a complex site requires processing time. If the source site was created 
in NetObjects Fusion, it is more efficient to import it as a template.

✦ You can import an existing site from a local or networked drive, or from a 
remote location such as an intranet server or the World Wide Web.

✧ To import from a local drive, you must know the drive and folder where the 
site’s Home page, usually named index.htm index.htm index.htm index.htm or index.html,  index.html,  index.html,  index.html, is stored.

✧ To import from a remote location, you must know the URL to the site’s top-
level source page, such as http:\\www.netobjects.com.http:\\www.netobjects.com.http:\\www.netobjects.com.http:\\www.netobjects.com.

✧ You can limit the number of pages and levels that NetObjects Fusion 
captures from a local or remote site. Levels are based on the hierarchy of 
pages in the source site, defined by the site’s navigation; the first level is 
always the site’s Home page. The second level consists of pages that are 
linked from the Home page. Third-level pages are linked from second-level 
pages, and so on. NetObjects Fusion imports as many pages as possible at a 
higher level before going to a lower level.

✧ You must be connected to the Internet or intranet to activate the remote 
import.

✦ When NetObjects Fusion imports a site, it starts with the page you specify and 
stops importing when it hits the page number limit, the site level limit, or the 
end of the site. If you don’t define import limits, NetObjects Fusion imports to 
the end of the site—no matter how long that takes or how much it requires in 
system resources. NetObjects recommends limits of 200 pages and 20 levels.

✦ When you create a new site from an imported site, NetObjects Fusion applies 
the imported MasterBorder. If you expand a site by importing a section, you can 
apply any MasterBorder already in the site.

✦ HTML coding practices vary, so the contents of the source site pages are 
unpredictable. Spaces in .html.html.html.html file names can cause import problems.

✦ NetObjects Fusion imports assets such as Java applets, Shockwave, and other 
media. It does not import server-side imagemaps or manage server-side 
resources. If the imported site originally used server resources such as 
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JavaScripts, CGI scripts, or Server-Side Includes, you must manually recreate 
these on your server.

✦ NetObjects Fusion imports HTML tables. If the source table has a visible border, 
no row or column spans, and a maximum size of 40 x 200 cells, then NetObjects 
Fusion imports it as a table. This works for Regular Tables and Nested Tables 
that meet the criteria. Otherwise, NetObjects Fusion converts the table into a 
series of text boxes and positions them on the page to represent the table 
structure. NetObjects Fusion tables do not support vertical alignment attributes.

✦ NetObjects Fusion’s import feature supports the HTML 3.2 specification. 
Cascading Style Sheet (CSS) coding is removed from pages during import. 
Content with no other alignment formatting is placed flush left on its page.

✦ When you import a site that was built using HTML frames, NetObjects Fusion 
imports the frameset’s content pages as regular pages, and references the original 
frameset page as an external HTML page.

Be prepared to clean up an imported site. Adjust font size and style as needed, and 
add NetObjects Fusion navigation bars and banners as appropriate to your design. 
If a page does not import the way you expect, check the original source file for 
incorrect or nonstandard HTML code or data.

Creating a New Site from an Existing Site
1. From the File menu, choose New Site, From Existing Web Site.

The Import Web Site dialog appears.
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2. Select Local or Remote import.

3. Enter the exact file location and path to the top-level page you want to import: 

✦ To specify a local site, enter the full drive and path to the local site’s top-level 
source page in the Home Page URL field, or click Browse, select the 
appropriate top-level page, and click OK.

✦ To specify a remote site, enter the full URL to the site’s top-level source page 
in the Home Page URL field. To ensure accuracy, navigate to the site or page 
using your browser, then copy and paste the URL from the browser.

The starting page of your site import does not have to be the source site’s Home 
page, usually named index.htm index.htm index.htm index.htm or index.html index.html index.html index.html; it can be any page of any accessible 
Internet or intranet site.

4. From the Assign MasterBorder drop-down list, select the MasterBorder you 
want to apply to the imported site or section.

The list includes MasterBorders available in the current site; if no site is open, 
Import is used as the name of the MasterBorder.

5. Set the limits for the number of pages and number of levels you want to apply to 
the import process. NetObjects recommends limits of 200 pages and 20 levels.

6. If you are importing a local site, enter the domain name for the site’s Home page 
in the Domain name field. If the local site was ever published on the Web, use 
the domain name that was used to access it; if not, leave the placeholder 
www.domain.comwww.domain.comwww.domain.comwww.domain.com in the field.

When it imports a local site, NetObjects Fusion needs to know the “home base” 
domain of that site, so it can tell whether to convert the links it finds into 
external or internal links. It does that by comparing the targeted domain, if there 
is one, to the domain name you enter.

7. If you are importing a remote site, make sure your system is connected to the 
Internet or intranet so NetObjects Fusion can link to and import the site.

8. Click OK.

The the Save Site As dialog appears.

9. Enter a name for the new site in the File name field. To ensure cross-platform 
compatibility, limit the name to a maximum of 26 characters.
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10. Select the location where you want to save the site. By default, NetObjects 
Fusion saves the site in the NetObjects Fusion 4.0\User SitesNetObjects Fusion 4.0\User SitesNetObjects Fusion 4.0\User SitesNetObjects Fusion 4.0\User Sites folder, but you can 
store it in the location of your choice.

11. Click Save.

NetObjects Fusion imports the site and converts its content, structure, and links 
into NetObjects Fusion format. It stores the site’s assets in the \\\\Sitename\Import\Import\Import\Import 
folder, and assigns the MasterBorder you selected to each page in the new site.

12. Navigate to each page and make necessary adjustments.

Using an Existing Site to Expand a Site
1. In Site view, select the page you want to use as the parent of the imported 

content.

2. From the File menu, choose Import Web Site.

3. Follow the steps in “Creating a New Site from an Existing Site” on page 5-3.
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Page View Basics 6
Page view is where you add text, graphics, and other objects to develop page design 
and add content. You can use a variety of tools, object properties, and layout aides, 
such as rulers, guides, and grids, to add and arrange objects on the page.

This chapter describes:

✦ MasterBorder and Layout area

✦ Setting up the Page view display

✦ Displaying pages in Page view

✦ Setting page size

✦ Adding objects to the page

✦ Editing objects

✦ Positioning objects

✦ Layering objects
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Exploring Page View

MasterBorder and Layout Area
In NetObjects Fusion, a page consists of a Layout area and a MasterBorder area. The 
Layout area is the body of the page. It contains objects that are unique to that page. 
The MasterBorder is the page margins. MasterBorders contain objects, such as 
navigation bars, that appear on multiple pages.

You can define multiple Layouts and MasterBorders, then assign one of each to a 
page. See “Working with MasterBorders” on page 10-2 and “Working with Layouts” 
on page 8-2.

Setting Up the Page View Display
Use the commands on the View menu to show or hide Page view elements.

✦ Show and hide palettes and toolbars as described in “NetObjects Fusion 
Window” on page 1-3.

✦ Use the MasterBorder command to hide the MasterBorder. This provides more 
onscreen area for you to work on the page Layout.

Layout area

MasterBorder area

Page name

Docked toolbar

Properties palette

Grid

Rulers
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✦ Use the Page Labels command to show and hide the Layout and MasterBorder 
labels and margin lines.

✦ Display object outlines to help you control object size and position.

✦ Use the Object Icons command to display or hide the indicator icons.

✧ Link icon indicates the object has an associated link.

✧ Anchor icon indicates the object has an anchor point to which you can link.

✧ Script icon indicates the object has associated HTML or scripts.

✧ HTML tag icon indicates the text has an HTML tag inserted at this point.

✧ Embedded object icon indicates the embedded object’s insertion point.

✧ Action icon indicates an action is associated with the object.

✧ Warning icon indicates a potential layout problem or other error condition. 
Move the mouse pointer over the warning icon to display a ToolTip that 
identifies the problem.

✦ Select Rulers & Guides from the View menu to show and hide rulers and guides.

✦ Select Grid from the View menu to show and hide grids.

Setting Page Properties
To display the Page Properties palette, from the View menu, select Page View 
Options and click the Page tab. See “Setting Page and Section Properties” on 
page 3-8.

Displaying Pages in Page View
From Site view, to display a page in Page view:

✦ Double-click the page icon.

✦ Click the page icon, then click the Page button on the control bar.

✦ Click the page icon, then from the Go menu, choose Page.
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Moving Between Pages in Page View
Move between pages in Page view using the page navigation buttons, the Site 
Navigation window, or the Go To command on the Go menu. For information 
about the Go To command, see “Using the Go Menu” on page 1-6.

The Page Navigation buttons and button for displaying the Site Navigation window 
are at the bottom of the NetObjects Fusion window.

Using Page Navigation Buttons
To move between pages using the page navigation buttons:

✦ On a child page, click the Parent page button to display its parent page.

✦ On a parent page, click the Child page button to display its first child page.

✦ Click the Previous page button to move to the preceding sibling page.

✦ Click the Next page button to move to the next sibling page.

Using the Site Navigation Window
The Site Navigation window displays the SiteStructure.

1. In Page view, click the Site Navigation window button.

The Site Navigation window appears.

2. Double-click the page you want to open.

Parent page button

Previous page button

Child page button

Site Navigation window button

Next page button
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Setting Page Size
The size of a NetObjects Fusion page is defined by the combined size of the 
MasterBorder and Layout area. The default page size is 600x555 pixels. You can 
redefine the default page size setting in the Preferences dialog as described on page 
1-9.

You can change the size of an individual page by adjusting the size of the 
MasterBorder area, the Layout area, or both.

To resize the Layout and MasterBorder areas:

With the rulers showing, drag a Layout or MasterBorder handle to change the area’s 
height and/or width. Use the far right MasterBorder handle to change the size of the 
right MasterBorder and the bottom MasterBorder handle to change the size of the 
bottom MasterBorder.

To set Layout size precisely, enter values in the Layout Width and Height fields on 
the General tab of the Layout Properties palette. For precision MasterBorders, enter 
values for the left, right, top, and bottom margins on the General tab of the 
MasterBorders Properties palette.

Layout Width 
and Height fields

MasterBorder handle

MasterBorder 
handles

Layout area handle

Layout area handle
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Adding Objects to the Page
You can use the tools on the toolbars, or drag and drop files onto the page to place 
objects.

Using Object Tools
1. In Page view, select the tool you want to use.

2. Draw a box to position the object.

For some objects, you must select a file from the Open dialog.

The object appears on the page with the appropriate properties palette. The 
options displayed on the properties palette vary depending on the object.

3. Set the object properties.

After you use a selected tool to place an object on the page, the Selection tool 
automatically becomes active. To use a tool repeatedly to add several objects, 
double-click it to keep it active. This is not true for the Component tools.

Page View Toolbars
Page view includes Standard, Advanced, Form, and Components toolbars. Internal 
Page components are on the NetObjects Fusion Components toolbar. If you install 
third-party Page components, associated toolbars are listed on the View, Toolbars, 
Component Tools menu. For general information about using toolbars, see “About 
Toolbars” on page 1-4.
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Standard ToolbarStandard ToolbarStandard ToolbarStandard Toolbar

Advanced ToolbarAdvanced ToolbarAdvanced ToolbarAdvanced Toolbar

Layout Region tool
See Chapter 8

Zoom tools
See Chapter 1

Form area tool
See Chapter 23

Banner tool
See Chapter 17

Line tools
See Chapter 15

Picture tool
See Chapter 13

Selection tool
See Chapter 1

Table tool
See Chapter 14

Hotspot tools
See Chapter 18

Text tool
See Chapter 12

Navigation Bar tool
See Chapter 17

Draw Shape tools
See Chapter 15

Java tool
See Chapter 20

Data List tool
See Chapter 25

Plugin tools
See Chapter 19

ActiveX Control tool
See Chapter 20

External HTML tool
See Chapter 22
Page View BasicsPage View BasicsPage View BasicsPage View Basics 6-7



   

Adding Objects to the Page

                         
Components ToolbarComponents ToolbarComponents ToolbarComponents Toolbar

Form ToolbarForm ToolbarForm ToolbarForm Toolbar

Ad Banner tool
See Chapter 24

DynaButton tool
See Chapter 24

Picture Loader tool
See Chapter 24

Go Menu tool
See Chapter 24

Site Mapper tool
See Chapter 24

Rotating Picture tool
See Chapter 24

Screen Door tool
See Chapter 24

Message Board tool
See Chapter 24

Picture Rollover tool
See Chapter 24

Form Handler tool
See Chapter 23

Time Based Picture tool
See Chapter 24

Ticker Tape tool
See Chapter 24

Forms Button tool
See Chapter 23

Check Box tool
See Chapter 23

Edit Field tool
See Chapter 23

Multi-line tool
See Chapter 23

Forms Combo Box tool
See Chapter 23

Radio Button tool
See Chapter 23
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Dragging and Dropping Objects
1. In Windows Explorer, select the file you want to place.

You can drag and drop any file you can place with an object tool.

2. Drag the file into the NetObjects Fusion window and drop it on the page.

3. Set the object’s properties.

Importing Pages
In Page view, you can import a page authored elsewhere, convert it to NetObjects 
Fusion format, and edit its contents as you would any other page. You can import 
files with .htm,.htm,.htm,.htm, .html.html.html.html, .jsp.jsp.jsp.jsp, .rtf.rtf.rtf.rtf, or .txt .txt .txt .txt extensions.

If you prefer not to convert an HTML page to NetObjects Fusion format, you can 
place it as an object. See “Referencing HTML from Page View” on page 22-4.

Note: Because of variations in HTML code, not all pages import exactly as you see them. 
Unpredictable results can occur if the page contains incorrect HTML. Non-HTML, such as 
JavaScripts and CGI scripts, does not import. However, assets such as Java applets, 
Shockwave, and other media do import. If NetObjects Fusion cannot parse the HTML, it 
is imported, but appears as external HTML.

1. In Page view, display the Layout on which you want to import the page.

It is easiest to import a page into a Layout that contains no content, because 
objects from the imported file will overlay existing objects.

2. From the File menu, choose Import Page.

The File Open dialog appears.

3. Select the type of file you want to import from the Files of type list.

4. Select a file from your hard disk or LAN. To use a file on a CD-ROM, copy it to 
your hard disk. To reuse an HTML file already included in the site, select it from 
the HTML Assets tab.

5. Click Open.

NetObjects Fusion places the contents of the file on the current page, beginning 
in the upper left corner of the Layout area.
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Reusing Assets
By treating object files as assets, NetObjects Fusion provides you with a convenient 
way to replace or update multiple instances of an object. Reusing assets can also 
reduce the number of files stored on the server. Instead of adding multiple copies of 
a file in several locations, you add the asset once and then select from the list of 
existing assets when you want to place another instance of the asset.

To place an asset:

1. In Page view, choose the appropriate tool and draw a box to specify where you 
want to place the asset.

The File Open dialog appears.

2. Click the Assets tab to see a list of current assets.

3. Select the asset you want to place and click Open.

NetObjects Fusion places the asset on the page and opens the appropriate properties 
palette. In Assets view, you can replace all instances of this asset in your site using a 
single command or add file assets. See Chapter 27, “Managing Assets.”

Adding and Modifying Alt Tags
To make pages load faster, some visitors set up their browsers so they do not display 
images. To ensure that your pages provide the information you want to convey 
regardless of how the site visitor’s browser is set up, use alt tags to provide 
descriptive text that appears when images are not displayed. You can add an alt tag 

Show thumbnail 
image check box for 
picture asset
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to Java, drawn shape, generic plugin, QuickTime, Shockwave, audio, and video 
objects in the AltTag field of the properties palette.

Microsoft Internet Explorer 3.x and 4.x and Netscape Navigator 4.x display alt tag 
text in a ToolTip when site visitors point at an object, so make sure every alt tag is 
appropriate for a ToolTip.

To add or modify an alt tag:

➲ On the object’s Properties palette, type a descriptive name in the AltTag field.

Editing Objects and Assets
You can edit objects created in other software applications from within NetObjects 
Fusion. In Page view, right-click the object and select Open File In External Editor 
from the Object menu. In Assets view, you select the Asset, and then from the Asset 
menu, select Open Asset. If the correct application does not open, the file type of 
the object or asset is probably not associated with the correct application. 

For example, to edit a .gif.gif.gif.gif image, right-click it in Page view and select Open File in 
External Editor. If Microsoft Internet Explorer opens rather than an image-editing 
application, you must change the application associated with .gif.gif.gif.gif files. For example, 
you can change the associated application to NetStudio 1.0.1, the image editor 
included with NetObjects Fusion 4.0.

To set the application associated with a specific file type in Windows:

1. Double-click the My Computer icon on your Windows Desktop.

2. From the View menu, select Options.

AltTag field
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3. Click the File Types tab.

4. For every image file type in the list, click Edit and choose the appropriate 
Content Type.

5. Click OK to close the Options dialog and close the My Computer window.

Selecting an Object
In NetObjects Fusion you might not always be aware of making a selection, but in 
Page view something is always selected. For example, when you switch from Site 
view to Page view, the Layout Properties palette appears. You might not see evidence 
that the Layout is selected, but it is indicated on the properties palette. To find out 
what is selected at any time, check the properties palette.

Using the Selection ToolUsing the Selection ToolUsing the Selection ToolUsing the Selection Tool

Selection toolSelection toolSelection toolSelection tool

➲ Click the Selection tool on the Standard toolbar.

✧ Click an object to select it. Click elsewhere to deselect it.

✧ Drag a marquee around multiple objects, or Shift+Click each object you 
want to select. Shift+Click selected objects one-by-one to deselect them.

Using the Object TreeUsing the Object TreeUsing the Object TreeUsing the Object Tree

The Object Tree provides a convenient way to select objects, especially if you are 
working with layered or hidden objects.

1. In Page view, from the View menu, choose Object Tree.

The Object Tree appears. 

2. Click an object in the Object Tree to locate it on the page.

Selection handles appear around the object on the page.
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Renaming an Object
If you add several of the same type of objects to a Layout or MasterBorder, 
NetObjects Fusion numbers each object in the order in which you placed it. You can 
rename the objects for easy identification.

1. In Page view, from the View menu, choose Object Tree.

The Object Tree appears.

2. Select the name of the object and type a new name.

Resizing an Object
➲ Click an object and drag the selection handles to resize the object. If Display is 

set to Normal, you cannot make the object larger.

To make multiple objects the same size:

1. In Page view, select the objects by Shift+Clicking each one or by drawing a 
marquee around them.

2. From the Objects menu, choose Size Objects:

✦ Width, to make the objects the same width.

✦ Height, to make the objects the same height.

The selected objects size to match the largest object you select.

Positioning Objects

Moving or Copying an Object
✦ Press Ctrl, then click and drag an object to copy it.

✦ Click and drag an object to move it.

✦ To prevent an object from dropping into a container, such as a Layout Region or 
text box, select the object and press Alt while moving it over a container.

✦ You can move or copy objects from Layout to Layout in Page view using the Cut, 
Copy, and Paste commands on the Edit menu.
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If you want to specify the position of an object before you paste it, click the page 
and then use the Paste command. The upper-left corner of the pasted object 
appears at the point where you click the page.

Aligning and Distributing Objects
In a Layout or Layout Region, you can align two or more objects to each other and 
distribute three or more objects equidistant from each other. You can also align and 
distribute objects relative to the Layout or Layout Region.

1. In Page view, select the objects you want to align by Shift+Clicking each one or 
by drawing a marquee around the objects.

The Multi-Object Palette appears.

2. If you want the objects to align or be distributed relative to the Layout or Layout 
Region in which the objects are placed, select Relative to Layout.

3. In the Align section, specify the horizontal and vertical alignment.

✦ Select an option from the Horizontally section to align objects’ left or right 
sides, or to center them on top of each other. If you select Relative to Layout, 
the objects align to the right or left side of the Layout, or are centered in the 
Layout, one on top of the other.
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✦ Select an option from the Vertically section to align objects’ top or bottom 
sides, or to center them next to each other. If you select Relative to Layout, 
the objects align to the top or bottom of the Layout, or are centered in the 
Layout side-by-side.

✦ Select Horizontally or Vertically from the Distribute section to make selected 
objects equidistant.

Note: Object alignment can have an impact on preserving your design and optimizing your 
code. See “Optimizing Nested Tables Output” on page 7-6.

Adding, Moving, and Deleting Guides
Use the page guides to align objects vertically and horizontally. You can add as many 
guides as you want to either the MasterBorder or the Layout area. MasterBorder 
guides are red, Layout area guides are blue. Guides associated with a MasterBorder 
appear on all pages that use that MasterBorder. Guides you create are saved with the 
site. To:

✦ Add a guide, click in the ruler or hold down the Ctrl key while you drag an 
existing guide.

✦ Move a guide, click its arrow on the ruler and drag it.

✦ Delete a guide, click its arrow and drag it off the ruler.

✦ Show or Hide a guide, select Rulers & Guides from the View menu.

Snapping Objects to Grids, Guides, and Each Other
Use the Snap feature to align objects exactly. When you select a Snap to command, 
NetObjects Fusion creates a “magnetic” attraction between the selected object and 
the grid, guide, or other objects. Forcing objects to snap to grids, guides, and each 
other makes your HTML code more efficient.

To force objects to snap to:

On the left, the objects 
are aligned horizontally 
to the left; on the right, 
the objects are aligned 
the same way relative to 
the Layout
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✦ Guides, select Snap to Guides from the View menu.

✦ Grids, select Snap to Grid from the View menu. 

✦ Other objects, select Snap to Object Outlines from the View menu.

Layering Objects
NetObjects Fusion supports CSSP+Layers, CSSP, and Layers, forms of HTML 
output that displays overlapped objects correctly. Site visitors using Microsoft 
Internet Explorer 4.x or Netscape Communicator 4.x can see objects overlap other 
objects. See “Publishing with CSSP+Layers” on page 7-9, “Publishing with CSSP 
Only” on page 7-10, and “Publishing with Layers Only” on page 7-10. 

To overlap objects:

1. In Page view, on the General tab of the Layout Properties palette, select 
CSSP+Layers in the HTML output section. If your site visitors use only Netscape 
Navigator 4.0 and above, select Layers; if they use only Microsoft Internet 
Explorer 4.0 and above, select CSSP.

2. Place two or more objects in the Layout or a Layout Region.

Objects are layered in the order in which you place them. To change the layering 
order, see “Rearranging Layered Objects.”

Rearranging Layered Objects
1. In Page view, from the View menu, select Object Tree.

2. In the Object Tree, click the object you want to move.

Handles appear around the object on the page.

3. Click and drag the object up or down the tree to move it to a different layer, or 
from the Object menu, choose Arrange Objects and select:

✦ Bring to Front to bring the object to the top of the layer.

✦ Bring Forward to bring the object up one layer.

✦ Send to Back to send the object to the bottom layer.

✦ Send Backward to send the object down one layer.
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Controlling Published Output7
The default settings for NetObjects Fusion generate efficient HTML that faithfully 
reproduces your visual design on the published page. The design of your text 
content, however, is subject to each site visitor’s browser settings. To limit these 
variations, NetObjects Fusion offers ways to control published output. You can:

✦ Select from four different types of page containers to serve as your page layout 
medium.

✦ Use one of five HTML output methods to generate your site’s HTML. For cross-
browser output, use Nested Tables, Regular Tables, or CSSP+Layers. If you are 
sure site visitors use only Netscape Navigator 4.0 or above, choose Layers; if you 
are sure they use only Microsoft Internet Explorer 4.0 or above, choose CSSP.

✦ Control the table formatting priority—horizontal or vertical—used to generate 
Nested Table HTML pages.

This chapter describes:

✦ Approaches to page design

✦ Selecting a layout method

✦ Publishing with Nested Tables

✦ Publishing with Regular Tables

✦ Publishing with CSSP+Layers

✦ Publishing with CSSP

✦ Publishing with Layers

✦ Applying HTML output methods

✦ Matching your design priorities with the appropriate HTML output 
method
7-1
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Approaches to Page Design
In NetObjects Fusion, a container is an object into which you can embed other 
objects. A container can be any size and can hold any kind of object. NetObjects 
Fusion provides four types of containers you can use to design and lay out pages:

✦ The Layout is the body of the page, surrounded on all four sides by the 
MasterBorder. Each page has at least one Layout, although you can create 
additional layouts as needed. See “Working with Layouts” on page 8-2.

✦ Layout Regions are mini-layouts that you can use to subdivide the page. You can 
draw and place Layout Regions anywhere on the page, and place any kind of 
objects—including text boxes or other Layout Regions—within their borders. 
See “Working with Layout Regions” on page 8-4.

✦ Text boxes are a special class of objects because you can embed other objects 
within them. You can also maximize a text box so it fills the entire Layout—in 
effect, using a single text box to lay out the entire page. See Chapter 9, “Working 
with Text Boxes.”

✦ Tables serve as containers for objects. If your page design is based on rows or 
columns of content—as in a spreadsheet or other tabular arrangement—you 
can lay out all or part of your page in tables. You can then lay out your content 
within the cells of the table. You can embed any object in a table cell. See 
Chapter 14, “Adding Tables.”

The type of container you choose determines which of the following page design 
options you use. You can: 

✦ Position content with pixel-level precision by dragging objects into place. The 
position-based approach uses Layouts and Layout Regions as containers and 
preserves your position-based layout by generating pages consisting of either 
HTML or CSS code.

✦ Use a text-based approach. With text-based design you can preserve the flow of 
content by embedding objects in text boxes or table cells. Text-based page layout 
generates lean and efficient HTML code that responds effectively to variations in 
browser and font size.

✦ Include hand-coded HTML pages in your site. You incorporate external HTML 
pages as part of your site by referencing them as objects on a page, or the page 
itself. See Chapter 22, “Referencing and Editing External HTML.”
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Selecting a Layout Method
There’s no “best way” to lay out your pages; your circumstances determine which 
method works best. The pros and cons of each method are listed here.

Using Layouts
If precise placement of content is important to you, or if you want to publish 
individual pages using an HTML output type that is different from the rest of the 
site, use the Layout area as the container for your page layout.

Layout AdvantagesLayout AdvantagesLayout AdvantagesLayout Advantages

✦ You have pixel-level control of the layout and design of your page.

✦ You can drag-and-drop objects into position.

✦ You can specify the HTML output type for any individual Layout.

✦ Layouts support the column or row priority for page formatting, which means 
pages adjust more predictably to site visitor’s font and display configurations.

Layout LimitationsLayout LimitationsLayout LimitationsLayout Limitations

✦ Position-based pages require more HTML code to achieve pixel-level placement 
of content, so your HTML files will be somewhat larger.

✦ Text cannot flow around other objects unless they are embedded in a text box. 
To create the text wrap effect you have to create multiple text boxes to contain 
the other objects.

✦ You cannot set the Layout to wrap to the width of your site visitor’s browser. If 
the browser window is wider than your page, the page’s background fills in; if 
the window is smaller than your page width, your site visitor has to scroll.

Using Layout Regions
Like Layouts, Layout Regions offer pixel-level placement and a choice of HTML 
output methods, but you can embed them in text boxes. So, if you need precise 
placement or specific output for some content, but want to generate leaner pages, 
you can use text boxes as your main layout container, and embed Layout Regions for 
selected content.
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Layout Region AdvantagesLayout Region AdvantagesLayout Region AdvantagesLayout Region Advantages

✦ You have pixel-level control of the layout and design of content within the 
Layout Region.

✦ You can embed the Layout Region within a text box, which combines the 
benefits of both containers.

✦ You can specify the HTML output type for any individual Layout Region.

✦ Layout Regions support the column or row priority for page formatting so 
selected sections of your page can adjust more predictably to site visitor’s font 
and display configuration.

Layout Region LimitationsLayout Region LimitationsLayout Region LimitationsLayout Region Limitations

✦ HTML page files are significantly larger, and download more slowly.

✦ Text cannot flow around other objects unless they are embedded in a text box. 
To create the text wrap effect, you have to create multiple text boxes within the 
Layout Region.

✦ You cannot maximize a Layout Region to the full Layout size, or set the Layout 
Region to wrap to the width of your site visitor’s browser.

Using Text Boxes
If efficient, lean HTML pages are more critical to site visitors than precise placement 
of content, use a text box for page layout.

Text Box AdvantagesText Box AdvantagesText Box AdvantagesText Box Advantages

✦ NetObjects Fusion generates extremely efficient HTML code for your site. 
HTML files are smaller, which means they load faster.

✦ Text within the text box flows around other embedded objects automatically, so 
you don’t have to create multiple text boxes to achieve a text-wrap effect.

✦ You can set the text box to resize itself to the size of the browser window. When 
your site visitor views the page, it rewraps to fit within the browser window.

✦ You can use any HTML output method: Nested Tables, Regular Tables, Layers, 
CSSP, or CSSP+Layers.
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Text Box LimitationsText Box LimitationsText Box LimitationsText Box Limitations

✦ You give up pixel-level control of the layout and design of your page, and use 
alignment choices to control the placement of objects.

Using Tables
If your page design or page content is tabular, you can use a NetObjects Fusion table 
to control the layout of the entire page.

Table AdvantagesTable AdvantagesTable AdvantagesTable Advantages

✦ Each cell within a table functions like a text box, with all the attributes and 
controls of a text box outside the table.

✦ You can embed objects within cells, arrange them using each object’s alignment 
properties, and wrap text around objects.

✦ You can use a percent width layout so the basic layout design is not affected by 
changes in browser window width, font sizes, or screen resolution.

Table LimitationsTable LimitationsTable LimitationsTable Limitations

✦ You give up pixel-level control of the layout and design of your page, and use 
alignment choices to control the placement of objects.

Selecting an HTML Output Method
You can choose Nested Tables, Regular Tables, CSSP+Layers, Layers only, or CSSP 
only.

Publishing with Nested Tables
When you choose Nested Tables, NetObjects Fusion uses complex hidden tables to 
achieve the highest level of layout accuracy across browsers. Nested Tables is the 
default publishing method for NetObjects Fusion. Using Nested Tables:

✦ You get relative placement of your content as you designed it in Page view, with 
relative spacing preserved regardless of the site visitor’s display configuration.

✦ You can prioritize either the vertical or horizontal relationship between objects 
so site visitors are more likely to see the pages as you designed them, regardless 
of their local browser, font, and display configurations.
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✦ Pages can be viewed in most browsers that support the 3.2 HTML specification, 
including Microsoft Internet Explorer 3.0 or higher and Netscape Navigator 3.0 
or higher.

Optimizing Nested Tables OutputOptimizing Nested Tables OutputOptimizing Nested Tables OutputOptimizing Nested Tables Output

If you set a Layout or Layout Region to Nested Tables output, you can control the 
text flow for each container by choosing the table formatting priority—columns or 
rows—that NetObjects Fusion uses to generate the page HTML. This helps to 
preserve your design if a browser’s font settings change the size of your text.

For example, a Columns or vertical priority keeps text together in a vertical 
orientation when text size changes rearrange the page.

A Rows or horizontal priority keeps text together in a horizontal orientation when 
text size changes rearrange the page.

The page with a Columns setting in 
Page view (at left) adjusts vertically 
to changes in browser text size, as 
shown at right

The page with a Rows setting in 
Page view (at left) adjusts 
horizontally to changes in browser 
text size as shown at right
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You can make pages more efficient and predictable by optimizing placement of 
objects within the site’s underlying table structure. As a general rule, it’s best to align 
objects to each other and to isolate text boxes in their own cells within the 
underlying table structure so they can resize as necessary in response to browser 
font changes.

.

To help determine the best alignment, you can preview the underlying table row 
and column structure to see if NetObjects Fusion can divide your Layout into cells 
efficiently or if you need to rearrange some objects.

1. In Page view, select the Layout or Layout Region you want to preview.

The General tab of the appropriate Properties palette appears.

2. Select Columns or Rows in the HTML output section.

3. Click and hold the Show button.

By staggering the text boxes and image objects, as shown in the diagram at left, you require 
NetObjects Fusion to create multiple tables with different sized columns. By aligning the page 
objects, as shown at right, you create a simpler underlying table structure for the page

Show table 
structure button
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NetObjects Fusion hides grid lines, guide lines, and object borders in the Layout 
and displays solid gray lines to show how the Layout is divided into rows and 
columns.

4. Identify underlying table cells that contain multiple text boxes or other objects.

5. Release the Show button.

6. If row and column dividers do not separate objects the way you think they 
should, those objects might not be aligned with pixel-level accuracy. To correct 
this, Shift+Click all the objects you want to align.

The Multi-Object palette appears.

7. Click the alignment setting appropriate for the selected objects.

8. Repeat steps 3 through 7 as needed.

9. Preview the site or page.

10. To test the results, reset your browser display fonts to a significantly larger size 
and preview the site again.

You can see a page’s table structure in the browser by holding down Shift when 
you click the Preview button.

Optimizing AutoFramesOptimizing AutoFramesOptimizing AutoFramesOptimizing AutoFrames

You can control realignment of AutoFrame content by selecting, for each frame, the 
table alignment setting that best preserves your design. When you use the Show 
button to preview the Layout’s table structure, the preview includes the table 
structure that NetObjects Fusion expects to use within AutoFrames.
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Locking or Maximizing a Text BoxLocking or Maximizing a Text BoxLocking or Maximizing a Text BoxLocking or Maximizing a Text Box

If all the objects on a page are embedded in a text box, you can apply three text box 
properties to reduce the impact of variations in browser configurations: locking the 
minimum size of a text box, sizing the text box to fill the Layout, and wrapping the 
text box contents to the browser width. See Chapter 9, “Working with Text Boxes” 
for information about these options.

Publishing with Regular Tables
When you choose Regular Tables, NetObjects Fusion translates each page Layout or 
Layout Region into an HTML table with rows and columns, and places your content 
into table cells. This results in relative placement of content on the page; content 
maintains its position in the underlying table. If text content expands because of a 
browser font setting, its table row expands with it, and the content below it on the 
page is moved down.

Regular Tables is recommended when you:

✦ Want pages to display successfully in older versions of some browsers.

✦ Embed form objects in the page’s Layout area or Layout Region.

✦ Include objects with actions on the page, and you choose not to use 
CSSP+Layers, CSSP, or Layers as the output method.

Publishing with CSSP+Layers
When you choose CSSP+Layers, NetObjects Fusion expresses the location of 
content in terms of absolute positioning. For example, instead of using HTML 
workarounds such as empty table rows and transparent .gifs.gifs.gifs.gifs to position a line of text 
below the top of the page, the absolute positioning supported by CSSP+Layers 
defines placement of the text box a specific distance from the top left corner of the 
page in a simple statement of x,y coordinates.

CSSP+Layers uses a combination of CSSP code, JScript, and browser-specific codes 
to control the placement and delivery of content. Pages published using 
CSSP+Layers can only be viewed accurately in Microsoft Internet Explorer 4.0 or 
higher or Netscape Navigator 4.0 or higher browsers. Older browsers can view the 
pages, but with unpredictable results; in many cases the page content is stacked 
flush left down the page.

When you select CSSP+Layers:
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✦ NetObjects Fusion generates HTML code that produces the same results in 
Microsoft Internet Explorer and Netscape Navigator.

✦ Pages are typically more compact and download faster than table-based HTML 
pages.

✦ You can overlap objects in Layouts or Layout Regions. See “Layering Objects” on 
page 6-16.

✦ You get consistent results with pages containing actions. See Chapter 21, 
“Building Dynamic Pages.”

✦ There is some risk for text-rich pages. If a CSSP+Layers page is viewed in a 
browser with large font settings, the text boxes expand without regard for other 
objects on the page, which can result in unplanned overlapping of objects.

Publishing with CSSP Only
If you are sure all site visitors use Microsoft Internet Explorer 4.0 or higher, choose 
the CSSP output method. In this method, NetObjects Fusion uses Cascading Style 
Sheet Positioning to achieve a high level of layout accuracy. The resulting HTML 
files are smaller than the files produced when you use CSSP+Layers.

Publishing with Layers Only
If you are sure all site visitors use Netscape Navigator 4.0 or higher, choose the 
Layers output method. In this method, NetObjects Fusion uses Layers to achieve a 
high level of layout accuracy. The resulting HTML files are smaller than the files 
produced when you use CSSP+Layers.

Applying HTML Output Methods
You must choose one output method as the default for your site. Note that if you set 
CSSP+Layers as the default, site visitors must have a 4.0-level browser to view the 
site correctly, which excludes site visitors who use older browsers. See “Setting the 
Site’s HTML Output Method” on page 28-6.

To change the HTML output method for a specific page Layout or Layout Region, 
you can override the:

✦ Site publishing method for a specific page Layout. When you publish selected pages 
in CSSP+Layers—while publishing the rest of the site in one of the table-based 
formats—you can keep the bulk of your site accessible to most browsers, and 
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provide specialized content to those with browsers that support it. See “Setting 
the HTML Output Method for a Layout or Layout Region” on page 8-6.

✦ Site or page publishing method for a specific Layout Region. Publishing a selected 
Layout Region in CSSP+Layers—while publishing the rest of the page and site in 
a table-based format—makes an even finer distinction between the content 
available in basic HTML format and specialized content for newer browsers. See 
“Setting the HTML Output Method for a Layout or Layout Region” on page 8-6.
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Design Priorities and Method Choices
Use this table to determine which combination of layout methods and HTML 
output methods best supports your site design priorities.

If your priority is... Suggested container object Suggested HTML output 
method

Lean HTML and fast browser loading Text box or Layout-sized table Nested Tables

Precise placement control for objects Layout and/or Layout Region(s) Nested Tables

Maximizing usability for site visitors 
with older browsers

Text box sized to Layout Regular Tables

Absolute control over minimum text 
box height 

Text box with size locked Nested Tables

Precise placement control for selected 
content, but lean HTML otherwise

Text box for page with embedded 
Layout Region for selected content

Nested Tables

Wrapping text around images and 
other objects

Text box and/or table Nested Tables

Overlapping selected objects Text box for page; overlapped objects in 
Layout Region embedded in the text box

Nested Tables for site; 
CSSP+Layers for Layout 
Region containing 
overlapped objects

Wrapping page to varying browser 
sizes

Text box sized to Layout with content 
wrapped to browser

Nested Tables

Drag-and-drop placement of objects 
while designing the page

Layout and/or Layout Region Nested Tables

Horizontal or row-based content 
flow such as spreadsheets or other 
tabular data

Table sized to page Nested Tables

Delivering objects with actions 
or other DHTML effects only to
advanced browsers

Text box and/or table CSSP+Layers

Delivering objects with actions 
or other DHTML effects to greatest
number of browser versions

Text box for page; objects with actions in 
Layout Region embedded in the text box

Nested Tables for site; 
Regular Tables for Layout 
Region containing objects 
with actions

Using cascading actions Text box for page; embedded Layout Regions 
containing objects with actions, grouped for 
cascading messages

Nested Tables
CSSP
Layers
CSSP+Layers
7-12 Controlling Published OutputControlling Published OutputControlling Published OutputControlling Published Output



 

C

 

H

 

A

 

P

 

T

 

E

 

R

 

 

 

8

          
Working with Layouts and 
Layout Regions 8
Layouts and Layout Regions are containers for the objects you place on your pages. 
When you use Layouts and Layout Regions you can position content with pixel-
level precision by dragging it into place in the container.

This chapter describes:

✦ Working with Layouts

✦ Creating Layouts

✦ Working with Layout Regions

✦ Creating Layout Regions

✦ Setting the HTML output method for Layouts and Layout Regions

✦ Setting the background of Layouts and Layout Regions
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Working with Layouts
The Layout makes up the body of the page. It is surrounded on all four sides by the 
MasterBorder. Each Layout is attached to a single page, unlike a MasterBorder, 
which can be applied to any page in the site. There is no connection between 
Layouts on separate pages.

Each page has a default Layout named PagenameLayout. For example, when you 
add a page, its page name is Untitled. Until you rename that page, the default Layout 
is named UntitledLayout.

You can add multiple Layouts to a page, each with its own properties, design, and 
content. You might use several Layouts to prototype or publish several versions of 
the same page. You could also create separate Layouts for different versions of your 
site, such as English, French, media, and text-only. When you publish the site, 
NetObjects Fusion publishes each page using the currently selected Layout.

The name of the currently selected Layout appears in the Layout drop-down list in 
the lower-left corner of Page view.

You can control various characteristics of the Layout’s appearance in Page view. See 
“Setting Up the Page View Display” on page 6-2.

Creating a New Layout
1. In Page view, display the page for which you want to create a Layout.

2. Select Add from the Layout drop-down list.

A new, blank Layout appears. Any content on the previous Layout is stored with 
that Layout. Each Layout you add is named PagenameLayout.

3. Change the Layout name so it is unique. See “Renaming a Layout” on page 8-3.

4. Add objects to the Layout and modify the Layout properties—such as size, 
background, or HTML output options.

Layout drop-down list

Current Layout
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Selecting a Layout
To display a different Layout for a page:

➲ In Page view, select a Layout from the Layout drop-down list.

Renaming a Layout
1. In Page view, select a Layout from the Layout drop-down list.

The General tab of the Layout Properties palette appears.

2. Enter a new name in the Layout name field.

Use letters and numbers only; Layout names cannot have spaces, hyphens, 
underscores, or other special characters, and they cannot begin with a number.

The name of the Layout changes and the Layout drop-down list is updated.

You can also use the Object Tree to change the name of the Layout. See “Renaming 
an Object” on page 6-13.

Changing Layout Size
You can set Layout size by entering specific measurements on the Layout Properties 
palette or by dragging the Layout handles. See “Setting Page Size” on page 6-5.

To reduce the size of the HTML file NetObjects Fusion generates for your page:

➲ In Page view, from the Object menu, select Size Layout to Objects.
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Adding an Object to the Layout
The Layout is the default container for the page, and can contain any object. To add 
objects to a Layout, you can:

✦ Select the appropriate tool and create an object within the Layout.

✦ Paste an object into the Layout from the Clipboard.

✦ Drag and drop any object that you previously placed with a tool.

Working with Layout Regions
A Layout Region is a container you use to group objects in a defined area on the 
page. Layout Regions are independent page segments that you can place, size, and 
control independently from the rest of the Layout.

There are five key aspects to using Layout Regions:

✦ When you move a Layout Region on the page, its embedded objects move with it 
and maintain their positions relative to each other and the Layout Region.

✦ You can send cascading action messages to the Layout Region, and it will pass 
the message to all objects embedded within it. See Chapter 21, “Building 
Dynamic Pages.”

✦ You can embed a Layout Region within a text box. This gives you position-based 
placement of the objects within the Layout Region, while the rest of the page is 
arranged in a text-based layout.

✦ You can assign an HTML output method to a Layout Region independent of the 
method used for its parent Layout. See “Setting the HTML Output Method for a 
Layout or Layout Region” on page 8-6.

✦ You can designate a Layout Region as a form and embed form objects within it. 
See Chapter 23, “Designing and Implementing Forms.”

Creating a Layout Region

Layout Region toolLayout Region toolLayout Region toolLayout Region tool

1. In Page view, select the Layout Region tool from the Standard toolbar.

2. Draw a Layout Region on the Layout.

3. Position and size the Layout Region, just as you would position any other object.

4. Add objects to the Layout Region.
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Adding Objects to a Layout Region
Like a Layout, a Layout Region can contain any object: text, pictures, media, or even 
other Layout Regions. To add objects to a Layout Region:

✦ Select the appropriate tool and create an object within the Layout Region.

✦ Drag objects into the Layout Region from elsewhere on the page.

✧ To make the Layout Region expand as needed to contain the object, drag the 
top left corner of the object into the Layout Region. 

✧ When the Layout Region border changes to a thick blue outline, the object is 
contained in the Layout Region.

Embedded object Embedded object Embedded object Embedded object 
symbolsymbolsymbolsymbol

✧ When the pointer changes into the embedded object symbol, you can drop 
the object.

✦ To drag an object over a Layout Region without embedding it, hold down Alt as 
you drag the object.

Displaying the Layout Region Grid
To make it easier to place objects precisely in the Layout Region, you can use a local 
alignment grid that is independent from the grid displayed within the Layout.

To display and modify the Layout Region grid:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. Select Local Grid if necessary.

3. Enter values for the width and height of the local grid. The Layout Region grid 
always displays in pixels.
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Setting the HTML Output Method
for a Layout or Layout Region
You can select the HTML output method that determines the type of HTML code 
NetObjects Fusion produces for the current Layout or Layout Region. This HTML 
method is independent of the method used to publish the parent container.

For example, if a Layout Region is placed in a Layout area, you can set the region to 
a different HTML output method than the one used for the Layout area. When you 
publish, the Layout area is published using its setting and the Layout Region is 
published using its setting. See “Applying HTML Output Methods” on page 7-10.

1. In Page view, click the Layout or Layout Region.

The General tab of the Properties palette appears.

2. In the HTML output section of the General tab, select the HTML output 
method you want from the drop-down list. 

✦ Publish Setting generates the Layout using the output method specified for 
the entire site.

Parent Setting generates the Layout Region using the output method 
specified for its parent container.

✦ Nested Tables uses Nested Table tagging and other features of the 3.2 HTML 
specification. If you select Nested Tables, you can set the table formatting 
preference. See “Optimizing Nested Tables Output” on page 7-6.

✦ Regular Tables    uses basic HTML table tagging. See “Publishing with Regular 
Tables” on page 7-9.

✦ CSSP+Layers uses Cascading Style Sheet Positioning code, layers, and scripts. 
See “Publishing with CSSP+Layers” on page 7-9.

For Layouts For Layout Regions
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✦ CSSP uses code that optimizes your site in Microsoft Internet Explorer 4.0 
and above. See “Publishing with CSSP Only” on page 7-10.

✦ Layers uses code that optimizes your site in Netscape Navigator 4.0 and 
above. See “Publishing with Layers Only” on page 7-10.

The method you select for the Layout affects the entire page, including the 
MasterBorder.

Setting Layout and Layout Region
Background Properties
You can control the appearance of each Layout and Layout Region by setting 
background properties. You can assign a background color and place an image in 
the background of a Layout or Layout Region. You can attach a background sound 
to a Layout that plays when a visitor views the page.

1. In Page view, select the Layout or Layout Region.

The General tab of the Properties palette appears.

2. Select the Background tab.

3. Select:

✦ SiteStyle to set the Layout background to the default background specified by 
the current SiteStyle or click the Color button and select a solid color from 
the Color Picker.
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Setting Layout and Layout Region Background Properties

                
Transparent to make the Layout Region transparent, so the background color 
and/or image assigned to the Layout underneath shows through or click the 
Color button and select a solid color from the Color Picker.

✦ Picture to specify an image file in the background.

Click Browse, select the image file you want to use for the background, and 
click Open. See “Choosing an Image Format” on page 13-2. If the picture is 
smaller than the Layout or Layout Region, the browser tiles the image. 

4. To assign a sound to a Layout that plays when a site visitor views the page:

a. Select Sound, click Browse, and select a sound file from your hard disk, 
CD-ROM, or LAN.

You can use sound files in .auauauau, .aiffaiffaiffaiff, .midimidimidimidi, or .wavwavwavwav formats.

b. To repeat the sound while the page is open, select Continuous Loop.

c. Click OK.

The selected sound plays when you preview the page.

Note: Site visitors must have a sound board, speakers, and a browser that supports 
background sounds installed on their computers to hear background sound. 
To preview and test sounds, your system must also be appropriately 
configured. Some sound formats also require support from the Web server. 
See “Inserting a Sound File” on page 19-10.
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Working with Text Boxes 9
A text box is a container for text as well as other kinds of objects, including pictures, 
sound objects, and tables. When you use a text box as a container, you do not have 
pixel-level control over embedded objects. For example, you do not insert a picture 
in a text box and drag it into position. Instead, you embed the object at a selected 
point in the text and adjust its placement using alignment, positioning, and text-
wrapping choices. When NetObjects Fusion publishes pages that use a text box as 
the main Layout container, they have extremely lean HTML code and load relatively 
quickly in the site visitor’s browser.

This chapter describes:

✦ Adding a text box

✦ Selecting a text box

✦ Embedding objects in a text box

✦ Wrapping text around objects

✦ Sizing a text box

✦ Scaling text box contents to the browser window

✦ Setting text box background color
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Adding a Text Box

     
Adding a Text Box

Text toolText toolText toolText tool

1. Select the Text tool from the Standard toolbar.

2. Drag a box in the location where you want to place the text box.

To add and format text, see Chapter 12, “Designing with Text.”

Selecting a Text Box
✦ To work with a text box as a container, click the text box. The selection handles 

are solid, and the Text Properties palette displays only Text Box and Actions tabs.

✦ To add or edit text within a text box, double-click in the text box. The text box 
selection handles are hollow, and the Text Properties palette includes a Format 
tab in addition to the Text Box and Actions tabs.

To add and format text, see Chapter 12, “Designing with Text.”
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Embedding Objects in a Text Box
When you embed an object in a text box, a wide border appears around the box and 
the insertion point appears as a vertical bar.

The insertion point indicates where the object’s HTML tags are inserted when 
NetObjects Fusion generates the HTML.

Insertion markerInsertion markerInsertion markerInsertion marker

NetObjects Fusion positions pictures at the insertion point. Text, tables, sound, 
video, and other objects are placed one line below the insertion point, flush left. You 
use the object’s alignment options to arrange the object within the text box. An 
insertion marker indicates the object’s insertion point.

Text box with wide border

Insertion point

Insertion marker

Embedded image aligned 
with Left wrap setting
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Embedding Objects in a Text Box

                 
To move an embedded object, drag it. To place an embedded object on the top line 
of the text box, drag it until its insertion marker is positioned before the first text 
character.

You can create a new object in a text box or insert an existing object.

Dragging and Dropping an Existing Object
1. In Page view, select the Text tool from the Standard toolbar and draw a text box.

2. Select an object elsewhere on the page and drag it into the text box.

The thick blue text box boundary indicates the object will be embedded.

3. Position the insertion point at the place in the text where you want to insert the 
object and drop the object.

4. Position the object within the text box. See “Wrapping Text around Objects.”

Creating a New Embedded Object
1. In Page view, select the Text tool from the Standard toolbar and draw a text box.

2. Add text. See Chapter 12, “Designing with Text.”

3. Select the appropriate tool to create the new object. 

Note: To embed a text box within a text box, you must create it outside the text box 
and drag it into place.

4. Position the mouse pointer in the text and draw a box for the new object.

If appropriate, the Open file dialog for that type of object appears. Select the 
object you want to embed and click OK.

5. Position the object within the text box. See “Wrapping Text around Objects.”

Insertion marker positioned 
before the first text character

Embedded Image aligned 
with Left wrap setting
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Wrapping Text around Objects
Once you embed an object in a text box, you can wrap text around it.

1. In Page view, select the object embedded in the text box.

The object’s properties palette appears.

2. Click the Align tab.

3. Set the alignment options.

Depending on the type of object you selected, NetObjects Fusion displays some 
combination of the following alignment options:

✦ Vertical alignment of the object to the top, middle, or bottom of the text line.

✦ Horizontal alignment of the object to the left, center, or right of the text box, 
without text wrapping.

✦ Horizontal alignment of the object to the text box, with text wrapping. If you 
select Left wrap, the text wraps around the right side of the object; if you 
select Right wrap, the text wraps around the left side of the object. To embed 
the object at the top left of the text box, move the pointer to the beginning of 
the text.

✦ In the Space around object section, specify the amount of space you want to 
leave between the image and the text.
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Sizing a Text Box

     
The text wraps around the object according to your specifications.

Setting Paragraphs to Clear Wrapped Objects
To force the paragraph following a wrapped paragraph to start on the next line:

1. In Page view, draw a text box, add the text, embed the objects, and set the 
alignment options. Press Enter at the end of each paragraph.

2. With the mouse pointer in the text box, in the Paragraph section of the Format 
tab of the Text Properties palette:

✦ Select the Clear Left check box to restart the text at the first left margin that is 
clear of a picture.

✦ Select the Clear Right check box to restart the text at the first right margin 
that is clear of a picture.

Sizing a Text Box
When you create or select a text box, you can control its width and internal margins, 
the minimum height, and the scaling of the text box to the full width of the Layout 
area or the browser window.

1. In Page view, select a text box or add a new text box.

The Text Properties palette appears.
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2. Click the Text Box tab.

3. To set the margins inside the text box, enter a Text Inset value.

Insetting text creates a new table in HTML.

4. To set the width of the text box, select it and drag the handles to size the text box 
as needed. The text box retains the width you set unless you size it to the Layout 
area as described in step 6.

5. To set a minimum height for the text box, select Lock height and drag the text 
box handles to the minimum height you want.

If Lock height is not selected, NetObjects Fusion automatically adjusts the 
height of a text box to fit the text and objects it contains. Selecting Lock height 
sets a minimum size, so your page design is maintained even if browsers display 
font sizes differently.

6. To use a text box as the main Layout container on the page, select Size Layout to 
Text. This results in extremely lean HTML code.

Before you do this, embed all objects in the Layout area in the text box or place 
them in the MasterBorder. Objects left in the Layout area outside the text box 
will be overlapped by the text box when you size it to the Layout. Unless you 
want this overlap—and use CSSP+Layers, CSSP, or Layers HTML output to 
support it—you must embed, move, or remove the objects.
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Scaling Text Box Contents to the Browser Window
You can configure NetObjects Fusion so the text box is maximized in the site 
visitor’s browser window. When you use this option, NetObjects Fusion generates 
the page’s HTML without using tables.

1. In Page view, click the MasterBorder.

The MasterBorder Properties palette appears.

2. Select the ZeroMargins MasterBorder from the MasterBorder name drop-down 
list or use any combination of AutoFrames and non-framed borders 
MasterBorders with margins set to zero.

3. Select an existing text box or create a new one and embed all objects in the 
Layout area in the text box.

4. On the Text Box tab or the Text Properties palette, select Size to Layout and then 
Contents wrap to browser width.

When you publish this page, the contents of the text box adjust to the size of the 
browser window.

Setting Text Box Background
You can add colors and pictures to text box backgrounds. If you choose a .gif.gif.gif.gif with a 
transparent color, the text box background color will show through.

1. In Page view, select the text box and click the Text Box tab on the Text Properties 
palette.

2. Select None to eliminate text box background color, or click Color and select a 
background color from the Color Picker.

3. To add a picture to the background, select Picture and choose an image in the 
Picture File Open dialog.

Preserving Your Design Intentions
When you place a text box on a page, the text is shown in the default display font. 
You format the text and position the text box relative to other objects on the page.

When you preview or publish the page and view it in your browser, the size of the 
text box and its alignment with the objects around it are controlled by the font 
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settings in the browser. If your NetObjects Fusion default browser font is 10-point 
Times Roman, and your browser default font is set to 14-point Arial, you see an 
immediate difference in the arrangement and spacing of objects, because text boxes 
expand to accommodate the new font size. 

This font variation is not caused by NetObjects Fusion; it’s a consequence of site 
visitors controlling their browser environment. You can avoid potential problems by 
viewing the page in a variety of browsers using different font sizes.

Browser view at 14-point Arial

Page view at 
10-point Times Roman
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Managing MasterBorders 10
NetObjects Fusion divides a page into the Layout area and the MasterBorder area. 
The MasterBorder contains objects that repeat on a set of pages. You can place 
anything in a MasterBorder that you can place in the Layout, including banners, 
pictures, and text.

You can create a MasterBorder and apply it to all the pages in your site or just to 
selected pages. A site can use more than one MasterBorder. When you modify a 
MasterBorder, NetObjects Fusion automatically makes the change on every page 
that shares the MasterBorder.

This chapter describes:

✦ Modifying a MasterBorder

✦ Creating a MasterBorder

✦ Changing MasterBorders

✦ Applying a MasterBorder to a section

✦ Renaming a MasterBorder

✦ Deleting a MasterBorder
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Working with MasterBorders

    
Working with MasterBorders
The MasterBorder is the set of margins—top, bottom, left, and right—on the page.

By default, the left, right, and bottom margins are separated from each other by an 
outline. The lack of an outline between the left margin and the top margin indicates 
objects can straddle that boundary.

All pages have a MasterBorder. If no MasterBorder is visible, the assigned 
MasterBorder has all margins set to zero. This is called the ZeroMargins 
MasterBorder. You can change the size of any MasterBorder margin, even those set 
to zero. See “Modifying the Current MasterBorder” on page 10-3.

When you create a new site, NetObjects Fusion creates a default MasterBorder that 
contains three navigation aids—a banner showing the page name at the top, a 
graphical navigation button bar on the left, and a text navigation bar on the bottom. 
If you do not want to include these objects, you can select the ZeroMargins 
MasterBorder, or create a new MasterBorder and delete the objects.

Top margin

Left margin

Right margin

Bottom margin
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Selecting a MasterBorder
➲ In Page view, click an empty space inside the MasterBorder. If the page has the 

ZeroMargins MasterBorder, click outside the page.

Modifying the Current MasterBorder
1. In Page view, select the MasterBorder.

The MasterBorder Properties palette appears. The Name field shows the name of 
the MasterBorder assigned to the current page.

This page has a visible MasterBorder. 
Click inside it

This page has the ZeroMargins MasterBorder. 
Click outside the page
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Modifying the Current MasterBorder

        
2. To change the size of the margins, drag the handles on the ruler.

Note: If an object is in the way—such as a banner occupying the top and left 
margin—you must move the object to resize the MasterBorder.

For precise margin settings, in the Margins section of the MasterBorder 
Properties palette, type values into the fields or click the arrows.

3. Arrange objects such as a banner or navigation buttons, delete unwanted 
objects, and insert additional text or objects.

4. When the objects are arranged to your satisfaction, from the Object menu, 
choose Size MasterBorder to Objects.

The MasterBorder shrinks to the minimum size required to display the objects it 
contains. This can conserve browser window space.

Drag these handles 
to change the 
MasterBorder size

MasterBorder margins before and after being resized
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Creating a MasterBorder
1. In Page view, select the MasterBorder.

The MasterBorder Properties palette appears. The Name field shows the name of 
the MasterBorder assigned to the current page.

2. Click the Add/Edit button.

The Edit MasterBorder List dialog appears displaying a list of all the 
MasterBorders in the site. The current MasterBorder is selected.

3. To add a MasterBorder, click Add.

The New MasterBorder dialog appears.

4. Type a name for the new MasterBorder, select an existing MasterBorder to base 
it on, and click OK.

Click to create a new MasterBorder

Click to add a MasterBorder
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You cannot include spaces in the MasterBorder name. You cannot begin the 
MasterBorder name with a number.

NetObjects Fusion creates a new MasterBorder based on the selected 
MasterBorder and makes it the current MasterBorder.

5. Continue working on the MasterBorder by following the steps in “Modifying 
the Current MasterBorder” on page 10-3.

Changing MasterBorders
1. In Page view, display the page where you want to apply a different MasterBorder.

2. Click in the MasterBorder to display the MasterBorder Properties palette.

3. Select the MasterBorder you want from the Name drop-down list.

The margins of the page now display the contents of the selected MasterBorder.

Applying a MasterBorder to a Section
You can apply a MasterBorder to a section of pages in Site view. A section is any 
page and all its children, their children, and so on. 

1. In Site view, select a section by holding down Shift and clicking the parent page 
of the section.

The Properties palette displays the Section tab.

2. Select the MasterBorder you want from the MasterBorder drop-down list.

The MasterBorder is applied to all the pages in the section.

Type a name for the new MasterBorder

Select a MasterBorder to base the new one on
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Renaming a MasterBorder
1. In Page view, click in the MasterBorder to display the MasterBorder Properties 

palette.

2. Click Add/Edit.

3. In the Edit MasterBorder List dialog, select the MasterBorder you want to 
rename and click Rename.

4. In the Rename MasterBorder dialog, type a new name and click OK.

5. Click Close.

The new MasterBorder name now appears in the Edit MasterBorder List dialog 
and in the drop-down list in the MasterBorder Properties palette.

Deleting a MasterBorder
1. In Page view, click in the MasterBorder to display the MasterBorder Properties 

palette.

2. Click Add/Edit.

3. In the Edit MasterBorder List dialog, select the MasterBorder you want to delete 
and click Delete.

4. Click Yes to confirm deletion.

If you delete a MasterBorder that is in use, the ZeroMargins MasterBorder is 
assigned to those pages.
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Working with AutoFrames 11
AutoFrames permit site visitors to scroll the body of the page while objects in the 
AutoFrame, such as navigation buttons, remain in view. You can set any or all of the 
MasterBorder margins as an AutoFrame.

This chapter includes:

✦ Understanding frames

✦ Adding AutoFrames

✦ Setting frame properties

✦ Targeting links in AutoFrames
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Understanding Frames

  

       
Understanding Frames
Frames are an HTML mechanism you can use to subdivide the browser window 
into independent areas. When a site visitor scrolls the Layout, the frame doesn’t 
scroll with it, so you can keep navigation buttons in view at all times. Frames can 
also reduce the amount of refreshing required by your visitor’s browser.

Generic MasterBorder 
applied to 
site’s Home page

Left border is an
11-2 Working with AutoFramesWorking with AutoFramesWorking with AutoFramesWorking with AutoFrames



 

Adding an AutoFrame

   
Each frame displays its own content, which can include links, a form, regions, or 
any text, graphic, or media objects. Links within a frame can display a page, or 
display information in the same frame or a different frame. You can define targets 
for the links contained in one frame so they retrieve content into another frame.

A special type of HTML page—called a frameset—establishes the combination of 
frames and frame properties that make up the browser window display. The 
frameset specifies the number of frames, defines their size and placement, and 
specifies the pages or resources that make up their original or default content.

NetObjects Fusion supports two ways of creating frames.

✦ You can use a graphical interface to set AutoFrames and add navigation controls, 
banners, text, graphics, links, and scroll bars. An AutoFrame frameset contains a 
body frame for the Layout area of the page and frames for one or more of the 
MasterBorder margins: Left, Right, Top, Bottom. An AutoFrame frameset 
cannot have more than these five frames and they must be in the specified 
positions.

✦ If you require more than five frames or frames in different positions, you can 
manually code frames using HTML. See “Examples of Page and AutoFrame 
HTML” on page 26-4.

Although Netscape Navigator and Microsoft Internet Explorer support frames, not 
all browsers do. If you use frames, you might want to consider creating an alternate 
site for visitors with browsers that do not support frames. See “Accommodating 
Browsers that Don't Support Frames” on page 26-6 and “Directing Visitors to a 
Browser-Specific Page” on page 24-16.

Within a frame, you can influence how variations in browser fonts affect your 
design. The Rows and Columns properties work within a frame the same way they 
work within a Layout. For information, see “Optimizing Nested Tables Output” on 
page 7-6.

Adding an AutoFrame
When you add AutoFrames, NetObjects Fusion applies them to the current 
MasterBorder and all pages that use that MasterBorder. Before you add AutoFrames, 
you might want to select or create a designated “framed” MasterBorder that you can 
apply to the appropriate pages. To apply different framesets to different pages, you’ll 
need one MasterBorder for each frameset. As you develop these MasterBorders, 
follow these guidelines:
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✦ Objects in frames can’t straddle frame boundaries, so check the corners of your 
page before you add AutoFrames. For example, if you have a banner across the 
top of the page that overlaps the left and top borders, resize it or move it before 
you turn on AutoFrames for either border.

✦ To avoid scroll bars displaying when you don’t need them, add a little extra 
room to margins you’re going to set as frames.

See “Creating a MasterBorder” on page 10-5 if you need help creating a 
MasterBorder.

To set a MasterBorder margin as an AutoFrame:

1. In Page view, click an empty space inside the MasterBorder, or in the gray area 
outside the page.

The MasterBorder Properties palette appears.

2. Click the AutoFrames tab.

3. Click the button for each margin you want to set as a frame—Left, Right, Top, or 
Bottom.

NetObjects Fusion adds a label—Left, Right, Top, or Bottom—to indicate a 
frame. In addition to the frame you select, the Layout area also becomes a frame.

If you add frames to more than one border, the selection sequence is important 
because frames overlap each other in the order in which you add them. You can 

The left margin is 
set as an AutoFrame
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change the overlap sequence by clearing the AutoFrame option for all margins 
and then reselecting them in a different sequence.

Keep in mind that because enabling AutoFrames makes your page consist of at least 
three HTML pages, it can slow page loading. 

Generating HTML Frame Borders
Frames have borders by default. If you want site visitors to be able to resize the 
frame, on the AutoFrames tab of the MasterBorders Properties palette leave 
Generate HTML frame borders selected.

To set frames to be borderless in the site visitor’s browser, clear Generate HTML 
frame borders. NetObjects Fusion turns off the borders for all frames in that 
MasterBorder.

Be sure that one of the frame buttons is selected; otherwise this setting will have no 
effect.

The left frame was 
selected, followed 
by the bottom 
frame, as indicated 
by the numbers on 
the AutoFrames tab. 
As a result, the left 
frame extends the 
full height of the 
page

The bottom frame 
was selected first, 
followed by the left 
frame. The bottom 
frame extends the 
full width of the 
page
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To combine frames with borders and frames without borders on the same page, you 
must script the frames. See “Examples of Page and AutoFrame HTML” on 
page 26-4.

Setting Frame Properties
1. In Page view, click the frame label or right-click in the frame and select Frame 

properties from the shortcut menu.

The Frame Properties palette appears. 

You cannot change the name of the frame.

2. Select a User scrollable option:

✦ Yes. The browser always displays vertical and horizontal scroll bars in the 
frame, whether needed or not.

✦ No. The browser never displays scroll bars, even if needed to display all 
objects in the frame. If the page content is larger than the frame itself, site 
visitors cannot see the entire page.

✦ Auto. The browser displays scroll bars if the size of the page content requires 
them.

Note: Due to the nature of browsers, links to anchors on a frame do not work if User scrollable 
is set to No.

3. Select User resizeable frame so site visitors can resize the frame.
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HTML frame borders must be visible so the site visitor can drag them to specify 
a new size. If User resizeable frame is not available, return to the AutoFrames tab 
and select Generate HTML frame borders.

4. Clear Enable margin padding if you want to place objects at the frame border 
with no spaces.

5. If you are publishing using the Nested Tables or Regular Tables HTML output 
method, choose the most efficient Table Structure—Columns or Rows. If you 
are publishing using CSSP+Layers, CSSP, or Layers, this setting has no effect. See 
Chapter 7, “Controlling Published Output.”

6. Click the Background tab and select:

✦ The background of the current SiteStyle or a color. If the color shown is not 
the one you want, click the Color button, select a color from the Color 
Picker, and click OK.

✦ To add a picture to the frame background, select Picture. In the Picture File 
Open dialog, select an image file. If the picture is smaller than the frame, it is 
automatically tiled to fill the frame. If you selected a picture with a 
transparent color, the background color shows through.

You can add an action to a frame using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Targeting Links in AutoFrames
When a site visitor clicks a link placed within a frame, the browser has to know 
where to display the results. The frame that displays the retrieved content is the 
target of the link; when you specify which frame is to display the results of a link, 
you are targeting that frame.

1. In Page view, select the object or text that you want to link.

The object’s properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the tab appropriate to the type of link you are targeting: Internal Link, 
Smart link, External Link, or File Link and set up the link. See Chapter 18, 
“Creating Links and Anchors.”
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AutoFrames and Browser Refresh

          
4. Choose the target frame in which you want to display the linked information 
from the Select Frame Target drop-down list.

Note: You may not need to assign a target. NetObjects Fusion automatically targets 
most internal links for you. You must always assign a target to external links.

5. Click Link to close the dialog and create the link.

6. Preview the page to test your targeted links.

Note: Targeted links in framesets do not load the URL of the page into the browser 
Location input field.

AutoFrames and Browser Refresh
When a site visitor clicks an untargeted link in a frame you created with 
AutoFrames, the browser either refreshes the entire page or only the content of the 
Layout area. This doesn’t affect the appearance of the page, but for performance 
reasons you might not want the browser to refresh the entire page unnecessarily.

✦ The browser refreshes the entire window if a framed MasterBorder contains a 
dynamic object, such as a banner, highlighted navigation buttons, or a smart 
link. The dynamic object, by definition, changes from page to page, so the 
browser has to load the new page. Rollover buttons do not change from page to 
page, so they do not affect the page refreshing.

✦ The browser exits the frameset and displays the retrieved resource in the full 
browser window if the link retrieves a page with a different MasterBorder, or an 
external HTML page.

If neither condition exists, the browser refreshes the body frame even if no target is 
assigned.
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Designing with Text 12
Text is the primary tool for delivering your message. You can type text onto your 
pages, add it to pictures and shapes, and format it for maximum impact.

This chapter describes:

✦ Adding text to a page

✦ Selecting text

✦ Formatting text

✦ Formatting paragraphs

✦ Creating bulleted and numbered lists

✦ Creating, modifying, and applying text styles 

✦ Inserting symbols

✦ Adding text to a shape or picture

✦ Creating and editing fields

✦ Checking spelling

✦ Finding and replacing text

✦ Counting words, lines, paragraphs, and characters 
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Adding Text to a Page

      
Adding Text to a Page
To add text to a page, you can use the Text tool, drag and drop text from another 
application, or paste text from the Clipboard. In each case, the text is placed in a text 
box. See Chapter 9, “Working with Text Boxes.”

Using the Text Tool

Text toolText toolText toolText tool

1. In Page view, select the Text tool from the Standard toolbar and draw a text box 
on the page.

A text box and the Text Properties palette appear. Hollow selection handles 
indicate the text box is in text editing mode.

2. Type or paste text into the box.

The text automatically wraps to the width of the box.

To force a line break, position the pointer at the end of the line and press 
Shift+Enter.

3. Click outside the text box to deselect it.

The text box length automatically sizes to the text you entered.
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Dragging and Dropping a Text File
1. In Windows Explorer, locate the text or .rtf.rtf.rtf.rtf (rich text format) file you want to 

add to the page.

2. Drag the file onto the page.

The text appears on the page in a text box.

Pasting Text from the Clipboard
1. Cut or copy the text from the original source, such as a word processing 

document.

2. In Page view, click where you want to position the text.

3. From the Edit menu, choose Paste.

The text appears on the page in a text box.

Selecting Text
1. Double-click the text box to edit the text.

Hollow selection handles appear around the text box.

2. To select:

✦ Specific characters, drag.

✦ A word, double-click.

✦ A paragraph, triple-click.

✦ A block of text, click the first word, then Shift+Click the last word.

✦ Multiple paragraphs, drag through them.

Formatting Text
With NetObjects Fusion you can format text using fonts. If the specified font is 
installed on the site visitor’s system, HTML 3.x-compatible browsers display your 
text using this font. If the font is not installed, the browser checks a substitution 
table. If the specified substitution is not possible, the browser uses its default font. 
You can change the substitution table by editing the fontmap.txtfontmap.txtfontmap.txtfontmap.txt file in the 
\NetObjects System\NetObjects System\NetObjects System\NetObjects System folder.
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Note: You can format selected characters in text boxes or table cells. On a stacked page, you 
can format selected characters in formatted text fields, but in simple text fields, all 
characters have the same format. See Chapter 25, “Data Publishing.”

To format text:

1. In Page view, select the text you want to format.

2. Select a font from the Font drop-down list on the Text Properties palette.

3. Click a font style button to assign characteristics—bold, italic, underline, and 
strikethrough—to the text. 

4. Click a font effects button to superscript or subscript the text.

5. Select a size for the text from the Size drop-down list.

6. To assign a color other than the SiteStyle color to the text, click Color and select 
a color from the Color Picker.

Formatting Paragraphs
1. In Page view, position the insertion point in the paragraph you want to format.

2. In the Paragraph section of the Text Properties palette, select left, center, or right 
alignment.

3. To indent the paragraph, click an indent button or press Tab.

Note: Due to limitations in HTML standards, you cannot insert a Tab character in a 
text box—for example, to indent the first line of a paragraph. You can only 
indent a whole paragraph.
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Applying, Creating, and Modifying Text Styles
A text style is a predefined set of font and paragraph formats. Text styles are a 
convenient way to specify, replicate, and update paragraph formatting.

You can create your own text styles and add them to the Styles list or modify the text 
styles included with NetObjects Fusion.

Applying a Text Style
1. In Page view, position the insertion point in the paragraph to which you want to 

apply a text style.

2. In the Paragraph section of the Text Properties palette, select a text style from 
the Style drop-down list.

Creating a Text Style
1. In Page view, from the Text menu, choose Edit Text Styles.

The Text Styles dialog appears.

2. Click New.
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The New Style dialog appears.

3. Enter a name for the new text style. If appropriate, select a text style on which to 
base this new style from the Based on drop-down list.

For example, if you create heading text styles, you could set up a format for the 
H1 style, then create an H2 text style based on H1 by specifying formatting that 
differs; for example, the font size or style.

4. From the Following Paragraph drop-down list, select the text style you want to 
apply to the paragraph that follows the paragraph you are formatting.

5. Click Paragraph to modify paragraph settings.

In the Paragraph dialog:

✦ Specify the number of units you want to indent the paragraph in the Indent 
Level field.

✦ If you are creating a text style for a list, select a bullet type or a numbered list 
option from the Bullet list.

✦ Specify how you want to align the paragraph by selecting an option in the 
Alignment section.

Click OK to close the Paragraph dialog. 

6. In the New Style dialog, click Font to select a font or modify the style, size, effect, 
or color of the current font.

In the Font - [style name] dialog:
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✦ Select the font, font style, and size you want to specify for the text style. The 
font size values represent size relative to your site visitor’s default browser 
font size.

✦ In the Effects section, click the check box for the effect or effects you want to 
specify for the style.

✦ To assign a color other than the SiteStyle color to the text, click Color, select a 
color from the Color Picker, and click OK.

Click OK to close the Font dialog.

The changes appear in the Preview and Description sections of the New Style - 
[style name] dialog.

7. In the New Style dialog, click OK.

The new style is added to the Styles list in the Text Styles dialog.

8. Click Close.

Modifying a Text Style
1. In Page view, from the Text menu, choose Edit Text Styles.

The Text Styles dialog appears.

2. Select the style you want to modify, then click Change.

The Change Style - [style name] dialog appears.

3. To change the style, see “Creating a Text Style” on page 12-5.

4. When you finish, click OK in the Change Style dialog.

5. In the Text Styles dialog, click Close.

NetObjects Fusion updates any paragraph to which you applied the style.

Deleting a Text Style
1. In Page view, from the Text menu, choose Edit Text Styles.

The Text Styles dialog appears.

2. Select the style you want to delete, then click Delete.

You cannot delete a style that has other styles based on it.

3. Click Yes to confirm deletion and click Close.
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Modifying a Text Style by Example
You can modify a text style by formatting a paragraph then reapplying the style.

1. In Page view, select a paragraph that is in the style you want to modify, so the 
style name is selected in the Style list on the Text Properties palette.

2. Select the text and use the options on the Format tab of the Text Properties 
palette to change it to the font, size, style, color, and alignment you want.

3. Select the style again from the Style list.

The Reapply Style dialog appears, showing the name of the selected style.

4. Select Redefine the style using the selection as an example and click OK.

If you select Reapply the formatting of the style to the paragraph, you lose all 
your changes and the paragraph returns to its original settings for that style.

The selected style now has the changed format, and all paragraphs with that style 
are updated.

Creating Bulleted and Numbered Lists
To create a simple numbered or bulleted list:

1. In Page view, select the text you want to format as a numbered or bulleted list.

2. Select an option from the Bullet drop-down list on the Format tab of the Text 
Properties palette.

3. If you select a numbered list and want to start with a value other than 1 or A, 
click Start Value, enter a number in the Start value field in the Start Value of 
Numbered List dialog, and click OK.

4. To add a bulleted item to the list, press Enter. Press Shift+Return to start a new 
line under the same bulleted item.
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To create a multi-level numbered or bulleted list:

1. In Page view, select the text you want to include in the list. Make sure each item 
in the list is a separate paragraph.

2. Select a list type from the Bullet drop-down list.

If you select a numbered list and want to start with a value other than 1 or A, 
click Start Value, enter a number in the Start value field in the Start Value of 
Numbered List dialog, and click OK.

3. Select the paragraph or paragraphs you want to make subordinate and click the 
right indent arrow or press Tab.

4. Select a different list type from the Bullet drop-down list. Be sure to set the 
indent before you choose a bullet style.

Inserting Symbols
You can insert special symbols, such as an em dash or copyright symbol into text.

1. In Page view, double-click the text box where you want to insert the symbol.

2. Click the location where you want to insert the symbol. 

3. From the Text menu, select Insert Symbol.
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4. In the Insert Symbol dialog, select a symbol and click Insert.

The symbol appears in the text.

You control whether quotation marks are straight or curly in Publish view. See 
“Setting the Site’s HTML Output Method” on page 28-6.

Adding Text to a Shape or Picture
When you add text to a shape or picture, the text becomes part of a new image file 
when you publish the page. Because the text is part of the image, the site visitor’s 
browser displays the correct font, even if the font you use is not installed.

If you add text to a picture file, when you publish the site, NetObjects Fusion 
generates a new picture file listed in Publish view as an Auto-generated image. Your 
original file is unchanged and not included among the site assets.

Windows NT, some versions of Windows 95, and Windows 98 include a utility for 
smoothing fonts that works with NetObjects Fusion. In Windows 95 and Windows 
NT, to turn on font smoothing, open the Control Panel, click the Display icon, and 
on the Plus! tab select Smooth edges of screen fonts. In Windows 98, the option is 
on the Effects tab.

To add text to a shape or picture:

1. In Page view, select the shape or picture to which you want to add text.

The corresponding properties palette appears. If you are working with a picture, 
click the Effects tab.

2. In the Text in element section, select Enable and click Settings.
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The Text in Element Settings dialog appears.

3. Replace the highlighted text with the text you want to add.

4. Click the Font Set button and select a font, style, and size, and click OK.

5. In the Text in Element Settings dialog, click the Color Set button, select a color 
in the Color Picker, and click OK.

6. In the Text in Element Settings dialog, select the Relative Alignment, Horizontal 
Position, and Vertical Position for the text.

The Relative Alignment left-aligns, centers, or right-aligns two or more lines of 
text. It has no effect on single lines of text.

The Horizontal Position and Vertical Position settings position the text within 
the object frame.

To specify multiple lines of text in a SiteStyle banner or button, use the Custom 
Names dialog as described in “Using Custom Page Names and Extensions” on 
page 3-11.

7. In the Orientation section, move the slider to rotate the text.

On the left, Relative Alignment is set to Left, 
Horizontal Position and Vertical Position are 
set to Center. On the right, Relative Alignment 
is set to Center, Horizontal Position to Left, and 
Vertical Position to Center
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Select Right angles to limit the text rotation to 90-degree increments.

8. Click Close to apply the text settings to the text.

Creating and Editing Fields
Fields contain variable text that is subject to change, such as the date and time the 
site was created or last modified, the site name and author, and so on. NetObjects 
Fusion includes several fields you can use and you can also define your own.

Inserting an Existing Field
1. In Page view, double-click the text box and position the insertion point where 

you want to insert the field.

2. From the Text menu, choose Insert Field.

The Insert Field dialog appears.

3. Select the type of field you want to insert from the Type drop-down list.

If you select Date & Time, click Date & Time Format, select a format from the 
list in the Date & Time Format dialog, and click OK.

Note: Once you publish the site, the date on the final HTML page does not change 
automatically. It only changes if you modify the site in NetObjects Fusion and 
publish again. This is true of all variables.

4. Select the specific field to insert from the Field list.
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5. Click OK in the Insert Field dialog.

Creating a User-Defined Variable
A user-defined variable is text or a phrase that is subject to change. For example, if 
you need to refer to quarterly sales figures, you can create a user-defined variable 
and insert the number as a field. As the figure changes each quarter, you can edit the 
field as described in “Editing a Variable” on page 27-10, and NetObjects Fusion 
automatically updates the name wherever it appears in your site. You can only create 
plain text variables. You cannot reference internal NetObjects Fusion fields, such as 
page names, asset names, or object properties.

1. In Page view, double-click the text box where you want to insert a user-defined 
variable.

2. From the Text menu, choose Insert Field.

The Insert Field dialog appears.

3. Select User-defined Variable from the Type drop-down list.

4. Click New.

The New Variable dialog appears.

5. Type a name and value for the field and click OK.

The field appears highlighted in the Field list of the Insert Field dialog.

6. Click OK.
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Checking Spelling
You can check the spelling of English language words in NetObjects Fusion. You can 
add words to a personal dictionary so they will no longer be flagged as misspelled. 
Your personal dictionary is a simple text file, so you can use any text editor to add or 
delete words. The spelling checker checks one page at a time.

1. In Page view, select the text you want to check. To check all text boxes and tables 
on the page, select the Layout area or MasterBorder.

2. From the Edit menu, choose Spell Check.

If NetObjects Fusion does not recognize the word, it displays the word in the 
Not found field of the Spelling dialog.

3. Click:

✦ Ignore to skip this instance of the word.

✦ Ignore All to skip all instances on this page.

✦ Change to replace this instance with the word in the Change to field.

✦ Change All to replace all instances on this page with the word in the Change 
to field.

✦ Add to put the word in your personal dictionary.

✦ Suggest to see alternate spellings for the word. Double-click a suggestion to 
use it.

✦ Options to choose U.S. or UK English, and to choose a location for your 
personal dictionary.

✦ Close to cancel the spelling check.
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Finding Text
1. In Page view, from the Edit menu, choose Find.

The Find dialog appears.

2. In the Find what field, type the word, letters, or phrase you want to find and 
select options to narrow the search.

3. Click Find Next.

NetObjects Fusion searches the current page.

Replacing Text
1. In Page view, from the Edit menu, choose Replace.

The Replace dialog appears.

2. In the Find what field, type the text you want to replace.

3. In the Replace with field, type the replacement text.

4. Select options to narrow the search.

5. Click Find Next.

NetObjects Fusion searches the current page.

6. Click Replace to replace the found text, or click Replace All to replace all 
instances of the text on the page with the replacement text.
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Counting Words, Lines, and Paragraphs
✦ To get a word count for the current page, in Page view, choose Word Count from 

the Edit menu.

✦ To get a word count for a section of text, select the text, then choose Word Count 
from the Edit menu.

The Page Word Count dialog appears.

If the text box includes embedded objects, the line count is incremented for each 
embedded object.
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Placing Pictures 13
You can enhance your pages by placing pictures in the Layout area and 
MasterBorder. This chapter tells how to add pictures and modify their size and 
appearance.

This chapter describes:

✦ Choosing an image format

✦ Adding a picture

✦ Resizing a picture

✦ Cropping a picture

✦ Tiling a picture

✦ Rotating a picture

✦ Creating a border around a picture

✦ Creating a transparent GIF
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Choosing an Image Format
To display a picture, most browsers require the picture to be stored in one of the 
following Web-standard formats:

✦ Joint Photographic Experts Group (.jpg.jpg.jpg.jpg) supports 24-bit true color.

✦ Graphics Interchange Format (.gif.gif.gif.gif) supports 8-bit, 256-color images. 
NetObjects Fusion also supports GIF 89, a format for transparency, interlacing, 
and animation, as well as animated .gif.gif.gif.gifs. An animated .gif.gif.gif.gif file contains multiple 
images that a browser plays in sequence, adding movement to your pages 
without browser plugins.

✦ Portable Network Graphics (.png.png.png.png) supports any color-depth image. To view .png.png.png.png 
images with Netscape Navigator 4.0, the PnP Live 2.0 plugin is required; 
Microsoft Internet Explorer 4.0 does not require a plugin. Earlier versions of 
both browsers require PNGLive 1.0 to view the image. You can find this plugin 
at http://home.netscape.com/plugins/image_viewers.html.http://home.netscape.com/plugins/image_viewers.html.http://home.netscape.com/plugins/image_viewers.html.http://home.netscape.com/plugins/image_viewers.html.

NetObjects Fusion includes sample pictures in the NetObjects Fusion NetObjects Fusion NetObjects Fusion NetObjects Fusion 
4.0\Samples\Content\Images4.0\Samples\Content\Images4.0\Samples\Content\Images4.0\Samples\Content\Images and \Animated GIFs\Animated GIFs\Animated GIFs\Animated GIFs folders. There are more samples in 
the \Extras \Extras \Extras \Extras folder on the NetObjects Fusion installation CD.

If you try to place a picture that is in .bmp.bmp.bmp.bmp, .pcx.pcx.pcx.pcx, .pct.pct.pct.pct, or .psd.psd.psd.psd format, NetObjects 
Fusion offers to convert it to .gif.gif.gif.gif or .jpg.jpg.jpg.jpg format.

If you are using Windows NT, you can use the Picture tool to place Flashpix (.fpx.fpx.fpx.fpx) 
images. You can also use the Media Plug-in tool, as described in “Inserting Other 
Types of Files” on page 19-12, to place an .fpx.fpx.fpx.fpx file in Windows 95, Windows 98, or 
Windows NT. 
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Adding a Picture

Picture toolPicture toolPicture toolPicture tool

1. In Page view, choose the Picture tool from the Standard toolbar, and draw a box 
where you want to place the picture.

The Picture File Open dialog appears.

2. Select the image file you want from your hard disk, CD-ROM, or LAN.

From the Files of type drop-down list, select:

✦ Web Images, to see a list of all image files that can be viewed in a Web 
browser, including .gif.gif.gif.gif, .jpg.jpg.jpg.jpg, and .png.png.png.png.

✦ A specific file type, to see only files of that type. You can select GIF, JPEG, 
PNG, BMP, PCX, PICT, or FPX.

✦ All Images, to view all files that are image files.

✦ All Files, to see all files in the selected folder.

3. Make sure Show thumbnail image is selected if you want to preview your image 
in the dialog.

4. Click Open to place the image on the page.

Show thumbnail 
image check box

Thumbnail image
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If you select a non-standard Web format, the Unsupported File Format dialog 
appears. 

✦ If you convert to .gif.gif.gif.gif, NetObjects Fusion reduces the image to 256 colors.

✦ If you convert to .jpg.jpg.jpg.jpg, NetObjects Fusion retains the color information from 
the original file.

✦ If you choose not to convert, NetObjects Fusion positions the image in 
HTML using the <EMBED> tag. Only browsers that have the appropriate 
plugin installed can view the image.

5. Choose the appropriate conversion format and click OK.

The picture and Picture Properties palette appear. The box you drew 
automatically resizes to fit the picture.

6. Type a description of the picture in the AltTag field.

See “Adding and Modifying Alt Tags” on page 6-10.
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If you want to use a picture that is already placed in the site, you can choose it from 
the list on the Image Assets tab in the Picture File Open dialog. See Chapter 27, 
“Managing Assets.”

Resizing a Picture
When you resize a picture and publish the site, NetObjects Fusion changes the 
HTML <HEIGHT> and <WIDTH> tags of the original image. Your original file is 
unchanged and included among the site assets.

1. In Page view, select the picture you want to resize.

The Picture Properties palette appears.

2. Set the picture’s Display property to Stretch.

3. Drag any handle until the picture is the size you want. To size the picture 
proportionally, hold down the Ctrl key as you drag a corner handle. 

To return the selected picture to its original size, either:

✦ Set the picture’s Display property to Normal.

✦ From the Object or shortcut menu, choose Restore Original Size.

Cropping a Picture
You can crop a picture to make only part of it visible. When you publish the site, 
NetObjects Fusion generates a new file listed in Publish view as an Auto-generated 
image. Your original file is unchanged and included among the site assets.

1. In Page view, select the picture you want to crop.

2. Set the picture’s Display property to Normal.

3. Drag the lower-right selection handle to reduce the size of the box enclosing the 
picture. NetObjects Fusion crops the bottom and right sides of the picture. To 
crop proportionally, hold down Ctrl as you drag.
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Tiling a Picture
You can create multiple instances of a picture by tiling it. When you publish the site, 
NetObjects Fusion generates a new file listed in Publish view as an Auto-generated 
image. Your original file is unchanged and included among the site assets.

1. In Page view, select the picture you want to tile.

The Picture Properties palette appears.

2. Set the picture’s Display property to Tile.

3. Drag a selection handle to enlarge the box and display more or fewer tiled 
images.

NetObjects Fusion displays multiple images of the picture in the box. Each 
image is the size of the picture in the source file.

Rotating a Picture
You can rotate pictures in 90-degree increments. When you rotate a picture and 
publish the site, NetObjects Fusion generates a new file listed in Publish view as an 
Auto-generated image. Your original file is unchanged and included among the site 
assets.

1. In Page view, select the picture you want to rotate.

The Picture Properties palette appears.

2. Click the Effects tab.

3. In the Rotate field, select the desired rotation.

Picture rotated 90 
degrees
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Creating a Border Around a Picture
You can use the Picture properties to add a black border around a picture.

1. In Page view, select the picture for which you want to create a border.

The Picture Properties palette appears.

2. Click the Effects tab.

3. In the Border field, specify the thickness of the border.

Creating a Transparent GIF
When you place a .gif.gif.gif.gif image on a page, you can make every pixel of one color 
transparent. Although only part of the image is transparent, it is called a transparent 
.gif.gif.gif.gif. You can use transparent .gif.gif.gif.gifs to blend an image background with the page 
background, or to silhouette an image against the page background.

An image with a solid background works best because only pixels of exactly the 
same color can be transparent. If the image background is dithered, it contains 
several colors.

Note: Transparency only works with .gif.gif.gif.gifs. You cannot set a transparency for a .jpg.jpg.jpg.jpg or other 
image file format.

When you use transparency, NetObjects Fusion generates an Auto-generated image. 
Your original file is unchanged and included among the site assets.

To create a transparent .gif.gif.gif.gif:

1. In Page view, select the picture for which you want to create a transparent .gif.gif.gif.gif.

The Picture Properties palette appears.

2. Click the Effects tab.

Ordinary .gif

Page background shows through 
transparent .gif
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3. Click the Transparency dropper, then click the color in the picture that you want 
to make transparent.

The Use color check box is selected, and NetObjects Fusion displays the color 
you selected in the box next to it.

4. To make a transparent color opaque, clear the Use color check box.

Adding Text to a Picture
You can add text to a picture and format its font, size, and alignment. The text you 
add becomes part of a new image file when you publish the page containing the 
picture. When you add text to a picture and publish the site, NetObjects Fusion 
generates a new file listed in Publish view as an Auto-generated image. Your original 
file is unchanged and included among the site assets. See “Adding Text to a Shape or 
Picture” on page 12-10.
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Adding Tables 14
Presenting information in tabular format is often an effective way to convey 
complex concepts and ideas. NetObjects Fusion makes it easy to add tables to a site. 
You can select and work with a whole table, just a row, just a column, a single cell, or 
several rows, columns, or cells. Each of these objects has its own properties palette 
and its own HTML button, so you can apply HTML to the cell, row, column, or 
table.

This chapter describes:

✦ Adding tables

✦ Setting table structure

✦ Working with cells

✦ Adding text and pictures to tables
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Adding a Table

Table toolTable toolTable toolTable tool

1. In Page view, choose the Table tool from the Standard toolbar and draw a box 
where you want to position the table.

The Create Table dialog appears.

2. Specify the number of columns and rows in the table and click OK.

The table appears with the Table Properties palette. These properties apply to 
the entire table; you can also select a row, column, or individual cell and set its 
properties. See “Setting Row and Column Properties” on page 14-5 and “Setting 
Cell Properties” on page 14-6.

Each table, column, row, and cell is an individual object. You can view the object 
hierarchy by selecting Object Tree from the View menu. You can also see which table 
object is selected by referring to the Object Tree. You can rename tables and cells in 
the Object Tree, but you cannot rename rows or columns.

You can add an action to a table or cell using the Actions tab on the Properties 
palette.

New table with two rows and 
two columns
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Setting Table Properties
1. In Page view, select the table and make sure the General tab of the Table 

Properties palette is displayed.

2. If the table is embedded in a text box, you can choose Fixed width or Relative 
width. If the table is not in a text box, these options are not available.

✦ If the text box containing the table is sized to the Layout and set to wrap to 
the browser width, you can use Relative width to size the table as a 
percentage of the text box. If a site visitor resizes the browser window, the 
table will resize accordingly.

✦ Use Fixed width to ensure that NetObjects Fusion does not resize the table if 
the site visitor resizes the browser window.

3. Select a thickness for the table border.

4. Set the Cell Padding, which is the amount of space between the contents of a 
table cell and the cell boundaries.

5. Set the Cell Spacing, which is the distance between cells.

6. In the Advanced section of the General tab, select:

✦ Generate <COL> tags to render the table quickly in Microsoft Internet 
Explorer 4.0 browsers.

✦ Generate width on all cells to improve rendering speed and WYSIWYG in both 
Netscape Navigator and Microsoft Internet Explorer browsers.

✦ Generate non-breaking spaces to prevent empty cells from collapsing in 
Netscape Navigator.

7. To make the table a form, select Table is a form. See Chapter 23, “Designing and 
Implementing Forms.”

You can add HTML code to a table. See Chapter 26, “Working with HTML 
Directly.”

Table Border

Cell Spacing

Cell Padding
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Setting the Table Background
You can have both a color and a picture in the table background. If the picture has a 
transparent area, the background color shows through.

1. In Page view, select the table.

2. Click the Background tab on the Table Properties palette.

3. To change the background color, click Color, select a color from the Color 
Picker, and click OK. To remove the background color, select None.

4. To add a picture to the background, select the Picture option, select a picture in 
the Picture File Open dialog, and click Open.

Adjusting the Table Structure
You can resize, add, or delete rows and columns, and merge or split cells to design 
the table structure.

Resizing Table Rows and Columns
➲ In Page view, select the table, and: 

✦ Drag the cell guides on the vertical or horizontal ruler to resize the rows or 
columns. If you drag the leftmost or topmost guide, you move the table.

✦ Point to the border of the row or column you want to resize and drag the cell 
boundary to the new size. This changes column width, but does not change 
the overall table width.

✦ For precise sizing of rows and columns, or to make all rows or all columns 
the same sized, see “Setting Row and Column Properties” on page 14-5.

Inserting a Row or Column
1. In Page view, select the table.

2. Select a row or column by pointing to it in the table border and clicking when 
you see the single-headed arrow.

3. Right-click to display to shortcut menu.

✦ To insert a row at the bottom of the table, or a column at the right side of the 
table, select Append Row or Append Column.
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✦ To insert a row above the selected row, or a column to the left of the selected 
Column, select Insert Row or Insert Column.

Removing a Row or Column
1. In Page view, select the table.

2. Select the row or column you want to delete by pointing to it in the table border 
and clicking when you see the single-headed arrow.

3. Right-click and select Delete Row or Delete Column from the shortcut menu.

Merging and Splitting Table Cells
1. In Page view, select the cells in the table that you want to merge or split.

2. Right-click to display the shortcut menu.

✦ To divide the cells, select Split Cells and enter the number of rows and/or 
columns you want to split the cell into in the Split Cells dialog. The 
maximum is 10 x 20.

✦ To merge cells, select Merge Cells. All borders between the selected cells 
disappear.

Setting Row and Column Properties
When you select a table row or column, a Row or Column tab is added to the Cell 
Properties palette.

1. In Page view, select the table.

2. Select a row or column by pointing to it in the table border and clicking when 
you see the single-headed arrow. Drag to select multiple rows or columns.
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The Cell Properties palette appears with the Row or Column tab added.

3. Set the Vertical and Horizontal Alignment to position objects within cells.

4. Set Row height or Column Width.

✦ To make all selected rows the same height, clear the Specified option and set 
the row height. If Specified is selected, rows maintain their individual 
heights. You can use this option to set the height for any individual row.

✦ To make columns the same width, select them, enter a number, and press 
Enter. To size each selected column to its contents, click Fit to Contents.

5. To make the row a form, select Row is a form. See Chapter 23, “Designing and 
Implementing Forms.” Due to limitations of HTML, you cannot make a column 
a form.

You can add HTML code to a row or column. See Chapter 26, “Working with 
HTML Directly.”

Working with Table Cells
Each table cell is an individual object. You can set its alignment, choose a 
background color and picture, format text, make the cell a form, or add HTML.

Setting Cell Properties
1. In Page view, click a cell in a table to select it.

The Cell Properties palette appears.
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2. If necessary, click the Cell tab.

3. Set the Vertical and Horizontal Alignment for the cell. Alignment for the row or 
column containing the cell is shown in parentheses.

✦ Vertical determines alignment of content within the cell.

✦ Horizontal determines alignment of the text in the cell.

4. Set the cell background. You can use both a color and a picture. If the picture has 
transparent areas, the background color shows through.

✦ To change the background color, click Color, select a color from the Color 
Picker, and click OK. To remove the background color, select None.

✦ To add a picture to the background, select the Picture option, select a picture 
in the Picture File Open dialog, and click Open.

5. Increase the text inset to add space between the text in a cell and the cell border.

6. To make the cell a form, select Cell is a form. See Chapter 23, “Designing and 
Implementing Forms.”

You can add HTML code to a cell. See Chapter 26, “Working with HTML Directly.”

Sizing Cells
To make a table cell shrink to fit the content in the cell:

1. Right-click in the cell you want to size.

2. Select Fit Cell from the shortcut menu.
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The cell shrinks to fit the content. Each cell in the column and row containing 
the cell becomes the same size.

Adding Text and Pictures to Cells
Working in a table cell is the same as working in a text box. You can:

✦ Add and format text. You can apply formats to all selected cells at one time. See 
Chapter 12, “Designing with Text.”

✦ Embed objects. See “Embedding Objects in a Text Box” on page 9-3.

✦ Wrap text around objects. See “Wrapping Text around Objects” on page 9-5.

✦ Modify text box properties. See Chapter 9, “Working with Text Boxes.”

To select a cell:

➲ Double-click the cell.

Cross-hatching appears around the selected cell. You can edit the text in the cell 
or change cell properties.
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Drawing Shapes and Lines 15
Shapes and lines are essential building blocks for your page designs. You can draw 
rectangles, rounded rectangles, ellipses, and polygons, as well as HTML horizontal 
rules, lines, or SiteStyle lines, and set shape and line properties.

This chapter describes:

✦ Drawing shapes and setting properties

✦ Drawing horizontal rules 

✦ Adding SiteStyle lines

✦ Drawing and editing lines and arrows
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Drawing Shapes
To draw an ellipse, rectangle, rounded rectangle, or polygon:

Draw Rectangle toolDraw Rectangle toolDraw Rectangle toolDraw Rectangle tool

1. In Page view, select the Draw tool on the Standard toolbar and choose the shape 
you want to add from the flyout.

2. Draw the shape on the page.

✦ To draw a rectangle, ellipse, or rounded rectangle, click and draw the shape.

✦ To draw a polygon, click to set the start point, click to set each subsequent 
point, and double-click to complete the shape.

The Properties palette for the shape you selected appears.

3. Type an alt tag in the AltTag field. 

See “Adding and Modifying Alt Tags” on page 6-10.

4. In the Line width box, set the shape outline thickness.

To make the outline invisible, set it to zero.

5. In the Color section of the Properties palette, click the Fill Color button. In the 
Color Picker, select the color you want to assign to the shape fill and click OK.

6. Click the Line Color button. In the Color Picker, select the color you want to 
assign to the shape border and click OK.

7. To adjust the shape, drag its handles.

✦ To change the shape proportionally, drag a handle while holding down Ctrl.

When you draw a shape, 
the appropriate properties 
palette appears
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✦ To vary the curve of a rounded rectangle, select it, place the pointer over the 
inside corner handle until it changes to a four-headed arrow, then drag 
toward the inside or outside of the shape.

✦ To edit the lines of a polygon, select it, place the pointer over any handle 
until you see the four-headed arrow, then drag the handle to adjust the 
shape.

8. To add text to a shape, see “Adding Text to a Shape or Picture” on page 12-10.

When you publish a page with shapes, NetObjects Fusion generates each shape as a 
.gif.gif.gif.gif file.

Adding HTML Horizontal Rules
HTML rules are always horizontal. They can display with beveled edges in a 
browser. When you embed an HTML rule in a text box, you can set its width as a 
percentage of the text box width.

To draw an HTML horizontal rule:

HR Rule toolHR Rule toolHR Rule toolHR Rule tool

1. In Page view, select the Line tool on the Standard toolbar and choose the HR 
Rule tool from the flyout. 

2. Draw the horizontal rule on the page.

Use this handle to modify the curve
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The HR Rule Properties palette appears.

3. In the Thickness box, set the thickness of the rule.

The standard width is 2 pixels.

4. Select Shaded to create a bevel effect.

The standard HR rule is shaded.

5. If the HR rule is embedded in a text box, you can specify its length as a 
percentage of the text box.

Adding a SiteStyle Line
You can use SiteStyle lines to divide a page into sections. A SiteStyle line is part of 
the current SiteStyle. See Chapter 16, “Using SiteStyles.”

SiteStyle Line toolSiteStyle Line toolSiteStyle Line toolSiteStyle Line tool

1. In Page view, select the Line tool on the Standard toolbar and choose the 
SiteStyle Line tool from the flyout.

2. Draw a box to position the line.

The SiteStyle line appears.

If you change SiteStyles, NetObjects Fusion updates the line. In your published site, 
a SiteStyle line is a .gif.gif.gif.gif file.

This option appears only when the 
line is embedded in a text box
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Drawing Lines and Arrows

Line Draw toolLine Draw toolLine Draw toolLine Draw tool

1. In Page view, select the Line tool on the Standard toolbar and choose the Draw 
tool from the flyout.

2. Drag from one point to another to set the position, length, and orientation of 
the line.

The point where you start dragging is the head of the line. The point where you 
finish is the tail of the line, regardless of the direction you drag. To constrain the 
line to vertical or horizontal, hold down the Shift key while dragging.

The Line Properties palette appears.

3. Type an alt tag in the AltTag field. 

See “Adding and Modifying Alt Tags” on page 6-10.

4. In the Line width box, set the width of the line in pixels.

5. In the Color section, click the Color button for the line, head, and tail, choose a 
color, and click OK. To set all three items to the line color, select All parts use 
one color.

6. In the Style section, select a style for the head and tail from the appropriate 
drop-down list. 

If you want the head and tail to share the same style, select the style for the head 
from one of the drop-down lists, then select Head/Tail same style. 

Select Outline to assign the line color to the head and tail outlines, regardless of 
their fill colors.
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When you publish a page with drawn lines, NetObjects Fusion generates each one as 
a .gif.gif.gif.gif file.

Editing Lines and Arrows
To change the length and width of a line, or change the shape and size of the line’s 
head and tail:

1. In Page view, select the line.

Selection handles appear. 

Place the pointer over a selection handle. The pointer changes to a crosshair.

✦ To make the line longer or shorter, or to change its direction, drag an end 
handle.

✦ To make the line thicker or thinner, drag a side handle.

✦ To change the shape of the head or tail, drag one of its handles.

2. In the Style section of the Line Properties palette, select a style from the Head or 
Tail drop-down lists to change the head or tail style.
15-6 Drawing Shapes and LinesDrawing Shapes and LinesDrawing Shapes and LinesDrawing Shapes and Lines



 

C

 

H

 

A

 

P

 

T

 

E

 

R

 

 

 

1 6

          
Using SiteStyles 16
SiteStyles are sets of thematic elements you can apply to your site. Some style 
elements are graphical and others affect the text colors on your pages. In Style view, 
you use SiteStyles to create the look and feel of your entire site. NetObjects Fusion 
comes with 55 professionally designed SiteStyles, and you can find additional 
SiteStyles in the \Extras\Extras\Extras\Extras folder on your installation CD. You can see examples of all 
the SiteStyles used in NetObjects Fusion versions 1.0 through 4.0 at www.eFuse.comwww.eFuse.comwww.eFuse.comwww.eFuse.com.

You can use SiteStyles as they are or edit them. You can also create SiteStyles using 
your own artwork to give your site a distinctive look.

This chapter describes SiteStyles and how to use them, including:

✦ Applying SiteStyles

✦ Editing SiteStyles

✦ Creating SiteStyles

✦ Adding and removing SiteStyles

✦ Styles folder structure
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What Is a SiteStyle?
A SiteStyle is a collection of graphical and typographical elements you can apply to 
every page in your site to create its look and feel. Your site’s SiteStyle gives it a 
consistent look that survives variations introduced by your site visitor’s browser. 
When you change the SiteStyle, NetObjects Fusion automatically updates every 
page in your site with the new look.

If you do not find a pre-built style that is appropriate for your site, you can create 
your own custom SiteStyle. Or, if a SiteStyle works for most, but not all, pages in 
your site, you can customize it for just a few pages. See Chapter 17, “Creating 
Navigation Bars and Banners.” For even more flexibility—for example, to use more 
than one banner image in your site or to use a different image for each button in a 
navigation bar—you can use the Navigation Bar and Banner Properties palettes in 
Page view. See “Customizing Banners and Buttons” on page 17-10. 

Style View
When you click the Style button on the control bar, NetObjects Fusion displays 
Style view. Style view shows a list of SiteStyles available for the current site and the 
elements of the selected SiteStyle.

List of SiteStyles

Current SiteStyle

Click to 
apply the 
selected 
SiteStyle 
to your 
site

Click to 
create a 
new 
SiteStyle

Selected 
SiteStyle

Elements 
of the 
selected 
style
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Each NetObjects Fusion SiteStyle is composed of nine style elements:

✦ Banner. Image containing the banner text

✦ Primary Navigation Bar. Images for highlighted and non-highlighted navigation 
buttons and highlighted and non-highlighted rollover buttons

✦ Secondary Navigation Bar. A second set of images for highlighted and non-
highlighted navigation buttons and highlighted and non-highlighted rollover 
buttons

✦ Data List Icons. Bullet graphic displayed when you use a data object to create a 
data list

✦ Normal Text Color. Color of text on the page

✦ Regular Link Color. Color of linked text on the page

✦ Visited Link Color. Color of linked text already explored by site visitor

✦ Background. Color or image used as a background of the page

✦ SiteStyle Line. Image for lines placed with SiteStyle Line tool

The SiteStyle designer is listed below the style elements. 

Applying SiteStyles
By default, navigation banners and buttons obtain their images and text attributes 
from the SiteStyle assigned to the site. When you apply a SiteStyle, NetObjects 
Fusion automatically applies style elements throughout your site. For example, it 
replaces all the buttons in your navigation bars with images from the style you 
specified, while maintaining the relevant links. 

To apply a SiteStyle:

1. In Style view, select a SiteStyle from the list of SiteStyles.

The elements of the selected style appear.

2. Click the Set style button on the control bar. 

NetObjects Fusion applies the style to your site. The more pages in your site, the 
longer this takes. When complete, a message confirms that the style was applied 
and the name above the style list changes to the one you selected. 

3. Click OK to acknowledge the message.

The next time you go to Page view, you see the new style elements and new text 
colors on each page.
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Editing SiteStyles
You can edit any element of an existing style to customize it. For instance, if you like 
every element of a style except the banner, you can change just the banner image. 
The image for every banner in your site changes to the new image. 

To customize SiteStyle elements for some, but not all pages, you do not edit the 
SiteStyle, you customize it just for those pages. See “Customizing Banners and 
Buttons” on page 17-10 for information.

Note: When you edit a SiteStyle, every site that uses the SiteStyle is affected. Your \StylesStylesStylesStyles 
folder stores only one copy of a SiteStyle. When you change it, the change appears in all 
sites that use that SiteStyle. If the style you want to change is used in other sites and 
you don’t want them to be affected, create a new style from the original style’s graphic 
elements and customize the new style. See “Creating a SiteStyle” on page 16-9. If you 
inadvertently change a style, you can find backups of style folders in the \Extras \Extras \Extras \Extras folder 
on the NetObjects Fusion CD. 

Editing a Style Banner
1. In Style view, select the style you want to change and double-click the banner.

The Banner dialog appears.

2. To change the banner’s image, click Browse, select an image file, and click Open. 

3. To change the appearance of text, click Text Settings and set text options as 
described in “Editing Text Settings for Buttons and Banners.” 

4. Click OK.
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Editing Text Settings for Buttons and Banners
With SiteStyles, you can choose any font on your system for banner and button text. 
NetObjects Fusion dynamically generates image files for these banners and buttons 
using the font you specified for each element. This means that on buttons and 
banners, your site visitors see the fonts you select regardless of their browser or the 
fonts installed on their systems. 

To format the text on navigation buttons and banners:

1. In Style view, double-click the banner or button image.

2. In the Banner, Primary Button, or Secondary Button dialog, click the Text 
Settings button.

The Text Settings dialog appears.

3. Edit the settings.

For details on how to change each text setting, see “Adding Text to a Shape or 
Picture” on page 12-10.

4. When you finish adjusting the text, click OK.

After you close the banner or button dialog, the banner or button text appears 
with its new options in Site view.
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Editing a Navigation Bar
Each SiteStyle includes a primary navigation bar and a secondary navigation bar. 
The two navigation bars differ only in the style of the button images. You can set the 
navigation bars in your site to display either style of navigation bar. For example, 
top-level pages can display the primary buttons while lower-level pages display the 
secondary buttons. See “Using Navigation Bars” on page 17-3.

Each navigation bar contains images for regular and highlighted buttons. 
Highlighted buttons appear in button navigation bars to show which page a visitor 
is currently viewing. You can turn highlighting on and off in the Navigation Bar 
Properties palette in Page view, as described in “Setting Navigation Bar Button 
Style” on page 17-6. Highlighting is turned on by default. 

Each regular or highlighted button can also have an image for a rollover button. Site 
visitors see the rollover button image when they move the mouse pointer over a 
button. Move your mouse pointer over the navigation bar samples to see how the 
rollover images appear. You can turn rollover buttons on and off in the Navigation 
Bar Properties palette in Page view, as described in “Setting Navigation Bar Button 
Style” on page 17-6.

To edit a navigation bar:

1. In Style view, select the style you want to change and double-click the Primary 
or Secondary Navigation Bar.

The Primary Button or Secondary Button dialog appears, depending on which 
navigation bar you are editing.

2. To select a different button image:
16-6 Using SiteStylesUsing SiteStylesUsing SiteStylesUsing SiteStyles



 

Editing SiteStyles

         
✦ Choose a regular button image by clicking the Regular Browse button, 
selecting an image file, and clicking Open.

✦ Choose a regular rollover button image by clicking the Regular Rollover 
Browse button, selecting an image file, and clicking Open. For best results, 
use an image that is the same size as the regular button image.

✦ Choose a highlighted button image by clicking the Highlighted Browse 
button, selecting an image file, and clicking Open.

✦ Choose a highlighted rollover button image by clicking the Highlighted 
Rollover Browse button, selecting an image file, and clicking Open. For best 
results, use an image that is the same size as the highlighted button image.

3. Choose text options by clicking the appropriate Text Settings button.

The Text Settings dialog appears, where you can set text options as described in 
“Adding Text to a Shape or Picture” on page 12-10.

4. When finished, click OK in the Text Settings dialog and then click OK in the 
Primary or Secondary Button dialog.

Editing a Data List Icon
Data list icons appear when you use the Data List tool to create a data list in 
Page view. See Chapter 25, “Data Publishing.”

1. In Style view, select the style you want to change and double-click a Data List 
icon.

The Picture File Open dialog appears.

2. Select an image file.

3. Click Open.

Editing Text Colors
You can set the colors for normal text, links, and visited links. These colors apply 
only to text created with the Text tool in Page view and to text navigation bars. They 
do not apply to text on buttons, banners, or other images. To edit the default font 
and font size, see “Setting General Preferences” on page 2-2. The normal text color 
is automatically applied to all text you add to text boxes in Page view. You can 
override the default color by formatting the text in Page view.
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The regular link color is applied to all text you link; the visited link color appears 
after your site visitor follows the link. You do not see this color in Page view. Link 
colors show site visitors where links are located, and browsers keep track of which 
links were followed. Choose different colors for ordinary text, links, and visited 
links so site visitors know at a glance which links they visited. If color consistency is 
more important than this detail, assign identical colors to regular and visited links. 

To edit a text color:

1. In Style view, select the style you want to change and double-click the text label 
you want to edit. Choose:

✦ Normal Text Color to change the default text color for the site. 

✦ Regular Link Color to change the color of links in the site. 

✦ Visited Link Color to change the color of visited links in the site.

2. In the Color Picker, select a color and click OK.

Editing a Style Background
1. In Style view, select the style you want to change and double-click the word 

Background. 

The Background Style dialog appears.

2. Select:

✦ None to use the default background color set in the browser’s preferences. 

✦ Color to use a solid-color background. White is the default. To choose a 
different color, click the Color button and select from the Color Picker. 

✦ Picture to use an image file as a background. Browsers tile the image across 
the page. Click Browse, select an image file, and click Open. 

3. Click OK.
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Editing the SiteStyle Line
You can use a variety of horizontal page-wide images to separate pages into sections. 
You insert these lines in Page view using the SiteStyle Line tool, as described in 
“Adding a SiteStyle Line” on page 15-4.

1. In Site view, select the style you want to change and double-click the SiteStyle 
Line.

The Picture File Open dialog appears. 

2. Select an image file.

3. Click Open.

Creating a SiteStyle
You can create original styles to give your site a unique look. When you create a new 
SiteStyle, each element is saved into its own subfolder in the style’s folder in the 
NetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\Styles folder. See “Styles Folder Structure” on page 16-12.

When you create your own SiteStyle, keep these points in mind:

✦ When you use an animated .gifgifgifgif for a style image, only the first frame of the 
animation displays on the image.

✦ Text labels for buttons and banners are placed on top of images. If you want the 
label to appear below the image, leave space above or below the image when you 
create it in your image editing application.

✦ If you plan to use your SiteStyle on a page with a background color or image, 
and you want the background to show through your image, use your image 
editing application to set transparency in your image.

To create a SiteStyle:

1. Create or collect images for your banner, buttons, lines, icons, and background. 

Use an image creation application to create the images. To be included in a 
published site they must be in .gifgifgifgif, .jpgjpgjpgjpg, or .png.png.png.png format. If you use an image in 
.bmpbmpbmpbmp, .pcxpcxpcxpcx, .pct, pct, pct, pct, or .fpx  .fpx  .fpx  .fpx format, NetObjects Fusion can convert a copy of the 
image to .gifgifgifgif or .jpg jpg jpg jpg for you.
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2. In Style view, click the New button on the control bar.

The New Style dialog appears.

3. Enter a name for your new SiteStyle and click OK.

NetObjects Fusion displays placeholders that indicate where you click to define 
the image for each element. It also displays default text colors.

NetObjects Fusion creates a new folder in the \Styles\Styles\Styles\Styles folder to contain the style 
elements. See “Styles Folder Structure” on page 16-12.

4. Define each style element by double-clicking it as described in “Editing 
SiteStyles” on page 16-4.

As you define each element, its image appears in Style view.

5. Click Set style to apply the new style to your site.

Your custom SiteStyle images and settings are applied to your site. 

Managing SiteStyles
You can add new styles to the list of available styles, such as those you obtain from 
your colleagues or those you create on your own. You can also remove styles and 
synchronize the list with the style folders currently in your \Styles\Styles\Styles\Styles folder. SiteStyles 
are stored in folders labeled with the style name. Because NetObjects Fusion stores a 
list of SiteStyles with each site file, you must add new styles you obtain to your site’s 
style list before you can use them.

If you create a new site from a template, your new site contains the same style list as 
the site from which the template was made. If you import a template into your 
current site, style names that were in the template’s style list are added to your site’s 
style list. Templates created in NetObjects Fusion 4.0 include the \Style\Style\Style\Style folder for the 
template’s style. Templates created in earlier versions of NetObjects Fusion do not 
include the style and you must manually copy the style to your \Styles\Styles\Styles\Styles folder to use 
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it. For more information on transferring SiteStyles, see Chapter 15, “If You Are 
Upgrading...” in Building Business Web Sites.

Adding a SiteStyle
You can add a style from any NetObjects Fusion style folder on your hard drive, 
CD-ROM, or LAN. The Add Style To List command on the Style menu makes a 
complete copy of the added style’s folder in your NetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\Styles folder. 
See “Styles Folder Structure” on page 16-12.

Note: When you add a style, it appears in the list of styles for the current site only. If you want 
that style to appear in the style list of every new site you create, see “Changing an 
Existing Template” on page 4-7.

To add a SiteStyle to the style list:

1. In Style view, from the Style menu, choose Add Style To List.

The Open dialog appears.

2. Navigate to the style folder of the style you want to import and select its .ssf.ssf.ssf.ssf file.

3. Click Open.

NetObjects Fusion adds the style name to the style list.

Adding All Available SiteStyles
To synchronize your style list with the styles in your \Styles\Styles\Styles\Styles folder:

➲ In Style view, from the Style menu, choose Update Styles List.

NetObjects Fusion updates the Style list of the active site to match the contents 
of the \Styles\Styles\Styles\Styles folder, adding and removing styles as necessary.

Removing SiteStyles
You can remove a style from the list of styles in the current site. You cannot remove 
the currently applied style. When you remove a SiteStyle, its name is removed from 
the current site only. Its style folder and the associated image files are not deleted, 
and it is not removed from any other sites. 

To remove a style from the list:
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1. In Style view, select the style you want to remove.

2. From the Style menu, choose Remove Style From List.

3. Click Yes to confirm.

The style disappears from the style list of the open site. It remains in the 
NetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\StylesNetObjects Fusion 4.0\Styles folder.

Styles Folder Structure
Each SiteStyle stores the images it uses in a special folder structure in the NetObjects NetObjects NetObjects NetObjects 
Fusion 4.0\StylesFusion 4.0\StylesFusion 4.0\StylesFusion 4.0\Styles folder.

NetObjects Fusion uses this folder structure to organize and label SiteStyle elements 
so you can easily locate parts of a style. When you assign an image to a SiteStyle 
element in Style view, NetObjects Fusion automatically copies the file to the 
appropriate folder within the \Styles\Styles\Styles\Styles folder. You can give a style element any name 
you want, but NetObjects Fusion style images generally have the name of the style 
and element, such as DaisyBanner.gifDaisyBanner.gifDaisyBanner.gifDaisyBanner.gif or DaisyLine.gifDaisyLine.gifDaisyLine.gifDaisyLine.gif.

When you select a new image for a style element, NetObjects Fusion copies it into 
the appropriate folder for the SiteStyle. If you’re editing an existing SiteStyle, the 
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new image replaces the file previously assigned to that element. NetObjects Fusion 
copies the new image to the folder, but doesn’t overwrite the old file unless the new 
and old files have identical names.

For example, suppose you want to modify the Corporate SiteStyle to change the 
highlighted button color. First, use an image editing application to open 
CorpPrimHi.gifCorpPrimHi.gifCorpPrimHi.gifCorpPrimHi.gif and change the button’s color. Give the new image file any name you 
like. Then in Style view, edit the Primary Navigation Bar highlighted button and 
choose the edited image. The image file you select is copied to the \Primary Buttons \Primary Buttons \Primary Buttons \Primary Buttons 
HighlightedHighlightedHighlightedHighlighted folder in the NetObjects Fusion 4.0\Styles\CorporateNetObjects Fusion 4.0\Styles\CorporateNetObjects Fusion 4.0\Styles\CorporateNetObjects Fusion 4.0\Styles\Corporate folder. If the new 
image file has the same name as the original file, the original is overwritten. Every 
site you create or open on your machine that uses the Corporate style uses this file 
for highlighted primary buttons.

This applies to all style elements that you can base on images: Background, Banner, 
Primary Navigation Bar, Secondary Navigation Bar, SiteStyle Line, and Data List 
Icon. This also occurs when you replace the image for a single instance of a button 
or banner. See “Customizing Banners and Buttons” on page 17-10.
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Creating Navigation Bars
and Banners 17
NetObjects Fusion includes tools you can use to create banners and navigation bars 
that help site visitors understand and navigate the structure of your site. A new 
blank site includes a navigation bar and banner in the MasterBorder. You can create 
your own banners and navigation bars and place them in any MasterBorder or 
Layout area. You save time using banners and navigation bars because NetObjects 
Fusion automatically places page names on the banner and navigation bar buttons 
and automatically links the buttons to pages in your site.

New banners and navigation bars you create use elements of the currently selected 
SiteStyle. However, you can customize the banners and buttons by assigning other 
styles or labels or by replacing their images with your own. 

This chapter tells you how to use navigation bars and banners, including:

✦ Creating navigation bars

✦ Setting navigation bar options

✦ Creating banners

✦ Customizing banners and navigation bars
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Working with Banners and Navigation Bars
Typically, in each new site you create, NetObjects Fusion automatically places a 
banner in the top margin, a button navigation bar in the left margin, and a text 
navigation bar in the bottom margin. You can place banners and navigation bars 
anywhere on the page, including MasterBorders and Layouts, as well as inside text 
boxes, table cells, and Layout Regions.

Banner titles and button names are determined by the page names you set in Site 
view or by the settings in the Custom Names dialog. Buttons are linked according to 
your site’s structure. Whenever you change your SiteStructure in Site view or change 
the name of a page, NetObjects Fusion updates the buttons and banners.

When you preview or publish your site, NetObjects Fusion creates a .gif.gif.gif.gif file for each 
button and banner. It combines the assigned font style, size, and color with the 
image file for that SiteStyle element to ensure the font you choose appears despite 
differences in site visitors’ browsers.

Button navigation bar

Text navigation bar

Banner

Button 
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Using Navigation Bars
Navigation bars are rows or columns of buttons or text that are automatically linked 
to other pages in your site. NetObjects Fusion provides two types of navigation bars: 
button navigation bars and text navigation bars. Use the Navigation Bar tool to add 
navigation bars to MasterBorders or page Layouts.

By default, a button name is the same as the page name unless you specify a custom 
name, as described in “Using Custom Page Names and Extensions” on page 3-11. 
You can split button text into two lines by customizing the button name.

The style for buttons is determined by the SiteStyle you set in Style view. See 
Chapter 16, “Using SiteStyles.” The SiteStyle button picture is automatically applied 
to buttons throughout your site. You can change the button style for an individual 
navigation bar or even an individual button without changing the overall SiteStyle. 
See “Customizing Banners and Buttons” on page 17-10.

You can assign an action to any navigation bar using the Actions tab of the 
Navigation Bar Properties palette. For example, a navigation bar could fly in from 
the top when the site visitor opens the page. See Chapter 21, “Building Dynamic 
Pages.”

Adding Button Navigation Bars
You can add a horizontal or vertical button navigation bar to a page. 

1. In Page view, display the page on which you want to place the navigation bar.

Navigation Bar toolNavigation Bar toolNavigation Bar toolNavigation Bar tool

2. Select the Navigation Bar tool from the Standard toolbar. 

3. Drag a box in the MasterBorder or Layout area where you want to place the 
navigation bar.

Drag in a horizontal direction for a horizontal navigation bar or in a vertical 
direction for a vertical navigation bar.

A new button navigation bar appears with buttons linked to the pages indicated by 
the setting in the Display field of the Navigation Bar Properties palette. 

Buttons are 
linked to other 
pages in your 
site

Choose pictures for 
buttons in Style view
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Setting Navigation Bar Display Options
You set the display level to specify the relationship between the current page and the 
pages represented on the navigation bar.

If a navigation bar appears in a MasterBorder assigned to pages at several different 
levels of the site, a single display level might not make sense at all levels. To make 
sure site visitors have access to all levels of your site, you can create new 
MasterBorders containing navigation bars with different display level settings. 

To set the display options:

1. In Page view, select the navigation bar.

The General tab of the Navigation Bar Properties palette appears.

2. In the Display section, click the Options button.

Highlighted button

Button navigation bar
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The Nav Bar Display dialog appears.

3. In the Show section, set the navigation option for this bar. Use the illustrations 
to visualize the page relationships.

✦ First Level links to the children of your Home page.

✦ Parent Level links to all pages in the level above the current page in the 
SiteStructure.

✦ Current Level links to the current page and all other pages that share the same 
parent page.

✦ Child Level links to the children of the current page.

Go to Site view or open the Site Navigation window if you are unsure about the 
site level you want to link.

4. To include the Home page as a link in the button bar, select Include Home Page. 

5. To change the orientation of the bar, select Horizontal or Vertical. 

Setting Border Width and Button Spacing
You can set the thickness of a button navigation bar’s border, as well as the spacing 
between buttons. You can increase the spacing between buttons to let the 
background show through or to add visual breaks around buttons. The border and 
spacing are measured in pixels regardless of the measurement you set in Preferences. 
You cannot change the spacing or border for text navigation bars.
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To set button border and spacing:

1. In Page view, select the button navigation bar.

The General tab of the Properties palette appears.

2. In the Display section:

✦ To change the thickness of the navigation bar border, enter a number in the 
Border field or click the arrows.

✦ To change the spacing between buttons, enter a number in the Spacing field 
or click the arrows.

Setting Navigation Bar Button Style
New navigation bars use the currently applied SiteStyle, but you can set individual 
navigation bars to use any available SiteStyle.

To change the button style:

1. In Page view, select the navigation bar.

The General tab of the Properties palette appears.

2. In the Button style section, select Other, and choose a SiteStyle from the drop-
down list.

Setting Navigation Bar Button Type
You can display navigation bar text buttons or picture buttons. Text navigation bars 
provide navigation for visitors whose browsers cannot display picture buttons. 

Primary and secondary navigation bars offer different sets of button pictures. Other 
than the pictures displayed, primary and secondary navigation bars function the 
same way. Because secondary button pictures are typically different in size, shape, or 
color, you can use a secondary navigation bar to visually distinguish links to 
different parts of your site. For example, to help site visitors understand the 
SiteStructure, you can use the secondary navigation bar for the lower levels of your 
site. To see the difference between primary and secondary navigation bars, go to 
Style view.

You can also choose whether the button for the current page will be highlighted or 
not. Use button highlighting to show site visitors which page they are on. If you are 
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using AutoFrames, be aware that highlighting can affect the way the browser 
refreshes your page.

You can also enable rollover buttons on the navigation bar. If rollover is on, when 
site visitors move their pointers over the button, the SiteStyle rollover image 
appears.

To set the navigation bar button type:

1. In Page view, select the navigation bar.

The General tab of the Properties palette appears.

2. In the Button Type section:

✦ Select Primary, Secondary, or Text buttons.

✦ Turn Highlighted buttons on or off.

✦ Turn Rollover buttons on or off.

Text navigation bars use the SiteStyle’s linked text color and the Normal text style. 
See “Formatting Text” on page 12-3 and “Editing Text Colors” on page 16-7.

Setting Navigation Bar Background
You can set a background color for a text or button navigation bar. The background 
color appears around buttons in a navigation bar or behind text in a text navigation 
bar. A background color can visually unify a navigation bar if buttons are widely 
spaced; it can also help site visitors distinguish the navigation bar from the 
background of the page.

To set navigation bar background:

1. In Page view, select the navigation bar, then click the Background tab of the 
Properties palette.

2. Click the Color button and select a color from the Color Picker or select None to 
use no background color.

A highlighted 
button indicates 
the current page
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Using Banners
Banners are picture title bars that display the name of the page, helping site visitors 
understand where they are in your site. You use the Banner tool to add new banners. 

By default, the banner text is the page name, but you can specify a custom name or 
no name for the banner. You can also split banner text into two lines. See “Using 
Custom Page Names and Extensions” on page 3-11. The style of a banner is 
determined by the current SiteStyle.

You can assign an action to any banner using the Actions tab of the Banner 
Properties palette. For example, you can make a banner “grow” into existence when 
a site visitor goes to the page by assigning the On Page Loaded do Transition action 
with the transition type set to Iris. See Chapter 21, “Building Dynamic Pages.”

Adding a Banner
1. In Page view, go to the page on which you want to place the banner.

Banner toolBanner toolBanner toolBanner tool

2. Choose the Banner tool from the Standard toolbar. 

3. Drag a box in the MasterBorder or Layout area where you want to place the 
banner.

Drag in a horizontal direction for a horizontal banner or in a vertical direction 
for a vertical banner.

Set the 
Banner style 
in Style view

Set the Page name in 
Site view or in the 
Custom Name dialog
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A new horizontal or vertical banner appears in the current SiteStyle and 
contains the page name or the text specified in the Custom Name dialog.

4. To change the banner orientation, select Horizontal or Vertical on the Banner 
Properties palette.

Setting Banner Style and Orientation
New banners use the current SiteStyle, but you can set a banner to any available 
style. If you change the style of a banner in a MasterBorder, it changes on every page 
using that MasterBorder.

1. In Page view, select the banner.

The General tab of the Banner Properties palette appears.

2. In the Style section, select Other, and choose a different style from the drop-
down list.

3. In the Display section, select Vertical or Horizontal orientation.
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Customizing Banners and Buttons
You can use a navigation bar’s automatic page linking, but design the button—
including special text effects not available in NetObjects Fusion—in an image 
editing application. Or, you could replace a banner on just one page, without 
affecting the other pages that use the same MasterBorder. The advantage to using 
customization is that NetObjects Fusion manages the page links for you. 

Changing the Image for One Banner
You can change the picture for a selected banner in Page view. When you assign a 
new picture to a banner, NetObjects Fusion does not display the page or custom 
banner name on the image. If you want text to appear on the banner, you must 
include the text in your banner graphic. If you change the image for a banner in a 
MasterBorder, the change does not affect the banner on all the other pages that use 
that MasterBorder. You do not change the SiteStyle when you customize a banner 
picture.

To change the picture for one banner:

1. In Page view, display the page containing the banner you want to change.

2. Select the banner.

The General tab of the Banner Properties palette appears.

3. Double-click the banner, or click Custom Image on the Properties palette.

The Picture File Open dialog appears.

4. Select an image file from your hard disk or LAN. If you want to use an image 
that is on a CD-ROM, copy it to your hard disk first.

The selected banner displays the new picture. If you change the SiteStyle, the banner 
no longer displays the custom picture. To restore the banner to its original image, 
select Remove Customization on the Banner Properties palette.

Changing the Image for One Button
You can change the picture on each individual button in a navigation bar in Page 
view. When you assign a new picture to a button, NetObjects Fusion does not 
display the page name or custom name on the button. If you want text to appear on 
the button, you must include the text in your button picture. You do not change the 
current SiteStyle when you customize a button picture.
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Changing a button picture affects every instance of the button for that page, even if 
the button is on different MasterBorders and on different pages. For example, if you 
change the picture for a regular button named “Download” in a primary navigation 
bar, every instance of the regular Download button in all primary navigation bars in 
your site will change. However, the highlighted and rollover buttons for Download 
do not change, nor do the Download buttons in secondary navigation bars. The 
Download page itself, which contains the highlighted button picture for the 
Download button, remains unchanged. To change the regular, highlighted, and 
rollover buttons you must customize the button for each page.

To change the picture for one button:

1. In Page view, navigate to the page containing the navigation button you want to 
change.

2. Double-click the button to select it.

A wide border surrounds the button to show it is selected.

The General tab of the Navigation Button Properties palette appears.

3. Double-click the selected button, or click Custom Image on the Properties 
palette.

The Picture File Open dialog appears.

4. Select an image file from your hard disk or LAN. If you want to use an image 
that is on a CD-ROM, copy it to your hard disk first.

The selected button displays the new picture. If you change the style assigned to the 
site, the button no longer displays the custom picture. To restore the original image, 
click Remove Customization on the Navigation Button Properties palette.
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Creating Links and Anchors 18
NetObjects Fusion makes it easy to create navigation aids using links. You can make 
any text, image, shape, or area of an image into a navigation aid by adding a link. 
Link page objects to any point on the Web, including points within your site. You 
can also create and link to anchors—markers at a specific location on a page—to aid 
navigation in long pages.

This chapter tells you how to create and use:

✦ Internal links

✦ Anchors

✦ Smart links

✦ External links

✦ Email links

✦ Relative links

✦ File links

✦ Links with added HTML

✦ Imagemaps
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Creating Links
You can use the linking techniques described in this chapter to manually link 
objects, such as text, pictures, and drawn shapes, to locations within a site and 
outside it. As you organize a site, you’re likely to create multiple links to the same 
location. You can easily update these links using the lists in Assets view. 

The Properties palette for all linkable objects has a Link button in the lower left 
corner. You click this button to open the Link dialog, where you specify the 
destination of a link. There are four types of links, each with its own tab in the Link 
dialog:

✦ Internal link, which links to a page or anchor within the site.

✦ Smart link, which links to a relative position in the site, such as previous page or 
next page. Smart links are sometimes called structural links. The Blank link, 
which you can use to trigger an action without going to a new page, is also a 
smart link.

✦ External link, which links to a page in another site via a URL, using a protocol 
such as ftp, mailto, http, or JavaScript.

✦ File link, which links to a file that is published with the rest of the site. 

Creating an Internal Link
Internal links link to pages or anchors within a site. If you move a linked page in the 
SiteStructure or change the page’s name, NetObjects Fusion automatically updates 
all associated links. Assets view lists the internal links in your site.

Using an anchor, you can link to a specific page or to a specific location on the 
current page. See “Adding, Editing, and Deleting an Anchor” on page 18-4. 

To create an internal link:

1. In Page view, select some text or select an object to link.

2. On the Properties palette for that object, click Link.
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The Link dialog appears.

The Select Frame Target field appears if the current page contains an 
AutoFrame. The Actions button appears if you are linking text.

✦ If you are linking to a page, select Page Name and choose a page name.

✦ If you are linking to an anchor and always want to link to a specific page, 
select Page Name and the name of a page. 

✦ If you are linking to an anchor and always want to link to an anchor on the 
browser’s current page, select Current Page.

3. If you are linking to an anchor, choose the name of the anchor from the Select 
Anchor drop-down list.

4. If the current page contains an AutoFrame, select the name of a frame from the 
Select Frame Target drop-down list.

Note: You may not need to select a target. NetObjects Fusion automatically targets 
most internal links.

The destination page for the link appears only in the frame you select.

5. Click Link.

Name of page to link to 

List of all pages in the site

Click to link to anchors on current page

See “Adding, Editing, and Deleting an 
Anchor” on page 18-4

See “Targeting Links in AutoFrames” on 
page 11-7

See “Adding an Action to Text” on 
page 21-8

See “Adding HTML to a Link” on 
page 18-12
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NetObjects Fusion creates the link. When your site visitor clicks the linked item, the 
browser displays the destination page or the selected anchor.

Adding, Editing, and Deleting an Anchor
An anchor marks a specific location on a page. Anchors let site visitors go directly to 
a particular part of a long page instead of scrolling and searching for information. 
You can place an anchor anywhere in a text box or table, or on a picture or drawn 
shape. You link to an anchor from the Link dialog. When a site visitor clicks the link, 
the browser displays the page containing the anchor, beginning at the location of the 
anchor.

When an anchor link is in a MasterBorder or AutoFrame, use the Current Page 
option in the Link dialog to ensure that the link always points to an anchor on the 
current page. If you want an anchor link to always lead to a specific page, select the 
page name instead of the Current Page option when you link to the anchor.

For example, suppose your Layout contains a very long text box. You place anchors 
at the top and bottom of the text box, and in the MasterBorder, you link the words 
To Top to the top anchor and the words To Bottom to the bottom anchor. In the 
Link dialog, instead of choosing the current page name in the Page Name section, 
you choose the Current Page option. If you copy that text box to another page with 
the same MasterBorder and replace its content, the To Top and To Bottom links still 
work, jumping to locations on the current page instead of the page where you made 
the links.

To add an anchor:

1. In Page view, select an image or drawn shape or double-click to place the 
insertion point within a line of text.

Make sure you place the insertion point within the text without selecting any 
text. If you select text, the Anchor button is not accessible.

2. On the Properties palette for the selected object, click the Anchor button.
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The Add Anchor dialog appears listing anchors already on the page. 

3. Type a name for the anchor in the Name field. The name cannot contain spaces. 

4. Click OK.

Anchor iconAnchor iconAnchor iconAnchor icon

If Object Icons is checked on the View menu, the Anchor icon appears at the anchor 
location on the page.

To edit the anchor, select the anchored text or object, click the Anchor button on the 
Properties palette, and change its name in the Change Anchor dialog. To delete the 
anchor, click the Anchor icon and click Remove in the Change Anchor dialog. If you 
are working with a text object, you can double-click the anchor icon to display the 
Change Anchor dialog.

Creating a Smart Link
Smart links lead to a page in your site based on its relative position in the 
SiteStructure, rather than its name. These links automatically adjust when you 
change the SiteStructure. For example, if your smart link leads to the parent of the 
current page, and you move the current page to a different parent, NetObjects 
Fusion updates the link to point to the new parent. Sometimes a smart link is called 
a structural link.

To create a smart link:

1. In Page view, select some text or select an object to link.

2. On the Properties palette for that object, click Link.

The Link dialog appears.
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3. Select the Smart Link tab.

The Select Frame Target drop-down list appears if the current page contains an 
AutoFrame. The Actions button appears if you are linking text.

4. Select the type of link you want. The links listed depend on the type of page you 
are on—normal or stacked, and on what pages are available to link to from the 
page you are on.

✦ Home links to your Home page.

✦ Up links to the parent of the current page.

✦ Next Stacked Page links to the next page in a set of stacked pages.

✦ Previous Stacked Page links to the previous page in a set of stacked pages.

✦ Next Page links to the sibling to the right of this page in your SiteStructure.

✦ Previous Page links to the sibling to the left of the current page in your 
SiteStructure.

✦ First Child Page links to the first child page of the current page.

✦ Blank creates an empty link on the page. You can use the Blank link to assign 
an action. 

5. Click Link.

For information about stacked pages, see Chapter 25, “Data Publishing.”

See “Targeting Links in AutoFrames” on 
page 11-7

See “Adding an Action to Text” on 
page 21-8

See “Adding HTML to a Link” on 
page 18-12
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Creating an External Link
External links are Universal Resource Locators (URLs) that point to other pages and 
items in other sites. A valid URL can include the protocol, host name or DNS, path 
name, and sometimes a file name, such as http://www.netobjects.com/products/http://www.netobjects.com/products/http://www.netobjects.com/products/http://www.netobjects.com/products/
fusion.htmlfusion.htmlfusion.htmlfusion.html. Each external link becomes an asset of the site that you can update in 
Assets view.

To create an external link:

1. In Page view, select some text or select an object to link.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the External Link tab.

The Select Frame Target drop-down list appears if the current page contains an 
AutoFrame. The Actions button appears if you are linking text.

4. Select a protocol from the URL drop-down list.

If you’re creating a link that does not require a protocol, select (none). If you 
want to use a protocol that is not in the drop-down list, type it in the protocol 
field.

URL drop-down list with protocol 
selected

URL field

List of previously entered links

See “Targeting Links in AutoFrames” on 
page 11-7

See “Adding an Action to Text” on 
page 21-8

See “Adding HTML to a Link” on 
page 18-12

Name of link in Assets view
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5. Enter the appropriate information in the URL field or select an existing link 
from the list. For example, you could enter a URL, a mailto address, or a Java 
command depending on the selected protocol. For details about email links, see 
“Adding an Email Link.”

6. If you’re creating a new external link, enter a name for this link in the Asset 
Name field. 

This name is for your reference. It appears in the list of links in Assets view so 
you can quickly identify and sort link destinations. It is not added to the HTML 
generated when your site is published. 

7. Click Link.

Adding an Email LinkAdding an Email LinkAdding an Email LinkAdding an Email Link

To add a mailto link:

1. In Page view, select some text or select an object to link.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the External Link tab.

4. Select mailto from the URL drop-down list.

5. In the URL field, type the email address using the format username@domain.com.

6. Preview the page.

When you click the link, the browser’s email client displays a mail window with 
the address you typed entered in the recipient field.

Adding a Relative LinkAdding a Relative LinkAdding a Relative LinkAdding a Relative Link

Relative links are important if you must link to files that are published separately 
from NetObjects Fusion. Relative links protect the links on your pages if your ISP 
moves or changes the server location. To create a relative link, you must know where 
the destination file is relative to the file containing the link.

For example, suppose you publish a site using the By Site Section publishing option. 
Your company PR department wants to place HTML documents on the server, but 
publish them separately from the main Web site. The PR department has its own 
ArticlesArticlesArticlesArticles directory on the server at the root of the site. There is also a NewsNewsNewsNews directory 
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and the index page for the site at the root of the site. The structure looks something 
like this:

index.htmlindex.htmlindex.htmlindex.html
/News/News/News/News

news.htmlnews.htmlnews.htmlnews.html
/Articles/Articles/Articles/Articles

PressRelease1.htmlPressRelease1.htmlPressRelease1.htmlPressRelease1.html
PressRelease2.htmlPressRelease2.htmlPressRelease2.htmlPressRelease2.html

The main NewsNewsNewsNews page is published in the NewsNewsNewsNews directory. You must create a relative 
link to link the news.htmlnews.htmlnews.htmlnews.html page to the articles in the ArticlesArticlesArticlesArticles directory.

To create a relative link:

1. In Page view, select some text or select an object to link.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the External Link tab.

4. Select (none) from the URL drop-down list.

5. In the URL field, type the relative path from the news page to the press release 
page. For example:

../Articles/PressRelease1.html../Articles/PressRelease1.html../Articles/PressRelease1.html../Articles/PressRelease1.html

You cannot test this link by previewing, because it requires the exact 
configuration of files that only exists on the server. However, after you publish 
the site and the PR department uploads articles into the ArticlesArticlesArticlesArticles directory, the 
link will work correctly.

When typing the path, if you do not include periods or slashes in front of the file 
name, NetObjects Fusion attempts to find the file in the same directory as the 
page containing the link. This is also true for the format ./filename.html./filename.html./filename.html./filename.html. To back 
up one directory before looking for the path, use ../path/filename.html../path/filename.html../path/filename.html../path/filename.html. For each 
directory you need to back up to find the destination file, include another ../../../../. For 
example, suppose you create a Press ReleasesPress ReleasesPress ReleasesPress Releases page in a directory called PRPRPRPR within 
the NewsNewsNewsNews directory:

index.htmlindex.htmlindex.htmlindex.html
/News/News/News/News

news.htmlnews.htmlnews.htmlnews.html
/PR/PR/PR/PR
Creating Links and AnchorsCreating Links and AnchorsCreating Links and AnchorsCreating Links and Anchors 18-9



   

Creating Links

            
PRlinks.htmlPRlinks.htmlPRlinks.htmlPRlinks.html
/Articles/Articles/Articles/Articles

PressRelease1.htmlPressRelease1.htmlPressRelease1.htmlPressRelease1.html
PressRelease2.htmlPressRelease2.htmlPressRelease2.htmlPressRelease2.html

A link from PRlinks.htmlPRlinks.htmlPRlinks.htmlPRlinks.html to PressRelease1.htmlPressRelease1.htmlPressRelease1.htmlPressRelease1.html looks like this:

../../Articles/PressRelease1.html../../Articles/PressRelease1.html../../Articles/PressRelease1.html../../Articles/PressRelease1.html

Remember that most servers are case sensitive; your link must exactly match the 
directory names and file names of where you want to go.

6. Click Link.

Creating a File Link
You use file links to link to a file. For example, you might create a file link so site 
visitors can download the file. When you create a file link, the file it refers to 
becomes an asset of the site and is uploaded to the server when the site is published. 

To create a file link:

1. In Page view, select some text or select an object to link.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the File Link tab.

Location of file

Alias for asset, which is 
the file name by default

See “Targeting Links in 
AutoFrames” on page 11-7

See “Adding HTML to a Link” 
on page 18-12

List of file links previously 
entered
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The Select Frame Target drop-down list appears if the current page contains an 
AutoFrame. The Actions button appears if you are linking text. The Path field is 
the path to the file and the Asset Name field is the name that appears in Assets 
view.

4. Click Browse and select a file in the Open dialog.

5. If necessary, enter or edit the Asset Name.

This name is for your reference. It appears in the list of links in Assets view so 
you can quickly identify and sort link destinations. It is not added to the HTML 
generated when your site is published. 

6. Click Link.

Following Links

Link iconLink iconLink iconLink icon

If Object Icons is checked on the View menu, NetObjects Fusion displays the Link 
icon wherever you create a link on an image. Text links are underlined and appear in 
the default font and color for links.

In Page view, you can follow an existing link to its target page or anchor:

✦ Right-click a linked object and select Follow Link from the shortcut menu, or 
select the object and from the Go menu, choose Follow Link. 

✦ To follow a text link, select the text marked as linked, then right-click the linked 
text and select Follow Link from the shortcut menu.

Editing or Removing a Link
To edit a link, select the linked text or object, click the Link button on the Properties 
palette, then change the link in the Link dialog. If you want to change the type of 
link, you must remove the link and then insert a new link. If an external link is used 
in multiple places in your site, you can edit the link in Assets view.

To remove a link, select it, click Link on the Properties palette, and click Unlink in 
the Link dialog. You cannot remove a link in Assets view; unlink every instance of 
the link and it is removed automatically.

You can use NetObjects Fusion’s HTML button to insert your own HTML and 
JavaScript before, inside, and after links. See “Adding HTML to a Link.” You can 
also use a link to trigger an action using the Blank link. See “Adding an Action to 
Text” on page 21-8.
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Adding HTML to a Link
You can add your own HTML or JavaScript to a link to extend its capabilities. For 
example, you might want to add HTML that directs the browser to open the link in 
a new window, or JavaScript that displays a dialog. The steps below demonstrate 
how to add HTML that directs the browser to open the link in a new window. For 
more information, see “Accessing an Object’s HTML” on page 26-8.

1. In Page view, select some text or an object to link.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select a link on one of the link tabs.

4. Click the HTML button in the Link dialog. For some components, the HTML 
button may not be available. This means the component does not allow 
additional HTML.

The Link HTML dialog appears.

5. Click the Inside Link tab to indicate where you want to enter HTML or 
JavaScript. 

6. Type target=NewWindowtarget=NewWindowtarget=NewWindowtarget=NewWindow.

As you type, the top part of the dialog displays your code in blue type as it will 
appear in the HTML NetObjects Fusion generates.
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7. Click OK in the Link HTML dialog.

8. Click Link in the Link dialog. 

When you preview or publish the site, the link opens a new browser window. 

Working with Imagemaps
An imagemap can contain several links in a single picture. You create an imagemap 
by drawing hotspots on a picture. You can link as many hotspots as you like in a 
single image, but the hotspots cannot overlap or extend beyond the edge of the 
picture. Because the imagemaps you create with the following procedure do not 
require a CGI script running on the server, they are called client-side imagemaps. 
Server-side imagemaps require setup on a Web server to run properly.

Creating an Imagemap

Hotspot toolHotspot toolHotspot toolHotspot tool

1. In Page view, click the Hotspot tool on the Standard toolbar, and select the 
appropriate tool from the flyout to create a rectangular, circular, or polygon 
hotspot.

2. Draw a hotspot on an image.

If you are using the Polygon Hotspot tool, you must click to establish each vertex 
of the polygon, then double-click to complete the hotspot shape.

The Link dialog appears.

3. In the Link dialog, select the type of link by clicking a tab.

4. Select a target for the link or type an URL and click the Link button.

Once a picture has hotspots, you can move it anywhere on the page and even copy 
and paste it elsewhere in the site without affecting the imagemap.

Editing an Imagemap
To edit an existing hotspot, click the hotspot. The General tab of the Hotspot 
Properties palette appears.

✦ To edit the link, click Link. The Link dialog appears, displaying the tab for the 
type of link. Change the link destination or click Unlink to remove the link.

✦ To add HTML to a hotspot, click HTML. See “Accessing an Object’s HTML” on 
page 26-8.
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✦ To assign an action to a hotspot, click its Actions tab on the Properties palette 
and follow the procedure described in “Adding Actions to Objects and Pages” on 
page 21-3.

✦ To resize a hotspot, select it and drag its handles.

✦ To create an alt tag for the hotspot, type in the AltTag field. The alt tag appears 
when the browser does not display the image.
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Placing Media 19
Media such as sound and video give a site impact. The tools in NetObjects Fusion 
make it easy to add various media files to your pages. Sample media files are 
available in the NetObjects Fusion 4.0\Samples\ContentNetObjects Fusion 4.0\Samples\ContentNetObjects Fusion 4.0\Samples\ContentNetObjects Fusion 4.0\Samples\Content folder. The \Extras\Extras\Extras\Extras folder on 
the NetObjects Fusion CD contains additional media sample files that you can use.

This chapter tells how to add:

✦ Shockwave files

✦ QuickTime movies

✦ Video

✦ Sound files

✦ Plugins
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Inserting a Shockwave File
With Shockwave from Macromedia, you can create multimedia, graphics, and 
audio that downloads quickly. NetObjects Fusion supports these Shockwave file 
formats: 

✦ Shockwave for Director 4.0 and 5.0 (.dcr.dcr.dcr.dcr)

✦ Director (.dir.dir.dir.dir)

✦ Protected Director (.dxr.dxr.dxr.dxr)

✦ Flash (.swf.swf.swf.swf) and Splash (.spl.spl.spl.spl) 

To view these files, site visitors must install the Shockwave plugin appropriate for 
their browser and platform. These plugins are available from the Macromedia Web 
site at www.macromedia.comwww.macromedia.comwww.macromedia.comwww.macromedia.com.

You cannot directly add a Shockwave audio (.swa.swa.swa.swa) file to a page. You must embed it 
in a Director movie by passing it as a parameter to the movie, and place the movie 
on your page. Then in Assets view, add the Shockwave audio file as a file asset. Any 
Shockwave files you place on a page appear inline on the page itself. 

To insert a Shockwave file:

Shockwave toolShockwave toolShockwave toolShockwave tool

1. In Page view, select the Shockwave tool from the Media flyout on the Advanced 
toolbar.

2. Draw a box to indicate the Shockwave file’s location.

The Open dialog appears. 

3. Select a Shockwave file from your hard disk or LAN, or select a Shockwave file 
already in use in the site from the Applets/Plug-in Assets tab. 

For information about using assets, see Chapter 27, “Managing Assets.”

4. Click Open.

The Macromedia Shockwave placeholder appears on your page, and the 
Shockwave Director Properties palette appears. 

NetObjects Fusion sizes the Shockwave placeholder to fit the stage, which is the 
space where the animation appears. If automatic sizing does not occur, you 
might not have the right browser plugin or ActiveX control installed. Before 
NetObjects Fusion can automatically set height and width parameters for 
Macromedia Director movies, you must install the Macromedia Director 
ActiveX control (version 6.0.1 or later) or the Macromedia Director Netscape 
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plugin (version 6.0.1 or later). To obtain the ActiveX control, create a site with 
NetObjects Fusion that contains a Director movie, then preview the site with 
Microsoft Internet Explorer. The ActiveX control is automatically downloaded 
and installed. If you don’t have Internet Explorer, you can download the current 
Macromedia Director plugin at www.macromedia.com/shockwave/downloadwww.macromedia.com/shockwave/downloadwww.macromedia.com/shockwave/downloadwww.macromedia.com/shockwave/download.

The Properties title changes depending on which type of file you selected. The 
name of the selected file appears in the File field on the General tab. 

5. To provide text for the browser to display if it cannot play the Shockwave file, 
enter a description in the AltTag field. See “Adding and Modifying Alt Tags” on 
page 6-10.

6. Click the HTML button to insert HTML tags and scripts. See Chapter 26, 
“Working with HTML Directly.”

7. Select the Controls tab.

The options on the Controls tab vary depending on the type of Macromedia file 
you selected, as described in “Setting Properties for Shockwave Director” and 
“Setting Properties for Shockwave Flash or Splash.”
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Setting Properties for Shockwave DirectorSetting Properties for Shockwave DirectorSetting Properties for Shockwave DirectorSetting Properties for Shockwave Director

➲ In Page view, after adding a Shockwave Director file, on the Controls tab of the 
Properties palette, click the option you want, enter the parameter, and click the 
check mark.

If you have worked with Director files, you should be familiar with these 
options. For information, see your Shockwave or Director user guide. 

Setting Properties for Shockwave Flash or SplashSetting Properties for Shockwave Flash or SplashSetting Properties for Shockwave Flash or SplashSetting Properties for Shockwave Flash or Splash

1. In Page view, after adding a Shockwave Flash file, click the Controls tab on the 
Properties palette.

The options for the Flash or Splash file appear.

2. To control the display when using anti-aliasing, select a Quality option.
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✦ AutoLow sets the default to normal quality. The host computer uses high 
quality if it has the capacity.

✦ AutoHigh starts the movie in high quality. The host computer uses low 
quality if it cannot display the movie in high quality.

✦ High anti-aliases the movie on any computer.

✦ Low uses a normal quality so the movie displays quickly. 

3. To determine how the movie fits in the frame, select the Scale option. 

✦ ShowAll displays the movie within the frame but maintains the image 
proportions.

✦ NoBorder displays the movie so it fills the frame but maintains the ratio of the 
animation. Some edges of the animation might be trimmed.

✦ ExactFit displays the movie exactly within the frame. 

4. To specify the movie’s alignment within the frame, select an Alignment option, 
such as Left, Right, or Top. 

5. To play the movie automatically when the site visitor opens the page, select Auto 
Start.

6. To replay the movie when it ends, select Loop. 

Inserting a QuickTime Movie
QuickTime, developed by Apple Computer, is a multimedia software architecture 
used to create and deliver graphics, sound, video, text, music, and 3D media. You 
can use the QuickTime tool to place QuickTime movies. 

To display QuickTime movies, site visitors must install the QuickTime plugin 
appropriate to their browser and platform. For more information on QuickTime, 
visit Apple Computer’s site at www.quicktime.apple.comwww.quicktime.apple.comwww.quicktime.apple.comwww.quicktime.apple.com. 

To insert a QuickTime movie:

QuickTime toolQuickTime toolQuickTime toolQuickTime tool

1. In Page view, select the QuickTime tool from the Media flyout on the Advanced 
toolbar.

2. Draw a box to indicate the location of the QuickTime movie.

The Open dialog appears.
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3. Select a QuickTime file from your hard disk or LAN, or select a QuickTime file 
that was already used in the site on the Video Assets tab. 

For information, see Chapter 27, “Managing Assets.”

QuickTime media has a .mov.mov.mov.mov or .qt .qt .qt .qt extension. 

4. Click Open.

The QuickTime placeholder appears on the page, and the QuickTime Properties 
palette appears. You might have to resize the QuickTime placeholder. 

The name of the file you selected appears in the File field on the General tab. To 
select a different movie file, click the Browse button. 

5. To provide text for the browser to display when it cannot play a movie, enter a 
description in the AltTag field.

6. In the Display section, select:

✦ Play inline to play the movie in your site.

✦ Launch from picture to use a picture other than the QuickTime icon to 
represent the movie.

7. Click the HTML button to insert HTML tags and scripts. See Chapter 26, 
“Working with HTML Directly.” 
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8. On the Controls tab, set the sound volume for the movie. You can enter a 
number from 0 to 256. 

9. In the Display options section, select:

✦ Hide All if you don’t want to show the movie but want to use it only as 
background sound. 

✦ Controller to display a control bar that site visitors can use to start or stop the 
movie. This option is not available when Hide all is selected and it does not 
work if you choose Launch from picture on the General tab.

✦ Auto start to automatically start playing the movie when the page loads.

✦ Loop to replay the movie when it comes to the end. To replay the movie from 
the end to the beginning, select Back and forth. 

10. To store the movie in the cache on the site visitor’s system, select Keep movie in 
user’s cache. If the visitor leaves the page and comes back, the movie doesn’t 
have to be downloaded again because it is already in the system cache. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Inserting a Video File
You can add video, such as an animation or a movie, to a site. To view these files, site 
visitors must install the appropriate plugin for their browser and platform. 

The latest browsers often have video players built in. For example, Netscape 
Navigator includes Live Video. To ensure that site visitors can view your video, 
provide a link to a site from which they can download the appropriate plugin.

NetObjects Fusion supports these popular video file formats:

✦ Moving Pictures Experts Group (.mpg(.mpg(.mpg(.mpg, .mpeg.mpeg.mpeg.mpeg, .mpe .mpe .mpe .mpe, .mpv.mpv.mpv.mpv), supported by 
Windows and the Macintosh with browser plugins

✦ Microsoft Audio Video Interleaved (.avi.avi.avi.avi), supported by Windows 

✦ Vivo Active Producer (.viv)(.viv)(.viv)(.viv), supported by Windows and the Macintosh with 
browser plugins

✦ QuickTime (.mov.mov.mov.mov, .qt.qt.qt.qt)

✦ Real Media (.rm.rm.rm.rm)

✦ Real Player Media (.rpm.rpm.rpm.rpm)

To insert a video file:

Video toolVideo toolVideo toolVideo tool

1. In Page view, select the Video tool from the Media flyout on the Advanced 
toolbar.

2. Click where you want to position the video placeholder. 

The Open dialog appears. 

3. Select a video file from your hard disk or LAN or select a video file already used 
in the site from the Video Assets tab. 

For information about using assets, see Chapter 27, “Managing Assets.”

4. Click Open.
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The video icon appears on the page, and the Video Properties palette appears. 
The selected file name appears in the File field on the General tab. 

5. To provide text that the browser displays if it cannot display the video, enter the 
text in the AltTag field.

6. In the Display section, select:

✦ Inline to display the first frame of the video in the browser window. The first 
frame of the video serves as a placeholder for the movie. Site visitors can 
start the movie by clicking the image.

✦ Icon to select a different image to represent the video. The video plays in a 
viewer or on a new blank page.

✦ Picture to use another image file to represent the video. Click Browse and 
choose an image file. The video plays in a viewer or on a new blank page.

7. Click the HTML button to insert HTML tags and scripts. See Chapter 26, 
“Working with HTML Directly.”

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Inserting a Sound File
Sounds are either digital or synthesized audio files that a browser with a built-in 
player or helper application can play. For example, Live Audio technology is built 
into Netscape Navigator. Visitors can also download helper applications from sound 
technology developers and install them in their browsers. To play sounds, a system 
must have a sound card and speakers. 

NetObjects Fusion supports the following popular audio file formats:

✦ Windows Wave (.wav.wav.wav.wav) format sound files that play on Windows and Macintosh. 
For Macintosh, site visitors must have Netscape 3.x or later. 

✦ Audio Interchange File Format (.aiff(.aiff(.aiff(.aiff) with browser plugins can play on Windows 
95 and Macintosh.

✦ Musical Instrument Digital Interface    (.midi, .mid.midi, .mid.midi, .mid.midi, .mid)    can play on almost all types of 
operating systems.

✦ .au,.au,.au,.au, a common sound format found on the Web, is used in Java applets and can 
play on Sun Microsystems and NeXT systems.

✦ RealAudio (.ra.ra.ra.ra, .ram.ram.ram.ram) can play streaming audio on all systems, requires 
RealAudio Web server-resident software, and sometimes includes video. Site 
visitors must install the RealAudio player browser plugin. 

✦ Rich Music Format (.rmf.rmf.rmf.rmf) is a sound file format that enhances the use of music 
and sound in interactive environments, such as the Web. 

You can also add any of these formats as a background sound that plays when a 
visitor views your page. See “Setting Layout and Layout Region Background 
Properties” on page 8-7.

Because an audio file has no visual object, NetObjects Fusion represents the audio 
file with a graphic, usually an icon or an inline player control bar the browser 
recognizes. When a site visitor clicks the icon or the play button on the inline player 
control bar, the browser plays the sound file or opens a helper application to play it.

To insert a sound file:

Sound toolSound toolSound toolSound tool

1. In Page view, select the Sound tool from the Media flyout on the Advanced 
toolbar.

2. Click on the page to indicate the location of the sound file.
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The Open dialog appears.

3. Select a sound file from your hard disk or LAN, or select a sound file already 
used in the site from the Audio Assets tab. 

For information about using assets, see Chapter 27, “Managing Assets.”

4. Click Open.

The default sound icon appears on the page, and the Sound Properties palette 
appears. The name of the file you selected appears in the File field on the 
General tab. You can use the Browse button to select a different sound file. 

5. To provide text that the browser displays if it cannot play the sound, type a 
description in the AltTag field.

6. In the Display section, select:

✦ Inline to use the audio player for your browser. If site visitors have Headspace 
Beatnik installed on their system, the browser uses that player to play the 
sound.

✦ Icon to change the sound icon. Click one of the three images. The selected 
image represents a link to the sound on the page. 

✦ Picture to use another image file as an icon linking to the sound. Click 
Browse and select an image file. 

7. Click the HTML button to insert HTML tags and scripts. See Chapter 26, 
“Working with HTML Directly.” 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Inserting Other Types of Files
Although NetObjects Fusion supports a wide variety of media files, you might have 
other formats, such as Adobe Acrobat PDF files, that you want to include in your 
site. You can place other files, including Adobe Acrobat, VRML, RealSpace FlashPix 
files, and Headspace Beatnik files, using the Plug-in tool.

When a site visitor clicks the document’s icon, the file appears in the visitor’s 
browser or downloads to the visitor’s system. When you insert a file using the Plug-
in tool, site visitors need the appropriate plugin for their browser and platform to 
use the file. 

To insert a file using the Plug-in tool:

Plug-in toolPlug-in toolPlug-in toolPlug-in tool

1. In Page view, select the Plug-in tool from the Media flyout on the Advanced 
toolbar.

2. Draw a box to indicate where you want to position the file.

The Open dialog appears. 

3. Select a file from your hard disk or LAN, or select a file that was already used in 
the site from the Applets/Plug-in Assets tab. 

To display the various file types that NetObjects Fusion supports, use the Files of 
type drop-down list. 

To insert a file that is not explicitly supported by NetObjects Fusion, choose All 
Files in the Files of type drop-down list, then select the file. 

4. Click Open.
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The plug-in placeholder image appears on your page, and the Plug-In Properties 
palette appears. The name of the file you selected appears in the File field on the 
General tab.

5. To provide text for the browser to display if it cannot display the file, enter a 
description in the AltTag field.

6. In the Display section, select:

✦ Play inline to display the file on the page in your site.

✦ Launch from picture to use a picture other than the plug-in icon to represent 
the plugin.

7. Click the HTML button to insert HTML tags and scripts. See Chapter 26, 
“Working with HTML Directly.” 

8. Select the Advanced tab.

The Advanced options appear.

Use the Parameters section to add custom 
settings to the plugin. You cannot change 
the plugin’s standard parameters, such as 
height and width
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9. Set the parameters. Because you can add different parameters for different files, 
see the associated user guide. 

✦ To edit parameters that appear in the Parameters section, double-click the 
parameter. Enter the value in the Add Plug-In Parameter dialog.

✦ To add a parameter, click the plus (+) button and enter the parameter name 
and value in the Add Plug-In Parameter dialog.

✦ To remove a parameter, select it and click the minus (–) button.

✦ To change the order of the parameters, click the Up or Down arrow buttons. 
The selected parameter moves up or down in the parameters list.

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Replacing a Media File
Sites are constantly changing and evolving. As you build your site or after using it 
for some time, you might want to change a media file that you used in a specific 
location. You can replace one file with another.

To replace a media file with a new file:

1. In Page view or Assets view, double-click the media placeholder on your page.

The Open dialog appears.

2. Select the new file and click Open.

Editing a Media File’s Properties
When you place a media file on your page, you can set the properties for that file on 
the Properties palette. The properties determine how the media file looks and works 
on your page. After previewing a page or from site visitors’ feedback, you might 
want to change the properties for a particular file.

To edit a media file’s properties:

1. In Page view, click the media file’s placeholder.

The Properties palette for that file appears. 

2. Change the options you want. 

3. Save the site.
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Adding Java and ActiveX 20
You can make your site more interesting and interactive by adding special 
applications, such as Java applets, Java Beans, or ActiveX controls. NetObjects 
Fusion tools make it easy to insert these items and set the properties. To choose 
appropriate properties settings, you should be familiar with Java or ActiveX before 
you add these types of application files to your site. Sample Java applets are available 
in the NetObjects Fusion 4.0\Java\Applets NetObjects Fusion 4.0\Java\Applets NetObjects Fusion 4.0\Java\Applets NetObjects Fusion 4.0\Java\Applets folder; sample Java Beans are available in the 
NetObjects Fusion 4.0\Java\Beans NetObjects Fusion 4.0\Java\Beans NetObjects Fusion 4.0\Java\Beans NetObjects Fusion 4.0\Java\Beans folder.    You can also find tips and tricks for using 
Java applets with NetObjects Fusion at www.netobjects.com/workbenchwww.netobjects.com/workbenchwww.netobjects.com/workbenchwww.netobjects.com/workbench.

This chapter describes how to add:

✦ Java applets and servlets

✦ Java Beans

✦ ActiveX controls
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Inserting a Java Applet or Servlet
Java applets and servlets are an efficient way to add sound and animation, such as 
scrolling messages and color cycling buttons, to a page. Java applets and servlets are 
platform-independent applications with compact file sizes. Usually, Java applets and 
servlets run on the client platform, which means site visitors download and run 
them from a browser; however, servlets can include commands that are executed on 
the server. Most browsers are Java-compatible, so site visitors don’t need special 
plugins to run a Java application.

To insert a Java applet or servlet:

Java toolJava toolJava toolJava tool

1. In Page view, select the Java tool from the Advanced toolbar.

2. Draw a box to indicate the position of the Java applet or servlet. 

The Open dialog appears.

3. Select a Java file from your hard disk or LAN, or select one that is currently used 
in the site from the Java Class Assets tab.

The extension for a Java file is .class.class.class.class.

4. Click Open.

The Java placeholder image appears on the page, and the Java Properties palette 
appears. The path to the file you selected appears in the File field on the General 
tab. To select a new file, click Browse, find the file, and click Open.

The current .class.class.class.class file is displayed in the Class field.
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You can also drag a Java .class .class .class .class file from Windows Explorer onto your page. The 
Java placeholder appears on the page, and you can set the Java properties for that 
file. 

5. To provide text for the browser to display if it cannot display the file, enter a 
description in the AltTag field.

6. Select Applet or Servlet depending on the type of file you are inserting.

7. If your applet or servlet requires additional files, click the Additional Files 
button, then click Add in the Java Applet Files dialog. 

8. Select another file in the Add Java Applet Files dialog, and click Open. Click OK 
to add the selected file. The file is added to the Class drop-down list.

To delete a .class.class.class.class file from the Class list, click the Additional Files button and 
select the appropriate applet in the Java Applet Files dialog. Click Delete, then 
click OK.

9. Click the Parameters tab. 

This guide assumes you are familiar with Java and understand the effects of 
setting these parameters. In some cases, Java developers provide documentation 
that explains the parameters.

✦ To edit parameters, double-click the parameter and enter a value in the Enter 
Value dialog.

For servlets, you can specify that the value is an initialization value for the 
parameter by checking the Value is an initialization option in the Enter Value 
dialog. 

✦ To learn more about each parameter, check the Parameter info section.

This list shows all the .class 
files that NetObjects 
Fusion detects in the 
chosen .class file
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✦ To remove a parameter, select it and click the minus (–) button.

✦ To add a parameter, click the plus (+) button and enter a name and value in 
the Enter Value dialog.

Typically, you can add more instances of a parameter that already exists. For 
example, if text1 and text2 already exist, the applet will probably recognize a 
text3 parameter. If you add a parameter the applet doesn’t recognize, the 
parameter is ignored.

✦ To change the order of the parameters, click the Up or Down arrow buttons. 
The selected parameter moves up or down in the Parameters list.

Note: After you place a Java object, you cannot change the applet or servlet it embeds. If you 
want to replace one object with another, you must delete the original Java object. 

Inserting a Java Bean Component
Java Beans are a type of Java applet. Unlike Java applets, which require .class.class.class.class files 
plus other types of files, Java Beans are an all-in-one implementation of Java. A 
single file contains everything required to run the applet.

To insert a Java Bean:

Java Bean toolJava Bean toolJava Bean toolJava Bean tool

1. Before you place a Java Bean, you must copy the file to the NetObjects Fusion NetObjects Fusion NetObjects Fusion NetObjects Fusion 
4.0\Java\Beans4.0\Java\Beans4.0\Java\Beans4.0\Java\Beans folder.

2. In Page view, select the Java Bean tool from the Java tool flyout on the Advanced 
toolbar.

3. Draw a box to indicate the position of the Java Bean.

The Open dialog appears.

4. Select a Java Bean file from the NetObjects Fusion 4.0\Java\BeansNetObjects Fusion 4.0\Java\BeansNetObjects Fusion 4.0\Java\BeansNetObjects Fusion 4.0\Java\Beans folder, or select 
one that is currently used in the site from the Java Archive Assets tab.

A Java Bean file can have a .jar .jar .jar .jar or .class  .class  .class  .class extension.

Note: Most Java Beans have a .jar.jar.jar.jar extension, but some .jar.jar.jar.jar files might not be Java 
Beans. If you try to open a .jar.jar.jar.jar file that is not a bean, you see a message from 
NetObjects Fusion.

5. Click Open.
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The Java Bean placeholder appears on the page. Different beans have different 
icons in the upper right corner of the placeholder; the icon has no effect on the 
bean or its behavior.

The path to the file you selected appears in the File field on the General tab of 
the Java Bean Properties palette. To select a different file, click Browse, find the 
file, and click Open. The current .class.class.class.class file is displayed in the Class field. 

6. To provide text for the browser to display if it cannot display the file, enter a 
description in the AltTag field.

7. Select Applet or Servlet depending on the type of bean you are inserting.

8. If the bean requires other files, click the Additional Files button, then click Add 
in the Java Applet Files dialog.

9. Select another file in the Add Java Applet Files dialog, and click Open. Click OK 
to add the selected file. The file is added to the Class drop-down list.

10. Click the Prop. tab.

Different beans have different sets of properties. This guide assumes you are 
familiar with Java Beans and understand the effects of setting these properties. 
In some cases, Java Bean developers provide documentation that explains 
properties.

11. To edit a property, double-click it. Some properties require you to choose a color 
or enter a value in a dialog. Other properties toggle True/False or require you to 
type text. In some cases properties appear that have no affect on the bean or its 
behavior.

12. Click the Parameters tab.
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If you know the bean’s internal parameters, you can add or remove them.

✦ To add a parameter, click the plus (+) button and enter a name and value in 
the Enter Value dialog.

✦ If there are parameters listed, to remove one, select it and click the minus (-) 
button.

✦ To change the order of the listed parameters, select a parameter and click the 
Up or Down arrow buttons.

13. Publish the page to see how the bean works.

You can add actions to Java Beans using the Actions tab. When you choose a Java 
Bean as the target or source of an action, you see an expanded selection of available 
actions or trigger events as appropriate. See Chapter 21, “Building Dynamic Pages.”

Inserting an ActiveX Control
ActiveX controls are small applications designed with a specific purpose, such as 
playing an animation. Microsoft Internet Explorer 3.x or later supports ActiveX 
controls with which you can add custom capabilities such as audio and movie 
players, calendars, custom buttons, and forms to your pages. You can view 
documents such as Microsoft Office files in Internet Explorer without launching the 
associated program. Site visitors must use Internet Explorer 3.x or later to view 
content created with ActiveX controls. To view the content in Netscape Navigator, 
site visitors must install special plugins.

ActiveX requires that you install Microsoft ActiveX controls on your system. You 
can get ActiveX controls from the Microsoft site. You can also check at 
www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com and www.microsoft.comwww.microsoft.comwww.microsoft.comwww.microsoft.com for links to archives of free, ready-to-use 
ActiveX controls.

To insert an ActiveX control:

ActiveX Control toolActiveX Control toolActiveX Control toolActiveX Control tool

1. In Page view, select the ActiveX Control tool from the Advanced toolbar.

2. Draw a box to indicate the position of the ActiveX control.
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The Insert ActiveX Control dialog appears, listing the ActiveX controls currently 
installed on your system. The bottom section shows the selected ActiveX 
control, which has an .ocx.ocx.ocx.ocx extension.

3. To display the file name of the control in the Codebase field of the ActiveX 
Properties palette, select Set Codebase. 

4. Select the control you want and click OK. The ActiveX placeholder appears on 
your page, and the ActiveX Control Properties palette appears.

The General tab displays the options for the selected control. If you selected Set 
Codebase in the Insert ActiveX Control dialog, the path name and file name of 
the ActiveX Control appear in the Codebase field. 

Note: If you use an ActiveX control that references an external file, such as a .pdf.pdf.pdf.pdf 
file, you must specify the relative path of the file as it will be in the final 
published site. First you must add the file as an asset of the site and set it to 

Palette options vary 
depending on which 
ActiveX Control is 
selected
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always publish. See “Adding a File Asset” on page 27-4. To determine the file’s 
relative path in the final site, look at the publish directory structure listed in 
Publish view. 

5. To provide text that the browser displays if it cannot launch the ActiveX control, 
enter the text in the AltTag field.

6. To change an option, select it and enter the information in the field.

✦ To accept any text you enter, click the check mark or move the cursor to 
another field.

✦ To cancel the change, click the X.

✦ To use the native property page for the ActiveX control, click the Properties 
button. You can change the control’s settings using the native property page 
instead of NetObjects Fusion properties. Some ActiveX controls do not have 
a native property page. 

✦ To insert HTML tags and scripts, click the HTML button. See Chapter 26, 
“Working with HTML Directly.” 
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Building Dynamic Pages 21
You can include animations and other cool effects in your site by adding actions to 
individual objects or pages. You can make objects move on, off, and around the 
screen, hide or show them, bump them with other objects, have them exchange 
places, and so on. Site visitors can drag them around the page. You can even have 
actions respond to a site visitor’s entry in a form. No programming is required. You 
build actions by choosing options from menus.

In addition to the actions NetObjects Fusion provides, JavaScript programmers can 
also script their own actions.

When you use actions, note that:

✦ Actions work only in versions 4.0 and later of Internet Explorer and Netscape 
Navigator.

✦ You can use actions on pages with AutoFrames, but not with frames scripted by 
adding HTML directly.

✦ For reliable performance, make sure CSSP+Layers, CSSP, or Layers is selected as 
the HTML output method on the Layout Properties palette.

This chapter describes:

✦ Adding actions to pages, objects, and text

✦ Tailoring actions with custom messages

✦ Targeting several objects with one action

✦ Scripting your own actions

✦ Examples, including a button rollover, collision detection, and a 
slide show
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How Actions Work
An action consists of a trigger event that causes the action to begin, a message and 
various parameters specifying what the action does, and one or more targets that 
perform the action. 

✦ A trigger event can be a mouse click or simply hovering over a button. It can be 
when a site visitor enters or exits a page, so a page load might trigger pictures to 
fly across the page. A trigger event can also be another action, so one object 
flying off the page could make another object fly on. 

✦ The action message might be to show or hide an object, make an object fly off 
the page, make an object stick to the pointer so the site visitor can drag it around 
the page, display a dialog or alert, and so on.

✦ The target can be one or more objects on the page, the page itself, or a 
MasterBorder.

You add an action to the object that triggers it. For example, if you add an action to 
a button with the trigger event “when clicked,” the action message “fly off the page,” 
and Picture A as the target, clicking the button makes Picture A fly off the page.

To sequence actions, you can trigger one with another. Say you also add an action to 
Picture A with the trigger event “motion ended,” the action message “fly onto the 
page,” and Picture B as the target. As soon as the first action makes Picture A fly off 
the page, the second action makes Picture B fly on.

These are, of course, only basic examples of what you can do with actions. Many 
more ideas are presented throughout this chapter.

Sends a “fly off the page” 
action message...

To the target picture, which 
flies off the page

Clicking a button that 
has an action...

It sends a “fly onto the 
page” action message...

To another target picture, 
which flies onto the page

After a picture with a “motion 
ended” action flies off the page...
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Adding Actions to Objects and Pages
You can add an action to any object, Layout, or MasterBorder. NetObjects Fusion 
comes with several actions you can apply by choosing options from menus. Just 
specify a trigger event to start the action, the action itself, and the object you want it 
to target.

You can add any number of actions to an object. For example, one action might 
cause a button to highlight when you mouse over it, while another action removes 
the highlighting when you move the mouse away.

Note: Remember that MasterBorders can apply to several pages. So any object in the Layout 
that’s targeted by an action involving a MasterBorder has to be available in all Layouts 
using that MasterBorder.

1. In Page view, select the item you want to trigger the action, and click the Actions 
tab on the Properties palette.

On the Actions tab, clear the Object initially visible in browser option if you 
want the object to be hidden when the page loads; for example, if an action 
targeting this object makes it fly onto the page.

Add action buttonAdd action buttonAdd action buttonAdd action button

2. Click the plus (+) button on the Properties palette to add a new action.

The Set Action dialog appears.

3. Specify the action’s trigger event in the When field. 

Lists all actions this object triggers. Actions 
with the same trigger event occur in the 
order listed

Adds or removes an action

Changes the order of actions
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When menu buttonWhen menu buttonWhen menu buttonWhen menu button

Click the button next to the field, point to a trigger category, and click the trigger 
event you want.

The trigger events available depend on the object you’re adding the action to. 
These can include:

✦ Mouse. Includes options for triggering the action when the site visitor clicks 
the object, mouses down or up (for example, you might display a pushed-in 
picture of a button on mouse down), or moves the pointer over or off the 
object. 

✦ Object. Triggers the action when the object is hidden or shown as the result of 
another action that targets this object.

✦ Page.    Triggers the action when the page finishes loading, or when the site 
visitor opens another page.

✦ Transition, Motion, Drag. In a sequence of actions, triggers the action at the 
start or end of another action that targets this object. For example, ending a 
drag might trigger another action to restore the object you dragged to its 
original position.

✦ Custom. These are messages you create to trigger one action with another for 
specialized action sequences. See “Tailoring Actions with Custom Messages” 
on page 21-9.

4. Make sure Standard Action is displayed in the action type drop-down list. For 
information about scripted actions, see “Scripting Your Own Actions” on 
page 21-13.

Trigger categories

Some of the 
choices available 
for this object
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5. Specify the object your action is to target in the Target field.

Target menu buttonTarget menu buttonTarget menu buttonTarget menu button

The action can target any object on the page, the Layout itself, or even the 
MasterBorder. By default, it targets the object triggering it. To target another 
object, click the button next to the Target field and choose an object from the 
Object Tree. If you add a “Fly Out to Top Right” action to one picture and target 
it at another, for example, clicking the first picture can trigger the target picture 
to fly off the page.

You can also cascade an action to several objects at once; see “Targeting Several 
Objects with One Action” on page 21-11.

6. Specify the action you want to occur in the Message field.

Expand or contract levels of the Tree by 
clicking the plus or minus sign for a level

Select a 
target from 
the Object 
Tree
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Message menu buttonMessage menu buttonMessage menu buttonMessage menu button

Click the button next to the Message menu, point to a category, and click the 
action you want. 

Your choices for actions depend on the object you’re targeting. These can 
include:

✦ Object. Includes options for hiding, showing, or otherwise arranging the 
target in relation to other objects; adding a delay between the trigger event 
and a subsequent action; loading different images to use for a picture, say to 
show a highlighted button when a site visitor mouses over or it. For 
examples, see  “Creating a Button Rollover” on page 21-16 and “Sequencing 
Actions for a Slide Show” on page 21-21.

✦ Transition, Motion. Redraws the object in any of several ways, or causes it to 
move in some way across, on, or off the page.

✦ Drag. Makes an object stick to the pointer so site visitors can drag it around 
the page. One action might make the object stick on mouse down, while 
another lets the object go on mouse up. For an example, see “Colliding One 
Object with Another” on page 21-18.

✦ Get Property, Set Property. These actions are typically used as components of 
scripted actions or parameter values, in particular when working with values 
entered in forms. For an example, see “Generating a Parameter Value from a 
Form” on page 21-25.

Action categories

Some of the 
choices available 
for this target
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✦ Location, Dialog, Window, Browser. If the target is a Layout or MasterBorder, 
you might open another URL after an animation occurs; display a dialog; set 
the size, position, or some other state of the window; or check what browser 
the site visitor is using, say to trigger a different set of actions depending on 
the browser type.

✦ Custom. These are messages you create to trigger one action with another in 
specialized action sequences. See “Tailoring Actions with Custom Messages” 
on page 21-9.

7. If the action you specify requires or can be tailored with additional parameters, 
specify a value in the Parameters field.

Parameter menu buttonParameter menu buttonParameter menu buttonParameter menu button

Click the button next to the Parameters field and click an available option. For 
example, for a Fly message you can choose a direction parameter like In from 
Top.

For some actions, you can click Values on the Parameters menu to choose from a 
wider selection of values.

Primary choices 
available for a Fly 
message

Opens a dialog with 
all default 
parameter values
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The Parameter Values dialog appears, listing all parameters currently available 
for this action and their default values. 

To modify a value, select a parameter and edit its value in the field at the top of 
the dialog. Depending on the parameter, you might type the value, or choose it 
from a drop-down list, Color Picker, Picture File Open dialog, or Link dialog. 
Click OK when you’re done editing parameters. 

You can also write your own JavaScript expression to generate a parameter 
value. See “Scripting Parameter Values” on page 21-15. 

8. Click OK in the Set Action dialog.

Adding an Action to Text
You can add an action to text by creating a smart, Blank link and opening the Set 
Action dialog from the Link dialog. Clicking the text then causes the action to occur 
instead of linking to another page.

1. In Page view, select the text and click Link on the Format tab of the Properties 
palette.

The Link dialog appears.

2. Click the Smart Link tab in the Link dialog, and select Blank under Link Types.

3. Click the Actions button.

The Actions dialog appears.

Parameter values for a Fly 
message

Whether you type a value 
directly or choose it from a list 
or dialog depends on the 
parameter

Select a parameter to edit its 
value in the text field
21-8 Building Dynamic PagesBuilding Dynamic PagesBuilding Dynamic PagesBuilding Dynamic Pages



 

Tailoring Actions with Custom Messages

       
4. Click the plus (+) button and add an action as described in “Adding Actions to 
Objects and Pages” on page 21-3.

5. Click OK in the Actions dialog and click Link again in the Link dialog.

Tailoring Actions with Custom Messages
You can simplify some action combinations or create specialized sequences by 
triggering actions with custom messages. A custom message is a simple text string 
you create that becomes available in the When menu as a trigger and in the Message 
menu as an action. You can then send it as a wildcard action from one object to 
trigger whatever action is added to another. Some actions also use custom messages 
as parameter values.

Say you want clicking any of several buttons to trigger an action on a picture, but 
you want to periodically change the action from Wipe to Iris. Instead of having to 
change each button’s action message from Wipe to Iris, you can have each button 
send a custom message that triggers a Wipe or Iris action added to the picture. 
Controlling the effect of each button then requires modifying only the picture’s 
action. Several uses of custom messages are given in “Examples” on page 21-16. 

To create a custom message:

1. Select the object you want to trigger the first action in a sequence, and click the 
plus (+) button on the Actions tab of the Properties palette.

The Set Action dialog appears.

2. In the Set Action dialog, open the When or Message menu, and choose Custom, 
Edit.

The Custom Messages dialog appears.

Lists all custom messages created 
for this site

Adds or removes a message from 
the dialog and the menus
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3. Click the plus (+) button.

The Add Message dialog appears.

4. Type a name for the message and click OK. You can use spaces in message 
names, but don’t use punctuation or it might cause problems in the HTML 
when you publish.

The message is added to the Custom Message dialog. You can remove it by 
selecting it in the dialog and clicking the minus (-) button.

5. Click OK in the Custom Message dialog.

6. In the Set Action dialog, create an action that sends your custom message to the 
target. 

For example, to make clicking the source object trigger an action added to a 
picture, fill out the Set Action dialog like this: Enter Mouse, Clicked in the When 
field; the picture object in the Target field; and your custom message, which is 
now available in the When and Message menus, in the Message field.

7. Click OK in the Set Action dialog to close it.

8. Select the target object, click the plus (+) button on the Properties palette, and 
add the action you want the custom message to trigger.

The Set Action dialog reappears. Enter your custom message in the When field, 
and specify a target and action in the remaining fields.

9. Click OK in the Set Action dialog.
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Targeting Several Objects with One Action
You can target an action at a container object—a Layout, MasterBorder, Layout 
Region, text box, or table—to apply the action to every object in the container. For 
example, clicking a button could hide all objects in a Layout Region. Just select the 
Cascade message option in the Set Action dialog when you create the action.

Cascading messages work best with custom messages. See “Showing One Object 
While Hiding Others” on page 21-19 for an example.

1. In Page view, place the objects you want to target in a Layout, MasterBorder, 
Layout Region, text box, or table.

Note: Actions sent to a Layout or MasterBorder apply to the entire page, not just the 
Layout or MasterBorder. So cascading a Hide message at a Layout makes the 
entire page go blank. To hide only a subset of objects on the page, put the 
objects in a Layout Region and target it instead.

2. Select the object you want to trigger the action, and click the plus (+) button on 
the Actions tab of the Properties palette.

The Set Action dialog appears.

3. Create an action targeting the container of objects you want the action to apply 
to.

When filling out the Set Action dialog, enter the Layout, MasterBorder, Layout 
Region, text box, or table in the Target field.

4. Select the Cascade message option.
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5. Click OK in the Set Action dialog.

Triggering the source object targets the action at the container and then at each of 
its objects in the order they’re listed in the Object Tree. Keep in mind that the 
container responds to the action if it can. So if you cascade a Hide action to a Layout 
Region hiding all the objects in it, and then send an action to show an object that’s 
in the region, the object won’t appear because the region itself is still hidden.

For an example of cascading an action, see “Showing One Object While Hiding 
Others” on page 21-19.

Modifying Actions
You can modify an object’s actions, for example, to change a trigger event, to 
reorder actions if the object has more than one, to disable an action, or to delete it 
altogether.

Target a container

The action applies to objects 
in the order listed here

Then select this option to 
apply the action to all objects 
in the container
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In Page view, select the object whose actions you want to modify, and click the 
Actions tab on the Properties palette. 

✦ To change the sequence of actions, select an action and click the up or down 
arrow at the bottom of the palette.

If two or more actions share the same trigger event, they occur in the order 
listed.

✦ If you don’t want to publish an action now but might want to later, or if you 
want an action available only to use in a scripted action or JavaScript expression, 
clear that action’s check box. Next time the site is published, this action is not 
included, but it is still available to insert in a script or expression.

✦ To change an action’s properties—its name, trigger event, target, action 
message, and so on—double-click the action and make changes in the Set 
Action dialog.

✦ To delete an action, select the action and click the minus (-) button.

Scripting Your Own Actions
In addition to the actions NetObjects Fusion provides in the Message menu, 
experienced JavaScript programmers can script their own.

1. In Page view, select the object you want to trigger the scripted action, and click 
the plus (+) button on the Actions tab of the Properties palette. 

The Set Action dialog appears.

2. Select Scripted Action from the action type drop-down list.

The object’s actions are listed here

An unchecked action doesn’t get 
published but can be used in scripted 
actions and JavaScript expressions

Reorders the selected action
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A text box appears in the dialog.

3. Enter your scripted action in the text box using JavaScript.

NetObjects Fusion doesn’t verify code you enter, so be sure to use valid syntax. 
You can use any combination of typing, inserting existing script text from a text 
file (click Insert Script and open the file from the File Open dialog), or inserting 
a call to an existing action.

To insert a call to an existing action, click Insert Action. A list of the actions you 
added to the object appears. Select an action to insert and click OK. NetObjects 
Fusion inserts the action at the insertion point in the text box, in the form 
$($($($(ActionName)))).

Type here

Inserts text from a text file

Inserts a call to an existing action

Selecting this action and 
clicking OK...

Inserts the action call $(FlyOut) in your script
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4. Click OK in the Set Action dialog.

Scripting Parameter Values
You can customize an action’s parameter values instead of choosing from the ones 
NetObjects Fusion provides, by generating them with a JavaScript expression. For 
example, you might use the value a site visitor types in a form object as the number-
of-seconds value in a Delay action.

If you know JavaScript, you can enter expressions directly. You can also modify code 
for the default values NetObjects Fusion creates, and you can assemble expressions 
out of an object’s other actions. For example, an expression might test for a 
particular condition—like time of day—and then trigger actions you created with 
the Set Actions dialog based on that condition. Just as the Values dialog often lists 
several values, an expression can generate one or more values, too.

For an example even nonprogrammers can try, see “Generating a Parameter Value 
from a Form” on page 21-25.

1. In Page view, select the object whose parameter values you want to script, and 
add any actions you want to use as components of the JavaScript expression.

For these actions, ignore the When field, since each action is triggered by the 
expression. Also, if an action’s only purpose is to be called by the expression, 
disable the action by clearing the check box next to it on the Actions tab of the 
Properties palette.

2. Create the action whose parameter value you want generated by the expression, 
as described in “Adding Actions to Objects and Pages” on page 21-3. Or, open an 
existing action by double-clicking it on the Actions tab of the Properties palette.

3. In the Set Action dialog, open the Parameters menu and choose Expression. 

The JavaScript Expression dialog appears. If the action already has default 
parameter values, the dialog displays the code for those values.
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4. Enter your own JavaScript to generate the parameter value, or modify the code 
that’s already there. NetObjects Fusion doesn’t verify code you enter, so be sure 
to use valid syntax. 

To build your expression around existing actions, click the Insert Action button, 
select an action from the Actions dialog, and click OK. NetObjects Fusion 
inserts the action at the insertion point, in the form $($($($(ActionName)))).

5. Click OK in the JavaScript Expression dialog and again in the Set Action dialog. 

When the action is triggered, it uses the parameter values generated by your 
expression.

For more information about JavaScript and scripting expressions, see 
www.scriptbuilder.comwww.scriptbuilder.comwww.scriptbuilder.comwww.scriptbuilder.com.

Examples

Creating a Button Rollover
You can use the Set Image and Use Image actions to give three-dimensional feel to a 
button, for example, by highlighting it when the site visitor’s pointer passes over it, 
by making it appear pushed in when pressed, and so on.

For this example, you need three pictures of a button—one showing how it looks 
when the page loads, one showing it highlighted, and one showing it pressed. 

1. In Page view, place the picture of the button as it looks when the page loads on 
your page.

Enter a JavaScript expression here, 
replacing or modifying existing code

Opens a list of actions you can call 
from the expression

Highlighted button

How buttons look when the page loads
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2. Add an action to the button, as described in “Adding Actions to Objects and 
Pages” on page 21-3, that makes all versions of your button available to the 
browser when the page loads.

In the Set Action dialog, enter Page, Page Loaded in the When field; the button 
itself in the Target field; and Object, Set Image in the Message field. 

Then open the Values dialog from the Parameters menu, and identify when to 
use which picture file: Make sure the “loaded” version of the button is selected 
for the Select Image 1 (Normal) value. Then select the highlighted button for 
Image 2 (Highlighted), and the pressed version for Image 3 (Depressed).

To specify a picture file in a Set Image action’s Values dialog, select a value, click 
the button next to the edit field, and open a file from the Picture File Open 
dialog.

3. Add four Use Image actions to the button, filling out the Set Action dialog for 
each action like this:

Action 1. Enter Mouse, Mouse Over in the When field; the button itself in the 
Target field; and Object, Use Image in the Message field. Then open the 
Parameters menu and click Image 2 (Highlighted).

Action 2. Enter Mouse, Mouse Out in the When field; the button in the Target 
field; Object, Use Image in the Message field; and Image 1 (Normal) in the 
Parameters field.

Action 3. Enter Mouse, Mouse Down in the When field; the button in the Target 
field; Object, Use Image in the Message field; and Image 3 (Depressed) in the 
Parameters field.

Action 4. Enter Mouse, Mouse Up in the When field; the button in the Target 
field; Object, Use Image in the Message field; and Image 2 (Highlighted) in the 
Parameters field.

Parameter values for a Set Image action
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Make sure CSSP+Layers, CSSP, or Layers is selected as the HTML output method 
on the Layout Properties palette. Then preview the page to test your rollover. Mouse 
over the button to see it highlighted, and press it to see it pushed in.

Colliding One Object with Another
This example demonstrates a drag action, collision detection, and custom messages, 
where dragging one object into another makes the second object fly off the page.

1. In Page view, add two objects to the page.

2. Select the first object (the one you plan to drag), and create a custom message 
named Fly Away, as described in “Tailoring Actions with Custom Messages” on 
page 21-9. Create an action to use in creating the custom message and then 
delete it.

3. Add an action to the first object (as described in “Adding Actions to Objects and 
Pages” on page 21-3) so that mousing down on it makes it stick to the pointer 
until you mouse up.

In the Set Action dialog, enter Mouse, Mouse Down in the When field; the first 
object in the Target field; Drag, Start Drag in the Message field; and Until Mouse 
Up in the Parameters field. 

4. Add a collision detection action to the first object like this:

In the Set Action dialog, enter Page, Page Loaded in the When field; the first 
object in the Target field; and Drag, Set Collision Detection in the Message field. 
Then open the Values dialog from the Parameters menu and specify the first 

Your message becomes available in the 
When and Message menus
21-18 Building Dynamic PagesBuilding Dynamic PagesBuilding Dynamic PagesBuilding Dynamic Pages



 

Examples

        
object for the Object ID value (type the object’s ID exactly as it appears on the 
Actions tab of its properties palette), and enter Fly Away for the Message value.

When the first object is dropped over the second, it sends the Fly Away message 
to the second object.

5. Add yet another action to the first object that’s triggered by the Fly Away 
message and tells the second object to fly off the page.

In the Set Action dialog, enter Custom, Fly Away in the When field; the second 
object in the Target field; Motion, Fly in the Message field; and Out To Top in 
the Parameters field. 

Make sure CSSP+Layers, CSSP, or Layers is selected as the HTML output method 
on the Layout Properties palette. Then preview the page to test your collision. Drag 
the first object over the second, drop it there, and watch the second object fly off the 
page.

Showing One Object While Hiding Others
Here’s an example of cascading a custom message to build a sequence of actions 
where displaying one object selectively hides others.

Say your page displays a map showing the locations of five company offices. For 
each location, a button superimposes a text box on the page profiling that office’s 
activities. When a site visitor clicks a location, you want to hide any profile that’s 
currently visible, and then display the one describing the selected location.

1. In Page view, place the buttons and text boxes in the Layout area, arranging 
them however you want.

ID of the object being dragged

Custom message sent to trigger the 
other object to fly away

Values for a collision detection action
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2. Select one of the buttons and create a custom message called Hide All Profiles, as 
described in“Tailoring Actions with Custom Messages” on page 21-9.

3. To each button, add an action, as described in “Adding Actions to Objects and 
Pages” on page 21-3, so clicking the button cascades the Hide All Profiles 
message to the Layout.

In the Set Action dialog, enter Mouse, Clicked in the When field; the Layout in 
the Target field; and Custom, Hide All Profiles in the Message field. Also, check 
the Cascade message option.

4. Add a second action to each button so clicking it targets a Show message to the 
text box associated with the button.

In the Set Action dialog, enter Mouse, Clicked in the When field; the text box 
this button should display in the Target field; and Object, Show in the Message 
field.

5. Select each text box, and on the Actions tab of the Properties palette, clear the 
Object initially visible in browser option.

6. Add an action to each text box that’s triggered by the Hide All Profiles message 
and hides the text box.

In the Set Action dialog, enter Custom, Hide All Profiles in the When field; the 
text box itself in the Target field; and Object, Hide in the Message field. 

Make sure CSSP+Layers, CSSP, or Layers is selected as the HTML output method 
on the Layout Properties palette. Then preview the page. Clicking a button should 
send Hide All Profiles as a cascading action message to the Layout. The Layout 
doesn’t have any actions triggered by this message so it doesn’t respond. But it does 
cascade the message down to its embedded objects. As a result, every object on the 
page receives the message. But only those objects with actions triggered by the 

Your message becomes available in the 
When and Message menus

Clear this option for each text box so its 
contents don’t appear until the site 
visitor clicks the appropriate button
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message—the text boxes—respond by hiding themselves. Next, the button sends a 
Show message to its associated text box, which makes itself visible.

Without cascading messages you’d have to add four additional actions to each 
button—one for hiding each text box. If you didn’t use a custom message to trigger 
the text boxes to hide, cascading a Hide message to the Layout would hide every 
object on the page.

Sequencing Actions for a Slide Show
Here’s an example of using custom messages and a delay action to build a slide 
show. When the page loads, a slide flies onto the page, stays there for the duration of 
a delay, flies off, and is followed by another slide.

Before you begin, gather the pictures you want to show in each slide. 

1. In Page view, create a Layout Region, and in it, place pictures and text for your 
first slide.

By creating each slide in a Layout Region, you can include multiple objects per 
slide.

2. Select the Layout Region and clear the Object initially visible in browser option 
on the Actions tab of the Properties palette.

This is so the slide doesn’t appear until an action triggers it to fly onto the page.

3. Create three custom messages named Show Picture, Picture Is In, and Delay Is 
Done, as described in“Tailoring Actions with Custom Messages” on page 21-9.

Using custom messages rather than a generic End Motion trigger to trigger each 
slide’s entrance and exit lets you control exactly which motion triggers what.

4. Add five actions to the Layout Region, as described in“Adding Actions to 
Objects and Pages” on page 21-3. For each action, fill out the Set Action dialog 
like this:

Action 1. Enter Page, Page Loaded in the When field; the Layout Region in the 
Target field; and Custom, Show Picture in the Message field.

Your messages become available under 
Custom in the When and Message 
menus
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Action 2. Enter Custom, Show Picture in the When field; the Layout Region in 
the Target field; and Motion, Fly in the Message field. Then open the Values 
dialog from the Parameters menu, enter a Direction value of 270 (degrees), and 
make sure Visibility is set to Show, which tells the picture to fly in from the left. 
Also enter Picture Is In as the Completion Message. 

You define the Fly action’s parameters in the Values dialog, instead of choosing 
In From Left from the Parameter menu, so you can trigger the next action with a 
custom message.

Action 3. Enter Custom, Picture Is In in the When field; the Layout Region in the 
Target field; and Object, Delay in the Message field. Then open the Values dialog 
from the Parameters menu and enter Delay Is Done as the Custom Message, and 
2 for the Delay value.

The arrival of the first slide triggers a two-second delay after which the Delay Is 
Done custom message is sent to trigger the next two actions.

Action 4. Enter Custom, Delay Is Done in the When field; the Layout Region in 
the Target field; Motion, Fly in the Message field; and Out To Right in the 
Parameters field.

After two seconds, the slide flies off the page.

These two settings are equivalent to 
choosing In From Left from the 
Parameter menu

When the Fly action is complete, this
custom message is sent to the target to 
trigger the next action

Values for a Fly action

The message sent to the target to trigger 
the next action, after this delay

The duration of the delay, in seconds

Values for a Delay action
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Action 5. Enter Custom, Delay Is Done in the When field; the Layout Region in 
the Target field (you change this later); and Custom, Show Picture in the 
Message field.

Also after two seconds, another slide flies onto the page.

5. Create the second slide by copying and pasting the entire Layout Region, placing 
the copy directly on top of (not inside) the first Region.

Copying the Layout Region copies its actions, too, so you don’t have to add the 
same actions over and over to subsequent slides.

To stack Layout Regions without inserting one in the other, select the Regions 
and align them using buttons on the Multi-Object Palette.

6. Select the new Layout Region, replace its contents with the contents for your 
second slide, and delete its first action from the Actions tab on the Properties 
palette.

To make sure you’re working with the second Layout Region’s actions, open the 
Object Tree (from the View menu choose Palettes, Object Tree), and select the 
Region.

7. Copy and paste the second Layout Region once for each remaining slide. Align 
the resulting Regions on top of each other as you did in step 5. While working 
with each Layout Region, replace its contents with those for a new slide.

You can uncover a Layout Region to work on in Page view by selecting Regions 
in the Object Tree and using the Hide Object or Show Object command on the 
Object menu. Also in the Object Tree, you can rename Regions Slide1, Slide2, 
and so on to keep track of which slide is which.

8. Edit the last action of all but the last slide so it targets the next slide in the show.

Select a Layout Region here to edit its 
actions, or hide or show it with the Hide 
Object or Show Object command

Type here to rename a Layout Region
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Double-click the action on the Actions tab of the Properties palette to open the 
Set Action dialog and change the target.

9. For the last slide, deactivate all but the first action by clearing the box to the left 
of the action.

By deactivating rather than deleting actions that target another currently 
nonexistent slide, you can easily add slides to your show later by reactivating and 
targeting the actions at a new slide.

Make sure CSSP+Layers, CSSP, or Layers is selected as the HTML output method 
on the Layout Properties palette. Then preview the page to test your slide show.

Double-click the last 
action of Slide 2...

and edit the action to 
target the Show Picture 
action at Slide 3

to open the Set Action 
dialog...

The last slide’s actions

Clear the box next to each 
action that doesn’t apply to the 
last slide, so the actions aren’t 
published
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Loading the page sends a Show Picture action to the first slide, triggering it to fly 
onto the page. The completion of the Fly action sends a message that triggers a two-
second delay, after which another custom message triggers both the exit of the 
current slide and the entrance of the next.

Generating a Parameter Value from a Form
Here’s an example of generating a parameter value with a JavaScript expression that 
even a nonprogrammer can try. This example also demonstrates getting a value 
from a form object. It builds off the example in “Sequencing Actions for a Slide 
Show” on page 21-21—specifically, you add a field to the show where the site visitor 
types a number of seconds to view each slide.

1. Build the slide show described on page 21-21.

2. In Page view, add a text-based form anywhere outside the Layout Regions 
containing your slides. Then place a forms edit field inside the form, as 
described in “Adding a Single-Line Text Field” on page 23-5.

3. Add an action to each Layout Region that retrieves the value typed in the new 
text field.

In the Set Action dialog, ignore the When field (any entry is fine), enter the 
forms edit field (not the text box it’s in) as the action’s target, and enter Get 
Property, Get Value in the Message field.

4. Click OK to close the Set Action dialog, then disable the action by clearing its 
check box on the Actions tab of the Properties palette.

5. Modify each Layout Region’s Delay action (the one labeled “On Picture Is In do 
Delay” on the Properties palette) to use the value retrieved by the action you 
created in step 2.

Double-click the action on the Actions tab of the Properties palette. Then from 
the Set Action dialog, open the Expression dialog from the Parameters menu, 
select the value 2 (the delay value you typed when you first built the show), click 

Clear the check box to 
deactivate the action
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the Insert Action button, and insert the action you created in step 2. Click OK 
when you’re done.

Make sure CSSP+Layers, CSSP, or Layers is selected as the HTML output method 
on the Layout Properties palette. Then preview the page to test your delay. After the 
page loads, type a number in the text field and press Enter. Each slide should remain 
on the page for the number of seconds you specified.

Customizing Default Actions
The trigger events, action messages, and default parameter values available in the 
Set Action dialog are defined in the JavaScript Beans (.jsb.jsb.jsb.jsb) and JavaScript (.js.js.js.js) files 
in the \NetObjects 4.0\NetObjects System\NetObjects 4.0\NetObjects System\NetObjects 4.0\NetObjects System\NetObjects 4.0\NetObjects System folder. If you’re experienced in JavaScript 
programming, you can add your own .jsb .jsb .jsb .jsb and .js  .js  .js  .js files to provide even more choices 
in the Set Action dialog.

Select the current delay value

Select the Get Value action and click OK to replace 
the delay value with a call to this action

Click here to open the 
Actions dialog
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Referencing and Editing 
External HTML 22
In addition to content you create and maintain in Page view, your site might also 
include pages that require special, hand-coded HTML. Instead of importing and 
converting this HTML, you can reference HTML files externally and place them 
anywhere in your site. NetObjects Fusion doesn’t parse the HTML when it publishes 
your site, ensuring that your HTML is kept pure.

You can manage external assets in Assets view, and apply a consistent look to the 
published pages by assigning a MasterBorder. You can edit referenced files using any 
HTML editor, such as Notepad, Allaire HomeSite, or NetObjects ScriptBuilder. To 
set a default HTML editor, see “Setting General Preferences” on page 2-2.

Note: You can reference files located on a hard disk or LAN, but not from a remote Web server. 
Also, <A HREF> links in the original HTML files should point to other HTML files and 
anchors within those files, using relative rather than absolute path names. See 
“Managing Referenced Assets” on page 22-8 for information.

This chapter describes how to work with external HTML by:

✦ Referencing HTML from Site view, Page view, or as an object

✦ Managing referenced assets

✦ Publishing native HTML

✦ Previewing and publishing unmanaged assets 
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Referencing HTML from Site View
You can reference an entire site or section of a site from Site view. For example, you 
might reference an existing site you want to manage with NetObjects Fusion now 
and import later. Or, you can reference files you prefer to maintain in their native 
code. 

Note: For links to work between the HTML files you reference, use relative path names in the 
original <A HREF> tags, keep all HTML files in the same directory, and publish files 
using the same directory structure as the original site. See “Managing Referenced 
Assets” on page 22-8 for information.

When you reference HTML from Site view, NetObjects Fusion publishes the 
<HEAD> content from the original files, along with <HEAD> content it generates.

1. In Site view, select the page to be the parent of the pages you reference.

2. From the File menu, choose Reference External HTML.

The Reference External HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the top-level HTML file you want to reference, and click Open to return 
to the Reference External HTML dialog. 

NetObjects Fusion adds the top level 
page you’re referencing here, and its 
children below

Select an existing page and 
choose the Reference 
External HTML command
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5. Choose which files to reference, and assign a MasterBorder.

✦ Assign MasterBorder. Choose a MasterBorder from this drop-down list. Each 
HTML file you reference occupies the Layout area of a page, while the 
MasterBorder gives pages the consistent look of your site. To display external 
content with its original look, choose ZeroMargins.

Note: If any external HTML you’re referencing contains frames, you must choose the 
ZeroMargins MasterBorder.

✦ Limit number of pages to. You can select this option to enter a number of files 
to reference. NetObjects Fusion begins with the Home page you select and 
stops referencing when it reaches the end of the site or the number of pages 
entered here.

✦ Down to structural level. Select this option to enter how many levels of your 
site structure to reference. NetObjects Fusion references as many pages as 
possible at a higher level before going to a lower level.

✦ Do not manage or move assets. If you select this option, NetObjects Fusion 
doesn’t copy external assets into Assets view. Do this if you prefer that path 
names in the published HTML not be edited from your native code. 
However, you then have to manage images and other assets yourself. See 
“Publishing Unmanaged Assets” on page 22-10.

6. Click OK.

The referenced files appear in Site view, where you can rename them just like other 
pages. You can keep track of what part of your site is externally referenced using the 

NetObjects Fusion references 
this file and child files in the 
domain you specify

Display referenced HTML on 
pages with your site’s 
MasterBorder, or choose 
ZeroMargins to publish external 
content with its original look
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View tab on the Properties palette to assign a different color to the referenced pages’ 
icons.

Referencing HTML from Page View
You can reference an external HTML file as the Layout area of a page from Page 
view, and incorporate the file’s <HEAD> content—for example, to include existing 
META tag keywords or JavaScript definitions.

1. Create a page in Site view.

2. In Page view, from the File menu, choose Reference External HTML Page. 

The Reference External HTML Page dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the external file you want to reference, and click Open to return to the 
Reference External HTML Page dialog.

If the file is already referenced elsewhere in the site, avoid creating a duplicate 
asset by clicking the HTML Assets tab and selecting the file from there.

5. Choose whether to import the referenced file’s <HEAD> content and manage 
external assets.

Open a file from this tab to add a 
new asset to the site

Open from this tab to reuse an 
existing asset

NetObjects Fusion places this 
file’s <BODY> in the Layout area 
of your new page

Check here to also publish the 
file’s <HEAD> content...

...either in addition to, or instead 
of, the <HEAD> NetObjects 
Fusion generates
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✦ Import <HEAD>. Select this option to publish the external HTML file’s 
<HEAD> content. Choose Append to Current <HEAD> to add external 
<HEAD> content to what NetObjects Fusion generates, or choose Replace 
Current <HEAD> to publish only the external file’s <HEAD> content.

Caution: Don’t select Replace Current <HEAD> if the page contains actions or is 
being published using the CSSP+Layers, CSSP, or Layers HTML output 
options. NetObjects Fusion generates <HEAD> content these options 
require. 

✦ Do not manage or move assets. If you select this option, NetObjects Fusion 
doesn’t copy any external assets into Assets view. Do this if you prefer that 
path names in the published HTML not be edited from your native code. 
However, you then have to manage images and other assets yourself. See 
“Publishing Unmanaged Assets” on page 22-10.

6. Click OK.

In Page view, a placeholder for the referenced HTML fills the Layout area.

Double-click the referenced Layout area to edit the referenced HTML. To choose a 
default editor, see “Setting General Preferences” on page 2-2.

Referencing HTML as an Object
You can reference an external file as an individual object on a page. Reference an ad 
banner, for example, an applet created by a Java generator such as NetObjects 
BeanBuilder, or any other object requiring special code. 

Information about the 
referenced file
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You can even reference several external files on a page. For example, you might 
construct a front page for a company newsletter that includes a slot for each of 
several externally maintained story leads. 

As when you reference HTML as a Layout area, you can incorporate each file’s 
<HEAD> tags and script definitions to include existing META tag and script 
definitions.

To reference HTML as an object:

External HTML toolExternal HTML toolExternal HTML toolExternal HTML tool

1. In Page view, choose the External HTML tool from the Advanced toolbar. 

2. Draw a box where you want the referenced content to appear. 

Put the box in the Layout area to publish the content on one page, or in the 
MasterBorder to publish it in the border of several pages.

The Reference External HTML Page dialog appears.

3. Click Browse, select the external file you want to reference, and choose whether 
to import the file’s <HEAD> content and manage external assets, as described in 
“Referencing HTML from Page View” on page 22-4.

4. Click OK.

A placeholder for the referenced HTML file fills the box. Preview the page to see the 
object. If necessary, go back and adjust the box’s position in Page view to get the 

This file’s <BODY> is published 
in the HTML table cell generated 
for the object

Check here to also publish the 
file’s <HEAD> content...

...either in addition to, or instead 
of, the <HEAD> NetObjects 
Fusion generates
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spacing you want. As with other objects, you can drag a referenced object around 
the page, drag it inside other objects, or even layer it. 

Double-click the referenced HTML placeholder to edit the referenced HTML. To 
choose a default editor, see “Setting General Preferences” on page 2-2.

Toggling Referenced Layouts and Objects
You can convert a referenced layout into an object; for example, to add other objects
to the Layout area. Or conversely, size a referenced object to fill the Layout area. Use 
the Size to Layout option on the External HTML Properties palette.

1. In Page view, click in the referenced Layout area or object you want to resize.

2. Click the General tab on the External HTML Properties palette.

3. Select or clear Size to Layout.

Add other referenced objects 
as well as pictures, media, and 
objects created in NetObjects 
Fusion

Referenced object

Adds or removes resize handles 
from referenced HTML
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Clearing this option adds resize handles to a referenced Layout area, so you can 
resize it, move it, and add other objects. Selecting the option removes resize 
handles from an object, which fills the Layout.

Note: Avoid sizing a referenced object to a Layout if there are other objects in the 
Layout area. You might get unexpected results in some browsers.

Managing Referenced Assets
When you reference an external HTML file, NetObjects Fusion lists the HTML file 
in Assets view. Unless you choose otherwise, it imports into Assets view pictures, 
applets, media, and most other external assets the file references. 

You can move external assets around in your directory structure in Publish view 
while maintaining paths. When you publish, NetObjects Fusion edits paths to the 
assets so they can be found. For example, depending on your original and published 
directory structures, NetObjects Fusion might change the original HTML’s <IMG <IMG <IMG <IMG 
SRC="Images/Logo.gif">SRC="Images/Logo.gif">SRC="Images/Logo.gif">SRC="Images/Logo.gif"> to <IMG SRC="../Index/Logo.gif"> <IMG SRC="../Index/Logo.gif"> <IMG SRC="../Index/Logo.gif"> <IMG SRC="../Index/Logo.gif"> in the published HTML.

However, NetObjects Fusion doesn’t edit paths to other HTML files, or to 
<TARGET=> anchors within a file. For these links to be maintained, the path 
names in the original files must work as-is when you publish. The original <A 
HREF> tags must use relative rather than absolute path names; that is, use 
<A HREF=".Index.html"><A HREF=".Index.html"><A HREF=".Index.html"><A HREF=".Index.html"> rather than <A HREF="HTTP://www.<A HREF="HTTP://www.<A HREF="HTTP://www.<A HREF="HTTP://www.your_original_domain.com/com/com/com/
Index.html">Index.html">Index.html">Index.html">. And you must position external HTML files in your NetObjects 
Fusion directory structure so these original paths work. See “Customizing Your 
Directory Structure” on page 28-19.

In particular, NetObjects Fusion manages external assets referenced by these tags:

✦ <IMG SRC=>

✦ <A HREF=> to non-HTML assets, such as sound files

✦ <BODY BACKGROUND=>

✦ <EMBED SRC=>

✦ <BGSOUND SRC=>

✦ <SCRIPT SRC=>

✦ <INPUT SRC=>

✦ <APPLET CODE=>
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Although NetObjects Fusion manages external applets that are assets of referenced 
HTML, it might not manage certain classes referenced by the applets. Look in Assets 
view to see if any classes you reference aren’t listed. Then see “Publishing 
Unmanaged Assets” on page 22-10 for information on getting these classes and 
other unmanaged assets to the \Preview\Preview\Preview\Preview folder or Web server.

Once an external asset is imported into Assets view, you can use it anywhere 
throughout your site. Deleting referenced HTML from your site removes its assets 
from Assets view unless they’re in use elsewhere.

Publishing Native HTML
When you preview or publish referenced HTML, NetObjects Fusion copies the 
HTML from the original files to .html.html.html.html files it creates in the \Preview\Preview\Preview\Preview or publish folder. 
If managing external assets or including MasterBorders, NetObjects Fusion also 
adds its own code to the published HTML. Of course it never modifies your original 
files.

If you don’t want HTML added to the original code when the site is published, you 
can choose these options in the Reference HTML dialog.

✦ When you reference from Site view, choose the ZeroMargins MasterBorder. 
NetObjects Fusion doesn’t add MasterBorder information to the published 
HTML or impose a table structure.

When you reference HTML 
from Page view, choose 
Replace current <HEAD>

In either case, select this 
option

When you reference HTML 
from Site view, choose the 
ZeroMargins MasterBorder
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✦ When you reference from Page view, choose Replace Current <HEAD> from the 
Import <HEAD> drop-down list. NetObjects Fusion publishes the original 
<HEAD> as-is, without adding HTML of its own.

Don’t do this if you’re using actions on the page or publishing using the 
CSSP+Layers, CSSP, or Layers HTML output options.

✦ In either case, select Do not manage or move assets. NetObjects Fusion doesn’t 
copy external assets into Assets view, so it doesn’t edit path names in the 
published HTML. However, you have to publish images and other assets 
yourself. See “Publishing Unmanaged Assets.”

✦ Be sure Size to Layout is selected on the External HTML Properties palette.

Publishing Unmanaged Assets 
If you choose not to manage assets when you reference external HTML files, you 
have to get external pictures, media files, applets, and other assets to the Web server 
yourself. 

You can upload the files to the server from wherever they reside using an FTP utility. 
Or, use the New File Asset command to copy assets into Assets view so they will be 
published with the rest of the site.

1. In Assets view, from the Assets menu, choose New File Asset.

The File dialog appears.

2. Click Browse in the dialog to open an external asset you want to publish, and 
type a name for the asset.

For information about this dialog, see “Adding a File Asset” on page 27-4.

3. Select Always publish file in the dialog and click OK.

This causes the file to be published, even though it’s not listed as being in use.

4. In Publish view, position the asset in your directory structure so when it’s 
published, it can be found by any HTML referencing it.

Because paths to unmanaged assets aren’t edited in the published HTML, you 
must position assets so the original paths will work. See “Customizing Your 
Directory Structure” on page 28-19.
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Designing and 
Implementing Forms 23
You can add forms to your site to collect information from site visitors; for example, 
to survey potential customers, conduct credit-card transactions, have customers 
register products, or otherwise process information visitors submit.

Using forms, visitors can type in text fields, and select options using check boxes, 
radio buttons, and combo boxes. You can use the NetObjects Form Handler 
component to have responses posted in an email or copied to a text file on your Web 
server. Or, you can assign a Common Gateway Interface (CGI) script to further 
process responses, for example, by summarizing them on a confirmation page. If 
you use a CGI script, check with your server administrator or ISP for setup 
information.

You can also use JavaScript or Visual Basic routines with forms. See Chapter 26, 
“Working with HTML Directly.” So you can test form features, sample forms are 
available in the NetObjects Fusion 4.0\TemplatesNetObjects Fusion 4.0\TemplatesNetObjects Fusion 4.0\TemplatesNetObjects Fusion 4.0\Templates folder. 

This chapter includes:

✦ Creating forms

✦ Adding text fields, check boxes, radio buttons, and combo boxes

✦ Adding Submit, Reset, and custom buttons

✦ Submitting data via email or to a text file

✦ Processing data with a CGI script

✦ Adding hidden fields for client-side parameters 
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Creating a Form
With NetObjects Fusion, you can devote an entire Layout area to a detailed survey, 
or create one or more forms, each in a Layout Region, table, or text box. One form 
might log product registrations, for example, while another emails customer 
comments to a product manager. You can also add a form to the MasterBorder so it 
appears on several pages.

Form Area toolForm Area toolForm Area toolForm Area tool

1. In Page view, select the Form Area tool from the Standard toolbar, and draw a 
rectangle in the Layout area or MasterBorder.

The Create Form dialog appears. 

2. Select a type of form.

✦ Create position-based form (Layout Region) creates a form in a Layout Region 
that you can resize and drag anywhere on the page. When you add form 
objects, text boxes, and other objects to the Layout Region, you can freely 
position and align them, just as you position objects in a Layout area.

✦ Create text-based form (Text box) creates a form in a text box. Text you type 
and form objects you add appear sequentially inline, just as when you type. 
This is a good choice for forms that have a lot of text, where objects appear 
inline, or that have a simple layout, like a row of check boxes or single 
column of fields. A text box form typically generates less HTML when you 
publish than a Layout Region form.

✦ Create form in a table creates a table where you can line up form objects by 
inserting them in table cells. Each cell acts like a text box, where you type and 
add objects just as you add other objects to a table. You can only have one 
table for the entire form.

If you define a Layout, Layout Region, or text box as a form, you can insert 
multiple tables to help align form objects.

Good for forms that include a lot of text 
or have a simple layout

Useful for forms with a rigid tabular layout

Provides flexibility in arranging form objects
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✦ Define Layout as a form (limits page to one form) creates a single form on the 
page that occupies the entire Layout area.

3. Click OK.

4. Add fields, check boxes, and other objects to your form, along with images and 
other content, as described in “Adding Objects to a Form.”

You can also turn an existing Layout or object into a form. Click the Layout area, 
Layout Region, text box, or table, and select the form option on the Properties 
palette; for example, Text box is a form.
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Adding Objects to a Form
You can add any standard form objects to a form, including single- and multiple-
line text fields, check boxes, radio buttons, scrolling lists, and drop-down lists. 

You add objects to a form using the Form toolbar. This toolbar appears when you 
first create the form, or you can open the toolbar from the View menu by choosing 
Toolbars, Form Tools.

Arrange and align the fields, check boxes, and other objects in a form, just as you 
would arrange objects in a Layout area, table, or text box. You must place form 
objects inside a form to make them work as part of the form. If you don’t place form 
objects inside a form, a red warning icon appears in the form object.

To minimize the HTML generated by a Layout Region form, align its objects using 
the options on the Multi-Object Palette.

Browsers display form objects differently, so test your form on all the browsers and 
platforms you plan to support. 

Edit fields

Radio buttons

Form buttons

Check boxes

Drop-down list

The Form toolbar appears 
when you create a form
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Note: If you publish pages containing forms using the CSSP+ Layers, CSSP, or Layers HTML 
output options, the forms don’t display properly and form objects display warning 
icons in Page view.

Naming Form Objects
When you add objects to a form, you provide a name or argument for each object 
that is passed to the NetObjects Form Handler component or CGI script which 
processes responses. These names can be used to output or otherwise process the 
text typed in a field, or the state of each check box, radio button, or combo box. 

If you’re using the Form Handler component to output responses, you must name 
each form object with a sequential number, beginning with 1, and continuing with 
2, 3, and so on. The exception to this sequential numbering is when you use radio 
buttons or check boxes in a form. See “Adding Radio Buttons” on page 23-8 and 
“Adding Check Boxes” on page 23-9. Don’t use text characters or punctuation, as in 
1-TextField. For Form Handler information, see “Submitting Responses as Plain 
Text” on page 23-13.

In addition to names, you can also provide a value to be sent when a site visitor 
selects a check box, radio button, or item in a combo box. For example, a check box 
named Yellow with a value of Yes might be sent to a CGI script as Yellow=Yes, 
depending on the script.

Actions you add with NetObjects Fusion can also use form object values to 
manipulate a site visitor’s response. See “Scripting Parameter Values” on 
page 21-15.

If you’re using a CGI script, you might need to coordinate the names and values you 
enter with those used in the script. Each CGI script has its own naming 
conventions, but in general, names cannot include spaces or punctuation. Check 
with your server administrator or ISP for information.

Adding a Single-Line Text Field
A single-line text field can accommodate just a few words, such as a name or phone 
number. After creating the form as described on page 23-2:

Edit Field toolEdit Field toolEdit Field toolEdit Field tool

1. In Page view, select the Forms Edit Field tool from the Form toolbar.

2. Draw a rectangle on the form.

The Forms Edit Field Properties palette appears.
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3. Set the Forms Edit Field properties.

✦ Name. Type the argument for this field that’s passed to the CGI script 
processing the form.

If you’re using the Form Handler, use a number indicating the object’s order 
in the output text.

✦ Text. Type text to appear in the field by default. This text is submitted as the 
response if the site visitor doesn’t replace it.

✦ Password field. Select this option if the field is for sensitive information like a 
password or credit card number. Characters site visitors type are submitted 
to the script, but depending on the browser, visitors see asterisks, bullets, or 
nothing at all as they type. 

✦ Visible length. Enter a number to define the number of characters visible in 
the field.

✦ Max length. Enter a number to define how many characters site visitors can 
enter in the field. When typing exceeds the field’s visible width, text scrolls 
up to this number of characters.

4. To label the field, use the Text tool on the Standard toolbar.

Text field width, measured in characters

Maximum number of characters that can be 
entered in the field

Select to hide the site visitor’s typing

Type text to appear in the field by default

Argument passed to the script processing the form
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Adding a Multiple-Line Text Field
To provide a place for long comments or descriptions, you can add a multiple-line 
text field. Site visitors can type as much as they want, and text scrolls as necessary. 
After creating the form as described on page 23-2:

Multi-Line toolMulti-Line toolMulti-Line toolMulti-Line tool

1. In Page view, select the Forms Multi-Line tool from the Form toolbar.

2. Draw a rectangle on the form.

3. Set the Forms Multi-Line properties.

✦ Name. Type the argument for this field that’s passed to the CGI script 
processing the form.

If you’re using the Form Handler, use a number indicating the object’s order 
in the output text.

✦ Text. Type text to appear in the field by default. This text is submitted as the 
response if the site visitor doesn’t replace it.

✦ Visible length. Enter a number to define the width of the text box by 
specifying the number of characters visible in the field.

✦ Visible height. Enter a number to define the number of lines visible in the 
field.

4. To label the field, use the Text tool.

Type text to appear in the field by default

Argument passed to the script processing the form
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Adding Radio Buttons
Use radio buttons when you want site visitors to choose one option from a group. 
Clicking one radio button deselects all others in its group. After creating the form as 
described on page 23-2:

Radio Button toolRadio Button toolRadio Button toolRadio Button tool

1. In Page view, select the Radio Button tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. Set the Forms Radio Button properties.

✦ Group name. Type the argument for this group of buttons that’s passed to the 
CGI script processing the form. This should be the same for all buttons in 
the group. If you’re using the Form Handler, use a number indicating the 
buttons’ order in the output text. 

✦ Value sent. Type the argument passed for the button if the site visitor 
selects it. If you’re using the Form Handler, and a visitor selects a button 
named Large in a group named 4, the output text might appear as 4=Large. 

✦ Default. Choose either Selected or Not selected to set the button’s initial state, 
which is returned as the response if the site visitor doesn’t change it. 
Remember that only one radio button in a group can be selected at a time.

4. To label each radio button, use the Text tool.

Value passed if this button is selected

Argument passed for the group to the script 
processing the form. This should be the same 
for all buttons in the group
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Adding Check Boxes
You can provide check boxes for making one or more selections from a group of 
options, or to turn a single option on or off. Unlike radio buttons, any number of 
boxes in a group can be selected at the same time, or site visitors can leave them all 
unselected. After creating the form as described on page 23-2:

Checkbox toolCheckbox toolCheckbox toolCheckbox tool

1. In Page view, select the Forms Checkbox tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. Set the Forms Checkbox properties.

✦ Name. Type the argument for this check box that’s passed to the script 
processing the form. If you’re using the Form Handler, use a number 
indicating the box’s order in the output text.

✦ Value. Type the argument passed for the box if the site visitor checks it. If 
you’re using the Form Handler, and a visitor checks a box named 6 that has 
the value Email, the output text might appear as 6=Email. If the site visitor 
doesn’t check it, no value is sent to the server.

✦ Default. Select either Checked or Unchecked to set the box’s initial status, 
which is returned as the response if the site visitor doesn’t change it.

4. To label each check box, use the Text tool.

Value that’s passed if this box is checked

Argument passed to the script processing the form
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Adding a Combo Box
If a long list of check boxes or radio buttons takes up too much space in your form, 
you can list options in a combo box. Use a scrolling list if you want site visitors to be 
able to select more than one option, which is a space-saving alternative to a group of 
check boxes. Or use a drop-down list for selecting only one option, which is an 
alternative to radio buttons. After creating the form as described on page 23-2:

Combo Box toolCombo Box toolCombo Box toolCombo Box tool

1. In Page view, select the Forms Combo Box tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. Set the Forms Combo Box properties.

✦ Name. Type the argument for this combo box that’s passed to the script 
processing the form. If you’re using the Form Handler, use a number 
indicating the combo box’s order in the output text.

✦ Type. Select whether you want a drop-down list that displays one item at a 
time, or a list box that displays several items in a scrolling list.

✦ Visible height. For a list box, enter the number of visible lines in the box.

✦ Allow multiple selections. For a list box, select this option if you want site 
visitors to be able to select more than one item in the list.

Argument passed to the script for the combo box

Names and values passed for each item in the list
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4. To add items to the list, click the plus (+) button and, in the Enter Value dialog, 
type a name and the value passed to the script for the item. 

✦ Name. Type the name passed for this item, which is also the name that 
appears in the list.

✦ Value. Type the value passed if the item is selected.

✦ Selected by Default. Check this option if you want this item initially selected. 
Unless you’re creating a list box and you select Allow multiple selections, 
only one item in the list can be selected.

5. To label the list, use the Text tool.

To remove items from the list, select the item and click the minus(-) button. Use the 
arrow buttons to rearrange the order of items in the list.

Adding Submit, Reset, and Custom Buttons
After adding objects for collecting data from site visitors, you must add a Submit 
button to send the data to your Web server. You can also supply a Reset button so 
visitors can clear the form and start over. And you can add a custom button that 
runs a script on the visitor’s browser; for example, to calculate shipping for a 
purchase or to validate that the right information is entered in a field. To make the 
interaction with the server work, you can use the NetObjects Fusion Form Handler 
or specify a custom CGI script.

Note: If you’re using the Form Handler component to send form responses in an email or to a 
text file, create your Submit button as described in “Submitting Data to a Text File” on 
page 23-13.

After creating the form as described on page 23-2:

Name that appears in the list

Value passed if this item is selected
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Forms Button toolForms Button toolForms Button toolForms Button tool

1. In Page view, select the Forms Button tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. Set the Forms Button properties.

✦ Name. Use the name your CGI script references.

✦ Text. Type the button label text in the field.

✦ Image. To use a picture as a label, select Image, click Browse, and choose an 
image file from the Picture File Open dialog.

✦ Type. Choose a button type:

✧ Submit creates a button that sends the site visitor’s responses to the Form 
Handler or CGI script on the server. 

✧ Reset creates a button that reverts to the form’s initial settings.

✧ Button creates a custom button that runs the script you add using the 
HTML button.

✦ HTML. Opens the Object HTML dialog so you can add a script that runs 
when site visitors click the custom button. See “Accessing an Object’s 
HTML” on page 26-8.

The button label can be text or a picture

Select Button to create a custom button

Click here to attach a script defining what a 
custom button does
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Submitting Responses as Plain Text
You can have responses submitted as plain text in an email or to a file on the Web 
server using the Form Handler component. When you use the Form Handler, you 
don’t have to provide your own CGI script, the Form Handler provides it for you. 

Note: Using the Form Handler component might require configuration of your Web server. To 
find out what’s required, see the usage note at www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com.

Submitting Data to a Text File
To use the Form Handler component to copy site visitors’ responses to a text file on 
your Web server, use the component tool to create the form’s Submit button. After 
creating the form as described on page 23-2:

Form Handler toolForm Handler toolForm Handler toolForm Handler tool

1. In Page view, select the Form Handler tool from the NetObjects Fusion 
Components toolbar, and draw a rectangle on the form.

2. Set the Form Handler properties.

✦ Button Name. Type another name for the button’s label, or accept Submit.

✦ Publish to. From the drop-down list, choose the type of Web server you’re 
publishing to: Windows, Mac, UNIX, or Email. If you chose Email, see 
“Submitting Data in an Email.”

✦ Success URL. Double-click this row and in the Link dialog, select the page to 
display when a visitor correctly completes the form. Click the Link button.
Designing and Implementing FormsDesigning and Implementing FormsDesigning and Implementing FormsDesigning and Implementing Forms 23-13



   

Submitting Responses as Plain Text

          
✦ Error URL. Double-click this row and in the Link dialog, select the page to 
display when submission fails, for example, if the visitor doesn’t fill in a 
required field.

✦ Output File. Type a name for the file you want responses copied to. Do not 
specify a path. 

✦ Perl Path for UNIX. If you’re publishing to a UNIX server, type the path to the 
Perl application on the server. Perl 5 is required on the server.

✦ CGI-Bin Directory. Type the path to the directory on the Web server where the 
CGI scripts provided by Form Handler should be copied. This directory 
must be in the Publish to directory or lower in the directory hierarchy.

✦ Abs. Storage Directory (Windows only) or Storage Directory. Type the path to the 
directory on the server where you want the server to put the output file.

✦ Required Fields. For each field, choose whether a response is required (True) 
or not (False) for a submission to be successful. If you mark a field True, and 
visitors don’t fill it in, they see the Error URL when they submit the form.

If any object in your form isn’t listed in the Form Handler Properties palette, 
you might have named it incorrectly. See “Naming Form Objects” on 
page 23-5.

Submitting Data in an Email
You can also use the NetObjects Form Handler component to copy site visitors’ 
responses into an email to any address you specify.

Form Handler toolForm Handler toolForm Handler toolForm Handler tool

1. In Page view, select the Form Handler tool from the Component toolbar, and 
draw a rectangle on the form for the Submit button.

2. On the Form Handler Properties palette, click the Publish to row and select 
Email.
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3. Enter the email address, and relabel the button if you want.

✦ Button Name. To change the button’s label, click in the Button Name row and 
type a name in the Form Handler text field. 

✦ Publish to. Choose Email from the drop-down list if you have not already 
done so.

✦ Email. Click and type the email address to which responses will be sent.

Processing Data with a CGI Script 
To process form responses other than by outputting text using the Form Handler 
component, use a custom CGI script. A CGI script is a program that controls a 
program on your Web server. Using a CGI script, you can format responses for a 
particular application, summarize them on a page that’s returned to the site visitor, 
or do practically anything else with the data.

Note: Not all administrators let you install CGI scripts on their servers. Some provide standard 
CGI scripts for you to use, and a few don’t support CGI at all.

1. In Page view, click anywhere in the form except on a form object.

2. On the Properties palette, click the Settings button.

For a text box form, look for the Settings button on the Text Box tab. For other 
forms, look on the General tab.

Select a Form Handler property

Enter the property value in this field
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The Form Settings dialog appears.

3. Specify:

✦ Form Name. Type an arbitrary name for the form. This is required by some 
browsers. 

✦ Action. Type the URL to the CGI script on a server. If the CGI script is already 
on the server, enter its URL here; for example:

http://www.host.com/myaccount/fusionproject/assets/cgi-bin/myscript.cgihttp://www.host.com/myaccount/fusionproject/assets/cgi-bin/myscript.cgihttp://www.host.com/myaccount/fusionproject/assets/cgi-bin/myscript.cgihttp://www.host.com/myaccount/fusionproject/assets/cgi-bin/myscript.cgi

Note: Normally, NetObjects Fusion publishes custom CGI scripts to the cgi-bincgi-bincgi-bincgi-bin 
directory specified in Publish view. If your server’s configuration requires 
publishing scripts somewhere else, you must use the Advanced Settings 
dialog in Publish view to specify that location in the CGI script field. This 
applies only to custom CGI scripts, not to the Form Handler. See “Creating 
Aliased Folders and Setting the CGI-Bin Directory” on page 28-16.

If the CGI script isn’t already on the server but needs to be published along 
with your site’s assets, click Browse and select the script file to be published 
from the Open dialog. This file appears in the Action field. NetObjects 
Fusion adds the file as an asset and puts it in the CGI bin directory.

When visitors click Submit, the server executes the CGI script at this URL. 

Note: If the URL isn’t to your server’s cgi-bincgi-bincgi-bincgi-bin folder, you also have to customize your 
site’s published directory structure by renaming cgi-bincgi-bincgi-bincgi-bin appropriately. See 
“Customizing Your Directory Structure” on page 28-19.

✦ Method. Choose a method for sending form data to the Web server:

✧ Post, which is the preferred method, sends data as a standard stream of 
name=value pairs, separated by an ampersand (&).
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✧ Get sends data using environment variables. Use Get with care, as some 
servers truncate data sent via this method.

✦ Encoding Type. If your server requires data to be encoded in a particular 
format, such as MIME or BinHex, type the format here.

4. Click OK.

Adding Hidden Fields
If a CGI script is processing your form, you probably need to use hidden fields to 
pass additional information to it, such as which fields must be filled out to display 
the success page or where to return data once it’s been processed. Site visitors don’t 
see these fields, but the values are submitted to the script with form responses.

1. In Page view, click anywhere in the form except on a form object.

2. On the Properties palette, click the Settings button.

For a text box form, look for the Settings button on the Text Box tab. For other 
forms, look on the General tab.

The Form Settings dialog appears.

3. Add names and values for each hidden field in the Form Settings dialog.
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✦ To add a field, click the plus (+) button, then enter a name and value for the 
field in the Enter Value dialog.

✦ To remove a field, select it and click the minus (–) button.

✦ To reorder fields in the list and define their order in the submitted data, 
select a field and click the up or down arrow.

4. Click OK.

If you’re using the Form Handler component to process a form, don’t enter hidden 
fields yourself. The Form Handler enters the fields it needs.
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Components are pre-built mini-applications that add interactivity to your site 
without custom programming or scripting. Three types of components are available 
in NetObjects Fusion 4.0: Site wizards, Publish components, and Page components. 
The component’s type dictates where it appears within NetObjects Fusion.

Internal components are installed when you install NetObjects Fusion. You can also 
install third-party components. Some, such as NetObjects Fusion Connector for 
Allaire Cold Fusion and NetObjects Fusion Components for IBM HotMedia, are 
included with NetObjects Fusion 4.0. As other components are developed and 
released you can purchase them at the NetObjects online store at 
www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com.

If you are a software developer and want to create your own NetObjects Fusion 
Components, sometimes called NFXes, you can use the NetObjects Component 
Development Kit (CDK), available for free from NetObjects. You can download the 
CDK from the NetObjects site at www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com. 

Note: You cannot preview components in NetObjects Fusion. When you add a component to a 
page and preview, you see a placeholder graphic. To see how the component works, 
you must publish the site. 

This chapter explains:

✦ Adding NetObjects Fusion Components to a page

✦ Setting component properties for the client site
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About Components
Components are pre-built mini-applications that add interactivity to your site 
without custom programming or scripting. There are three types of components in 
NetObjects Fusion: Site wizards, Publish components, and Page components. The 
component’s type dictates where it appears within NetObjects Fusion.

✦ You access Site wizards by selecting Launch Site Wizard from the File menu in 
Site view. Generally, Site wizards help you create a SiteStructure based on your 
responses to a series of questions. The resulting site has components and other 
objects already placed on the page. See “Starting with a Site Wizard” on 
page 3-4.

✦ Publish components are listed on the Components tab of the Publish Setup 
dialog. Publish components are used to post-process the HTML generated by 
NetObjects Fusion or to change NetObjects Fusion’s FTP capabilities. See 
“Publishing Components” on page 28-19.

✦ Page components appear on toolbars in Page view. You use the tools to place 
components on your pages. Page components are likely to be used to configure a 
single page or object on the page.

Internal components are automatically installed when you install NetObjects 
Fusion. The 12 internal components appear on the NetObjects Fusion Components 
toolbar in Page view. Eleven of these internal Page components are discussed in this 
chapter; the Form Handler component is discussed in “Submitting Responses as 
Plain Text” on page 23-13.

In addition, you can install third-party components included with NetObjects 
Fusion 4.0, such as NetObjects Fusion Connector for Allaire Cold Fusion and 
NetObjects Fusion Components for IBM HotMedia. As other components are 
developed and released you can purchase them at the NetObjects online store at 
www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com. 

Depending on their type, third-party components are installed in the appropriate 
place in NetObjects Fusion. Additional component toolbars become available in 
Page view when you install a third-party Page component. For information about 
using some of the third-party components, see Building Business Web Sites; for 
additional information check www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com.
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Adding a Rotating Banner
You can use the Ad Banner component to display a series of images within a banner. 
You determine which images display, associate a transition with each image, set the 
amount of time each image is displayed, and specify a URL linked to each image.

NetObjects Fusion supports the most popular graphics formats used on the Web, 
including .gif .gif .gif .gif and .jpeg .jpeg .jpeg .jpeg. See “Choosing an Image Format” on page 13-2.

To add an Ad Banner:

Ad Banner toolAd Banner toolAd Banner toolAd Banner tool

1. In Page view, select the Ad Banner tool from the Components toolbar.

2. Draw a box on the page where you want to place the Ad Banner.

An Ad Banner placeholder appears on the page, and the Ad Banner Properties 
palette appears.

3. Specify the Banner Type.

✦ Image Size. The Ad Banner is the same size as the images you select.

✦ Standard Banner Size. Click Banner Size and choose from the drop-down list.

✦ Custom. Enter a width and height for the Ad Banner.

4. Enable or disable Automatic Resizing. 

If Automatic Resizing is disabled, you must choose images that are the same size. 
If Automatic Resizing is enabled, Ad Banner resizes the smaller images to match 
the largest image. For best results, use images that are the same size.

5. Set Pause Time to control how long each image is displayed.
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6. Enter the total number of images you want to use. You can use from 1 to 50 
images.

7. To select an image, double-click the Image row, select the image from the Picture 
File Open dialog, and click Open.

8. Double-click the URL for Image row and in the Link dialog select a type of link 
for the image. See “Creating Links” on page 18-2.

9. Specify the link information and click Link.

10. Click the Transition row and select a transition from the drop-down list. You 
can choose:

✦ Column to draw increasingly larger columns of the new image onto the old 
image. The new image appears to slide in from behind the old image.

✦ Fade to change one image into another by drawing a set of random pixels 
from the new image onto the old image.

✦ Rotate to make it appear as though one image is rotating upward from below 
the other image.

✦ Smash to drop the new image onto the old one. The old image appears to 
crumble under the weight of the new image.

✦ Tear to make it appear as though the old image is ripped away to reveal the 
new image.

✦ Unroll to place the new image on top of the old image and unroll it.

When the site displays in the browser, the sequence begins with a random image 
and its associated transition.

11. Repeat steps 7 through 10 for each image you want to rotate into the Ad Banner.

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Adding a Message Board
You can create a Message Board on your site by adding the Message Board 
component to a page. The Message Board is also called the BBS or BBS component. 

When site visitors click the Message Board button, the Message Board appears in a 
new browser window. Visitors can read messages organized by thread, subject, 
author, or time; expand or collapse the view; post new messages; and reply to 
messages.

Note: The Message Board component does not work if cookies are turned off in the site 
visitor’s browser. 

You can have only one Message Board per site. For the Message Board to run 
properly, your Web server must be able to run CGI scripts, and the site visitor’s 
browser must support the Netscape JavaScript standard. Before you can view the 
Message Board, you must complete the server-side setup described in usage notes 
available at www.netobjects.com/supportwww.netobjects.com/supportwww.netobjects.com/supportwww.netobjects.com/support.

Note: For UNIX and Macintosh servers, Perl5 must be installed for the CGI scripts to run. 

Site visitors can 
select how to display 
messages 
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Some components, such as the Message Board and Form Handler, generate files 
when the site visitor uses them. When you publish your site, NetObjects Fusion 
attempts to set up the proper file and directory permissions using the CHMOD 
command. Some servers do not allow this permission change. The Message Board 
will not work if it cannot write to certain files and directories. This situation is more 
common with UNIX servers. Contact your ISP to find out if CHMOD through FTP 
is implemented on the server. 

To add a Message Board and set its properties:

Message Board toolMessage Board toolMessage Board toolMessage Board tool

1. In Page view, select the Message Board tool from the Components toolbar.

2. Draw a box on the page to indicate where you want to place the Message Board.

The Message Board button appears on the page, and the Message Board 
Properties palette appears. 

3. To specify where Message Board files are stored, double-click the Subdirectory 
row, type the new location in the Message Board field, and click the check mark. 

The default is BBS. NetObjects Fusion creates the directory in your site’s base 
directory, which is the directory where you want to publish the site. 

4. To specify the title that appears in the title bar of the Message Board window, 
double-click the Page Title row, type the title, and click the check mark.

The Page Title cannot include a single quote.

5. To select the operating system platform on which the server is running, click the 
Publish to row, then select the platform from the drop-down list. 
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This option determines if the Perl5 CGI script, the Mac Perl5 binaries, or NT 
CGI binaries are uploaded to the server. 

Note: If you are publishing your site to a Macintosh Web server, Message Board 
Macintosh CGI requires a Webstar 2.0 Web server running on a PowerPC 
computer with Mac Perl5 installed.

6. If you are publishing to a UNIX server, Perl5 must be installed on the server. 
Click the PerlPath for UNIX row, then type the path name to the Perl 5 
interpreter.

The path name is relative to the base publishing directory. You can obtain the 
path name from your ISP. Or, if you want to get the Perl5 path yourself, you can 
type which perlwhich perlwhich perlwhich perl or which perl5which perl5which perl5which perl5 at the UNIX command-line prompt.

7. To specify the CGI-bin directory where the BBS CGIs are to reside, double-click 
the CGI-bin Directory row, type the path name for the directory, and click the 
check mark. You can obtain the path from your ISP. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Adding DynaButtons
DynaButtons are Java buttons that link to another page on your site, other sites, or a 
specific file. You can place DynaButtons anywhere on your pages and assign up to 20 
buttons to a DynaButton bar. In addition, you can assign up to 20 sub-buttons to 
each DynaButton. You can create sub-buttons for navigating from a main page to 
pages at a lower level. 

When you publish the site, each button appears in the browser in the primary 
button style selected for the site and displays the name of the page to which it is 
linked. You cannot assign custom images to DynaButtons. The button’s style is 
determined by your SiteStyle. To use custom images for buttons, use the Picture 
Rollover tool.

Because a DynaButton is an active link, the button appears active when a site visitor 
moves the mouse pointer over the DynaButton or clicks the button. The site visitor 
can click the DynaButton to go to the appropriate link.

To add DynaButtons and set properties:
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DynaButtons toolDynaButtons toolDynaButtons toolDynaButtons tool

1. In Page view, select the DynaButtons tool from the Components toolbar.

2. Draw a box on the page to indicate the DynaButtons’ location. 

A button placeholder labeled DynaButtons appears on the page, along with the 
DynaButtons Properties palette. 

3. Select the buttons’ orientation—vertical or horizontal—from the drop-down 
list.

4. Click the Number of Buttons row, specify how many buttons you want, and click 
the check mark. 

5. Double-click the number row, such as Button 1. 

The Link dialog appears. You can link this button to another page, file, smart 
link, or external link. See “Creating Links” on page 18-2. 

6. Create the link for the button and click Link. 

The details of the link appear in the right column of the button row. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Adding Sub-Buttons
If a DynaButton contains sub-buttons, the sub-buttons appear when a site visitor 
clicks the DynaButton. The sub-button shows information about the link associated 
with the button. For example, if a sub-button is linked to an external link, the sub-
button displays the asset name for the external link. 

To add sub-buttons and set the properties:
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1. In Page view, create a DynaButton as described in “Adding DynaButtons” on 
page 24-7. 

2. Double-click the Use Sub-Buttons row.

Yes appears in the right column and NetObjects Fusion adds a Number
Sub-Buttons row under the Use Sub-Buttons row.

3. To specify the number of sub-buttons, select the Number Sub-Buttons row, 
enter the number of buttons, and click the check mark. 

The limit is 20 sub-buttons. The appropriate number of sub-button rows 
appear, numbered in sequential order. 

4. To define the link for each sub-button, double-click the appropriate 
sub-button row, such as Sub-Button 1,2. The first number, in this case the 1, 
identifies the button for which the sub-button was created, and the second 
number is number of the current sub-button. 

The Link dialog appears. See “Creating Links” on page 18-2.

5. Create the link for the sub-button and click Link.

6. Repeat steps 4 and 5 to create and define each sub-button. 

Double-click here and name the 
button that appears on the 
published site
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Loading Pictures onto Your Site
Use the NetObjects Picture Loader Component to load an image from a site other 
than your own. You can use this to place advertising banners if the banners are 
located on a server other than your Web server. 

To load a picture from an external source:

Picture Loader toolPicture Loader toolPicture Loader toolPicture Loader tool

1. In Page view, select the Picture Loader tool from the Components toolbar.

2. Draw a box on the page to indicate where you want to place the picture.

A picture placeholder appears on your page, and the Picture Loader Properties 
palette appears.

3. Click the Image URL row and type the URL where the picture is located.

Type the complete URL. For example: http://www.netobjects.com/http://www.netobjects.com/http://www.netobjects.com/http://www.netobjects.com/
announcements/assets/images/homepagemainart.gif.announcements/assets/images/homepagemainart.gif.announcements/assets/images/homepagemainart.gif.announcements/assets/images/homepagemainart.gif.

4. Click the check mark. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Adding a Go Menu
You can use the Go Menu component to easily create a drop-down navigation 
menu, with each menu item corresponding to a single page in the site.

Go Menu toolGo Menu toolGo Menu toolGo Menu tool

1. In Page view, select the Go Menu tool from the Components toolbar.

2. Draw a box on the page where you want to place the Go Menu.

A Go Menu appears on the page, and the Go Menu dialog appears.

3. On the Menu Items tab, select a link type from the drop-down list and set up a 
link to the items you want to include on the Go Menu. See “Creating Links” on 
page 18-2.

4. From the list on the left, select the specific items you want to include on the Go 
menu and click the right arrow to move them into the Link column.

✦ To change the way an item is listed on the menu, double-click it in the Menu 
Item Name column and type a new name.

✦ Select an item and click the Move up or Move down button to change the 
order of items on the menu.

✦ To delete an item, select it and click Delete.
Using NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion Components 24-11



   

Adding a Go Menu

    
5. Click the Button Format tab.

6. Select one of the three formats. An example of each format is shown on the left.

7. Click OK.

8. To change the items included on the Go Menu or the button format, use the Go 
Menu Properties palette.

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Adding Pictures That Roll Over
You can use the Picture Rollover component to create JavaScript rollovers for any 
image on your site. Because this component uses JavaScript, the colors of your 
images are not compromised. 

To view a rollover picture, site visitors must use Netscape Navigator 3.x or 4.x or 
Microsoft Internet Explorer 3.x or 4.x. You can also create rollovers for any image 
using NetObjects Fusion actions; however, this only works in Netscape Navigator 
4.x or Microsoft Internet Explorer 4.x. 

To add pictures that roll over:

Rollover Picture toolRollover Picture toolRollover Picture toolRollover Picture tool

1. In Page view, select the Picture Rollover tool from the Components toolbar.

2. Draw a box on the page where you want to locate the pictures.

A picture placeholder appears on your page, and the Picture Rollover Properties 
palette appears.

3. To specify the first image to display, double-click the Initial image row, select the 
image from the Picture File Open dialog, and click Open. 
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The Picture Rollover Properties palette changes and displays two new rows—
Mouse over image and Mouse out image.

4. To specify the image to display when the mouse pointer moves over the image, 
double-click the Mouse over image row, select the image from the Picture File 
Open dialog, and click Open.

5. To specify which image to display when the site visitor moves the mouse pointer 
off the picture, double-click the Mouse out image row, select the image from the 
Picture File Open dialog, and click Open. 

6. To link the image to a specific URL, double-click the Link URL row. 

The Link dialog appears. Because the entire image is treated as one object, you 
can link it to another page, file, smart link, or external link, such as another site. 
See “Creating Links” on page 18-2.

7. Create the link for the image and click Link. 

The details of the link appear in the right column of the button row. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
24-14 Using NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion Components



 

Adding Rotating Pictures

          
Adding Rotating Pictures
You can use the Rotating Picture component to display different pictures in 
succession in the same place on the page. For example, you could rotate among 
several images that advertise new products or current sale items. 

To add a rotating picture, you specify the image to display and the number of 
seconds to pause before displaying the next picture in the sequence. You can also 
assign a link to each picture.

NetObjects Fusion supports the most popular graphics formats used on the Web, 
including .gif .gif .gif .gif and .jpeg .jpeg .jpeg .jpeg. See “Choosing an Image Format” on page 13-2.

To add pictures that rotate and set their properties: 

Rotating Picture toolRotating Picture toolRotating Picture toolRotating Picture tool

1. In Page view, select the Rotating Picture tool from the Components toolbar.

2. Draw a box on the page to indicate where you want to place the picture.

A rotating picture placeholder appears on the page, and the Rotating Picture 
Properties palette appears.

3. To set the number of seconds each picture is displayed before moving to the next 
one, click the Pause Time (Seconds) row, specify the number of seconds, and 
click the check mark.

4. To set the number of different images to display in the rotating picture, double-
click the Number of Images row, specify the number of images, and click the 
check mark. 

You can display up to 50 images for your rotating pictures. An Image row and 
URL for Image row for each image you specified appears. 
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Note: The images you select for rotating pictures are resized to the size of the first 
image you select. For best results, use images that are the same size.

5. Double-click an Image row, select an image file from the Picture File Open 
dialog, and click Open.

6. To create a link for this image, double-click the image’s URL for Image row, then 
in the Link dialog select the type of link. See “Creating Links” on page 18-2.

7. Specify the appropriate information for the link and click Link.

8. Repeat steps 5 through 7 for each image.

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Directing Visitors to a Browser-Specific Page
The Screen Door component detects the visitor’s browser type and redirects the 
visitor to a page targeted for that specific browser. You can choose Netscape 
Navigator 4.0 and up, Microsoft Internet Explorer 4.0 and up, Netscape Navigator 
3.0, or Microsoft Internet Explorer 3.0. You select an image to represent the link on 
your page and then choose the specific pages to link to.

You can only include one Screen Door per page.

Screen Door toolScreen Door toolScreen Door toolScreen Door tool

1. In Page view, select the Screen Door tool from the Components toolbar.

2. Draw a box on the page where you want to place the Screen Door.

A Screen Door placeholder appears on the page, and the Screen Door Properties 
palette appears.
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3. Choose a Method. 

✦ JavaScript (client) works for all browsers except the few that do not support 
the META tag.

✦ ASP (server) requires that your Web server is ASP compliant.

4. Choose to pause or not pause before redirecting a site visitor.

5. Set up appropriate links for the default page and for each individual browser 
type. See “Creating Links” on page 18-2.

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Adding a Site Map Button
Site Mapper is a Java navigation applet that site visitors can use to create an 
interactive map of a site. If your site is large, Site Mapper simplifies navigation by 
providing a detailed view of the site’s levels. Using the site map, visitors can jump 
directly from page to page without using the page navigation controls.

The Site Map button provides three ways for visitors to view the site:

✦ By structure, similar to Site view in NetObjects Fusion. 

✦ In an outline view 

✦ By searching for certain words

This site map shows a 
site by structure 

The site visitor can 
use these buttons to 
view the site three 
different ways 

Display 2, 3, 4, or all 
levels of the site 

The size of each node 
adjusts so that the 
entire tree fits in the 
window. With a large 
site, the nodes may be 
too small to use
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To add a Site Map button and set its properties:

1. In Page view, display the page where you want to add the Site Mapper 
component.

If you place the Site Mapper component in a MasterBorder, any page can be 
displayed. 

Site Mapper toolSite Mapper toolSite Mapper toolSite Mapper tool

2. Select the Site Mapper tool from the Components toolbar.

3. Draw a box on the page to indicate the location of the Site Map button.

The Site Map button appears on the page, and the Site Mapper Properties 
palette appears. 

4. To change the image displayed for the Site Map button, double-click the Image 
row, then select the image file you want from the Picture File Open dialog. 

The selected image appears on the page.

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”
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Using Ticker Tape 
Often, you want to announce a special promotion or event on your site. You can use 
the Ticker Tape component to add a scrolling message to a page and set the colors 
and speed used to display the message.

To add a Ticker Tape display and set its properties:

Ticker Tape toolTicker Tape toolTicker Tape toolTicker Tape tool

1. In Page view, select the Ticker Tape tool from the Components toolbar.

2. Draw a rectangle to indicate the location of the Ticker Tape display. Make the 
rectangle the size you want for the message background.

The Ticker Tape placeholder appears on the page, and the Ticker Tape Properties 
palette appears.

3. To display multiple messages in the Ticker Tape display, double-click the 
Number of Messages row, enter the number, and click the check mark.

You can specify up to 50 messages. A new Text for Message and URL for Message 
row appears for each message you specified. 

4. Click the Text for Message row, and type the message in the Ticker Tape text 
entry field. Click the check mark. 

5. Double-click the URL for Message row.

The Link dialog appears. See “Creating Links” on page 18-2. 

6. Create the link for this message and click Link. 

7. Repeat steps 4 through 6 for each message in the Ticker Tape display. 
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8. Click the Speed row, and specify the scrolling speed (1 to 50) of the message. 

Specify a higher number to make the message scroll faster; a lower number to 
make the message scroll slower.

9. To set the frame, background, and LED colors, click the appropriate row, then 
select the color you want from the drop-down list. 

✦ Frame Color determines the border color of the Ticker Tape display. The 
default is gray. 

✦ Background Color determines the background color of the Ticker Tape 
display. The default is black. 

✦ LED Color determines the color of the message text. The default is green. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

Adding Time Based Pictures
You can use the Time Based Picture component to display different pictures at the 
same location on your page at different times. You select the image to display and 
specify the hour at which to display it. The browser automatically displays the 
picture at the specified time. The picture remains on the page until it is time for the 
next picture to be displayed. 

NetObjects Fusion supports the most popular graphics formats used on the Web, 
including .gif.gif.gif.gif and .jpeg.jpeg.jpeg.jpeg. See “Choosing an Image Format” on page 13-2. 

To add time based pictures and set the properties:

Time Based Picture toolTime Based Picture toolTime Based Picture toolTime Based Picture tool

1. In Page view, select the Time Based Picture tool from the Components toolbar.

2. Draw a box on the page where you want to locate the picture.
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A picture placeholder appears on your page, and the Time Based Picture 
Properties palette appears.

3. Click the Number of Images row and specify the number of images you want to 
rotate.

You can use up to 24 images. NetObjects Fusion adds an Image, Start Time for 
Image, and URL for Image row for each image.

4. To select an image, double-click the Image row, select the image from the Picture 
File Open dialog, and click Open. 

5. Double-click the URL for Image row, then select the type of link.

See “Creating Links” on page 18-2.

6. Specify the link information and click Link. 

7. Click the Start Time for Image row and select a starting time from the drop-
down list.

The start time determines when the image is displayed on your site. You can 
select one-hour increments from 12 a.m. to 12 p.m. The image is displayed until 
the next image’s starting time. Be sure images have consecutive starting times.

8. Repeat steps 4 through 7 for each image you add. 

You can add an action to an object using the Actions tab. See Chapter 21, “Building 
Dynamic Pages.”

The number of 
images is 3 by 
default 
Using NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion Components 24-21



 

24-22

 

Using NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion ComponentsUsing NetObjects Fusion Components

 

Adding Time Based Pictures



 

C

 

H

 

A

 

P

 

T

 

E

 

R

 

 

 

2 5

         
Data Publishing 25
NetObjects Fusion makes it easy to publish information such as employee 
directories, product and service catalogs, and event schedules. You can enter, 
manage, and store this information as records either in your NetObjects Fusion site, 
or in an external application such as a database or spreadsheet.

To publish the data, you specify its source and create a layout for the pages that will 
display it. NetObjects Fusion uses your Layout to create a separate page for each 
record, and can automatically provide site visitors with buttons to navigate between 
them.

This chapter describes how to publish data using NetObjects Fusion, including:

✦ Static and dynamic data publishing

✦ Creating a data object

✦ Storing data internally

✦ Using data stored externally

✦ Creating a data list

✦ Creating stacked pages
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Static and Dynamic Data Publishing
NetObjects Fusion supports two kinds of data publishing: static and dynamic.

✦ Static data publishing takes any kind of data—text, pictures, multimedia files, 
and so on—from a database or spreadsheet. NetObjects Fusion publishes the 
data on your site, where it remains unchanged—static—until the source data is 
changed and the site is re-published. Static data publishing, which is the focus of 
this chapter, uses data objects that derive data from internal or external sources.

✦ Dynamic data publishing makes it possible to refresh the data each time a visitor 
goes to the site. When the browser requests the data, it is assembled on the spot; 
it does not depend on re-publishing the site.

Dynamic data publishing requires third-party components. To learn how to use 
the third-party data publishing components included with NetObjects Fusion 
4.0, see Building Business Web Sites. Third-party publishers regularly release new 
components for NetObjects Fusion. For the latest information, visit the 
NetObjects Web site at www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com. To purchase additional third-party 
components, visit the NetObjects online store.

Storing Data with NetObjects Fusion
Using the data publishing capabilities of NetObjects Fusion, you can store text and 
pictures in a database internal to your site, or import data from external sources 
such as Microsoft Excel, Access, and ODBC databases. In both cases, NetObjects 
Fusion publishes your data in standard HTML pages. This makes it easy to add 
listings, such as product and service catalogs, employee directories, and event 
schedules to your site.

You use the following objects when you publish data in NetObjects Fusion:

✦ Data objects. A data object is a collection of data fields that define what data will 
be published. Creating a data object is the essential first step in adding internal 
or external data to your site. The data object becomes an asset of your site. When 
you reference records internally, you must specify the data fields you want to 
store. When you store records from external data, NetObjects Fusion includes all 
fields available in the source.

✦ Data fields. Defined in the data object, data fields appear on stacked pages and 
are the containers for the data in your site. You can arrange and label data fields; 
the arrangement appears on all stacked pages.
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✦ Data lists. The data list appears on the parent page of the stacked pages that 
contain the actual data. The data list functions as a table of contents for the 
internal or external data in your site. You select the fields you want to display as 
column headers in the list. The field data from either the internal or external 
source populates the data list when you publish.

✦ Stacked pages. Each record in your database appears on a separate stacked page 
below the page containing the data list. Stacked pages are not siblings of each 
other, but instead are iterations of the same page, containing the fields defined 
in your data object.

The following illustration shows the relationship of these objects for internal and 
external databases.

For example, you could publish a backpack catalog on your site with a record for 
each backpack. Each row in the data list lets the site visitor navigate to the stacked 
page that contains the corresponding backpack’s description, photo, and price.

Data object with internal data source Data object with external data source
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To create the backpack catalog, your first step is to create a backpack data object. 
You can define a data object once and use it in different filtered data lists. For 
example, you can create one data list of all the backpacks in your database. With the 
same data object, you can create additional data lists of internal frame backpacks, 
external frame backpacks, frameless backpacks, and so on.

If you create a data object from an external source—for example, from a Microsoft 
Access database—and then update or change the external source, you must 
republish the site to update the data. For example, suppose your backpack data 
object referenced 50 records originally and the external database is increased with 
25 new records. After you republish your site, the data object references 75 records, 
the backpack data list contains 75 rows, and there are 75 stacked pages.

After you create a data list on a page, NetObjects Fusion generates the first stacked 
page. You create the Layout of how all stacked pages look on the first stacked page. 
When you create the Layout of the first stacked page, the remaining stacked pages 
automatically inherit the same Layout. The following illustration shows how the 
data list page and its child stacked pages appear in Site view.

Publishing Data
In general, when you work with data publishing, you follow this process:

1. Create a data object.

2. Create a data list.

3. Design a set of stacked pages.

When you create a data list, you create the stacked page for the data object. On this 
stacked page you create the Layout to be used for all the pages in the stack, including 
the field data you want to display on the page.

✦ If you are storing data internally, you enter the field data on the stacked page 
itself.

Data list page

Stacked pages
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✦ If you are using an external source, the field data is drawn from the external 
database, spreadsheet, or ASCII text file.

When you use the Data List tool in Page view, you can perform all three tasks within 
the Data Publishing dialog.

Creating a Data Object
You can create two types of data objects:

✦ Internal data objects reference simple text, formatted text, and picture data fields 
stored within your site.

✦ External data objects import simple text fields from a data field created in a 
program other than NetObjects Fusion. External data sources include external 
databases, spreadsheets, and ASCII text files. Use external data if your database 
is maintained by others who do not use NetObjects Fusion, if you have large 
quantities of data, or if the data is frequently updated. 

Note: Importing external data takes a single table from a database or a single 
worksheet from a program such as Microsoft Excel; it does not import the 
entire database.

The tools for creating the two data object types appear on the Data tools flyout 
on the Advanced toolbar. Use the New External Data Source tool to create a data 
object for external data; use the Data List tool to create a data object for internal 

Create or select a data object

Choose options for the data list

Choose options for stacked pages

Click OK to create the data list and 
stacked pages
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data. After you create an internal data object, use the Data Field tool to add data 
fields to the stacked pages.

Creating a Data Object for Internal Data
Internal data is records and fields stored within your site. You enter internal data 
directly into a stacked page by typing text or numbers and by placing pictures.

You can create a data object in Page view or in Assets view. If you create a data object 
in Page view, you can immediately create stacked pages and start entering data. If 
you create a data object in Assets view, you must return to Page view to create a data 
list and stacked pages.

To create a new internal data object:

Data List toolData List toolData List toolData List tool

1. Display the Data Object dialog:

✦ In Page view, select the Data List tool from the Advanced toolbar, and draw a 
rectangle on the page. In the Data Publishing dialog, click the New button.

✦ In Assets view, click the Data Objects tab and then click the New button on 
the control bar.

New External Data Source toolData List tool

Data Field tool (only available on stacked pages)
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2. Select Internal and enter a name for the data object and comments about it.

NetObjects Fusion uses the data object name in the list of data objects in the 
Data Publishing dialog and in Assets view.

3. Click the plus (+) button to add a field. Fields define the kind of data you can 
enter.

The Data Field dialog appears.

4. Type the field name and select a data type for the field.

✦ Formatted Text. Characters in these fields can be formatted individually. 
Formatted text fields can contain paragraph breaks and line breaks and can 
exceed 255 characters. You cannot sort on formatted text fields.

✦ Simple Text. All characters in these fields share the same formatting 
characteristics. Simple text fields cannot contain paragraph breaks or line 
breaks and cannot exceed 255 characters. You can sort on simple text fields.

✦ Image File. These fields can contain an image in one of these formats: .bmp.bmp.bmp.bmp, 
.gif.gif.gif.gif (animated, embedded, interlaced), .jpg.jpg.jpg.jpg, .pct.pct.pct.pct, .pcx.pcx.pcx.pcx, .png.png.png.png, .psd.psd.psd.psd, .tga.tga.tga.tga, or .tif.tif.tif.tif. 
You can sort on image file fields. NetObjects Fusion uses the file names to 
sort the image files.

Note: Take special care as you define fields. Once you click OK in the Data Field 
dialog, you cannot delete the field from the data object. 

5. Click OK.

6. Repeat steps 3, 4, and 5 to add fields.
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7. When you are done, click OK in the Data Object dialog.

The data object is now an asset of your site, and you can continue as follows:

✦ If you’re working in Page view, the Data Publishing dialog is still open. You can 
select fields and format the data list as described in “Creating a Data List” on 
page 25-13, and lay out your stacked pages as described in “Creating Stacked 
Pages” on page 25-16.

Data List toolData List toolData List toolData List tool

✦ If you’re in Assets view, go to Page view, select the Data List tool from the 
Advanced toolbar, and draw a rectangle on the page. In the Data Publishing 
dialog, select the newly created data object from the drop-down list. Select fields 
and format the data list as described in “Creating a Data List” on page 25-13, 
and lay out your stacked pages as described in “Creating Stacked Pages” on 
page 25-16.

Changing an Internal Data Field Name
1. Go to Assets view.

2. Click the Data Objects tab.

3. Double-click the data object name. 

The Data Object dialog appears.

4. In the Fields list, double-click the name of the field you want to rename. 

The Data Field dialog appears.

5. Type a new name in the Name field and click OK.

6. Click OK. 

Creating a Data Object for External Data
External data exists in local desktop databases or in ODBC data sources. To make 
this data available to your site, you must choose an appropriate driver. NetObjects 
Fusion uses two types of drivers to access external data:

✦ Indexed Sequential Access Method (ISAM) drivers draw data from desktop databases, 
such as Microsoft Access, Paradox®, dBASE®, Microsoft FoxPro®, Microsoft 
Excel, or delimited text files.

✦ Open Data Base Connectivity (ODBC) drivers draw data from Structured Query 
Language (SQL) data sources, such as Oracle and Sybase data files.
25-8 Data PublishingData PublishingData PublishingData Publishing



 

Creating a Data Object

         
A data source is either:

✦ an ISAM driver plus a source data file

✦ an ODBC data source, which is an ODBC driver bound to a database

If your system includes both types of drivers for your application, use the ISAM 
driver, which is faster. In addition, selecting an ISAM driver takes fewer steps.

NetObjects Fusion automatically imports all the fields available in the external 
database file. If a simple text field contains a valid path to an image file, NetObjects 
Fusion asks if you want to make the field an image field. Before you add an external 
data object, make sure you have all the necessary fields. You cannot add fields once 
you create the external data object.

Note: NetObjects Fusion Connector for Allaire Cold Fusion and NetObjects Fusion Connector 
for Microsoft Active Server Pages support dynamic data publishing.

Creating an External Data Object from a Desktop Database
You can draw data from desktop databases such as Microsoft Access, Paradox, 
dBASE, Microsoft Fox Pro, Microsoft Excel, or from delimited text files. Your system 
must include an ISAM driver appropriate for your source. ISAM drivers are 
automatically installed with most desktop databases.

To create an external data object from a desktop database:

New External Data New External Data New External Data New External Data 
Source toolSource toolSource toolSource tool

1. Display the Data Source Type dialog:

✦ In Page View, select the New External Data Source tool from the Advanced 
toolbar, and draw a rectangle on the page.

✦ In Assets view, click the Data Objects tab, and then click New on the control 
bar. In the Data Object dialog, select External and then click the Source 
button.
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2. Select the data file type from the drop-down list.

NetObjects Fusion always lists the Microsoft Access Driver. Additional data 
types are available if ISAM drivers are installed. ISAM drivers are automatically 
installed when you install Microsoft FoxPro, Microsoft Visual FoxPro, Paradox, 
Microsoft Excel, or dBASE. 

Note: If the data is in Microsoft Excel 97 Workbook format, use an ODBC driver. See 
“Creating an External Data Object from a SQL Data Source” on page 25-11.

3. Click the Browse button, locate the database, and open it.

When you click Browse, the Open dialog shows the database files available for 
the selected file type. If the file you select is a multiple-file database or a 
spreadsheet with multiple tabs, the Select dialog appears.

4. Select the file or tab you want to use and click OK.

5. If a simple text field contains a valid windows path to an image file, choose to 
make it a text field or an image field.
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NetObjects Fusion creates the data object and makes it an asset of your site. The 
data object contains all fields in the external source, and takes the name of the 
selected file or tab.

The data object is now an asset of your site, and you can continue as follows:

✦ If you’re working in Page view, the Data Publishing dialog opens or it might still 
be open. You can select fields and format the data list as described in “Creating a 
Data List” on page 25-13, and lay out your stacked pages as described in 
“Creating Stacked Pages” on page 25-16.

Data List toolData List toolData List toolData List tool

✦ If you’re in Assets view, go to Page view, select the Data List tool from the 
Advanced toolbar, and draw a rectangle on the page. In the Data Publishing 
dialog, select the newly created data object from the drop-down list. Select fields 
and format the data list as described in “Creating a Data List” on page 25-13, 
and lay out your stacked pages as described in “Creating Stacked Pages” on 
page 25-16.

Creating an External Data Object from a SQL Data Source
This section describes how you use an Open Data Base Connectivity (ODBC) driver 
to draw data from a Structured Query Language (SQL) data source, such as an 
Oracle data file.

Before you can choose an ODBC data source, you must specifically create the data 
source by binding your data file to a driver. You can do this in the Windows ODBC 
Data Source Administrator, found in the Control Panel as 32bit ODBC. After you 
create the ODBC data source, you can select it in NetObjects Fusion.

If you use MS Office or MS Office Professional, you might already have a set of 
ODBC drivers installed on your system. If you do not use those products, contact 
Microsoft for information.

To create a data object from a SQL data source:

1. Display the Data Source Type dialog:

New External Data New External Data New External Data New External Data 
Source toolSource toolSource toolSource tool

✦ In Page view, select the New External Data Source tool from the Advanced 
Tools toolbar, and draw a rectangle on the page.
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✦ In Assets view, click the Data Objects tab, and then click New on the control 
bar. The Data Object dialog appears. Select External and then click the 
Source button.

2. Click ODBC and then click the Select button.

The Select Data Source dialog appears. It displays all the ODBC data sources 
stored on your computer. You can select an existing data source, or you can 
create a new data source. 

To create a new data source:

➲ Click New in the Select Data Source dialog, and then follow the steps in the 
Windows Create New Data Source wizard. 

To select an existing ODBC source on your system, you can use the File Data Source 
tab or the Machine Data Source tab:

✦ File Data Source. Select from the list of data sources and click OK.

✦ Machine Data Source. Select from the Data Source Name list and click OK. 
Depending on the data source type you choose, the Select Workbook or Select 
Database dialog appears. Follow these steps:

✧ Select a file in the dialog and click OK.

✧ If the source refers to a multiple-file database or a spreadsheet with multiple 
tabs, the Select dialog appears. Select the file or tab and click OK.

NetObjects Fusion creates the data object, gives it the name of the selected 
file or tab, and imports its fields as simple text fields.

If a simple text field contains a valid path to an image file, you can choose to make it 
a text field or an image field.
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The data object is now an asset of your site, and you can continue as follows:

✦ If you’re working in Page view, the Data Publishing dialog is still open. You can 
select fields and format the data list as described in “Creating a Data List” on 
page 25-13, and lay out your stacked pages as described in “Creating Stacked 
Pages” on page 25-16.

Data List toolData List toolData List toolData List tool

✦ If you’re in Assets view, go to Page view, select the Data List tool from the 
Advanced toolbar, and draw a rectangle on the page. In the Data Publishing 
dialog, select the newly created data object from the drop-down list. Select fields 
and format the data list as described in “Creating a Data List” on page 25-13, 
and lay out your stacked pages as described in “Creating Stacked Pages” on 
page 25-16.

Creating a Data List 
Once you create a data object, you can create a data list on any page. You create a 
data list and a set of stacked pages at the same time. NetObjects Fusion 
automatically includes linked data list icons in the first column in the data list. The 
data list thus acts as a table of contents—each row contains data for, and is linked to, 
a single stacked page.

To create a data list:

1. In Page view, display the page on which you want to place the data list.

Data List toolData List toolData List toolData List tool

2. Select the Data List tool from the Advanced toolbar and draw a rectangle in the 
Layout area.

The Data Publishing dialog appears. Select the data object you want to use for 
this data list.
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The fields in the selected data object are listed.

3. Choose a sort field from the drop-down list. For internal data objects, you can 
only sort on simple text or image fields.

Records are sorted in ascending order.

4. To filter the data, click the Set button. You can use simple text fields to filter the 
data. 

The Filter dialog appears.

By default, all available records in the data list and on stacked pages appear. You 
can set up a filter to select a subset of the available records to display. You can 

Current data object

Fields in the table or worksheet in the 
current data object
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create selection criteria that isolate exactly the records you want to appear in 
your data list.

5. Enter your selection criteria and click OK.

If you do not use all three lines, choose end from the drop-down list at the end 
of the last line you use.

6. In the Data List area of the Data Publishing dialog, enter a name for the data list.

7. In the Fields list, select fields to include in the data list by clicking the check 
boxes to the left of the fields.

As a shortcut, you can click the Add All button, which marks all fields for 
display. Typically, however, you display only a subset of fields in the data list and 
display all fields on stacked pages.

8. To link a field to its stacked page, select the field in the Data Publishing dialog 
and click the Link/Unlink button.

A data list automatically includes at the left of each row a navigation button that 
links to the record’s stacked page. When you link a field, your site visitor can 
click either the button or the linked field to jump to the record’s stacked page.

9. To change the order in which fields appear left to right in the data list, click a 
field and then click the up and down arrow buttons.

Continue to select fields and press the up and down arrow buttons until the list 
is in the order you want. 

10. Set the Stacked Page options:

✦ Display all fields places all fields available in the data object in a simple layout 
when NetObjects Fusion creates the first stacked page. Use this shortcut to 
avoid placing fields individually as described in “Designing the Stacked Page 
Layout” on page 25-17.

✦ Add navigation buttons creates smart links to navigation buttons (next/
previous/up) when NetObjects Fusion creates the first stacked page. Use this 
shortcut so you don’t have to create these buttons as described in “Adding 
Navigation Buttons to Stacked Pages” on page 25-19.

The images used for the these buttons—SPNavLeft.gifSPNavLeft.gifSPNavLeft.gifSPNavLeft.gif, SPNavRight.gifSPNavRight.gifSPNavRight.gifSPNavRight.gif, and 
SPNavUp.gifSPNavUp.gifSPNavUp.gifSPNavUp.gif—are in the NetObjects Fusion 4.0\NetObjects SystemNetObjects Fusion 4.0\NetObjects SystemNetObjects Fusion 4.0\NetObjects SystemNetObjects Fusion 4.0\NetObjects System folder.

11. Click OK.
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The data list placeholder appears. Its column heads are the names of the fields 
you selected for display, and a data list button appears at the left of the first row. 
NetObjects Fusion populates the data list only when you preview or publish the 
page. Data never appears in the data list in Page view.

12. Set the Data List properties.

Adjust the settings to change the bullet type, background color, border size, 
spacing of data, and column title display. Drag the column heading borders to 
adjust column width.

When you are satisfied with the appearance of the data list, create a layout for 
the stacked pages as described in “Designing the Stacked Page Layout” on 
page 25-17.

Creating Stacked Pages
Stacked pages correspond to records in a database. When you store information 
internally in NetObjects Fusion, you enter data for one record on each stacked page. 
If you are drawing information from an external data file, each stacked page 
automatically displays information from a record.

Note: You can add or delete stacked pages for internal data as described in “Adding a Stacked 
Page for Internal Data” on page 25-20. To add or delete records for external data, you 
must make the changes in your external database or spreadsheet and then republish 
the site.

Data List icon 
from the current 
SiteStyle

Field names 
identify 
columns of 
data
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Designing the Stacked Page Layout
The stacked page Layout determines the appearance of all the stacked pages. Data 
fields and non-data objects (text, pictures, or other assets) added to the stacked page 
Layout are repeated across all the stacked pages. Layout changes you make to any 
stacked page are automatically applied to all pages in the stack.

If you did not select any stacked page options when you created your data list, your 
stacked page Layout is blank. You can add text and graphic objects to this page, just 
like any other page. The key items to be added, however, are the data fields you 
defined in the data object.

To design stacked pages:

1. Go to Site view or use the Site Navigation window in Page view to navigate to the 
first stacked page.

If you are working with external data, the control bar indicates this is 1 of as 
many records as were imported from the external source. If you are working 
with an internal data object, it indicates this is 0 of 0 because you have not 
created any records.

Data Field toolData Field toolData Field toolData Field tool

2. In Page view, select the Data Field tool from the Advanced toolbar, and draw a 
rectangle in the Layout area of the stacked page. The dashed rectangle represents 
the first field you are adding.

Drawing a data field
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The Data Field dialog appears. The fields available on the Name drop-down list 
are in the data object you selected in the Data Publishing dialog when you 
created the stacked pages.

3. Select a field and click OK.

✦ If you are using external data, NetObjects Fusion displays simple text field 
data from the first record in the data file. 

✦ If you are using internal data and selected an image file field, the field area is 
marked with an X. After you create a new record, you can double-click the X 
to open the Picture File Open dialog, select the file, and then click OK. 

✦ If you are using internal data and selected a simple or formatted internal text 
field, NetObjects Fusion displays a blank field. Simple text fields allow only 
one line of information and no character formatting. Formatted text fields 
allow multiple lines of information and character formatting. See “Adding a 
Stacked Page for Internal Data” on page 25-20.

4. Drag the field to the location you want on the stacked pages.

5. Place additional data fields. Add text blocks to label your fields, lines, and other 
graphics until you are satisfied with the Layout.
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6. Use the Data Field Properties to set the background and other options for the 
current data field.

7. Do one of the following:

✦ If you are using external data, your stacked pages are already created. You 
can use the Next and Previous buttons on the control bar to scroll though all 
pages in the stack. 

✦ If you are using internal data, add records as described in “Adding a Stacked 
Page for Internal Data.” You cannot enter data until you add a record to 
contain it.

Adding Navigation Buttons to Stacked Pages
Next and Previous buttons simplify navigation between stacked pages. You can 
automatically add navigation buttons when creating your data list as described in 
“Creating a Data List” on page 25-13, or you can create custom navigation aids by 
drawing or importing buttons, as described here.

To add navigation buttons for stacked pages:

1. In Page view, on one of the stacked pages, add an object to serve as a button. 

You can place text, draw a button using the Draw tool, or import an image using 
the Picture tool. If you copied the \Extras\Extras\Extras\Extras folder from the NetObjects Fusion CD, 
look for the pictures designed to be used as page navigation buttons. 

2. Select the object.

3. Click Link on the object’s Properties palette.
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4. In the Link dialog, click the Smart Link tab.

5. Select Next Stacked Page or Previous Stacked Page, and then click Link.

Adding a Stacked Page for Internal Data
To add a new record to internal data, you create a new stacked page. Each new 
stacked page has the same layout of data fields and non-data objects as all the others 
in the stack.

You can create as many new stacked pages as you want. For each new stacked page, 
NetObjects Fusion adds a row to the data list on the data list page. You can delete 
stacked pages for internal data whenever you want.

Note: You cannot add or delete stacked pages associated with an external data object. To add 
or delete records when data is stored externally, you must update your external 
database or spreadsheet application and re-publish your site.

To add internal data stacked pages:

➲ In Page view, on the first stacked page, click the plus (+) button on the control 
bar. 

A stacked page with blank data fields appears. The counter on the navigation bar 
indicates the new total of records in the stack.

Deleting a Stacked Page
To delete the current stacked page of an internal data object:

➲ In Page view, click the minus (-) button on the control bar and click Yes to 
confirm deletion. 

Adding Text and Images to Stacked Pages
When a stacked page displays data from an internal data object, you can enter text 
and add pictures in fields on the stacked page. You cannot edit text on stacked pages 
that reference external data.

To enter text in a text field:

➲ Double-click the field.
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A dotted outline with hollow handles highlights the field, and an insertion point 
appears inside. Type the text you want, then click outside the field to deselect it.

To add an image in an image file field:

➲ Double-click the field and select the image you want in the dialog that appears.

After you add data to the stacked pages, the data list can display it. Preview the data 
list page to see how it will look in your browser.

Deleting a Data Object
If you created stacked pages for the data object, you must delete the stacked pages 
and any data lists before you can delete the data object.

1. Go to Site view and select the stacked pages.

2. Press Delete, and click Yes to confirm.

3. Switch to Page view, select the data list, and press Delete.

4. Switch to Assets view.

5. Click the Data Objects tab.

6. Select the data object and press Delete.

7. Click Yes to confirm the deletion.
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Working with HTML Directly 26
In addition to adding content, links, and DHTML actions to your site using 
NetObjects Fusion’s tools, you can work directly with the code to insert HTML and 
scripts yourself. For example, you can add META tags to index your site for search 
engines, power content with JavaScript or Visual Basic routines, center pages 
throughout your site, or do whatever else you can when coding raw HTML. You 
can’t edit the HTML that ultimately gets published, but you can add your own code 
virtually anywhere.

Before working with HTML directly, you should be familiar with HTML tags and 
page structure. If you’re not familiar with HTML, you can still complete the tasks in 
“Examples of Page and AutoFrame HTML” on page 26-4 and “Examples of Object 
HTML” on page 26-10.

You can also insert code within link tags and add your own actions. See “Adding 
HTML to a Link” on page 18-12 and “Customizing Default Actions” on page 21-26.

Note: NetObjects Fusion doesn’t verify HTML you add, so be sure to use valid syntax, enclosing 
scripts within <SCRIPT> and </SCRIPT> tags, and so on. Also, assets referenced in 
your HTML aren’t managed in Assets view. If you move the HTML or its assets in your 
directory structure, edit paths in the HTML accordingly.

This chapter tells you how to add HTML or scripts by:

✦ Accessing the page’s HTML

✦ Accessing an AutoFrame’s HTML

✦ Accessing an object’s HTML

✦ Inserting HTML in a text box

✦ Coding your own objects

✦ Coding your own frames
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Accessing the Page’s HTML
You can add HTML or script to the <HEAD> or <BODY> of the HTML 
NetObjects Fusion generates. First, select the area of the page you want to access—
the Layout area to access the current page’s HTML, or a MasterBorder to access the 
HTML of several pages. Then use the Page HTML dialog to add code between the 
<HEAD> tags, inside the <BODY> tag, or at the beginning of the <BODY>.

To find out how to add HTML or script to pages that use AutoFrames, see 
“Accessing an AutoFrame’s HTML” on page 26-3.

1. In Page view, click in an empty spot in the Layout area or MasterBorder. To 
select a ZeroMargins MasterBorder, click outside the page.

2. Click the HTML button on the Properties palette.

The Page HTML dialog appears.

3. Click a tab to indicate where in the HTML you want to add tags or script. 

✦ Between Head Tags. Adds code to the <HEAD> content, inserting it just 
before the </HEAD> tag.

✦ Inside Body Tag. Adds code inside the <BODY> tag, as in 
<BODY<BODY<BODY<BODY attribute=value>>>>, where attribute=value is your code.

✦ Beginning of Body. Adds code just below the <BODY> tag.

4. Enter your code on the tab.

Your typing also appears in blue in the dialog’s gray area, where you can preview 
its location in the HTML that gets generated.

Note: To enter a tab character as part of the HTML, press Shift+Ctrl+Tab.
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You can click the Insert File button to insert contents of an HTML, script, or 
other text file. Click the Insert Field button to insert a field. See “Managing 
Variables” on page 27-10.

5. Click OK.

Preview the site to test your code, and view the source from your browser to see the 
resulting HTML. To edit your code, open the Page HTML dialog again, click the tab 
containing the code, and make your changes. 

Accessing an AutoFrame’s HTML
If your site uses AutoFrames, you can add HTML or script to the frameset file that 
gets generated, for example, to include a <NOFRAMES> tag for browsers that don’t 
support frames, or to modify the size or layout of your frames. You can also add 
code to any content page the frames display, for example, to center the frame’s 
contents.

In Page view:

➲ To access the frameset’s HTML, click in the MasterBorder or AutoFrame, then 
click the HTML button on the General tab of the Properties palette. Or right-
click in the MasterBorder or AutoFrame, and choose Master HTML from the 
shortcut menu.

To add HTML or script 
between the <HEAD> 
and </HEAD>... 

...inside the <BODY> 
tag itself...

...or to the page's 
content, just below 
the <BODY> tag

Type or paste your 
HTML or script on the 
tab

Click to insert contents 
of an HTML, script, or 
other text file

Click to insert a field

Preview your code in 
placeholder HTML that 
NetObjects Fusion
generates
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➲ To add code to a frame’s actual contents, click the AutoFrame label and then 
click the HTML button on the Frame Properties palette. Or right-click in the 
AutoFrame, and choose Frame HTML from the shortcut menu.

In each case, the Page HTML dialog appears, where you can add code between the 
<HEAD> tags, inside the <BODY> tag, or at the beginning of the <BODY>, as 
described in “Accessing the Page’s HTML” on page 26-2.

Note: If you convert an AutoFrame back to a MasterBorder, code added to the frame’s content 
HTML is deleted.

Examples of Page and AutoFrame HTML

Centering a Page’s Contents
NetObjects Fusion generates fixed-width pages by default. As a result, content 
doesn’t widen or narrow when site visitors resize their browsers. If your pages are 
narrow, you can center them to avoid an imbalance of white space by adding the 
<CENTER> tag at the beginning of each page’s <BODY>.

Note: This works only if you select Nested or Regular tables as your HTML output method.

1. In Page view, click in the Layout area of the page you want to center, in a 
MasterBorder to center a set of pages, or on an AutoFrame label to center just 
the contents of the frame. 

2. Click the HTML button on the Properties palette.

The Page HTML dialog appears.

3. Click the Beginning of Body tab and type <CENTER><CENTER><CENTER><CENTER>.

4. Click OK.

Preview the site and resize your browser to test the centered pages. 

You cannot use NetObjects Fusion to add a <\CENTER> tag at the end of the page’s 
<BODY>, which is considered standard HTML syntax. Although this breach of 
protocol might be noted by an HTML code-checking program, it doesn’t cause 
problems in your site.

For information on scaling page content, see “Changing Layout Size” on page 8-3.
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Indexing Pages for Search Engines
To give your content the best chance of being found and ranked by search engines 
like AltaVista, you can add META tag descriptions and keywords to your pages’ 
<HEAD> content. Site visitors don’t see this information, but search engines 
require it to index your site.

Note: Search engines index frameset files, so if your site uses AutoFrames or scripted frames, 
be sure to access Master HTML so your tags are added to the frameset file. 

1. In Page view, click in the Layout area of the page you want indexed, or in the 
MasterBorder or AutoFrame to index a set of pages.

2. Click the HTML button on the General tab of the Properties palette. 

The Page HTML dialog appears.

3. Click the Between Head Tags tab and enter META tags that describe your 
content. For example, type:

<META NAME="DESCRIPTION" CONTENT="<META NAME="DESCRIPTION" CONTENT="<META NAME="DESCRIPTION" CONTENT="<META NAME="DESCRIPTION" CONTENT="Large selection of valuable, high quality 
antiques and collectibles for any budget."> "> "> "> 

where the content is a one-sentence description containing the most important 
keywords site visitors might search for. Then type:

<META NAME="KEYWORDS" CONTENT="<META NAME="KEYWORDS" CONTENT="<META NAME="KEYWORDS" CONTENT="<META NAME="KEYWORDS" CONTENT="antiques, quality antiques, valuable antiques, 
low-cost antiques, collectibles, jewelry, furniture, novelties">">">">

where the content lists all important keywords.

4. Click OK.

5. Register your site with search engines.

You must do this separately with each search engine for it to find your site. Visit 
AltaVista, Excite, Lycos, Yahoo, and so on, for information. Search engines 
continually evolve how they use content to index and rank pages, and many of 
them make this information available at their sites. 

To see the resulting HTML, publish the site and view the source in your browser. To 
test the tags you added, publish the site and search for keywords using the various 
search engines. Be patient, as it can take days or weeks for indexers to find your site.
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Auto-Forwarding from a Transition Page
You can create a transition page that appears for a few seconds, for example, to 
display a product logo, and then forwards site visitors automatically to another 
page. You do this by inserting a META tag in the page’s <HEAD>.

Note: This might not work with all browsers.

1. In Page view, click in the Layout area of the transition page, and click the HTML 
button on the Layout Properties palette.

The Page HTML dialog appears.

2. Click the Between Head Tags tab and type:

<META HTTP-EQUIV="REFRESH" CONTENT="<META HTTP-EQUIV="REFRESH" CONTENT="<META HTTP-EQUIV="REFRESH" CONTENT="<META HTTP-EQUIV="REFRESH" CONTENT="seconds; URL=; URL=; URL=; URL=http://server.domain.com/
page.html">">">">

where seconds is the number of seconds you want the transition page to appear, 
and http://server.domain.com/page.htm is the URL of the page you want to link to.

3. Click OK.

Preview the site to test the transition, and view the HTML source in your browser to 
see your code.

Accommodating Browsers that Don't Support Frames
Some older browsers don’t support frames. To prevent site visitors using these 
browsers from being greeted with a blank page or error message when they access 
your site, add alternate content for them using the HTML <NOFRAMES> tag. 

You add the <NOFRAMES> tag and your alternate content to the frameset file 
generated when you publish. Your content can include text, pictures, and links, 
using standard HTML tags.

1. In Page view, select the AutoFrame.

2. Click the HTML button on the General tab of the Properties palette.

The Page HTML dialog appears.

3. Click the Beginning of Body tab and enter:

<NOFRAMES><NOFRAMES><NOFRAMES><NOFRAMES>

<H1><H1><H1><H1>Thanks for visiting our site!</H1></H1></H1></H1>
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We’re sorry you haven’t had a chance to upgrade your browser yet and can’t see our framed 
site. We think the frames make it easier to find what you want.

<P><P><P><P>If you want to obtain a more current browser, check out either Microsoft’s <A <A <A <A 
HREF=HREF=HREF=HREF=”http://www.microsoft.com”>>>>Internet Explorer</A></A></A></A> or Netscape’s <A HREF=<A HREF=<A HREF=<A HREF=”http:/
/www.netscape.com”>>>>Navigator or Communicator</A></A></A></A> products!

</NOFRAMES></NOFRAMES></NOFRAMES></NOFRAMES>

4. Click OK to close the dialog.

A site visitor with a browser that supports frames sees the framed site as you 
designed it. A site visitor with an older browser sees the following: 

Creating a Default Target Frame
If you code your own frames, and one content page contains a lot of links that target 
the same frame, you can make that frame the default target. That way you don’t 
have to script a target attribute for each link. The default target for the contents of a 
frame that displays navigational buttons, for example, might be a frame that 
displays the primary content those buttons point to. Unless you add a target 
attribute specifying differently, all links on that page display their contents in the 
default frame.
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1. In Page view, open the content page to be targeted.

2. Click the HTML button on the Layout Properties palette.

The Page HTML dialog appears.

3. Select the Between Head Tags tab and enter:

<base target="<base target="<base target="<base target="framename">">">">

where framename is the name of the frame as defined in the frameset file that you 
want to be the default target.

4. Click OK to close the Page HTML dialog.

Create several links on the content page using the Link dialog. Don’t add any HTML 
specifying a target frame. Preview the site and test the links. They should all display 
contents in the default target frame. 

Accessing an Object’s HTML
You can add HTML or script to pictures, media, a text box, or any other object, to 
modify or control that object. You can enclose the object in HTML tags, or add 
HTML or script inside the object’s tag.

You can add code before and after a text box’s HTML as described here. To insert 
code inside a text box, see “Inserting HTML in a Text Box” on page 26-13.

1. In Page view, select the object you want to add code to, and click the HTML 
button on the Properties palette. Or from the Object menu, choose HTML.

The Object HTML dialog appears.

2. Click the tab to indicate where you want to insert HTML or script. 

✦ Before Tag. Adds code just before the object’s tag, as in your_code <IMG SRC=><IMG SRC=><IMG SRC=><IMG SRC=>, 
if the object is a picture.

✦ Inside Tag. Adds code inside the object’s tag, as in <IMG SRC=”<IMG SRC=”<IMG SRC=”<IMG SRC=”Image.gif” ” ” ” 
attribute>>>>, where attribute is your code. This tab appears only if you can add 
something inside the object’s tag.

✦ After Tag. Adds code just after the object’s tag; for example, to insert a closing 
HTML tag for any opening tag inserted before the object.

3. Enter your code on the tab.
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Your typing also appears, shown in blue, in the dialog’s gray area, where you can 
preview its location in the object’s HTML.

You can click the Insert File button to insert contents of an HTML, script, or 
other text file. Click the Insert Field button to insert a field. See “Managing 
Variables” on page 27-10.

4. Click OK.

HTML indicator iconHTML indicator iconHTML indicator iconHTML indicator icon

The object is marked with an HTML icon.

Preview the site to test your code, and view the source from your browser to see the 
resulting HTML. To edit the code, open the Object HTML dialog again, click the tab 
containing your code, and make changes.

To add HTML or 
script before the 
object’s HTML tag

To add code inside 
the object’s tag

To insert a closing 
HTML tag for any 
opening tag inserted 
before the object

Type or paste your 
HTML or script in this 
part of the dialog

Click to insert contents 
of an HTML, script, or 
other text file

Click to insert a field

See the object’s 
HTML, and preview 
your code as you type
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Examples of Object HTML

Displaying a Message on Mouse Click
You can display a message when site visitors click an image or text link. One way to 
do this is by creating a Blank link and inserting an onClick    JavaScript in the link’s 
opening <A HREF> tag. 

1. In Page view, select the image or exact text site visitors are to click, and click the 
Link button on the Properties palette.

The Link dialog appears.

2. Click the Smart Link tab and select a Blank link.

3. Click the HTML button in the Link dialog.

The Link HTML dialog appears.

4. Click the Inside Link tab and type:

onClick="alert('onClick="alert('onClick="alert('onClick="alert('your message')"')"')"')"

where your message is the text of your message.

5. Click OK in the Link HTML dialog, then click Link in the Link dialog.

Preview the page and click the image or text to see the message.

View the HTML source in your browser to see the resulting HTML.

Another way to add this JavaScript to a picture or text link is to create a custom link. 
In the Link dialog, click the External Link tab, choose javascript from the URL drop-
down list, and type the onClick    script in the URL field. See “Linking to a New 
Browser Window” for another example of creating a link this way.

Message that 
appears when site 
visitors click the link
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Linking to a New Browser Window
You can have a link open a page in a new browser window rather than in the current 
window, so site visitors can keep the current page around while exploring a new 
part of your site. To do this, define a window.open JavaScript in a page’s <HEAD>, 
and call the function from the link using the Link dialog.

1. In Page view, select the image or exact text to be the link, and click the Link 
button on the Properties palette.

The Link dialog appears.

2. In the Link dialog, click the External Link tab and create a custom link.

✦ URL. Choose javascript from this drop-down list. In the field, type openMe().openMe().openMe().openMe().

✦ Asset Name. In this field, type NewWindowNewWindowNewWindowNewWindow, which identifies the link in Assets 
view.

3. Click the Link button to close the dialog.

4. On the same page, click in the Layout area or MasterBorder depending on where 
the link is, and click the HTML button on the Properties palette.

The Page HTML dialog appears.

5. Click the Between Head Tags tab and type:

<SCRIPT LANGUAGE="javascript"><SCRIPT LANGUAGE="javascript"><SCRIPT LANGUAGE="javascript"><SCRIPT LANGUAGE="javascript">
function openMe() function openMe() function openMe() function openMe() 

Choose javascript to 
indicate you’re linking, 
not to another page, 
but to a JavaScript

Type the name or function call that 
you’ll use in the page’s <HEAD> to 
define the script’s function

The name you type here identifies the 
link in Assets view
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{{{{
window.open("window.open("window.open("window.open("http://server.domain.com/filename.htm", "newwindow")", "newwindow")", "newwindow")", "newwindow")
}}}}
</SCRIPT></SCRIPT></SCRIPT></SCRIPT>

where http://server.domain.com/filename.htm is the URL of the page you’re linking 
to.

6. Click OK.

Preview the page to test the link, and view the HTML source in your browser to see 
the resulting HTML.

Linking from a Frame to a Page without Frames
To create a link within a frame that displays its target in a full browser window—not 
within the current set of frames—you can add a target attribute to the link. 

1. In Page view, select the text or object you want to link, and click the Link button 
on the Properties palette.

The Link dialog appears.

2. Click the tab for the type of link you want—Internal, Smart Link, External, or 
File—and enter the page or resource you’re linking to (as described in “Creating 
Links” on page 18-2).

Make sure the Select Frame Target drop-down list is set to (none).

3. Click the HTML button in the Link dialog.

The Link HTML dialog appears.

4. Click the Inside Link tab and type:

target =“_top”target =“_top”target =“_top”target =“_top”

to display the link in the full browser window (not within a current frame). Or 
type:

target =“_blank”target =“_blank”target =“_blank”target =“_blank”

to display the link in an entirely new window.

5. Click OK in the Link HTML dialog, and click Link in the Link dialog.

NetObjects Fusion inserts your target attribute inside the link tag, telling the 
browser to display the new page in either the full browser window or in another 
window.
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6. Preview the page and test the link. View the HTML source in your browser to see 
the resulting HTML.

Inserting HTML in a Text Box
You can insert HTML or script inside the contents of a text box at the insertion 
point, for example, to add text attributes or comments to the HTML.

1. In Page view, double-click in the text box to get an insertion point.

2. From the Text menu, choose Insert HTML.

The Insert HTML dialog appears.

3. Enter your HTML or script.

4. Click OK. 

Marks HTML inserted in Marks HTML inserted in Marks HTML inserted in Marks HTML inserted in 
a text boxa text boxa text boxa text box

Preview the page to test your code, and view the source from your browser to see the 
resulting HTML. 

...is inserted where 
you clicked in the 
text box, in the 
published HTML

What you type or paste here...

For <BLINK>SPECIAL DEALS</BLINK>, click hereFor <BLINK>SPECIAL DEALS</BLINK>, click hereFor <BLINK>SPECIAL DEALS</BLINK>, click hereFor <BLINK>SPECIAL DEALS</BLINK>, click here

You can double-click here to reopen the 
Insert HTML dialog to view or edit the code
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Coding Your Own Objects
You can create an object, such as a Java applet or a table you want to code yourself, 
by entering HTML or script in an empty text box.

1. In Page view, draw a text box where you want the object to go.

The box marks the object’s position when you publish, but it can grow vertically 
or horizontally depending on the object. To approximate the published size in 
your Layout area, select Lock height on the Text Box tab of the Text Properties 
palette.

2. Right-click in the text box and choose Object HTML from the shortcut menu.

The Object HTML dialog appears.

3. On the Before Tag tab, type, paste, or insert the HTML or script.

4. Press Enter after the script and type <!--<!--<!--<!--

5. On the After Tag tab, type -->-->-->-->

6. Click OK. 

You defined a space on the page for a text item, inserted the HTML or script, and 
told NetObjects Fusion to put the HTML or script in place of the text.

Preview the page to test your code, and view the source from your browser to see the 
resulting HTML. If necessary, go back and adjust the box’s position in Page view to 
get the actual spacing you want. 

Coding Your Own Frames
You can create HTML frames in any part of the MasterBorder without coding 
HTML by using AutoFrames. But if you want to put frames in the body of your 
page, you can script them, just as with any HTML editor. 

Here’s an example of accessing HTML to create a section of a site that uses two 
horizontal frames–one body frame that scrolls, and a footer frame that doesn’t. 
Navigation buttons in the footer open each of two pages in the body, while a Home 
Page button links out of the frames section to the site’s Home page.

1. In Site view, create a new page for the frameset—the page where your frames 
begin. Name the page Frames.
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2. Beneath this page, create three content pages for the frames to display, named 
Footer, One, and Two.

3. Display the Frames page in Page view, and add HTML that defines it as a 
frameset, setting the size and position of each frame, and the content it initially 
displays.

Select the Layout, click the HTML button on the Layout Properties palette, and 
type the following on the Between Head Tags tab of the Page HTML dialog:

<frameset rows=”*,70”><frameset rows=”*,70”><frameset rows=”*,70”><frameset rows=”*,70”>
<frame name=”main” src=”./one.html”><frame name=”main” src=”./one.html”><frame name=”main” src=”./one.html”><frame name=”main” src=”./one.html”>
<frame name=”menu” src=”./footer.html><frame name=”menu” src=”./footer.html><frame name=”menu” src=”./footer.html><frame name=”menu” src=”./footer.html>
</frameset> </frameset> </frameset> </frameset> 

Or, if you’re publishing the site using the By Site Section directory structure 
rather than the Flat or By Asset Type structure, type instead for the second and 
third lines:

<frame name=”main” src=”./html/one.html”><frame name=”main” src=”./html/one.html”><frame name=”main” src=”./html/one.html”><frame name=”main” src=”./html/one.html”>
<frame name=”menu” src=”./html/footer.html><frame name=”menu” src=”./html/footer.html><frame name=”menu” src=”./html/footer.html><frame name=”menu” src=”./html/footer.html>

This HTML creates two horizontal frames—one called “main” that occupies the 
bulk of the page, and a 70-pixel-high frame called “footer” at the foot of the 
page.

Click OK in the dialog when you’re done.

Note: The srcsrcsrcsrc attribute is a relative path name to a content page that must match 
exactly the path name generated when you publish the page. The path 
depends on the directory structure selected in the Setup dialog in Publish 
view. The file name is the page’s name in Site view, all lowercase, with an 
.html.html.html.html extension and an underscore in place of spaces and other special 

Attach HTML to this page to define it 
as a frameset

Add content that will appear in the frames to 
these pages using NetObjects Fusion tools
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characters. So Page OnePage OnePage OnePage One in Site view becomes page_one.htmlpage_one.htmlpage_one.htmlpage_one.html in the 
resulting HTML. If you’re not sure where a content file is relative to your 
frameset page, or what its HTML name is, look in Publish view.

4. Open the Footer page in Page view.

5. Click in the MasterBorder and select ZeroMargins in the Name field on the 
MasterBorder Properties palette.

6. Click in the Layout area and enter 110 in the Height field on the Layout 
Properties palette.

7. Add three text boxes to the Layout, containing the text One, Two, and Home.

8. Select the text One, create an Internal link to the One page, and add HTML that 
makes the page’s contents appear in the mainmainmainmain frame.

Create the link as described in “Creating an Internal Link” on page 18-2. Keep 
the Link dialog open, click the HTML button in the dialog, and type the 
following on the Inside Link tab of the Link HTML dialog:

target="main"target="main"target="main"target="main"

When you’re done, click OK in the Link HTML dialog and click Link in the Link 
dialog.

9. Select the text Two and repeat the previous step to create an Internal link to the 
Two page and add HTML that makes that page’s contents appear in the mainmainmainmain 
frame.

10. Select the text Home, create an Internal link to the Home page, and add HTML 
that makes the page’s contents appear in the full browser window, not in frames.

Create the link in the Link dialog, click the HTML button in the dialog, and type 
the following on the Inside Link tab of the Link HTML dialog:

target="_top"target="_top"target="_top"target="_top"

When you’re done, click OK in the Link HTML dialog and click Link in the Link 
dialog.
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11. Open the One and Two pages in Page view, choose the ZeroMargins 
MasterBorder on the MasterBorder Properties palette, and add whatever content 
you want to appear in the mainmainmainmain frame for each page.

Publish the site to test your frames (you can’t preview to see scripted frames). Click 
each button in the bottom frame. The One button should display the contents of the 
One page in the top frame, the Two button should display the Two page in the top 
frame, and the Home button should exit the frames altogether and display the 
Home page in the whole browser window.

“main” frame

Add pictures and text to 
content pages using 
NetObjects Fusion tools

“footer” frame

Frameset HTML you 
added defines the frame 
boundaries
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Managing Assets 27
With NetObjects Fusion, you can manage all the assets—files, links, data objects, 
and variables—used in your site. In Assets view, you can navigate to the pages on 
which these assets appear, delete unused assets, and verify the location of assets that 
are in use. For information about how to add assets to a site, see Chapter 6, “Page 
View Basics.”

NetObjects Fusion uses aliases for files and external links, so you can globally 
replace an item that appears on several pages—such as a picture or an external 
link—by replacing the file or link once in Assets view. If you insert a variable in text 
boxes on different pages, you can edit the value of the variable in Assets view, and 
NetObjects Fusion updates all instances of the variable throughout your site 
automatically.

This chapter describes:

✦ Managing files

✦ Managing links

✦ Managing data objects

✦ Managing variables
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Working in Assets View
When you switch to Assets view, choose which kind of asset to view by clicking one 
of the four tabs below the control bar. You can sort a list by clicking a column 
heading, and you can change the width of any column by dragging the column 
divider to the left or right. 

Depending on the selected asset type, Assets view lists:

Click a tab to see file assets, links, data 
objects, or user-defined variables

Click a column heading 
to sort the table

Drag the column divider to 
change column width

Files Links Data Objects Variables

Name Name Name Name

Type Link To Contents

In Use Type

Location Target

Size Verify Status

Date

Verify Status
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Managing File Assets
When you click the Files tab, a list of the files associated with your site appears, 
including external files and those generated by NetObjects Fusion. File types 
include image, audio, video, applets/plugins, Java class, HTML, data source, and 
link target.

In Assets view, you can add assets, edit asset names, and go directly to the page 
containing a selected asset. You can verify the locations of assets in your site, and 
you can open an asset file for editing in the application associated with it. Replace 
assets, delete selected assets, or delete all unused assets in a single action.

For example, if you have an image file of an arrow that indicates the next page in the 
site, you could name this asset Next Page and place it on several pages. If you later 
decide to change the image to a pointing finger, you need only edit the file asset so 
Next Page uses the pointing finger image file. NetObjects Fusion automatically 
changes the image on all the pages that include the Next Page image asset.

The File dialog displays an asset’s name, location, and the pages on which it is used. 
To display the File dialog, double-click an asset’s name in Assets Files view.

Note: Image files that you place on stacked pages to populate an internal data object are not 
listed in Assets view. You can manage such files directly on the stacked pages. For 
information about data objects and stacked pages, see Chapter 25, “Data Publishing.”

This is the asset’s location

This is the name that appears in the 
Name list in Assets Files view

These are the pages on which the 
asset is used
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Adding a File Asset
1. In Assets Files view, from the Assets menu, choose New File Asset, or click New 

on the control bar.

The File dialog appears.

2. In the Location field of the File dialog, type the path and file name of the asset 
you want to add, or click Browse and select a file.

3. If you want, edit the Asset name and click OK. See “Editing Asset Names and 
Locations” on page 27-4.

4. To force publication of the file, even if it is not in use, select Always publish file.

5. Click OK. 

When you add an asset in this manner, it is available for use in your site, but it is not 
yet actually in use. The asset now appears on the Assets tab in the Open dialog. See 
“Reusing Assets” on page 6-10.

Editing Asset Names and Locations
Giving custom names to assets can make them easier to manage. 

1. In Assets Files view, double-click the asset name to display the File dialog.

2. Type a new name into the Name field and click OK. 

You can also edit the location directly in the File dialog. For example, you could 
enter a URL instead of a file path to point to a dynamic image on a server. Such 
images, however, are represented by an X in Page view, because the asset is not 
accessible.

This picture shows 
its new name

The original asset 
name appears here
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Opening a File Asset in an External Application
NetObjects Fusion can automatically open a file asset in the external application 
with which the file asset is associated. For HTML documents, you can specify your 
preferred HTML editor in the Preferences dialog. See “Setting General Preferences” 
on page 2-2. For other types of files, see “Editing Objects and Assets” on page 6-11.

To open a file asset in an external application:

1. In Assets Files view, select the asset.

2. From the Assets menu, choose Open Asset.

3. Make your changes and save the file in the external application.

Displaying a Page Containing a Specific File Asset
1. In Assets Files view, double-click a file asset to open the File dialog.

2. Select the page you want to see from the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.

Deleting a File Asset
To delete a file asset:

1. In Assets view, right-click the file asset you want to delete and choose Delete File 
Asset from the shortcut menu. 

2. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the New File Asset command 
on the Assets menu to recreate the file asset.

Deleting All Unused File Assets
1. In Assets view, from the Assets menu choose Delete All Unused File Assets.

2. Click Yes to confirm the deletion.

NetObjects Fusion removes all file assets for which the In Use indicator is not 
Yes.
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Note: You cannot undo this operation. You must use the New File Asset command to 
recreate file assets.

Verifying File Assets
To make sure assets publish correctly, you can verify that all file assets are in their 
expected directories.

1. In Assets view, from the Assets menu choose Verify All File Assets.

NetObjects Fusion verifies and reports the path status of all files.

✦ When a file’s path information is correct, NetObjects Fusion lists the date 
and time found in the Verify Status column.

✦ When a file’s path information is incorrect and the file or folder cannot be 
found, the Verifying Files Used by File Assets dialog appears.

2. Resolve the paths of any lost files or folders.

✦ To specify a new path, click Browse and locate the file or folder.

✦ To skip the lost item and continue verification, click Skip. NetObjects Fusion 
gives this file Not found status and goes on to verify subsequent files or 
folders. If the file is due to be published, you receive a publish error.

✦ To stop the verification process, click Cancel. The verification status of the 
current file or subsequent files is not updated.

3. When verification is complete, click OK in the confirmation dialog.
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Managing Links
When you click the Links tab, a list of all the links used in your site appears, 
including external links, user-defined internal links, and smart links. See 
Chapter 18, “Creating Links and Anchors.”

Links between entries in a data list and their associated stacked pages do not appear 
in Assets view. You can manage such links directly on the data list pages. See 
“Creating a Data List” on page 25-13.

Updating an External Link
The Link To location varies depending on the type of link. In Assets view, you can 
change the location of an external link yourself by changing the URL.

1. In Assets Links view, double-click the external link you want to update.

The Links dialog appears.

List of pages that use the link
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2. Change the name in the Name field if desired.

3. Update the URL in the Link To field and click OK.

Displaying the Page Containing a Link
1. Double-click the link in Assets Links view. The Links dialog appears.

2. Select the page you want to see in the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.

Adding a Link
1. In Assets Links view, from the Assets menu choose New Link, or click the New 

button on the control bar. 

The Links dialog appears.

2. Enter a name.

3. Type the link destination and click OK. 

Deleting a Link
1. In Assets Links view, select the link you want to delete

2. From the Edit menu, choose Delete Link or press Delete.

3. Click Yes to confirm the deletion.

You cannot delete a link that is in use. You must use the Link dialog to unlink.

Note: You cannot undo this operation. You must use the Add Link command to 
recreate the link.

Verifying Links
To make sure links will work properly when a site visitor clicks them, you can verify 
link destinations.

1. In Assets Links view, from the Assets menu, choose Verify All Links.

NetObjects Fusion displays a progress bar as it verifies and reports the status of 
link destinations. It accesses the Internet to verify external link references. 
27-8 Managing AssetsManaging AssetsManaging AssetsManaging Assets



 

Managing Data Objects

        
✦ When a link’s destination is found, the date and time of validation appear in 
the Verify Status column.

✦ If a link’s destination is not found, the problem is described in the Verify 
Status column.

When verification is complete, the progress bar disappears.

2. Resolve the destinations of any broken links by double-clicking the link and 
editing it as described in “Updating an External Link.”

Link verification takes place in the background, so you can switch to another view 
and continue working while links are being verified.

To verify links through a proxy server, open the Windows Control Panel and 
double-click the Internet icon. In the Internet Properties dialog, click the Advanced 
tab, select Use Proxy Server, and configure your proxy server settings.

Note: When NetObjects Fusion cannot verify that an http, rlogin, tn3270, snews, or javascript 
link is valid, “Unsupported URL Type”displays. If NetObjects Fusion cannot verify a 
mailto, news, or telnet link, no status displays.

Managing Data Objects
Data objects are collections of fields of data. You can use a data object to publish 
data without using CGI scripts or database programming. For information about 
data objects, including how to create and delete them in Assets view, see Chapter 25, 
“Data Publishing.”

When you click the Data Objects tab, NetObjects Fusion displays a list of all the data 
objects used in your site. In an internal data object, you can edit the name and field 
names and add new fields. See “Changing an Internal Data Field Name” on 
page 25-8.

For an external data object, you can change Simple fields to Image fields and vice 
versa, but you cannot edit field names or add new fields, because these items depend 
on data in the external data file.
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Managing Variables
Text variables make it easy to update text that appears throughout your site. User-
defined variables are displayed in Assets Variables view so you can edit, create, or 
delete them. NetObjects Fusion also provides standard variables, such as the date 
and time the site was created or last modified, but these are not displayed in Assets 
Variables view.

Adding a Variable
1. In Assets Variables view, from the Assets menu choose New User-Defined 

Variable, or click New on the control bar. 

The New Variable dialog appears.

2. Enter a name and value for your variable and click OK.

Editing a Variable
1. Double-click the variable in Assets Variables view. 

The Edit Variable dialog appears.

2. Edit the name and value of the variable and click OK.
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If you edit the value of the variable, NetObjects Fusion updates all text blocks 
containing that variable with the new value.

Deleting a Variable
1. In Assets Variables view, select the variable you want to delete.

2. From the Edit menu, choose Delete User-Defined Variable.

3. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the New Variable command to recreate 
the variable. Do not delete a variable that is in use. If you do, it will be replaced with 
Undefined User variable:variable name    in the text where it was used.
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Publishing Your Site 28
When you complete your site design and development, you’re ready to publish the 
results. The publishing process generates the HTML pages and associated assets. 
When you publish, you can control the location of your published site, directing 
NetObjects Fusion to store your site on a local disk or a remote server.

Note: Sites published with NetObjects Fusion work with any Web server, on any operating 
platform. No special Web-server extensions are required. If your site contains server-
side components—including NetObjects Fusion Message Board or Form Handler 
components, CGI scripts, or third-party components —it will require additional server 
setup.

This chapter describes:

✦ The publishing process

✦ Configuring the directory structure

✦ Selecting the default HTML output method

✦ Defining server profiles

✦ Publishing locally or remotely
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The Publishing Process
When you publish your site, NetObjects Fusion generates HTML pages and 
associated assets from the information in the Sitename.nod.nod.nod.nod file,    which contains your 
SiteStructure, page design, content, links, and assets.

You can publish your site to a local drive, a Web server on your intranet, an ISP’s 
Web server, or any server to which you have access. If you want to test your site 
before you share it with the world, you can publish it to a local drive. You do not 
need a Web server when you publish locally. If you want a few site visitors to test 
your site, you could publish to a private Web server. When you are ready to share 
your site with the world, publish to your ISP’s Web server or your company’s Web 
server.

To publish to multiple locations, you simply set up different server profiles. The My 
Computer profile included with NetObjects Fusion is preconfigured to publish your 
site to your local drive. You do not have to do additional setup to publish locally. 
When you are ready to publish to a Web server, you must set up a server profile. You 
can create as many server profiles as you need. 

To publish a site to a Web server the first time:

1. Select Publish Setup in Publish view.

2. Define your site’s publishing settings in the Publish Setup dialog by:

a. Defining the directory structure.

b. Selecting the HTML output method. 

c. Defining server profiles. 

d. Selecting Publish components, if necessary.

These settings are saved in your Sitename.nod.nod.nod.nod file for future use.

3. Customize your site’s directory structure, if needed, by:

a. Re-arranging and renaming site folders.

b. Creating custom folders.

c. Changing the publishing properties for folders, pages, and assets.

NetObjects Fusion saves the customized directory structure in the Sitename.nod.nod.nod.nod 
file for future use. The file and directory structure you use does not change the 
appearance, design, or content your site visitor sees; it only controls the way the 
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pages and assets are stored on the server and the paths in the HTML to those 
assets.

4. Publish your site to the selected server location. 

Once you successfully publish, you can re-publish at any time by clicking the 
Publish button on the control bar. You can also modify these settings at any time 
and then re-publish.

Exploring Publish View
You must be in Publish view to publish your site. When you go to Publish view, it 
looks similar to the Microsoft Windows Explorer or the Windows NT File Manager. 
You can manipulate the directory structure, rename folders, create new folders, and 
so on in Publish view.

The Directory Structure pane on the left displays the directory structure of your site 
as it will be published on your server. You can delete, rearrange, or rename folders 
shown in the Directory pane, and you can create new subfolders at any level below 
the root. Components and their related assets have a black lock image on their 
icons, signifying that they cannot be renamed or rearranged.

The pane on the right displays the contents of the folder currently selected in the 
Directory pane. For each folder, page, or asset, the pane displays its name, type, 
attributes, and the date and time of the last local and remote publish. You can sort 
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the content files and folders by clicking a column heading, and you can resize the 
columns by dragging the column heading border. The icons associated with 
different file types are set in the Windows File Types Registry.

Click a folder’s plus sign to expand the display to show the subfolders beneath it. 
Click a folder’s minus sign to collapse the display and hide the subfolders beneath it. 
Resize the Directory Structure and Contents panes by dragging the divider bar in 
either direction.

Setting the Directory Structure
When you publish your site, you control the directory structure used to arrange 
your files and assets on the server. Setting the directory structure does not change 
the structure that the site visitor sees, nor does it affect the relationships or links 
between pages and assets. It simply defines how your pages and assets are stored on 
the server, and what URL is required to access them. For example, some servers 
require a one-level structure, with all pages, images, and other assets in the same 
directory; others let you set up your own directories. 

NetObjects Fusion supports three pre-configured directory structures:

✦ Flat for servers that require all resources and assets to be in a single directory. 
Many commercial ISPs require this kind of structure. 

✦ By Asset Type arranges your site contents into folders according to their asset 
type. This is the structure generated by earlier versions of NetObjects Fusion. 
For example, if your site contains a typical mix of text and media, a structure set 
By Asset Type arranges your contents into the structure shown below.

✦ By Site Section arranges your site contents into a directory structure that looks 
like your site in Site view:

✧ Your Home page and its assets are stored in the site’s root directory.

✧ Each first-level page is stored in its own folder with its assets.
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✧ Any child page is stored with its assets in a subfolder beneath the folder that 
contains its parent page. You determine the maximum number of subfolders 
by setting the Number of Levels option.

For example, a structure set By Site Section would have this directory structure 
on the server.

This setting creates the most efficient file structure, allowing your server to load 
your pages as quickly as possible in your site visitor’s browser. It is the default 
directory structure setting in NetObjects Fusion. It also provides the most 
effective directory structure for search engines, which might index only one 
page per folder.

Note: If you apply the By Site Section directory structure, shared assets are stored in 
the deepest folder common to all pages that use that asset. This makes the 
shared access to those assets as efficient as possible.

To set the Directory Structure property for this site:

1. In Publish view, click the Setup button on the control bar.
Publishing Your SitePublishing Your SitePublishing Your SitePublishing Your Site 28-5



   

Setting the Site’s HTML Output Method

    
The Directory Structure tab of the Publish Setup dialog appears.

2. Select the arrangement you want from the Directory Structure drop-down list. 

3. If you customized your directory structure and want to reset your arrangement 
to the default directory structure, click the Clear All Customizations button. 

NetObjects Fusion removes any custom folders and changes all customized asset 
names back to their original, auto-generated names. See “Customizing Your 
Directory Structure” on page 28-19.

4. Click OK to apply the selected directory structure type. 

The directory structure is revised and displayed in Publish view.

Setting the Site’s HTML Output Method
The wide range of browser versions and capabilities makes it difficult to know 
exactly what kind of HTML tags and functions will display effectively to site visitors. 
Advances in HTML coding and browser abilities have also made it possible to create 
pages using less code and more efficient downloads—if your site visitor’s browser 
can support it. To address these concerns and take advantage of these 
improvements, you can choose among several types of HTML output when 
publishing your site.
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✦ Nested Tables uses Nested Table tagging and other features of the 3.2 HTML 
specification. This is the default output method because it produces the most 
predictable and consistent results onscreen, regardless of the type, version, or 
configuration of the site visitor’s system or browser fonts. Both Microsoft 
Internet Explorer 2.x and above and Netscape Navigator 2.x and above correctly 
display pages published in Nested Tables format. See “Optimizing Nested Tables 
Output” on page 7-6.

✦ Regular Tables    uses basic HTML table tagging to deliver your design and content. 
Both Microsoft Internet Explorer 2.x and above and Netscape Navigator 2.x and 
above correctly display pages published in Regular Tables format, although site 
visitors’ results might vary according to their system and browser font settings.

Note: If you select either Nested Tables or Regular Tables, be sure your pages do not 
have overlapping objects, or your published results will not be what you 
expected. See “Editing Objects and Assets” on page 6-11 for information.

✦ CSSP+Layers uses Cascading Style Sheet Positioning code, layers, and scripts to 
position and publish your design and content. Both Microsoft Internet Explorer 
4.x and Netscape Communicator 4.x correctly display pages published in 
CSSP+Layers format, although the site visitors’ results might vary according to 
their system and browser font settings.

✦ CSSP uses Cascading Style Sheet Positioning to achieve a high level of layout 
accuracy. The resulting HTML files are smaller than the files produced when you 
use CSSP+Layers. If you are sure all site visitors use Microsoft Internet Explorer 
4.0 or higher, choose the CSSP output method.

✦ Layers uses Layers to achieve a high level of layout accuracy. The resulting HTML 
files are smaller than the files produced when you use CSSP+Layers. If you are 
sure all site visitors use Netscape Navigator 4.0 or higher, choose the Layers 
output method.

On the HTML Output tab of the Publish Setup dialog, you designate which type of 
HTML output is generated. This setting determines the site setting for HTML 
output. You can override this setting for individual Layouts and Layout Regions, so 
NetObjects Fusion generates the HTML using a different method. See “Setting the 
HTML Output Method for a Layout or Layout Region” on page 8-6 for 
information.

To set the publishing method for your site:
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1. In Publish view, click the Setup button on the control bar.

The Publish Setup dialog appears.

2. Click the HTML Output tab.

3. Select the publishing method you want to use from the Output Type drop-down 
list.

The selected output method becomes the default for all the pages in the site, 
unless overridden in a specific Layout or Layout Region.

4. In the Options section of the dialog:

✦ Choose a character set from the Site Character Set drop-down list. See 
“Setting the Site’s Character Set” on page B-3.

✦ Use the Quote Type drop-down list to select one of the three types of 
quotation marks you can use in your site’s text objects.

Straight Quotes is the default setting. The site visitor’s browser font settings 
control the appearance of these quotes in the browser.

"These are Straight Quotes."

“These are Curly Quotes.”

``These are Newspaper Quotes."
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5. Click the Advanced button to set additional HTML options. See “Setting 
Advanced HTML Options.”

6. Click OK to set the selected HTML output options.

Setting Advanced HTML Options
NetObjects Fusion includes a variety of options you use to control HTML format 
and generation.

1. In Publish view, click Setup on the control bar.

2. Click the HTML Output tab and click the Advanced button.

3. Set the Formatting options. These settings affect only the appearance of the 
HTML code; they have no impact on the appearance of the site.

✦ Case. Choose Uppercase, Lowercase, or Initial Cap for HTML tags and 
attributes.

✦ Indentation. Choose tabs or indicate a specific number of spaces.

✦ Line breaks. Choose PC/Unix or Mac.

✦ Wrap width. Enter a value for the number of characters on each line.

✦ Do not format document HEAD. Select this option to exclude the HEAD section 
from the format settings in this dialog.
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✦ Maximum compression. Select this option to produce the smallest possible 
HTML code. The code will be illegible. To restore the code, clear the option 
and republish the site.

4. Click the HTML Generation tab and set the options.

✦ Charset information. If you select this option, NetObjects Fusion creates a 
META tag displaying the site character set selected on the HTML Output 
tab. This may cause Netscape Navigator to refresh unnecessarily.

✦ Generator. Select this option to list the HTML generator listed in the META 
tag. You can accept the default or enter your own generator information.If 
you clear this option, no generator information is listed in the META tag.

✦ User Transparent GIF as Spacer. If you select this option and publish using 
Regular Tables or Nested Tables, invisible image files named clearpixel.gif 
with varying widths and heights are placed in table cells to ensure accurate 
placement of objects. If you clear this option, your HTML files will be 
smaller, but your pages may not display as you intended. Be sure to test your 
pages in all browsers.

✦ Descriptive comments. Select this option to include comments in the HTML 
file created for each page. Comments identify the beginning and ending of 
each page’s head and body, as well as objects.

5. Click OK to close the Advanced HTML Options dialog.

6. Click OK to save the settings.
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Defining Server Profiles
The last task in configuring your publishing settings is to define the local or remote 
server locations where you want to store the published site. 

Each server profile has a name and a set of properties that define the local path 
name or the remote host connection settings that NetObjects Fusion uses to publish 
your site to that location and server. You can select a server profile or set its 
properties any time before you publish the site. The profile is stored with the rest of 
your publishing specifications in the Sitename.nod.nod.nod.nod file.

NetObjects Fusion includes two default server profiles: 

✦ My Computer, which defaults to a local setting with the target directory of My My My My 
\\\\Sitename\Local Publish\Local Publish\Local Publish\Local Publish.

✦ Remote Publish Server, which defaults to a blank remote server profile that you 
must fill out before publishing.

You can modify these default profiles, create your own, or delete unneeded profiles. 

Defining a Server Profile for Local Publishing
1. In Publish view, click the Setup button on the control bar. 

The Publish Setup dialog appears.

2. Select the Server Locations tab.
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To modify an existing local server profile, select the profile from the list and click 
Edit. Continue with step 4.

3. To create a new server profile, click Add.

NetObjects Fusion displays the Location Properties dialog with the Server Name 
field blank.

Enter a name for this profile in the Server Name field.

4. Click Local and fill in the Directory field using one of these methods:

✦ Enter the drive and directory path you want to use. This path can point to an 
existing directory or create a new directory.

✦ Click Browse to display the Browse for Folder dialog and select the local 
directory you want to use. To create a new directory, browse to and select the 
directory immediately above the location you want, then click OK. Enter the 
name of the new directory at the end of the path in the Directory field.

To prevent your published site files from getting mixed in with other files, enter 
or select a new or empty directory. Also, make sure the local drive has sufficient 
space for your published site files.

5. To set the file name for the Home page of your site, use the Rename the home 
page as drop-down list. You can select:
28-12 Publishing Your SitePublishing Your SitePublishing Your SitePublishing Your Site



 

Defining Server Profiles

                  
✦ Index, which is the default page name automatically recognized by most 
current servers. This is the default.

✦ Current Page Name, which is set by the value of the Name property for the 
Home page.

✦ Home, as in Home.htmlHome.htmlHome.htmlHome.html.

✦ Default, as in default.htmldefault.htmldefault.htmldefault.html.

6. Set the default file name extension applied to each page in your site by either:

✦ Selecting .htm.htm.htm.htm, .html.html.html.html, or .shtml.shtml.shtml.shtml from the drop-down list.

✦ Entering an extension of your choice.

For local publishing, be sure to use a page extension that your browser 
recognizes, or it might not display the page properly. If you defined a file name 
extension for an individual page in the Custom Names dialog, that extension 
overrides the site default for that page.

7. To convert all spaces and most non-alphanumeric characters in asset file names 
to underscore characters (_), select Replace spaces and other special characters 
with underscores. NetObjects Fusion doesn’t replace periods (.) or hyphens (-) 
because all servers understand those characters.

8. Click OK to complete the configuration of the local server profile.

Defining a Server Profile for Publishing on a Remote Server
The information needed to connect to a remote server is specific to your server. 
Contact your ISP or Web server administrator for the precise information to enter 
in these fields. For guidance on the questions you need to ask, see “Remote Server 
Access Checklist” on page 28-27.

To define a remote server profile:

1. In Publish view, click Setup on the control bar. 

The Publish Setup dialog appears.

2. Select the Server Locations tab. 

To modify an existing remote server profile, select the profile from the list and 
click Edit. Continue with step 4.

3. To create a new remote server profile, click Add.
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The Location Properties dialog appears with the Server Name field blank.

Enter a name for this profile in the Server Name field.

4. Select Remote and in the Remote Host field, enter the name or IP number used 
to connect to the remote server. This can be your site’s domain name, the name 
of an intranet server, or the name of your ISP’s server.

5. To specify a CGI FTP port number or custom port number, or establish aliases 
or virtual directories for some of your site content, click Advanced to display the 
Advanced Settings dialog. See “Creating Aliased Folders and Setting the CGI-
Bin Directory” on page 28-16 for information.

6. Enter the Base Directory for your site that defines where on the server your 
content will be stored:

✦ If your site’s Home page should be stored in the home directory of the user 
ID or server account that you use to publish your site to your Web server, 
leave this field blank.

✦ If you want your site’s Home page to be stored in a different directory than 
the home directory, enter the absolute or relative path to the Home page 
here, such as ./public_html/user./public_html/user./public_html/user./public_html/user.
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For more information on the base directory setting, see “Remote Server Access 
Checklist” on page 28-27.

7. In the Name field, enter the user ID needed to log on to the remote server so you 
can transfer files to it.

8. In the Password field, enter the password that authorizes this ID to access the 
server. To effectively publish your site, you need server permissions that let you 
add files and create directories, so you can transfer scripts and other executable 
resources to a directory on the server that lets them run.

9. Select the Remember password option if you do not want to be prompted for 
your password every time you publish remotely to this server. 

10. To set the file name for the Home page of your site, use the Rename the home 
page as drop-down list. You can select:

✦ Index, which is the default page name automatically recognized by most 
current servers. This is the default.

✦ Current Page Name, which is set by the value of the Name property for the 
Home page.

✦ Home, as in Home.htmlHome.htmlHome.htmlHome.html. 

✦ Default, as in default.html.default.html.default.html.default.html.

If you use Current Page Name, your site visitors must include the exact file name 
as part of the URL to reach your site.

11. Set the default file name extension .htm.htm.htm.htm, .html .html .html .html, or .shtmlshtmlshtmlshtml from the drop-down list 
that is applied to each page in your site. If you define a file name extension for an 
individual page in the Custom Names dialog, that extension overrides the site 
default for that page.

12. To convert all spaces and most non-alphanumeric characters in asset file names 
to underscore characters (_), select Replace spaces and other special characters 
with underscores. 

Your site might be hosted on a server that cannot handle spaces in file names, so 
it’s recommended that you select this option. NetObjects Fusion does not 
replace periods (.) or hyphens (-), because all servers understand those 
characters.

13. Click OK to complete the configuration of the remote server profile.
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Creating Aliased Folders and Setting the CGI-Bin Directory
Sometimes you need to store certain assets of your site in a location separate from 
the rest of your site. For example:

✦ You can link to programs such as CGI scripts or other executables that have to 
be placed in a specific CGI directory so they run properly.

✦ You can place an order form or other pages in a secure location that requires 
authorized access, without restricting access to the rest of your site.

✦ You can link to images or other assets that are maintained or controlled by 
others, and stored in a protected location.

Note: You cannot do this with NetObjects Fusion’s Message Board or Form Handler 
components.

To do this, you create alias folders, using a process in which you define two 
locations: the actual physical location where you want to FTP the pages or assets, 
and the URL or logical address that you want NetObjects Fusion to use when 
referring to that object. On some servers, this is referred to as creating virtual 
folders.

Once the site is published, you or your server administrator must configure the 
server to look in the FTP location for assets that are described as being in the URL 
location. For example, your site might include several stock images from your 
company’s marketing department, such as the company logo and other approved 
artwork. When you create your site, you use copies of the artwork that you stored 
on a local disk. When you publish and upload your site to the company server, 
however, you want to use the “official” images that have been approved and 
maintained by the marketing department.

Check with your server administrator to see if your site contents or remote server 
configuration requires a CGI directory or other aliases. 

To specify the CGI-BIN directory:

1. In Publish view, click Setup.

2. Click the Server Locations tab, select a remote server, and click Edit.

3. Click the Advanced button.
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The Advanced Settings dialog appears.

4. Enter the FTP path where CGI scripts are stored in the CGI field.
This establishes an alias to the executable directory on the server where CGI 
scripts are kept. 

You can also use the Advanced Settings dialog to define a specific server port or 
permissions setting—even if you are not defining aliases or virtual folders. 
Depending on your Web server configuration, you might need to set specific 
permissions so your Web server software can access your published files. This 
section describes how to set a different permission string to override the default 
permissions normally set by NetObjects Fusion. If you simply want to define a 
specific server port or permissions setting for this server profile, proceed to step 10. 

To create other aliased folders:

1. In Publish view, arrange the directory structure for your site the way you want it 
to appear on your server. 

2. Isolate the pages or assets you want to store in an aliased location into one 
branch of the directory structure, under a common parent folder. If necessary, 
create a custom folder for each set of aliased content. 

If your site requires more than one alias—such as one alias for secure pages and 
another alias for protected assets—you can create more than one custom folder. 

3. Drag pages and assets into the appropriate custom folder(s) as needed.
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4. Click Setup on the control bar. 

The Publish Setup dialog appears.

5. Select the Server Locations tab.

6. Select the remote server profile that you want to change, and click Edit. 

The Location Properties dialog appears.

7. Enter remote server profile information, if needed.

8. Position the Locations Properties dialog so you have a clear view of the 
Directory pane of Publish view. Refer to the directory structure to make sure 
you type the URL to your custom folder correctly. 

9. Click the Advanced button. 

The Advanced Settings dialog appears.

10. To specify a port or permissions setting to access this server, enter the port 
number or permissions flag in the appropriate field.

11. To add a new alias, click the Add button. To edit an existing alias, select it from 
the list, then click the Edit button.

The New Alias dialog appears.

12. Enter the absolute or relative path from your site’s root folder to the custom 
folder containing the aliased pages and assets as the URL Path.

Refer to the directory panel as needed to enter the path exactly as it appears, 
including the use of uppercase and lowercase names and spaces. For example, if 
you create a custom folder called \Companypix\Companypix\Companypix\Companypix and place it under your \Assets\Assets\Assets\Assets 
folder, the URL Path would be./Companypix. ./Companypix. ./Companypix. ./Companypix. 

13. Enter the FTP path that you want to use to actually store that folder and its 
contents. This FTP location must be on the same server as the rest of the site 
because your server profile only logs onto one server at a time.
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14. Click OK. 

15. To add additional aliases, return to step 11.

When you publish your site, NetObjects Fusion keeps all links and references to 
your aliased content pointing toward the URL path, but actually stores the pages 
and assets in the FTP location you specified.

Note: The server must be configured to support this alias. This is a system administrator task 
outside of NetObjects Fusion, so you or your server administrator must define the alias 
on the server.

Publishing Components
If you installed third-party Publish components, you can choose to publish or not 
publish them. These components generally perform post-publish processing of the 
generated HTML files.

1. In Publish view, click Setup on the control bar.

2. Click the Components tab.

A list of available components appears. NetObjects Fusion 4.0 does not include 
Publish components, so if you do not install any third-party components, such 
as NetObjects Fusion Connector for Allaire Cold Fusion, this tab will be blank.

3. Select a component to turn it on.

Customizing Your Directory Structure
Although NetObjects Fusion offers three directory structures, you might need to 
customize your site’s directory structure further. You can do this in Publish view by 
renaming, rearranging, or deleting site folders, creating custom folders, or changing 
the publishing properties for folders, pages, and assets.

Note: Customizing your directory structure does not change the appearance, design, or 
content that your site visitor sees; it only controls how the pages and assets are stored 
on the server, and the URL necessary to access the site’s interior information.
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Creating a Custom Folder
1. In either pane of Publish view, right-click the folder, page, or asset where you 

want to add a custom folder, and select New Folder from the shortcut menu.

NetObjects Fusion adds a custom subfolder named New FolderNew FolderNew FolderNew Folder below the 
selected folder or file.

2. Enter a new name for the folder and press Enter or select another object to 
record your changes.

3. Drag other folders or files into the custom folder as needed. 

Renaming Folders and Files
1. In either pane of Publish view, right-click the object and select Rename from the 

shortcut menu.

2. Edit the existing object name, or enter a new name. Press Enter or select another 
object to record your changes.

You can rename auto-generated folders and files; NetObjects Fusion remembers the 
new names the next time you generate your site. Any folder or file that you rename 
is considered customized. If you name a customized folder with a name used by an 
auto-generated folder, it is still treated as a customized folder. 

Aliased folders are also considered customized folders. Publish view displays them 
in the directory structure, even if they are empty, and tracks their name and location 
in the event you change them. See “Creating Aliased Folders and Setting the CGI-
Bin Directory” on page 28-16.

By definition, read-only assets, such as script files used by NetObjects Fusion 
Components, can’t be changed. NetObjects Fusion ignores attempts to move or 
rename read-only files.

Deleting Folders
1. In either pane of Publish view, click the folder you want to delete, and make sure 

it is empty. You cannot delete a folder until it is empty, and you also cannot 
delete pages or assets in Publish view. 

2. Right-click the folder and select Delete Folder from the shortcut menu.

NetObjects Fusion deletes the folder.
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After you delete a customized folder, the next time you publish the site, NetObjects 
Fusion recreates auto-generated assets that it needs.

Rearranging the Directory Structure
➲ In either pane of Publish view, click the folder, page, or asset and drag it to its 

new location.

NetObjects Fusion moves the object and updates all references to it.

If you move pages, NetObjects Fusion remembers their new locations, but might 
continue to auto-generate folders needed to contain that page’s assets. Components 
and their related assets have a black lock image on their icons, signifying that they 
cannot be renamed or rearranged.

Viewing and Setting Publication Properties
In addition to their other properties, your site’s folders, pages, and assets have 
publishing properties that indicate or control the way they are included in your 
published site. Three of these publication properties are indicators of the publishing 
status for that folder, page, or asset:

✦ Folders, pages, and assets that were renamed or moved from their default 
location have a customized publication property. Customized assets display a C 
in the Attributes column in Assets view, and a checkmark in the Customized 
option in the Attributes section of the Properties dialog.

✦ Some folders, pages, and assets are marked read-only:

✧ Assets created by NetObjects Fusion components, such as Site Mapper or 
Message Board.

✧ Dependent Java .class.class.class.class files that were added to the site’s assets. When you add 
a Java object and preview or publish your site, NetObjects Fusion analyzes 
the object’s .class.class.class.class file to see if it calls for other .class .class .class .class files; if so, those 
dependent .class.class.class.class files are added as read-only assets.

Read-only assets display an R in the Attributes column of the Contents pane, 
and a check in the Read-only option of the Properties dialog.

✦ Pages and assets have two published date properties that display the latest 
publication date in both the Last Remote Publish and Last Local Publish 
columns of the Contents pane. 
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✧ If an asset was never published locally or remotely, it displays Never 
Published in red in the appropriate column, and has a check in the Needs 
Publishing option of the publication Properties dialog.

✧ If an asset was changed since the last time it was published, it displays the 
Last Published date in red, and has a check in the Needs Publishing option of 
the Publication properties dialog. If you select Publish changed assets only 
when you publish this site, the assets with red dates are re-published to the 
server.

Suppressing a Page or Asset from the Published Site
You can also suppress publishing for a selected page or asset by setting its Don’t 
Publish property. If you set this property, NetObjects Fusion:

✦ Overrides Needs Publishing or Publish changed assets setting for this page or 
asset.

✦ Displays a diagonal red slash mark through the page or file icon in Publish view 
and adds a D to its attribute column.

✦ Publishes the site without that page or asset.

To suppress publishing for a page or asset:

1. In Publish view, right-click the page or asset and choose Properties from the 
shortcut menu.

The Properties dialog appears.

2. Select Don’t Publish, then click OK.

NetObjects Fusion displays a red slash through the page or asset icon and 
suppresses it from the site when published.

To re-enable publishing for a suppressed page or asset, repeat step 1, then clear 
Don’t Publish and click OK.
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Publishing Your Site
When your publishing configuration settings are complete, you are ready to publish 
your site. 

1. In Publish view, click the Publish button on the control bar.

The Publish Site dialog appears.

Publish the entire site the first time. Later, if you change the site, make sure you 
publish the page or section with the changes. 

2. Use the Location drop-down list to select a server profile.

Click Edit to change the server profile settings. See “Defining Server Profiles” on 
page 28-11.

3. Select Publish changed assets only to publish only those assets that changed 
since the last time you published the site.

NetObjects Fusion determines which assets have changed since the last time the 
site was published, then generates and transfers only those assets.

Note: NetObjects Fusion does not query the server to see if it has all the unchanged 
assets needed by the site. If you publish changed assets only, be sure you 
publish to the same location you did previously, so unchanged assets are still 
available.

4. Select what part of the site to publish.
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✦ Entire Site. Publishes all the pages on the site. 

✦ Site Section. Publishes everything within a section of a site. Click the arrow 
(>) to display the SiteStructure. In the tree structure, double-click the base 
section page to publish. The section name appears in the Site Section field.

If you change the directory structure after publishing the site for the first 
time, make sure you publish the entire site and not a site section.

✦ Selected Page only. Publishes the page you select in the SiteStructure. You can 
use this feature if you want to make a change on one page and then re-
publish that page. To publish a page, click the greater than sign (>) to display 
the SiteStructure. Double-click page you want to publish. The page name 
appears in the Selected Page only field. 

5. Click OK to publish your site.

✦ If you publish locally, NetObjects Fusion creates the local directories if 
needed and stores the formatted site as specified.

✦ If you publish your site on a remote server, NetObjects Fusion generates a 
temporary copy of the site, connects to the remote server using the settings 
in the server profile, and uses its internal FTP program to transfer the site 
files and directories to the remote server, using the file and directory 
structure you specify.

If you specify in Publish Setup a folder that doesn’t exist yet on the server, 
NetObjects Fusion alerts you that the target directory doesn’t exist, and asks 
for confirmation that you want it to be created.

6. While NetObjects Fusion is transferring the published site to the server, you can 
select a different view and continue working. You cannot open a different site.

Note: Any changes made to the site while it is being transferred are not 
automatically made in the published version. 

7. When the transfer is complete and your site is in place, access it with your 
browser and examine the results. You can now make changes to the site file 
(Sitename.nod.nod.nod.nod), and re-publish the site or its changed assets as needed.
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Additional Publishing Guidelines
✦ Sites published with NetObjects Fusion work with any Web server, on any 

operating platform. No special Web server extensions are required.

✦ When you re-publish your site, NetObjects Fusion overwrites existing files as 
needed. It does not, however remove old files or obsolete assets from local or 
remote directories; you have to perform these housekeeping duties yourself. 
Delete unused assets and clean out obsolete files before publishing a new version 
of a site. See Chapter 27, “Managing Assets.”

✦ NetObjects Fusion does not automatically publish through firewalls or to proxy 
servers. See “Publishing with Firewalls or Proxy Servers” on page 28-25.

✦ If NetObjects Fusion has difficulty storing your site on a remote server:

✧ Make sure your system is online and has a valid connection to your network 
or the Internet.

✧ Make sure the server is not down or offline.

✧ Make sure your server profile settings are correct. Test the remote host, 
account name, and password settings displayed in the Location Properties 
dialog by using them to log onto the server using a separate FTP or telnet 
application.

✧ Make sure your account has the appropriate permissions, and that there is 
sufficient storage space for your site on the server.

✦ If you define publishing configuration settings for a site, and then export that 
site as a template, those settings travel with the template. If you are sharing a 
template with colleagues who can use the same publishing settings, you can save 
time by configuring the publishing settings in advance, exporting them with a 
template, and then distributing the template. 

Publishing with Firewalls or Proxy Servers
If you develop sites behind a firewall and need to publish to a remote server that is 
outside the firewall, you might be able use FTP passive mode to connect to the 
server.

1. In Publish view, click Setup.

2. Click the Server Locations tab, select a remote server, and click Edit.

3. Click the Advanced button.
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4. In the Advanced Settings dialog, select Connect passive [PASV] mode.

If the reverse is true and your remote server is behind a firewall or stored on a proxy 
server, NetObjects Fusion cannot publish directly to the server. If that’s the case, 
follow these steps:

1. Publish your site to a local folder other than the \Sitename\Preview\Preview\Preview\Preview folder of your 
site. Use whatever directory structure and publishing method you would 
normally. The default setting, My Computer, publishes to the folder 
\Sitename\Local Publish\Local Publish\Local Publish\Local Publish.

2. Consult with your server administrator for the preferred method of transferring 
content to the remote server. Potential methods include: 

✦ Transferring the entire directory structure of the locally published site to a 
holding location on an unprotected server, so an authorized administrator 
can then transfer the site to the protected location.

✦ Using an FTP application such as WS-FTP or other means of access 
authorized by the server administrator to transfer the entire directory 
structure of the locally published site to the protected server.

In either instance, be sure to transfer all files and to duplicate the local folder 
structure precisely.

Publishing Special Assets
When you publish your site, NetObjects Fusion transfers the entire site to your 
designated location, including special assets you told it to manage. These special 
assets include things like Java classes, images and assets contained on external 
HTML pages, and CGI scripts. The list of managed assets included in your 
published site is displayed in Assets view.

There are three ways to ensure that these special assets are included in your site’s 
managed assets when you publish:

✦ Include the assets when you add the object that refers to them. For example:

✧ If you reference external HTML pages using the External HTML tool, 
NetObjects Fusion automatically analyzes the external pages and includes 
their assets in the Asset Manager—unless you select Do not manage or move 
assets. If you do not select this option, you have to add the assets those pages 
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need to the Asset Manager, using one of the two methods below. See “Adding 
a File Asset” on page 27-4.

✧ If you add Java objects to your pages using the Java tool, NetObjects Fusion 
analyzes their .class.class.class.class files and adds other .class  .class  .class  .class files referenced there. If you 
listed special assets in the Java Object Properties palette, NetObjects Fusion 
includes them as managed assets. See “Inserting a Java Applet or Servlet” on 
page 20-2.

✦ You can add a file link to a special asset, and NetObjects Fusion manages and 
publishes the asset. See “Creating a File Link” on page 18-10.

✦ You can explicitly add any special asset to the Asset Manager and select Always 
publish file to ensure that NetObjects Fusion manages and publishes the asset. If 
you select Always publish file and only publish a section of the site, NetObjects 
Fusion places this asset at the root of the site. See “Adding a File Asset” on 
page 27-4.

Managing Script Assets
NetObjects Fusion does not analyze custom scripts that you add to pages, 
MasterBorders, or other objects. If those scripts reference special assets, they are not 
automatically included in the site’s managed assets. To have NetObjects Fusion 
manage and publish assets called in custom scripts, you must create file links to 
those assets, or explicitly add them to the Asset Manager. 

Remote Server Access Checklist
Before you create a remote server profile, answer these questions.

1. Who is your service provider? This is the ISP, organization, or department that is 
going to store your site on its server and provide your site visitors access to it. 

The technical support staff of your service provider should be able to provide 
the answers to the rest of these questions. ISPs and other service providers often 
offer technical support pages on their own Web sites.

2. What is the name of your remote host? This is the name of the server where you are 
going to store your site. It might be the same as your domain name, such as 
www.www.www.www.yourname.com.com.com.com; a name assigned by the service provider, such as 
inbox.inbox.inbox.inbox.isp.com.com.com.com; or a specific IP address, a series of four numbers separated by 
periods.
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My Remote Host: ___________________________________________My Remote Host: ___________________________________________My Remote Host: ___________________________________________My Remote Host: ___________________________________________

3. What is your base directory? When you log onto your remote host, you 
automatically begin in the home directory for your log-in account. This might 
not be the right place to put your site, however. For a variety of reasons, you 
might need to store your site in a subdirectory of your home directory, or in 
another directory altogether.

You must know the absolute or relative path from your account’s home 
directory to the base directory where your site should be stored. When 
NetObjects Fusion publishes your site and logs onto your service provider, it 
stores your site’s pages and assets in this base directory. This path statement is 
the value you enter for Base Directory in the Location Properties palette for 
remote server publishing. 

However, the host and base directory might not look anything like the URL that 
your site visitors use to access your site. For security and other reasons, service 
providers frequently name their host machines and user directories according to 
their own needs.

My Base Directory or path to my site folder:_____________________________________My Base Directory or path to my site folder:_____________________________________My Base Directory or path to my site folder:_____________________________________My Base Directory or path to my site folder:_____________________________________

Note: If you have your own domain, such as www.www.www.www.mycompany.com.com.com.com, and are 
logging in directly to the account that owns that domain, you might not need 
to specify a base directory, because the home directory of that account might 
be the same location as the base directory.

4. What is the name and password for your account? You need these so NetObjects 
Fusion can log on to the server and store your site files.

My account name:______________ Password: _______________My account name:______________ Password: _______________My account name:______________ Password: _______________My account name:______________ Password: _______________

5. What is the preferred name for the default Home page? Your service provider 
determines what file name the server displays by default for each directory on 
the server. Some servers are configured to display by default any file named 
indexindexindexindex; others default to homehomehomehome or defaultdefaultdefaultdefault. You must match this preferred name in 
the Location Properties dialog for remote server publishing.

My server’s default file name is: ____________________________My server’s default file name is: ____________________________My server’s default file name is: ____________________________My server’s default file name is: ____________________________

6. What HTML file name extension does your server support? Web page servers typically 
support .htmlhtmlhtmlhtml, .htmhtmhtmhtm,    or .shtml  .shtml  .shtml  .shtml as file name extensions. Some service providers 
map one to the other so the server recognizes all of them; others require you to 
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use a specific one. You must set the Location Properties dialog so NetObjects 
Fusion publishes files with the correct extension. You can also enter a custom 
extension, if your server supports it.

My server’s preferred or required extension: __________________My server’s preferred or required extension: __________________My server’s preferred or required extension: __________________My server’s preferred or required extension: __________________

7. Is a specific port required for upload? The service provider might have designated a 
specific port on the server that it wants you to use to upload files. If so, you must 
specify this for NetObjects Fusion. See “Creating Aliased Folders and Setting the 
CGI-Bin Directory” on page 28-16.

My server’s custom port number: __________________My server’s custom port number: __________________My server’s custom port number: __________________My server’s custom port number: __________________

8. Does your log-in account have the necessary permissions? Servers use permission 
configurations to control what users are allowed to do while logged on—
whether they can delete files, for example, or create new directories. 

In Publish view, you can specify the server file and directory structure that you 
want NetObjects Fusion to create or use for your site. Your log-in account—
which NetObjects Fusion uses to store the files—must have the server 
permissions necessary to create the directory structure you defined. 

If your service provider does not let user accounts create directories, then you 
must use the Flat directory structure option to publish your site.

My account does / does not have permission to create server directories.My account does / does not have permission to create server directories.My account does / does not have permission to create server directories.My account does / does not have permission to create server directories.

9. How much server space do you have? Before you publish, you should publish your 
site locally and check the size of the generated \Sitename\Publish\Publish\Publish\Publish folder, including 
all its sub-folders. Make sure the space allocated on the server is enough to 
accommodate all the files in the Publish folder. 

My account’s storage capacity: _________________________My account’s storage capacity: _________________________My account’s storage capacity: _________________________My account’s storage capacity: _________________________
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Working Around Browser 
Problems A
Sometimes browsers don’t properly display or handle actions, forms, and other 
objects you create in NetObjects Fusion. This can happen because earlier versions of 
browsers don’t support the latest features available in HTML, or because of 
problems in the browsers themselves. This appendix helps you work around 
browser problems that affect the way your pages display.

The information in this appendix is current for browser versions available at the 
time of publication. If you encounter a browser problem, obtain the latest browser 
version from the vendor to determine if the problem is fixed in the latest release.

Also be aware that later versions of browsers might have different problems. See the 
usage notes at www.netobjects.comwww.netobjects.comwww.netobjects.comwww.netobjects.com for the latest information on browser problems. 
This includes not only the browser problems you might encounter while using 
NetObjects Fusion, but also URLs to sites that have more comprehensive listings of 
browser problems.

This appendix describes problems with:

✦ Actions

✦ Components

✦ Forms

✦ Java Beans

✦ Sounds and Shockwave objects

✦ Older Browsers
A-1
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About HTML Output Methods
You can often work around browser problems by changing the HTML output 
method you use to publish the affected page or Layout Region. The HTML output 
method specifies the format of the HTML generated by NetObjects Fusion. To 
determine which HTML output methods are appropriate for your site, read the 
discussions on publishing with Nested Tables, Regular Tables, CSSP+Layers, CSSP, 
and Layers in Chapter 7, “Controlling Published Output.” To learn how to change 
the HTML output method for a page or Layout Region, see “Setting the HTML 
Output Method for a Layout or Layout Region” on page 8-6.

If the solution to your problem is to publish the page with a particular HTML 
output method, but other objects on the same page require a different HTML 
output method, use Layout Regions to accommodate both requirements. For 
example, if you have a form, which must be published in Nested Tables or Regular 
Tables, and you also have the Use Image action assigned to an image, which must be 
published in CSSP+Layers, you can put the form in a Layout Region set to publish 
with Regular Tables and put the image inside a Layout Region set to publish with 
CSSP+Layers. Layout Regions change the HTML output method for a portion of a 
page, which lets you take advantage of the strengths of each HTML output method 
on the same page.

The CSSP output setting is designed specifically for site visitors who use Microsoft 
Internet Explorer 4.0 and above; the Layers setting for site visitors using Netscape 
Navigator 4.0 and above. If you view a site published with one of these settings in 
the “wrong” browser, objects might be positioned incorrectly. If you are not sure 
which browser your site visitors use, choose CSSP+Layers as the HTML output 
method.

Problems with Actions
If you or your site visitors have problems seeing actions work correctly, check the 
following list of problems and solutions. If you publish a page that contains actions, 
make sure your site visitors view the page with 4.x browsers because earlier browser 
versions do not support the DHTML that makes actions possible. 

Problem: I have objects with actions on a page. The page is published with Nested 
Tables as the HTML output method. Actions do not work when I view the page in a 
browser.

❖
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Solution: In general, you should publish pages with actions with Regular Tables or 
CSSP+Layers as the HTML output method. Many actions, such as those triggered 
by mouse events, do not display properly in Netscape Navigator 4.x when the page is 
published with Nested Tables as its HTML output method. 

Problem: I have an object with an action inside a Layout Region on a page. The 
page, including the Layout Region, is published with Regular Tables as the HTML 
output method. The action does not work when I view the page in Microsoft 
Internet Explorer 4.0.

Solution: In general, if you have an object with an action inside a Layout Region, 
change the Layout Region’s HTML output method to CSSP+Layers and republish 
the site. If both the object and the Layout Region that contains it have actions, 
change the HTML output method for the entire page to CSSP+Layers and republish 
the site.

Problem: I assigned an action to an object embedded inside a text box, table, or 
Layout Region. When I view the published page, the object disappears or appears in 
the wrong place. If the object does appear, the action assigned to the object does not 
work. The page is published with Nested Tables as the HTML output method.

Solution: If Netscape Navigator 4.x doesn’t display some objects or if it displays 
them in the wrong place, publish the page with CSSP+Layers as the HTML output 
method. If you don’t want to use CSSP+Layers as your HTML output method, 
move the object with the action outside the text box or Layout Region, change the 
page’s HTML output method to Regular Tables, and republish the site. You also 
might be able to fix the problem by removing any action assigned to the table, text 
box, or Layout Region.

Problem: When I preview pages that contain actions in Netscape Navigator 4.x, 
most of the actions do not work, but if I publish the page to a remote Web server 
and view the page, the actions work correctly. 

Solution: Avoid using Netscape Navigator 4.05 to preview sites with actions. A 
security feature in that version prevents actions from working correctly when you 
preview or publish locally. This problem does not exist in other versions of Netscape 
Navigator.

Problem: Transition and movement actions seem jerky and slow when I view them 
with my Macintosh browser. Sometimes when I click to start an action, the action 
does not start.

◆

❖

◆

❖

◆

❖

◆

❖
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Solution: You might experience delays starting actions when you view your pages on 
a Macintosh. Actions are also slower to execute with Macintosh browsers, making 
them seem shaky. Make sure you wait until the loading activity in the browser’s 
status bar is complete before you try to invoke actions that require user input, such 
as a mouse click. Also, if you click and hold down the mouse button, the browser 
might incorrectly identify the click as an attempt to see the context menu.

Problem: My drag and collision detection actions work only sporadically in 
Macintosh browsers.

Solution: The Macintosh operating system’s drag-and-drop functionality sometimes 
interferes with drag and collision detection actions in the browser. The operating 
system tries to interpret a drag in the context of the operating system’s built-in drag 
and drop functionality.

Problem: I assigned a transition effect action or a clip action (such as Iris, Peek, Set 
Clip Top, Set Clip Right, and so on) to an object on my page. The transitions do not 
display when I view the page in Microsoft Internet Explorer.

Solution: If you are viewing the page in Microsoft Internet Explorer 4.x for 
Windows, set the page’s HTML output method to CSSP+Layers and republish the 
site to see the transition or clip action. If the objects with transition actions are 
inside a table or text box, changing the HTML output method will not fix the 
problem. Either put the object inside a Layout Region instead of the table or text 
box and set its HTML output method to CSSP+Layers, or use a motion transition 
instead.

If you are viewing the page in Microsoft Internet Explorer 4.x for Macintosh, 
transitions and clip actions do not work. Images with transitions on Macintosh 
display in their static state. Tell your Macintosh site visitors to view the page with 
another browser or use a motion action instead. 

Problem: I assigned an action to an object that is triggered by a mouse click, a 
mouse over, or a mouse out. When I view the published page in Netscape Navigator 
4.x, the action does not work. The page is published with Nested Tables as the 
HTML output method.

Solution: Sometimes Netscape Navigator 4.x does not register mouse clicks properly 
when the HTML output method is Nested Tables or Regular Tables. Change the 
HTML output method to Regular Tables or CSSP+Layers and republish the site.

◆
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Problem: I have a SET SRC or Use Image action attached to an object. It is supposed 
to cause a different image to appear based on a mouse event (mouse click, mouse 
over, mouse out, mouse up, or mouse down), but these actions do not work when 
viewed in Netscape Navigator 4.x. The page is published with Nested Tables as the 
HTML output method. 

Solution: Use Regular Tables or CSSP+Layers as the HTML output method and 
republish the site.

Problem: I made a Layout Region and assigned a Display HTML action to it. The 
Display HTML action does not work correctly. 

Solution: In Netscape Navigator 4.x, the Display HTML action, assigned to a Layout 
Region, does not work if the Layout Region’s container is published with Regular 
Tables or Nested Tables as its HTML output method. Make sure the Layout Region’s 
container, which can be either the page or another Layout Region, has CSSP+Layers 
as its HTML output method. If you don’t want to change the HTML output method 
of the entire page, make another Layout Region of the same size, set its HTML 
output method to CSSP+Layers, and embed the first Layout Region inside the 
second Layout Region. 

You might encounter another problem with the way the Display HTML action and 
Layout Regions work together. If the Display HTML action’s target is a Layout 
Region, and the Layout Region has a background color or image, the Layout Region 
shrinks to the size of the displayed HTML when the action is performed. To avoid 
this, use Microsoft Internet Explorer to view the page.

Problem: I added actions to a page that includes custom JavaScript expressions and 
I see JavaScript errors when I view the page in a browser. 

Solution: If you use the JavaScript Expression dialog box to specify the parameters of 
an action, the code you enter must be valid JavaScript. If you want to type in your 
own JavaScript to complete an action, consult a JavaScript reference guide for 
correct syntax and acceptable values. 

Also, if you create custom messages that you send to other objects on a page, use 
only alphanumeric characters in the message name because the name is used in a 
JavaScript expression when the HTML is generated for the page.

❖

◆

❖

◆

❖

◆

Working Around Browser ProblemsWorking Around Browser ProblemsWorking Around Browser ProblemsWorking Around Browser Problems A-5



   

Problems with Components

                    
Problems with Components

Problem: I added the Picture Rollover component to a page. Some of my site 
visitors get JavaScript errors when they mouse over the picture. 

Solution: Site visitors who view the Picture Rollover component with Netscape 
Navigator 3.x get JavaScript errors as they mouse over the picture. Tell your visitors 
to use a different browser version to avoid this problem.

Problem: Dynabuttons do not display in Microsoft Internet Explorer 3.01 for the 
Macintosh. 

Solution: Tell your site visitors to view your site with Microsoft Internet Explorer 4.x 
or Netscape Navigator 3.x or 4.x.

Problem: I put the Message Board component on a page. When I view it in the 
browser, the forward and back buttons do not work consistently. 

Solution: In Microsoft Internet Explorer 4.0, the forward and back buttons for the 
Message Board component work only once. Tell your site visitors to use another 
browser to access the page containing the Message Board component.

Problem: I placed a Form Handler component on a page and configured it to email 
when the Submit button is clicked. When site visitors fill out the form on the 
browser page and click Submit, it brings up an addressed, but otherwise empty 
email document. It does not put the values in the body of the email.

Solution: If the site visitor is using Microsoft Internet Explorer 4.x browser, the 
browser must be correctly configured to use email. If the site visitor is using a 3.x 
browser, sometimes the mailto: HTML tag does not work properly. They might 
need to use Netscape Navigator 4.x to submit the form.

Problem: I included the Screen Door component to redirect site visitors using 
Netscape 4.5 and it is not working properly.

Solution: This is a problem with the browscap.ini file in Windows NT that you can 
fix easily. On your IIS server, go to the \\\\%SystemRoot%\System32\InetSrv\\System32\InetSrv\\System32\InetSrv\\System32\InetSrv\ directory, 
where %SystemRoot% is the Windows NT directory, typically C:\WinNT\C:\WinNT\C:\WinNT\C:\WinNT\. In the 
browscap.inibrowscap.inibrowscap.inibrowscap.ini file, search for the phrase Navigator 4.x WILDCARDNavigator 4.x WILDCARDNavigator 4.x WILDCARDNavigator 4.x WILDCARD. On the line below this 
phrase, change [Mozilla/4.0*][Mozilla/4.0*][Mozilla/4.0*][Mozilla/4.0*] to [Mozilla/4.*][Mozilla/4.*][Mozilla/4.*][Mozilla/4.*] and save the changed file. If you don’t 
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want to edit the file, you can get an updated version at www.cyscape.com/asp/www.cyscape.com/asp/www.cyscape.com/asp/www.cyscape.com/asp/
browsercapbrowsercapbrowsercapbrowsercap.

Problems with Forms

Problem: I have a page with a form. Within the form, I also have an object with an 
action. None of the form objects are visible when I view the page in Netscape 
Navigator 4.x.

Solution: The problem occurs if the object with the action appears within <FORM> 
tags before the form objects. If the object with the action is after the form objects, 
the problem does not occur. If the object with the action is before the form objects, 
but is not within <FORM> tags, the problem does not occur.

Move the object with the action so it appears below the form objects in the form 
container, or place the form objects in a Layout Region form and place the object 
with the action above the layout Layout Region form.

Problem: I placed form objects on a page, set the Layout to be a form, and set the 
page’s HTML output method to CSSP+Layers. When I view the page in any 
browser, I see all the content on the page stacked vertically against the left margin of 
the browser.

Solution: Forms do not work in Netscape 4.x browsers if the form is published with 
CSSP+Layers as the HTML output method. Change the HTML output method to 
Regular Tables or Nested Tables and republish the site. 

Problems with Java Beans

Problem: I placed a Java Bean on a page, but the Java Bean does not work when site 
visitors view it in their browsers.

Solution: Check to see if the page includes actions and also note the page’s HTML 
output method. If you have actions on the same page as your Java Bean, and you use 
Nested Tables as the HTML output method, Java Beans do not work. Either change 
the HTML output method or remove the actions from the page.

Also, Java Beans do not work in version 4.04 of Netscape Navigator Japanese. Tell 
site visitors to use another browser version.

❖
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Problems with Sounds and Shockwave

Problem: In some situations, sound or Shockwave objects published using Nested 
Tables or Regular Tables as the HTML output method can’t be started, stopped, or 
otherwise controlled in Netscape Navigator 4.0. 

Solution: To avoid this problem, change the HTML output method to CSSP+Layers.

Problem: I assigned Play, Pause, and Stop actions to objects on my page. When 
clicked, the objects are supposed to control a sound. When I view the page in a 
browser and click the objects, nothing happens.

Solution: In Netscape Navigator 4.x, the Play, Pause, and Stop actions do not work 
unless the sound icon is an inline icon and the HTML output method is 
CSSP+Layers. When you place the sound, choose the inline icon in the Display 
section of the Sound Properties palette, change the page’s HTML output method to 
CSSP+Layers, and republish the site. The actions do not work in Microsoft Internet 
Explorer 3.x, 4.x, or Netscape Navigator 3.x. Site visitors with those browser 
versions must click the controls in the inline icon itself to control the sound.

Problem: I put a RealAudio sound on my page. When I view the page in a browser, I 
get a message that says the plugin is not loaded. But I know I have the RealAudio 
plugin loaded, and it works for other RealAudio sounds.

Solution: You might have selected the inline option in the Display section of the 
Sound Properties palette. Netscape Navigator does not handle the sound properly if 
the inline icon is displayed. Select another icon or picture in the Display section of 
the Sound Properties palette.

Problems with Older Browsers

Problem: When I view my published page in either Netscape or Microsoft browsers, 
I see all the content on the page stacked vertically against the left margin of the 
browser. 

Solution: You probably viewed a page published in CSSP+Layers with an older (3.x) 
browser, or you viewed a form published in CSSP+Layers with a 4.x browser. If you 
viewed a form, see “Problems with Forms” on page A-7 for information. If the 
problem occurred because you used an older browser to view a page published in 
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CSSP+Layers, either view the page with a 4.x browser or change the HTML output 
method to Regular Tables or Nested Tables and republish the site. 

Problem: Some images do not display in older Netscape or Microsoft browsers. 

Solution: Make sure the images are not in .png.png.png.png format. NetObjects Fusion 3.0 lets 
you place .png.png.png.png images on the page, but 3.x and earlier browsers do not support .png.png.png.png 
images. If you want the images to display correctly in all browsers, open them in an 
image editing application and save them in .gif.gif.gif.gif or .jpg.jpg.jpg.jpg format.

Other Browser Problems

Problem: I have links to anchors in my site, but they don’t work. The links take my 
site visitor to the correct page, but not to the anchor location.

Solution: In Netscape Navigator 3.x, if you have a link to an anchor, and the anchor 
is on a page that is published with CSSP+Layers as its HTML output method, the 
link displays the page, but does not scroll to the anchor. To fix this, change the 
HTML output method for the page with the anchor to Nested Tables or Regular 
Tables and republish the site.

Problem: I made a table and embedded it inside a Layout Region. The table does not 
display properly in Netscape Navigator. It displays as an empty one-celled table. The 
HTML output method for the Layout Region is CSSP+Layers.

Solution: This occurs if you embed a table in a Layout Region whose HTML output 
method is set to CSSP+Layers, and the Layout Region’s container is set to Nested 
Tables. To ensure that the table displays properly, change the HTML output method 
for the Layout Region’s container to Regular Tables or CSSP+Layers. The Layout 
Region’s container can be the page Layout or another Layout Region.

Problem: I embedded an object inside some text and set its alignment to Middle on 
the Align tab of the Picture Properties palette. When I view the page in the browser, 
the object is aligned to the bottom of the text instead of the middle.

Solution: If the embedded object is shorter than the text, the Middle option does not 
work correctly in Netscape Navigator 3.x or 4.x. If it is important that your site 
visitors see the object aligned correctly, tell them to use another browser.

Problem: I applied a background image to a Layout Region, but the background 
image does not display in the browser.
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Solution: Background images do not display in Netscape Navigator 4.x for Layout 
Regions if the HTML output method is Nested Tables or Regular Tables. Change the 
HTML output method for the Layout Region to CSSP+Layers. For the page itself, 
you can leave the HTML output method set to Nested Tables or Regular Tables.

Problem: I have multiple Layout Regions inside of one another on a page. 
Sometimes Layout Regions do not display in the browser, and sometimes Netscape 
Navigator crashes or hangs.

Solution: When you publish a page with Nested Tables or Regular Tables as the 
HTML output method, Netscape Navigator 4.x has problems handling multiple 
Layout Regions on top of one another. Redesign your page so it does not contain 
multiple Layout Regions within Layout Regions, change the page’s HTML output 
method to CSSP+Layers, or instruct your site visitors to use another browser.

Problem: Site visitors who view my site with Microsoft Internet Explorer on the 
Macintosh do not see scroll bars on the browser window. They cannot scroll to see 
content outside the visible portion of the browser window. 

Solution: Microsoft Internet Explorer 4.x for Macintosh does not display scroll bars 
for pages published with CSSP+Layers as the HTML output method. Either change 
the HTML output method for the page to Regular Tables or Nested Tables and 
republish the site, or tell your Macintosh site visitors to use another browser to view 
the site.

Problem: The alt tags I assign to imagemap hot spots don’t show up in my browser.

Solution: In Microsoft Internet Explorer 4.0, alt tags assigned to hot spots don’t 
appear in the browser window.
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Working with Character Sets B
In the past, most computers used the same character set to represent upper and 
lowercase English language letters, number characters, and punctuation characters. 
This character set is known as ASCII. However, ASCII is a very limited character set, 
unable to support a variety of alphabets. To accommodate computer users 
worldwide, different character sets were developed. These new character sets are 
often identified by a number, such as code page 850 or ISO-8859-1.

Character sets are composed of code points, which are the numbers assigned to 
characters that the computer uses to identify the character. For example, in ASCII, 
when you type a capital A, the computer sees its code point, which is the number 65; 
if you type a B, the computer sees a 66. Both the code page 850 and the ISO-8859-1 
character sets include accented characters, but 850 uses the code point 130 for the 
character é, and 8859-1 uses 233 for the same character. To eliminate this confusion, 
an effort is underway to create a universal character set that includes every character 
from every language. This character set is called Unicode.

Characters display correctly in NetObjects Fusion because they are stored in 
Unicode. When NetObjects Fusion publishes or previews a page, it converts the text 
from Unicode to the character set selected for the site or for the individual page.

Suppose you type Greek characters on a page, set the page character set to Western 
European, and preview the page. Because their particular code points do not have 
equivalents in the Western European character set, the Greek characters are 
displayed as yen characters (¥). If you want the Greek characters on the NetObjects 
Fusion page to display correctly when you preview or publish, you must choose a 
character set that includes Greek characters. This character set is then inserted in the 
charset parameter in the generated HTML META tag, which tells the browser how 
to interpret and display the characters.

If you have a page that contains languages that use different character sets, for 
example, English on the right and Greek on the left, you can use Unicode (UTF-8) 
as a character set for the page. Remember that Unicode is evolving; it is not 
complete yet, but it does include code points for most characters in languages 
commonly used on computers today. Note that only Netscape 4.0 and Microsoft 
Explorer 4.0 and up currently support UTF-8.
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Available Character Sets
The following character sets are included with NetObjects Fusion:

✦ Western European (ISO-8859-1)

✦ Western European (Windows-1252)

✦ Western European (CP850)

✦ Western European (CP437)

✦ Central European (ISO-8859-2)

✦ Central European (Windows-1250)

✦ Japanese (JIS)

✦ Japanese (SHIFT_JIS)

✦ Japanese (EUC-JP)

✦ Traditional Chinese (BIG5) 

✦ Simplified Chinese (GB2312)

✦ Korean (KSC5601)

✦ Cyrillic (KO18-R)

✦ Cyrillic (ISO-8859-5)

✦ Cyrillic (Windows-1251)

✦ Greek (ISO-8859-7)

✦ Greek (Windows-1253)

✦ Turkish (ISO-8859-9)

✦ Turkish (Windows-1254) (Windows 98 and Windows NT only)

✦ Unicode (UTF-8)

✦ Unicode (UTF-7)

✦ Baltic (Windows-1257) (Windows 98 and Windows NT only)

The following character sets are not included with NetObjects Fusion, but are 
supported once installed in your operating system. You can download language kits 
at www.microsoft.com www.microsoft.com www.microsoft.com www.microsoft.com or install them from your Windows NT installation disks.

✦ Western European (CP-437)

✦ Western European (CP-850)

✦ Central European (CP-852)

✦ Cyrillic (CP-866)

✦ Greek (CP-869)

✦ Greek (CP-737)
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✦ Turkish (CP-857)

✦ Turkish (CP-1254)

✦ Baltic (CP-1257)

Setting the Site’s Character Set
1. Go to Publish view.

2. Click the Setup button on the control bar.

3. In the Publish Setup dialog, click the HTML Output tab.

4. Select a character set from the Site Character Set drop-down list.

All text you type on pages in this site is published in this character set, unless you 
change the character set for the individual page. 

All characters display properly in NetObjects Fusion because it stores all 
characters in Unicode. However, if you type characters that are not included in 
the selected character set, when you preview or publish the page, you see 
question marks or yen marks (¥) in place of unknown characters.
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Setting the Character Set for an Individual Page
You can override the default site character set and choose a different character set 
for individual pages.

1. In Page or Site view, right-click on the page and select Page Character Set from 
the shortcut menu.

The character set for the site is shown. To change this setting, you must go to the 
Publish Setup dialog.

2. Select a character set for the page from the Page Character Set drop-down. This 
character set will be applied only to this page.

Setting the Character Set for a Section
1. Go to Site view and select a section by holding down the Shift key and clicking 

the parent page of the section.

2. Right-click the parent page of the section and select Section Character Set from 
the shortcut menu.

The character set for the site is shown. To change the setting for the site, you 
must go to the Publish Setup dialog.
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3. Select a character set for the section from the Section Character Set drop-down.

Setting the Character Set for Imported Pages
When you import a site into NetObjects Fusion, you must ensure that it has the 
correct character set before you begin the import.

1. From the Edit menu, choose Preferences.

2. In the Preferences dialog, click the International tab.

3. In the Imported HTML section of the dialog, select a character set for imported 
text from the drop-down list.

If you know the HTML pages in the site you are importing have the appropriate 
character set specified in the META tag, you can use the Specified in imported 
Meta tag setting. If, however, you know the site is in Greek and the correct 
character set is not specified in the META tag, then before importing you should 
choose an appropriate character set from the drop-down list. 

If there is no character set specified in the META tag, and you forget to set the 
correct character set before importing, you must delete the imported pages, set 
the correct character set, and then import the pages again.
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URL and Page Name Character Requirements
The characters in a URL are limited to those represented in lower ASCII, which 
includes upper and lowercase English letters, numbers, and common English 
punctuation. You cannot use accented characters or other special characters in a 
URL.

You can, however, name pages using international characters. The names on the 
banner and buttons display in the correct international form. In Publish view, 
however, you see the ASCII version of the file names, page names, folders, and so 
on. For the Asian languages, NetObjects Fusion uses the ASCII characters that are 
normally converted to an Asian character. For European languages, NetObjects 
Fusion strips out the accents; the words look the same but without accents. For 
example, if you name a page été in Site view, in Publish view it is listed as ete.htmlete.htmlete.htmlete.html. 
B-6 Working with Character SetsWorking with Character SetsWorking with Character SetsWorking with Character Sets



 

Index

 

I-1

 

Index

 

File Types
.aiff files

 

    

 

19-1019-1019-1019-10
.au files

 

    

 

19-1019-1019-1019-10
.avi files

 

    

 

19-819-819-819-8
.class files

 

    

 

20-2, 20-2, 20-2, 20-2, 

 

20-420-420-420-4
.dcr files

 

    

 

19-219-219-219-2
.dir files

 

    

 

19-219-219-219-2
.dxr files

 

    

 

19-219-219-219-2
.fpx picture files

 

    

 

13-213-213-213-2
.gif files

 

    

 

13-213-213-213-2
animated

 

    

 

13-213-213-213-2
dithered background

 

    

 

13-713-713-713-7
transparent

 

    

 

13-713-713-713-7
.jar files

 

    

 

20-420-420-420-4
.jpg/.jpeg files

 

    

 

13-2, 13-2, 13-2, 13-2, 

 

25-725-725-725-7
.midi files

 

    

 

19-1019-1019-1019-10
.mov files

 

    

 

19-6, 19-6, 19-6, 19-6, 

 

19-819-819-819-8
.mpe/.mpv files

 

    

 

19-819-819-819-8
.mpg/.mpeg files

 

    

 

19-819-819-819-8
.nod files

 

    

 

3-23-23-23-2
.ocx files

 

    

 

20-720-720-720-7
.pdf files

 

    

 

19-1219-1219-1219-12
.png files

 

    

 

13-213-213-213-2
.qt files

 

    

 

19-6, 19-6, 19-6, 19-6, 

 

19-819-819-819-8
.ra/.ram files

 

    

 

19-1019-1019-1019-10
.rm files

 

    

 

19-819-819-819-8
.rmf files

 

    

 

19-1019-1019-1019-10
.rpm files

 

    

 

19-819-819-819-8
.shtml files

 

    

 

3-123-123-123-12
.spl files

 

    

 

19-219-219-219-2
.swa files

 

    

 

19-219-219-219-2
.swf files

 

    

 

19-219-219-219-2
.viv files

 

    

 

19-819-819-819-8
.wav files

 

    

 

19-1019-1019-1019-10

 

A
A HREF

 

    

 

22-822-822-822-8
Action icon

 

    

 

6-36-36-36-3
actions

 

    

 

21-121-121-121-1
action messages

 

    

 

21-2, 21-2, 21-2, 21-2, 

 

21-621-621-621-6
adding to objects

 

    

 

21-321-321-321-3
adding to text

 

    

 

21-821-821-821-8
assigning to banners

 

    

 

17-817-817-817-8
assigning to navigation bars

 

    

 

17-317-317-317-3
button rollover example

 

    

 

21-1621-1621-1621-16
cascading

 

    

 

21-1121-1121-1121-11
cascading message example

 

    

 

21-1921-1921-1921-19
collision detection example

 

    

 

21-1821-1821-1821-18
custom message example

 

    

 

21-18, 21-18, 21-18, 21-18, 

 

21-19, 21-19, 21-19, 21-19, 

 

21-2121-2121-2121-21
custom messages

 

    

 

21-921-921-921-9
customizing Set Action dialog

 

    

 

21-2621-2621-2621-26
deactivating

 

    

 

21-13, 21-13, 21-13, 21-13, 

 

21-15, 21-15, 21-15, 21-15, 

 

21-2421-2421-2421-24
delay example

 

    

 

21-2221-2221-2221-22
deleting/modifying

 

    

 

21-1321-1321-1321-13
dragging example

 

    

 

21-1821-1821-1821-18
examples

 

    

 

21-1621-1621-1621-16
generating parameter value

from form example

 

    

 

21-2521-2521-2521-25
parameters

 

    

 

21-7, 21-7, 21-7, 21-7, 

 

21-1521-1521-1521-15
reordering

 

    

 

21-1321-1321-1321-13
restrictions with frames

 

    

 

21-121-121-121-1
scripting your own

 

    

 

21-13, 21-13, 21-13, 21-13, 

 

21-15, 21-15, 21-15, 21-15, 

 

21-2521-2521-2521-25
slide show example

 

    

 

21-2121-2121-2121-21
targets

 

    

 

21-2, 21-2, 21-2, 21-2, 

 

21-5, 21-5, 21-5, 21-5, 

 

21-1121-1121-1121-11
trigger events

 

    

 

21-2, 21-2, 21-2, 21-2, 

 

21-421-421-421-4
troubleshooting

 

    

 

A-2A-2A-2A-2
ActiveX controls

 

    

 

20-620-620-620-6
Ad Banner component

 

    

 

24-324-324-324-3
Adobe Acrobat PDF files

 

    

 

19-1219-1219-1219-12
Advanced toolbar

 

    

 

6-76-76-76-7
aliased folders

 

    

 

28-16, 28-16, 28-16, 28-16, 

 

28-2028-2028-2028-20
aligning

objects

 

    

 

6-146-146-146-14
text

 

    

 

12-1112-1112-1112-11



 

I-2

 

Index

alt tags
adding and modifying

 

    

 

6-106-106-106-10
Anchor icon

 

    

 

6-3, 6-3, 6-3, 6-3, 

 

18-518-518-518-5
anchors

adding

 

    

 

18-418-418-418-4
adding HTML

 

    

 

18-1318-1318-1318-13
deleting

 

    

 

18-4, 18-4, 18-4, 18-4, 

 

18-518-518-518-5
editing

 

    

 

18-4, 18-4, 18-4, 18-4, 

 

18-518-518-518-5
external HTML

 

    

 

22-822-822-822-8
see also links

animated .gif files

 

    

 

13-213-213-213-2
SiteStyles

 

    

 

16-916-916-916-9
animation, see video files

 

    

 

19-819-819-819-8
APPLET CODE

 

    

 

22-822-822-822-8
arrows, see lines
asset type directory structure, publishing

 

    

 

28-428-428-428-4
assets

creating

 

    

 

1-51-51-51-5
custom HTML

 

    

 

26-126-126-126-1
custom names

 

    

 

27-427-427-427-4
customized

 

    

 

28-2128-2128-2128-21
data objects

 

    

 

27-927-927-927-9
displaying pages containing file assets

 

    

 

27-527-527-527-5
displaying pages containing links

 

    

 

27-827-827-827-8
editing

 

    

 

6-116-116-116-11
file

 

    

 

27-327-327-327-3
file types

 

    

 

27-327-327-327-3
import limitations

 

    

 

5-25-25-25-2
links

 

    

 

27-727-727-727-7
managing external HTML

 

    

 

22-822-822-822-8
managing script

 

    

 

28-2728-2728-2728-27
publishing external HTML

 

    

 

22-1022-1022-1022-10
publishing special

 

    

 

28-2628-2628-2628-26
reusing

 

    

 

6-106-106-106-10
types

 

    

 

27-227-227-227-2
unmanaged

 

    

 

22-1022-1022-1022-10
variables

 

    

 

27-1027-1027-1027-10
see also file assets, links, variables

Assets folder

 

    

 

1-101-101-101-10
Assets view

 

    

 

1-2, 1-2, 1-2, 1-2, 

 

27-227-227-227-2
audio file formats

 

    

 

19-1019-1019-1019-10

author name

 

    

 

3-133-133-133-13
Auto Save preference

 

    

 

2-22-22-22-2
AutoFrames

 

    

 

11-311-311-311-3
adding

 

    

 

11-311-311-311-3
adding HTML/scripts

 

    

 

26-3, 26-3, 26-3, 26-3, 

 

26-626-626-626-6
browser refresh

 

    

 

11-811-811-811-8
converted to MasterBorders,

effect on HTML

 

    

 

26-426-426-426-4
defined

 

    

 

11-111-111-111-1
optimizing layout

 

    

 

7-87-87-87-8
selection sequence

 

    

 

11-411-411-411-4
setting properties

 

    

 

11-611-611-611-6
table structure

 

    

 

7-87-87-87-8
targeting links in

 

    

 

11-711-711-711-7
using with actions

 

    

 

21-121-121-121-1
see also frames

AutoSite templates

 

    

 

4-24-24-24-2

 

B
background

Layout Region

 

    

 

8-78-78-78-7
page

 

    

 

8-78-78-78-7
SiteStyle

 

    

 

16-816-816-816-8
sounds

 

    

 

8-88-88-88-8
table

 

    

 

14-414-414-414-4
table cell

 

    

 

14-714-714-714-7
background color

in text boxes

 

    

 

9-89-89-89-8
navigation bars

 

    

 

17-717-717-717-7
Site view

 

    

 

3-13, 3-13, 3-13, 3-13, 

 

22-422-422-422-4
background images

 

    

 

2-52-52-52-5
backing up sites

 

    

 

2-62-62-62-6
Backups folder

 

    

 

1-101-101-101-10
banners

 

    

 

17-217-217-217-2
adding

 

    

 

17-817-817-817-8
assigning actions

 

    

 

17-817-817-817-8
changing pictures

 

    

 

17-1017-1017-1017-10
custom names

 

    

 

3-113-113-113-11
default location

 

    

 

17-217-217-217-2
editing

 

    

 

16-416-416-416-4
orientation

 

    

 

17-917-917-917-9



 

Index

 

I-3

setting style

 

    

 

17-8, 17-8, 17-8, 17-8, 

 

17-917-917-917-9
SiteStyle text

 

    

 

16-516-516-516-5
using

 

    

 

17-817-817-817-8
base directory

 

    

 

28-2828-2828-2828-28
BBS, see Message Board
BGSOUND SRC

 

    

 

22-822-822-822-8
blank site

default MasterBorder

 

    

 

10-210-210-210-2
BODY

accessing HTML

 

    

 

26-226-226-226-2
BODY BACKGROUND

 

    

 

22-822-822-822-8
borderless frames

 

    

 

11-511-511-511-5
borders

creating around pictures

 

    

 

13-713-713-713-7
tables

 

    

 

14-314-314-314-3
Browser Safe Palette

 

    

 

1-81-81-81-8
browsers

action support

 

    

 

21-121-121-121-1
default display font

 

    

 

9-89-89-89-8
display problems

 

    

 

A-1A-1A-1A-1
displaying forms

 

    

 

23-423-423-423-4
font settings

 

    

 

2-42-42-42-4
fonts in AutoFrames

 

    

 

11-311-311-311-3
frame support

 

    

 

11-311-311-311-3
frameless, alternate content

 

    

 

26-626-626-626-6
previewing sites

 

    

 

2-22-22-22-2
redirecting site visitors

 

    

 

24-1624-1624-1624-16
refreshing pages

 

    

 

11-811-811-811-8
setting text display

 

    

 

2-32-32-32-3
targeting

 

    

 

26-11, 26-11, 26-11, 26-11, 

 

26-1226-1226-1226-12
targeting new window

 

    

 

26-1226-1226-1226-12
troubleshooting

 

    

 

A-8A-8A-8A-8
using unsupported image files

 

    

 

13-413-413-413-4
bulleted lists

 

    

 

12-812-812-812-8
Bulletin Board, see Message Board
button navigation bars

 

    

 

17-317-317-317-3
adding

 

    

 

17-317-317-317-3
default location

 

    

 

17-217-217-217-2
display levels

 

    

 

17-517-517-517-5
setting style

 

    

 

17-617-617-617-6
see also navigation bars

buttons

 

    

 

17-217-217-217-2
changing picture on one button

 

    

 

17-1017-1017-1017-10
custom names

 

    

 

3-113-113-113-11
default style

 

    

 

17-317-317-317-3
highlighted

 

    

 

16-616-616-616-6
rollover

 

    

 

16-616-616-616-6
rollover action

 

    

 

21-1621-1621-1621-16
SiteStyle text

 

    

 

16-516-516-516-5

 

C
cascading actions

 

    

 

21-1121-1121-1121-11
CENTER tag

 

    

 

26-426-426-426-4
centering page content

 

    

 

26-426-426-426-4
CGI directory for publishing

 

    

 

28-1728-1728-1728-17
CGI scripts

naming conventions

 

    

 

23-523-523-523-5
Perl5

 

    

 

24-724-724-724-7
processing data

 

    

 

23-1523-1523-1523-15
support

 

    

 

23-1523-1523-1523-15
CGI-BIN folder

 

    

 

23-1623-1623-1623-16
character sets

available

 

    

 

B-2B-2B-2B-2
overview

 

    

 

B-1B-1B-1B-1
page

 

    

 

B-4B-4B-4B-4
section

 

    

 

B-4B-4B-4B-4
site

 

    

 

B-3B-3B-3B-3
check boxes

 

    

 

23-923-923-923-9
checklist, remote server access

 

    

 

28-2728-2728-2728-27
child pages

 

    

 

3-63-63-63-6
CHMOD command

 

    

 

24-624-624-624-6
client-side imagemaps

 

    

 

18-1318-1318-1318-13
collision detection action

 

    

 

21-1821-1821-1821-18
Color Picker

 

    

 

1-71-71-71-7
colors

Browser Safe palette

 

    

 

1-81-81-81-8
changing

 

    

 

1-71-71-71-7
palettes

 

    

 

1-8, 1-8, 1-8, 1-8, 

 

1-91-91-91-9
SiteStyle text

 

    

 

16-716-716-716-7
text

 

    

 

12-412-412-412-4
Web safe

 

    

 

1-81-81-81-8
combo boxes

 

    

 

23-1023-1023-1023-10



 

I-4

 

Index

Common Gateway Interface
see CGI

compacting files

 

    

 

2-62-62-62-6
Component Development Kit (CDK)

 

    

 

24-124-124-124-1
components

Ad Banner

 

    

 

24-324-324-324-3
DynaButtons

 

    

 

24-724-724-724-7
Go Menu

 

    

 

24-1124-1124-1124-11
internal components

 

    

 

24-224-224-224-2
Message Board

 

    

 

24-524-524-524-5
Page components

 

    

 

24-224-224-224-2
Picture Loader

 

    

 

24-1024-1024-1024-10
Picture Rollover

 

    

 

24-1324-1324-1324-13
Publish components

 

    

 

24-224-224-224-2
rotating banner

 

    

 

24-324-324-324-3
Rotating Picture

 

    

 

24-1524-1524-1524-15
Screen Door

 

    

 

24-1624-1624-1624-16
Site Mapper

 

    

 

24-1724-1724-1724-17
Site wizards

 

    

 

24-224-224-224-2
third-party components

 

    

 

24-224-224-224-2
Ticker Tape

 

    

 

24-1924-1924-1924-19
Time Based Picture

 

    

 

24-2024-2024-2024-20
troubleshooting

 

    

 

A-6A-6A-6A-6
types

 

    

 

24-1, 24-1, 24-1, 24-1, 

 

24-224-224-224-2
Components folder

 

    

 

1-101-101-101-10
Components toolbar

 

    

 

6-86-86-86-8
containers

defined

 

    

 

7-27-27-27-2
Layout Regions

 

    

 

8-18-18-18-1
Layouts

 

    

 

8-18-18-18-1
text boxes

 

    

 

9-19-19-19-1
cropping pictures

 

    

 

13-513-513-513-5
CSSP

HTML output method

 

    

 

7-10, 7-10, 7-10, 7-10, 

 

28-728-728-728-7
overlappping objects

 

    

 

6-166-166-166-16
CSSP+Layers

forms

 

    

 

23-523-523-523-5
HTML output method

 

    

 

7-9, 7-9, 7-9, 7-9, 

 

28-728-728-728-7
overlapping objects

 

 6-16 6-16 6-16 6-16
using with actions

 

 21-1 21-1 21-1 21-1
curly quotes

 

    

 

28-828-828-828-8

Current Page option, links

 

    

 

18-418-418-418-4
custom messages in actions

 

    

 

21-18, 21-18, 21-18, 21-18, 

 

21-1921-1921-1921-19
customized assets

 

    

 

28-2128-2128-2128-21
customizing

banners

 

    

 

17-1017-1017-1017-10
buttons

 

    

 

17-1017-1017-1017-10
navigation bars

 

    

 

17-1017-1017-1017-10
templates

 

    

 

4-7, 4-7, 4-7, 4-7, 

 

4-84-84-84-8

 

D
data fields

defined

 

    

 

25-225-225-225-2
formatted text

 

    

 

25-725-725-725-7
image file

 

    

 

25-725-725-725-7
simple text

 

    

 

25-725-725-725-7
data list icon

SiteStyle, editing

 

    

 

16-716-716-716-7
data lists

creating

 

    

 

25-1325-1325-1325-13
defined

 

    

 

25-325-325-325-3
searching

 

    

 

1-51-51-51-5
data objects

defined

 

    

 

25-225-225-225-2
deleting

 

    

 

25-2125-2125-2125-21
external

 

    

 

25-5, 25-5, 25-5, 25-5, 

 

25-825-825-825-8
internal

 

    

 

25-5, 25-5, 25-5, 25-5, 

 

25-625-625-625-6
managing

 

    

 

27-927-927-927-9
data publishing

 

    

 

25-125-125-125-1
data lists, creating

 

    

 

25-1325-1325-1325-13
process

 

    

 

25-425-425-425-4
stacked pages

 

    

 

25-1625-1625-1625-16
data sources

 

    

 

25-925-925-925-9
data, submitting via email

 

    

 

23-1423-1423-1423-14
date format

 

    

 

2-72-72-72-7
date property, published sites

 

    

 

28-2128-2128-2128-21
decimal format

 

    

 

2-72-72-72-7
deleting

anchors

 

    

 

18-518-518-518-5
data objects

 

    

 

25-2125-2125-2125-21
file assets

 

    

 

27-527-527-527-5
folders

 

    

 

28-2028-2028-2028-20



 

Index

 

I-5

links

 

    

 

18-11, 18-11, 18-11, 18-11, 

 

27-827-827-827-8
MasterBorders

 

    

 

10-710-710-710-7
stacked pages

 

    

 

25-2025-2025-2025-20
table rows and columns

 

    

 

14-514-514-514-5
text styles

 

    

 

12-712-712-712-7
unused file assets

 

    

 

27-527-527-527-5
variables

 

    

 

27-1127-1127-1127-11
Director

ActiveX control

 

    

 

19-219-219-219-2
Netscape plugin

 

    

 

19-219-219-219-2
setting properties

 

    

 

19-419-419-419-4
WYSIWYG height and width parameters

 

    

 

19-219-219-219-2
directory structure

custom HTML

 

    

 

26-126-126-126-1
customizing

 

    

 

28-1928-1928-1928-19
external HTML

 

    

 

22-8, 22-8, 22-8, 22-8, 

 

22-1022-1022-1022-10
setting for publishing

 

    

 

28-428-428-428-4
display levels

button navigation bars

 

    

 

17-517-517-517-5
distributing objects

 

    

 

6-146-146-146-14
dithering in transparent .gif files

 

    

 

13-713-713-713-7
domain names

imported sites

 

    

 

5-45-45-45-4
drop-down lists

 

    

 

23-1023-1023-1023-10
DynaButtons component

 

    

 

24-724-724-724-7
sub-buttons

 

    

 

24-824-824-824-8
dynamic pages

 

    

 

21-121-121-121-1

 

E
edit fields

 

    

 

23-523-523-523-5
editing

color palettes

 

    

 

1-91-91-91-9
custom HTML you added

 

    

 

26-3, 26-3, 26-3, 26-3, 

 

26-926-926-926-9
file assets

 

    

 

27-4, 27-4, 27-4, 27-4, 

 

27-527-527-527-5
hotspots

 

    

 

18-1318-1318-1318-13
imagemaps

 

    

 

18-1318-1318-1318-13
links

 

    

 

18-11, 18-11, 18-11, 18-11, 

 

18-1318-1318-1318-13
navigation bars

 

    

 

16-616-616-616-6
paths to custom HTML assets

 

    

 

26-126-126-126-1
SiteStyles

 

    

 

16-1316-1316-1316-13
variables

 

    

 

27-1027-1027-1027-10

ellipses, see shapes
email links

 

    

 

18-818-818-818-8
email, submitting forms data

 

    

 

23-1423-1423-1423-14
EMBED SRC

 

    

 

22-822-822-822-8
Embedded object icon

 

    

 

6-36-36-36-3
embedded objects

creating

 

    

 

9-49-49-49-4
moving

 

    

 

9-49-49-49-4
exporting

sites

 

    

 

4-64-64-64-6
expressions, JavaScript

 

    

 

21-15, 21-15, 21-15, 21-15, 

 

21-2521-2521-2521-25
external data objects

creating from desktop database

 

    

 

25-925-925-925-9
creating from SQL data sources

 

    

 

25-1125-1125-1125-11
definition of types

 

    

 

25-525-525-525-5
filtering

 

    

 

25-1425-1425-1425-14
ISAM drivers

 

    

 

25-825-825-825-8
ODBC drivers

 

    

 

25-825-825-825-8
external HTML

 

    

 

22-122-122-122-1
assets managed

 

    

 

22-822-822-822-8
distinguishing in Site view

 

    

 

22-422-422-422-4
publishing unmodified code

 

    

 

22-922-922-922-9
referencing as object

 

    

 

22-522-522-522-5
referencing from Site view

 

    

 

22-222-222-222-2
referencing in the Layout area

 

    

 

22-422-422-422-4
sizing on page

 

    

 

22-722-722-722-7
external links

 

    

 

18-218-218-218-2
creating

 

    

 

18-718-718-718-7
updating

 

    

 

27-727-727-727-7

 

F
fields

adding to internal data object

 

    

 

25-725-725-725-7
adding to stacked pages

 

    

 

25-1725-1725-1725-17
changing field names

 

    

 

25-825-825-825-8
displaying all on Layout

 

    

 

25-1525-1525-1525-15
inserting

 

    

 

12-1212-1212-1212-12
file assets

adding

 

    

 

27-427-427-427-4
deleting

 

    

 

27-527-527-527-5
editing

 

    

 

27-527-527-527-5



 

I-6

 

Index

external HTML

 

    

 

22-822-822-822-8
managing

 

    

 

27-327-327-327-3
opening

 

    

 

27-527-527-527-5
types

 

    

 

27-327-327-327-3
File Data Source, external data objects

 

    

 

25-1225-1225-1225-12
file formats

audio

 

    

 

19-1019-1019-1019-10
for internal data

 

    

 

25-725-725-725-7
images

 

    

 

13-213-213-213-2
Shockwave

 

    

 

19-219-219-219-2
video

 

    

 

19-819-819-819-8
file links

 

    

 

18-218-218-218-2
creating

 

    

 

18-1018-1018-1018-10
file names

asset

 

    

 

28-1528-1528-1528-15
HTML

 

    

 

26-1526-1526-1526-15
in frameset files

 

    

 

26-1526-1526-1526-15
files

.nod

 

    

 

3-23-23-23-2
compacting

 

    

 

2-62-62-62-6
moving

 

    

 

4-94-94-94-9
renaming

 

    

 

28-2028-2028-2028-20
site files

 

    

 

3-23-23-23-2
filtering external data

 

    

 

25-1425-1425-1425-14
firewalls, publishing with

 

    

 

28-2628-2628-2628-26
Flash files

 

    

 

19-2, 19-2, 19-2, 19-2, 

 

19-419-419-419-4
Flashpix files

 

    

 

13-213-213-213-2
flat directory structure, publishing

 

    

 

28-428-428-428-4
flyouts

 

    

 

1-41-41-41-4
folders

aliased

 

    

 

28-16, 28-16, 28-16, 28-16, 

 

28-2028-2028-2028-20
creating custom

 

    

 

28-2028-2028-2028-20
deleting

 

    

 

28-2028-2028-2028-20
renaming

 

    

 

28-2028-2028-2028-20
folders, virtual

see aliased folders

 

    

 

28-1628-1628-1628-16
fonts

browser fonts in AutoFrames

 

    

 

11-311-311-311-3
browsers

 

    

 

2-42-42-42-4
default display in browser

 

    

 

9-89-89-89-8
SiteStyle banners and buttons

 

    

 

16-516-516-516-5

Form Handler component

 

    

 

23-1323-1323-1323-13
form objects

adding

 

    

 

23-423-423-423-4
creating

 

    

 

23-423-423-423-4
naming

 

    

 

23-523-523-523-5
warning icons

 

    

 

23-5, 23-5, 23-5, 23-5, 

 

A-7A-7A-7A-7
form responses, processing

 

    

 

23-1523-1523-1523-15
form templates

 

    

 

4-24-24-24-2
Form toolbar

 

    

 

6-8, 6-8, 6-8, 6-8, 

 

23-423-423-423-4
formatted text fields

 

    

 

25-725-725-725-7
forms

adding objects

 

    

 

23-423-423-423-4
assigning CGI script

 

    

 

23-1523-1523-1523-15
check boxes

 

    

 

23-923-923-923-9
combo boxes

 

    

 

23-1023-1023-1023-10
creating

 

    

 

23-223-223-223-2
CSSP+Layers

 

    

 

23-5, 23-5, 23-5, 23-5, 

 

A-7A-7A-7A-7
displaying in browsers

 

    

 

23-423-423-423-4
edit fields

 

    

 

23-523-523-523-5
Form Handler

 

    

 

23-1323-1323-1323-13
Form toolbar

 

    

 

23-423-423-423-4
hidden fields

 

    

 

23-1723-1723-1723-17
HTML output method

 

    

 

23-5, 23-5, 23-5, 23-5, 

 

A-7A-7A-7A-7
multiple-line text fields

 

    

 

23-723-723-723-7
objects

 

    

 

23-423-423-423-4
passwords

 

    

 

23-623-623-623-6
position-based

 

    

 

23-223-223-223-2
radio buttons

 

    

 

23-823-823-823-8
Reset button

 

    

 

23-1123-1123-1123-11
Submit button

 

    

 

23-1123-1123-1123-11
submitting data in email

 

    

 

23-1423-1423-1423-14
submitting data to text files

 

    

 

23-1323-1323-1323-13
submitting responses as plain text

 

    

 

23-1323-1323-1323-13
tables

 

    

 

23-223-223-223-2
text-based

 

    

 

23-223-223-223-2
troubleshooting

 

    

 

A-7A-7A-7A-7
types

 

    

 

23-223-223-223-2
frameless browsers, alternate content

 

    

 

26-626-626-626-6
frames

AutoFrames

 

    

 

11-311-311-311-3
borderless

 

    

 

11-511-511-511-5



 

Index
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browser support

 

    

 

11-3, 11-3, 11-3, 11-3, 

 

26-626-626-626-6
coding your own

 

    

 

26-1426-1426-1426-14
creating default target

 

    

 

26-726-726-726-7
defined

 

    

 

11-211-211-211-2
generating borders in HTML frames

 

    

 

11-511-511-511-5
generating visible borders

 

    

 

11-511-511-511-5
HTML

 

    

 

11-311-311-311-3
linking out of

 

    

 

26-1226-1226-1226-12
links within

 

    

 

11-311-311-311-3
setting properties

 

    

 

11-611-611-611-6
targeting in HTML

 

    

 

11-711-711-711-7
using in external HTML

 

    

 

22-322-322-322-3
using with actions

 

    

 

21-121-121-121-1
see also AutoFrames

framesets

 

    

 

11-311-311-311-3
accessing HTML in AutoFrames

 

    

 

26-326-326-326-3
coding your own

 

    

 

26-1526-1526-1526-15

 

G
Go menu

 

    

 

1-61-61-61-6
Go Menu component

 

    

 

24-1124-1124-1124-11
Go To button

 

    

 

1-51-51-51-5
graphic-based Layouts

 

    

 

7-27-27-27-2
Graphics Interchange Format

see .gif files
grids

Layout Region

 

    

 

8-58-58-58-5
showing/hiding

 

    

 

6-36-36-36-3
snap to

 

    

 

6-156-156-156-15
unit of measurement

 

 2-4 2-4 2-4 2-4
guides

adding/moving/deleting

 

    

 

6-156-156-156-15
Layout Region

 

    

 

8-58-58-58-5
showing/hiding

 

    

 

6-3, 6-3, 6-3, 6-3, 

 

6-156-156-156-15
snap to

 

    

 

6-156-156-156-15

 

H
HEAD

accessing HTML

 

    

 

26-226-226-226-2
defining JavaScript function

 

    

 

26-1126-1126-1126-11
referencing externally

 

    

 

22-222-222-222-2

using content in external HTML

 

    

 

22-1022-1022-1022-10
Headspace Beatnik files

 

    

 

19-1219-1219-1219-12
highlighted buttons

 

    

 

16-616-616-616-6
Home page, setting published file name

 

    

 

28-1228-1228-1228-12
hotspots

 

    

 

18-1318-1318-1318-13
editing

 

    

 

18-1318-1318-1318-13
HTML

accessing

 

    

 

26-126-126-126-1
adding to anchors

 

    

 

18-1318-1318-1318-13
adding to AutoFrames

 

    

 

26-3, 26-3, 26-3, 26-3, 

 

26-626-626-626-6
adding to links

 

    

 

18-1218-1218-1218-12
adding to object

 

    

 

26-8, 26-8, 26-8, 26-8, 

 

26-1026-1026-1026-10
adding to page

 

    

 

26-2, 26-2, 26-2, 26-2, 

 

26-426-426-426-4
coding your own frames

 

    

 

26-1426-1426-1426-14
coding your own frameset

 

    

 

26-1526-1526-1526-15
custom file extensions

 

    

 

3-113-113-113-11
custom, editing

 

    

 

26-3, 26-3, 26-3, 26-3, 

 

26-926-926-926-9
custom, managing assets

 

    

 

26-126-126-126-1
drawing horizontal rules

 

    

 

15-315-315-315-3
editor, choosing

 

    

 

2-32-32-32-3
file names

 

    

 

3-113-113-113-11
formatting options

 

    

 

28-928-928-928-9
frames

 

    

 

11-311-311-311-3
generation options

 

    

 

28-1028-1028-1028-10
importing pages

 

    

 

6-96-96-96-9
importing tables

 

    

 

5-35-35-35-3
inserting in text box

 

    

 

26-1326-1326-1326-13
Layouts

 

    

 

7-27-27-27-2
minimizing file size

 

    

 

23-423-423-423-4
publishing options

 

    

 

28-928-928-928-9
referencing external

 

    

 

22-122-122-122-1
syntax when adding

 

    

 

26-126-126-126-1
typing a tab character

 

    

 

26-226-226-226-2
see also specific HTML tag

HTML examples
accommodating frameless browsers

 

    

 

26-626-626-626-6
auto-forwarding from transition page

 

    

 

26-626-626-626-6
centering page content

 

    

 

26-426-426-426-4
coding frames

 

    

 

26-1426-1426-1426-14
creating default target frame

 

    

 

26-726-726-726-7
displaying Alert on mouse-click

 

    

 

26-1026-1026-1026-10



 

I-8

 

Index

indexing pages for search engines

 

    

 

26-526-526-526-5
linking out of frames

 

    

 

26-1226-1226-1226-12
opening new browser window

 

    

 

26-1126-1126-1126-11
HTML output

applying output methods

 

    

 

7-107-107-107-10
CSSP

 

    

 

7-10, 7-10, 7-10, 7-10, 

 

28-728-728-728-7
CSSP+Layers

 

    

 

7-9, 7-9, 7-9, 7-9, 

 

28-728-728-728-7
Layers

 

 7-10, 28-7 7-10, 28-7 7-10, 28-7 7-10, 28-7
Nested Tables

 

    

 

7-5, 7-5, 7-5, 7-5, 

 

28-728-728-728-7
previewing tables

 

    

 

7-77-77-77-7
Regular Tables

 

    

 

7-9, 7-9, 7-9, 7-9, 

 

28-728-728-728-7
selecting method

 

    

 

7-57-57-57-5
setting for publishing

 

    

 

28-628-628-628-6
setting output method

 

    

 

8-68-68-68-6
troubleshooting

 

    

 

A-2A-2A-2A-2
HTML tag icon

 

    

 

6-36-36-36-3
HTML-based Layouts

 

    

 

7-27-27-27-2

 

I
icons

indicator

 

    

 

6-36-36-36-3
object

 

    

 

6-36-36-36-3
image file fields

 

    

 

25-725-725-725-7
adding images

 

    

 

25-2125-2125-2125-21
identifying

 

    

 

25-1825-1825-1825-18
image files

formats

 

    

 

13-213-213-213-2
SiteStyle formats

 

    

 

16-916-916-916-9
stacked pages and Assets view

 

    

 

27-327-327-327-3
thumbnail

 

    

 

13-313-313-313-3
transparent .gif files

 

    

 

13-713-713-713-7
unsupported formats

 

    

 

13-413-413-413-4
see also pictures

imagemaps
creating

 

    

 

18-1318-1318-1318-13
editing

 

    

 

18-1318-1318-1318-13
hotspots

 

    

 

18-1318-1318-1318-13
images

adding to stacked pages

 

    

 

25-2025-2025-2025-20
background

 

    

 

2-52-52-52-5
editing

 

    

 

6-116-116-116-11

IMG SRC

 

    

 

22-822-822-822-8
importing

assets

 

    

 

5-25-25-25-2
HTML pages

 

    

 

6-96-96-96-9
HTML tables

 

    

 

5-35-35-35-3
Indexed Sequential Access Method drivers

 

    

 

25-825-825-825-8
INPUT SRC

 

    

 

22-822-822-822-8
internal components

 

    

 

24-224-224-224-2
internal data fields, changing names

 

    

 

25-825-825-825-8
internal data objects

adding stacked pages

 

    

 

25-2025-2025-2025-20
creating

 

    

 

25-625-625-625-6
defined

 

    

 

25-525-525-525-5
internal links

 

    

 

18-218-218-218-2
ISAM drivers

 

    

 

25-825-825-825-8

 

J
Java

applets

 

    

 

20-220-220-220-2
file parameters

 

    

 

20-320-320-320-3
files

 

    

 

20-220-220-220-2
servlets

 

    

 

20-220-220-220-2
Java Beans

 

    

 

20-420-420-420-4
adding actions

 

    

 

20-620-620-620-6
troubleshooting

 

    

 

A-7A-7A-7A-7
Java folder

 

    

 

1-101-101-101-10
JavaScript

in actions

 

    

 

21-14, 21-14, 21-14, 21-14, 

 

21-15, 21-15, 21-15, 21-15, 

 

21-2521-2521-2521-25
in links

 

    

 

18-12, 18-12, 18-12, 18-12, 

 

26-10, 26-10, 26-10, 26-10, 

 

26-1126-1126-1126-11
Joint Photographic Experts Group,

see .jpg/.jpeg files

 

K
keyboard shortcuts

 

    

 

1-61-61-61-6

 

L
Last button

 

    

 

1-61-61-61-6
Layers

HTML output method

 

    

 

7-10, 7-10, 7-10, 7-10, 

 

28-728-728-728-7
overlapping objects

 

    

 

6-166-166-166-16
layout methods and design priorities

 

    

 

7-127-127-127-12



 

Index
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Layout Regions
adding objects

 

    

 

8-58-58-58-5
background picture

 

    

 

8-88-88-88-8
container

 

    

 

7-27-27-27-2
creating

 

    

 

8-48-48-48-4
defined

 

    

 

8-48-48-48-4
grids/guides

 

    

 

8-58-58-58-5
minimizing HTML

 

    

 

23-423-423-423-4
setting background color

 

    

 

8-78-78-78-7
setting HTML output method

 

    

 

8-68-68-68-6
working with

 

    

 

8-48-48-48-4
Layouts

accessing HTML

 

    

 

26-226-226-226-2
adding objects

 

    

 

8-48-48-48-4
adding sounds

 

    

 

8-88-88-88-8
background picture

 

    

 

8-88-88-88-8
cascading action messages to

 

    

 

21-1121-1121-1121-11
container

 

    

 

7-27-27-27-2
creating

 

    

 

8-28-28-28-2
defined

 

    

 

1-2, 1-2, 1-2, 1-2, 

 

8-28-28-28-2
external HTML

 

    

 

22-422-422-422-4
graphics based

 

    

 

7-27-27-27-2
HTML-based

 

    

 

7-27-27-27-2
multiple

 

    

 

8-28-28-28-2
naming

 

    

 

8-38-38-38-3
naming requirements

 

    

 

8-38-38-38-3
selecting

 

    

 

8-2, 8-2, 8-2, 8-2, 

 

8-38-38-38-3
selecting layout method

 

    

 

7-37-37-37-3
setting background color

 

    

 

8-78-78-78-7
setting HTML output method

 

    

 

8-68-68-68-6
showing/hiding label

 

    

 

6-36-36-36-3
sizing

 

    

 

6-5, 6-5, 6-5, 6-5, 

 

8-38-38-38-3
text-based

 

    

 

7-27-27-27-2
working with

 

    

 

8-28-28-28-2
lines

adding SiteStyle

 

    

 

15-415-415-415-4
constraining to horizontal/vertical

 

    

 

15-515-515-515-5
drawing

 

    

 

15-515-515-515-5
editing

 

    

 

15-615-615-615-6
SiteStyle, editing

 

    

 

16-916-916-916-9
Link icon

 

    

 

6-3, 6-3, 6-3, 6-3, 

 

18-1118-1118-1118-11

links
adding

 

    

 

27-827-827-827-8
adding anchors

 

    

 

18-418-418-418-4
adding HTML

 

    

 

18-1218-1218-1218-12
adding JavaScript

 

    

 

18-1218-1218-1218-12
broken, resolving

 

    

 

27-927-927-927-9
creating

 

    

 

18-218-218-218-2
Current Page option

 

    

 

18-418-418-418-4
deleting

 

    

 

18-11, 18-11, 18-11, 18-11, 

 

27-827-827-827-8
deleting anchors

 

    

 

18-418-418-418-4
editing

 

    

 

18-11, 18-11, 18-11, 18-11, 

 

18-1318-1318-1318-13
editing anchors

 

    

 

18-418-418-418-4
email

 

    

 

18-818-818-818-8
external

 

    

 

18-2, 18-2, 18-2, 18-2, 

 

18-718-718-718-7
external, updating

 

    

 

27-727-727-727-7
file

 

    

 

18-2, 18-2, 18-2, 18-2, 

 

18-1018-1018-1018-10
following

 

    

 

18-1118-1118-1118-11
hotspots

 

    

 

18-1318-1318-1318-13
imagemaps

 

    

 

18-1318-1318-1318-13
in external HTML

 

    

 

22-822-822-822-8
internal

 

    

 

18-218-218-218-2
mailto

 

    

 

18-2, 18-2, 18-2, 18-2, 

 

18-818-818-818-8
managing

 

    

 

27-727-727-727-7
out of frames

 

    

 

26-1226-1226-1226-12
relative

 

    

 

18-818-818-818-8
smart

 

    

 

18-2, 18-2, 18-2, 18-2, 

 

18-5, 18-5, 18-5, 18-5, 

 

18-618-618-618-6
targeting

 

    

 

11-711-711-711-7
text color

 

    

 

16-716-716-716-7
text, adding actions

 

    

 

21-821-821-821-8
to new browser window

 

    

 

26-11, 26-11, 26-11, 26-11, 

 

26-1226-1226-1226-12
untargeted

 

    

 

11-811-811-811-8
verifying

 

    

 

27-827-827-827-8
within a frame

 

    

 

11-311-311-311-3
see also anchors

Live Audio

 

    

 

19-1019-1019-1019-10
Live Video

 

    

 

19-819-819-819-8

 

M
Machine Data Source, external data objects

 

    

 

25-1225-1225-1225-12
Macromedia Director, see Director
Macromedia Shockwave, see Shockwave



 

I-10

 

Index

mailto links

 

    

 

18-2, 18-2, 18-2, 18-2, 

 

18-818-818-818-8
margins

 

    

 

10-210-210-210-2
default

 

    

 

2-52-52-52-5
setting

 

    

 

2-52-52-52-5
MasterBorders

accessing/adding HTML

 

    

 

26-226-226-226-2
applying

 

    

 

10-610-610-610-6
changing

 

    

 

10-610-610-610-6
changing margins

 

    

 

10-410-410-410-4
converted from AutoFrames, 

effect on HTML

 

 26-4 26-4 26-4 26-4
creating

 

    

 

10-510-510-510-5
default in blank site

 

    

 

10-210-210-210-2
defined

 

    

 

6-2, 6-2, 6-2, 6-2, 

 

10-210-210-210-2
deleting

 

    

 

10-710-710-710-7
modifying

 

    

 

10-310-310-310-3
naming

 

    

 

10-710-710-710-7
selecting

 

    

 

10-310-310-310-3
setting for sections

 

    

 

3-9, 3-9, 3-9, 3-9, 

 

10-610-610-610-6
setting properties

 

    

 

10-310-310-310-3
showing/hiding

 

    

 

6-26-26-26-2
sizing

 

    

 

6-5, 6-5, 6-5, 6-5, 

 

10-410-410-410-4
with actions

 

    

 

21-3, 21-3, 21-3, 21-3, 

 

21-1121-1121-1121-11
ZeroMargins

 

    

 

10-210-210-210-2
media files

editing properties

 

    

 

19-1419-1419-1419-14
replacing

 

    

 

19-1419-1419-1419-14
sample

 

    

 

19-119-119-119-1
Message Board component

 

    

 

24-524-524-524-5
Macintosh Web servers

 

    

 

24-724-724-724-7
UNIX servers

 

    

 

24-724-724-724-7
messages

Alert, displaying on mouse-click

 

    

 

26-1026-1026-1026-10
META tags

 

    

 

26-5, 26-5, 26-5, 26-5, 

 

26-626-626-626-6
Microsoft Audio Video Interleaved files

 

    

 

19-819-819-819-8
Microsoft Internet Explorer

action support

 

    

 

21-121-121-121-1
modifying

server profiles

 

    

 

28-1228-1228-1228-12
Moving Pictures Experts Group files

 

    

 

19-819-819-819-8

 

N
naming

custom for assets

 

    

 

27-427-427-427-4
files

 

    

 

28-2028-2028-2028-20
folders

 

    

 

28-2028-2028-2028-20
form objects

 

    

 

23-523-523-523-5
Layouts

 

    

 

8-38-38-38-3
MasterBorders

 

    

 

10-710-710-710-7
objects

 

    

 

6-136-136-136-13
pages

 

    

 

3-113-113-113-11
sites

 

    

 

4-44-44-44-4
navigating

 

    

 

1-51-51-51-5
between pages

 

    

 

6-46-46-46-4
page navigation buttons

 

    

 

6-46-46-46-4
Site Navigation window

 

    

 

6-46-46-46-4
navigation bars

 

    

 

16-3, 16-3, 16-3, 16-3, 

 

17-217-217-217-2
actions

 

    

 

17-317-317-317-3
customizing

 

    

 

17-1017-1017-1017-10
editing

 

    

 

16-616-616-616-6
highlighted buttons

 

    

 

17-617-617-617-6
primary and secondary

 

    

 

17-617-617-617-6
rollover buttons

 

    

 

17-717-717-717-7
setting background color

 

    

 

17-717-717-717-7
setting border width

 

    

 

17-517-517-517-5
setting button spacing

 

    

 

17-517-517-517-5
setting display options

 

    

 

17-417-417-417-4
setting type

 

    

 

17-717-717-717-7
using

 

    

 

17-317-317-317-3
see also button navigation bars,

text navigation bars
navigation buttons

adding to stacked pages

 

    

 

25-1525-1525-1525-15
stacked pages

 

    

 

25-1925-1925-1925-19
navigation controls, see banners,

button navigation bars, text navigation bars
Nested Tables

HTML output method

 

    

 

7-5, 7-5, 7-5, 7-5, 

 

28-728-728-728-7
optimizing output

 

    

 

7-67-67-67-6
NetObjects Component Development

Kit (CDK)

 

 24-1 24-1 24-1 24-1
NetObjects Fusion



 

Index
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folder structure

 

    

 

1-91-91-91-9
navigating

 

    

 

1-51-51-51-5
overview

 

    

 

xxixxixxixxi
starting

 

    

 

3-23-23-23-2
NetObjects Fusion Components,

see components

 

 24-1, 24-2 24-1, 24-2 24-1, 24-2 24-1, 24-2
NetObjects System folder

 

    

 

1-101-101-101-10
NetObjects Web site

address

 

    

 

xxiiixxiiixxiiixxiii
Netscape Navigator

action support

 

    

 

21-121-121-121-1
ActiveX support

 

    

 

20-620-620-620-6
New button

 

    

 

1-51-51-51-5
newspaper quotes

 

    

 

28-828-828-828-8
NFX components, see components

 

    

 

24-1, 24-1, 24-1, 24-1, 

 

24-224-224-224-2
NOFRAMES tag

 

    

 

26-626-626-626-6
non-alphanumeric characters

in asset file names

 

    

 

28-13, 28-13, 28-13, 28-13, 

 

28-1528-1528-1528-15
numbered lists

 

    

 

12-812-812-812-8

 

O
object HTML, examples

 

    

 

26-1026-1026-1026-10
Object Tree

 

    

 

6-126-126-126-12
in actions

 

    

 

21-5, 21-5, 21-5, 21-5, 

 

21-12, 21-12, 21-12, 21-12, 

 

21-2321-2321-2321-23
using with tables

 

    

 

14-214-214-214-2
objects

accessing/adding HTML

 

    

 

26-826-826-826-8
adding

 

    

 

6-66-66-66-6
adding actions

 

    

 

21-321-321-321-3
adding to Layout Regions

 

    

 

8-58-58-58-5
adding to Layouts

 

    

 

8-48-48-48-4
aligning

 

    

 

6-146-146-146-14
coding your own

 

    

 

26-1426-1426-1426-14
copying

 

    

 

6-136-136-136-13
creating embedded

 

    

 

9-49-49-49-4
distributing

 

    

 

6-146-146-146-14
dragging and dropping

 

    

 

6-96-96-96-9
embedding

 

    

 

7-2, 7-2, 7-2, 7-2, 

 

9-39-39-39-3
layering

 

    

 

6-166-166-166-16
moving

 

    

 

6-136-136-136-13
naming

 

    

 

6-136-136-136-13

optimizing placement on page

 

    

 

7-77-77-77-7
overlapping

 

    

 

6-16, 6-16, 6-16, 6-16, 

 

28-728-728-728-7
pasting

 

    

 

6-146-146-146-14
placing

 

    

 

6-66-66-66-6
resizing

 

    

 

6-136-136-136-13
selecting

 

    

 

6-126-126-126-12
showing/hiding indicator icons

 

    

 

6-36-36-36-3
showing/hiding outlines

 

    

 

6-36-36-36-3
sizing

 

    

 

6-136-136-136-13
snapping

 

    

 

6-156-156-156-15
updating multiple instances

 

    

 

6-106-106-106-10
wrapping text around

 

    

 

9-59-59-59-5
ODBC

Data Source Administrator

 

    

 

25-1125-1125-1125-11
drivers

 

    

 

25-825-825-825-8
Open Data Base Connectivity

see  ODBC

 

    

 

25-825-825-825-8
orientation, Site view

 

    

 

3-133-133-133-13
Outline view

 

    

 

3-153-153-153-15
output method

 see HTML output
ovals, see shapes
overlapping objects

 

    

 

6-166-166-166-16

 

P
Page components

 

    

 

24-224-224-224-2
page HTML, examples

 

    

 

26-426-426-426-4
page layout

 see Layouts
page names

allowable characters

 

    

 

3-113-113-113-11
character requirements

 

    

 

B-6B-6B-6B-6
custom

 

    

 

3-113-113-113-11
setting

 

    

 

17-817-817-817-8
spaces in

 

    

 

3-11, 3-11, 3-11, 3-11, 

 

26-1526-1526-1526-15
page navigation buttons

 

    

 

6-46-46-46-4
page size

 

    

 

6-56-56-56-5
page templates

 

    

 

4-24-24-24-2
inserting

 

    

 

4-54-54-54-5
Page view

 

    

 

1-2, 1-2, 1-2, 1-2, 

 

6-16-16-16-1
displaying pages

 

    

 

6-36-36-36-3



 

I-12

 

Index

referencing external HTML

 

    

 

22-422-422-422-4
pages

accessing/adding HTML

 

    

 

26-226-226-226-2
adding

 

    

 

3-93-93-93-9
adding actions

 

    

 

21-321-321-321-3
centering content

 

    

 

26-426-426-426-4
character set

 

    

 

B-4B-4B-4B-4
child

 

    

 

3-63-63-63-6
containing file assets, displaying

 

    

 

27-527-527-527-5
containing links, displaying

 

    

 

27-827-827-827-8
creating

 

    

 

1-51-51-51-5
custom names

 

    

 

3-113-113-113-11
deleting

 

    

 

3-103-103-103-10
displaying

 

    

 

6-36-36-36-3
dynamic

 

    

 

21-121-121-121-1
importing

 

    

 

6-96-96-96-9
indexing for search engines

 

    

 

26-526-526-526-5
margins

 

    

 

10-210-210-210-2
moving

 

    

 

3-103-103-103-10
navigating

 

    

 

6-46-46-46-4
optimizing object placement

 

    

 

7-77-77-77-7
page properties

 

    

 

3-83-83-83-8
parent

 

    

 

3-63-63-63-6
publishing

 

    

 

28-2428-2428-2428-24
redirecting site visitors

 

    

 

24-1624-1624-1624-16
referencing external HTML

 

    

 

22-422-422-422-4
renaming

 

    

 

3-113-113-113-11
searching

 

    

 

1-51-51-51-5
selecting

 

    

 

3-63-63-63-6
setting background

 

    

 

8-78-78-78-7
setting size

 

    

 

6-56-56-56-5
showing/hiding Layout

and MasterBorder labels

 

    

 

6-36-36-36-3
sibling

 

    

 

3-63-63-63-6
site sections

 

    

 

3-73-73-73-7
sizing

 

    

 

6-56-56-56-5
transition, creating

 

    

 

26-626-626-626-6
palettes

color

 

    

 

1-81-81-81-8
properties

 

    

 

1-3, 1-3, 1-3, 1-3, 

 

2-22-22-22-2
showing/hiding

 

    

 

6-26-26-26-2

paragraphs
indenting

 

    

 

12-412-412-412-4
styles, see text

parameters
action

 

    

 

21-721-721-721-7
parent pages

 

    

 

3-63-63-63-6
passwords

forms

 

    

 

23-623-623-623-6
paths

custom HTML assets, editing

 

    

 

26-126-126-126-1
in external HTML

 

    

 

22-8, 22-8, 22-8, 22-8, 

 

22-1022-1022-1022-10
in frameset files

 

    

 

26-1526-1526-1526-15
Perl5 CGI script

 

    

 

24-724-724-724-7
permission, publishing

 

    

 

28-1828-1828-1828-18
Picture Loader component

 

    

 

24-1024-1024-1024-10
Picture Rollover component

 

    

 

24-1324-1324-1324-13
pictures

adding

 

    

 

13-313-313-313-3
adding to stacked pages

 

    

 

25-2025-2025-2025-20
changing in banners

 

    

 

17-1017-1017-1017-10
changing on one button

 

    

 

17-1017-1017-1017-10
creating borders

 

    

 

13-713-713-713-7
cropping

 

    

 

13-513-513-513-5
inserting in frame background

 

    

 

11-711-711-711-7
rotating

 

    

 

13-613-613-613-6
sizing

 

    

 

13-513-513-513-5
tiling

 

    

 

13-613-613-613-6
polygons, see shapes
Portable Network Graphics

see .png files
ports for publishing

 

    

 

28-1828-1828-1828-18
position-based forms

 

    

 

23-223-223-223-2
preferences

international

 

    

 

2-72-72-72-7
Preferences dialog

 

    

 

2-22-22-22-2
Preview button

 

    

 

1-51-51-51-5
Preview folder

 

    

 

1-101-101-101-10
previewing

choosing browser

 

    

 

2-22-22-22-2
primary navigation bars

 

    

 

16-3, 16-3, 16-3, 16-3, 

 

17-617-617-617-6
printing



 

Index

 

I-13

SiteStructure

 

    

 

3-143-143-143-14
properties

page

 

    

 

3-83-83-83-8
section

 

    

 

3-93-93-93-9
Site view

 

    

 

3-133-133-133-13
Properties palette

 

    

 

1-31-31-31-3
Publish components

 

    

 

24-224-224-224-2
Publish view

 

    

 

1-2, 1-2, 1-2, 1-2, 

 

28-328-328-328-3
Publish/Don’t Publish setting

 

    

 

3-83-83-83-8
publishing

aliased folders

 

    

 

28-16, 28-16, 28-16, 28-16, 

 

28-2028-2028-2028-20
asset type directory structure

 

    

 

28-428-428-428-4
base directory

 

    

 

28-2828-2828-2828-28
CGI directory

 

    

 

28-1728-1728-1728-17
configuring setup

 

    

 

28-428-428-428-4
creating custom folders

 

    

 

28-2028-2028-2028-20
custom properties

 

    

 

28-2128-2128-2128-21
customizing directory structure

 

    

 

28-1928-1928-1928-19
data,see data publishing
deleting folders

 

    

 

28-2028-2028-2028-20
external HTML, unmodified

 

    

 

22-922-922-922-9
firewalls

 

    

 

28-2628-2628-2628-26
flat directory structure

 

    

 

28-428-428-428-4
forced

 

    

 

27-427-427-427-4
guidelines

 

    

 

28-2528-2528-2528-25
HTML options

 

    

 

28-928-928-928-9
local server profile

 

    

 

28-1128-1128-1128-11
managing script assets

 

    

 

28-2728-2728-2728-27
overlapping objects

 

    

 

28-728-728-728-7
overview

 

    

 

28-228-228-228-2
properties

 

    

 

28-21, 28-21, 28-21, 28-21, 

 

28-2228-2228-2228-22
proxy servers

 

    

 

28-2628-2628-2628-26
quotation mark types

 

    

 

28-828-828-828-8
read-only folders, pages, assets

 

    

 

28-2128-2128-2128-21
rearranging directory structure

 

    

 

28-2128-2128-2128-21
remote host

 

    

 

28-2728-2728-2728-27
remote server access checklist

 

    

 

28-2728-2728-2728-27
remote server profiles

 

    

 

28-1328-1328-1328-13
renaming custom files/folders

 

    

 

28-2028-2028-2028-20
server port and permission settings

 

    

 

28-1828-1828-1828-18
server profiles

 

    

 

28-1128-1128-1128-11

setting directory structure

 

    

 

28-428-428-428-4
setting HTML output

 

    

 

28-628-628-628-6
setting HTML output method

 

    

 

28-728-728-728-7
single page

 

    

 

28-2428-2428-2428-24
site section

 

    

 

28-2428-2428-2428-24
site section directory structure

 

    

 

28-428-428-428-4
sites

 

    

 

28-2328-2328-2328-23
special assets

 

    

 

28-2628-2628-2628-26
unmanaged assets

 

    

 

22-1022-1022-1022-10
publishing method

 see HTML output
publishing options and design priorities

 

    

 

7-127-127-127-12

 

Q
QuickTime movies

 

    

 

19-819-819-819-8
display options

 

    

 

19-6, 19-6, 19-6, 19-6, 

 

19-719-719-719-7
inserting

 

    

 

19-519-519-519-5
volume

 

    

 

19-719-719-719-7
QuickTime plugin

 

    

 

19-519-519-519-5
quotation marks in published sites

 

    

 

28-828-828-828-8

 

R
radio buttons

 

    

 

23-823-823-823-8
read-only folders, pages, assets

 

    

 

28-2128-2128-2128-21
Real Media

 

    

 

19-819-819-819-8
Real Player Media files

 

    

 

19-819-819-819-8
RealAudio files

 

    

 

19-1019-1019-1019-10
RealSpace FlashPix files

 

    

 

19-1219-1219-1219-12
rectangles, see shapes
referencing external HTML

 

    

 

22-122-122-122-1
all or part of a site

 

    

 

22-222-222-222-2
as a page

 

    

 

22-422-422-422-4
see also external HTML

Regular Tables
HTML output method

 

    

 

7-9, 7-9, 7-9, 7-9, 

 

28-728-728-728-7
relative links

 

    

 

18-818-818-818-8
relative paths

in external HTML

 

    

 

22-822-822-822-8
in frameset files

 

    

 

26-1526-1526-1526-15
remote host

 

    

 

28-2728-2728-2728-27
remote server access checklist

 

    

 

28-2728-2728-2728-27



 

I-14

 

Index

Reset button

 

    

 

23-1123-1123-1123-11
resizing

objects

 

    

 

6-136-136-136-13
Rich Music Format files

 

    

 

19-1019-1019-1019-10
right-click menus

 

    

 

1-71-71-71-7
rollover buttons

 

    

 

16-616-616-616-6
rotating

pictures

 

    

 

13-613-613-613-6
text

 

    

 

12-1112-1112-1112-11
Rotating Picture component

 

    

 

24-1524-1524-1524-15
rounded rectangles, see shapes
rulers

showing/hiding

 

    

 

6-3, 6-3, 6-3, 6-3, 

 

6-156-156-156-15

 

S
sample

sites

 

    

 

4-24-24-24-2
Samples folder

 

    

 

1-101-101-101-10
saving sites

 

    

 

2-22-22-22-2
scaling pictures

 

    

 

13-513-513-513-5
Screen Door component

 

    

 

24-1624-1624-1624-16
Script icon

 

    

 

6-36-36-36-3
SCRIPT SRC

 

    

 

22-822-822-822-8
SCRIPT tags

 

    

 

26-126-126-126-1
scripts

adding to AutoFrames

 

    

 

26-326-326-326-3
adding to objects

 

    

 

26-826-826-826-8
adding to page HEAD or BODY

 

    

 

26-226-226-226-2
inserting in actions

 

    

 

21-13, 21-13, 21-13, 21-13, 

 

21-15, 21-15, 21-15, 21-15, 

 

21-2521-2521-2521-25
inserting in links

 

    

 

26-10, 26-10, 26-10, 26-10, 

 

26-1126-1126-1126-11
inserting in text boxes

 

    

 

26-1326-1326-1326-13
managing assets

 

    

 

22-9, 22-9, 22-9, 22-9, 

 

28-2728-2728-2728-27
scrolling lists

 

    

 

23-1023-1023-1023-10
scrolling messages

 

    

 

24-1924-1924-1924-19
search engines

directory structure for publishing

 

    

 

28-528-528-528-5
indexing pages

 

    

 

26-526-526-526-5
secondary navigation bars

 

    

 

16-3, 16-3, 16-3, 16-3, 

 

17-617-617-617-6
sections

 

    

 

3-73-73-73-7
applying MasterBorder

 

    

 

10-610-610-610-6
character set

 

    

 

B-4B-4B-4B-4

properties

 

    

 

3-93-93-93-9
publishing

 

    

 

28-2428-2428-2428-24
setting MasterBorder

 

    

 

3-93-93-93-9
selecting

Layouts

 

    

 

8-2, 8-2, 8-2, 8-2, 

 

8-38-38-38-3
MasterBorders

 

    

 

10-310-310-310-3
objects

 

    

 

6-126-126-126-12
table cells

 

    

 

14-814-814-814-8
text

 

    

 

12-312-312-312-3
text boxes

 

    

 

9-29-29-29-2
tools from flyout

 

    

 

1-51-51-51-5
server profiles

adding

 

    

 

28-1228-1228-1228-12
defining local

 

    

 

28-1128-1128-1128-11
modifying

 

    

 

28-1228-1228-1228-12
publishing

 

    

 

28-1128-1128-1128-11
servers

adding profiles

 

    

 

28-1328-1328-1328-13
defining profiles

 

    

 

28-1328-1328-1328-13
locations

 

    

 

28-1328-1328-1328-13
modifying profiles

 

    

 

28-1328-1328-1328-13
port and permission settings

 

    

 

28-1828-1828-1828-18
publishing with proxy servers

 

    

 

28-2628-2628-2628-26
server-side imagemaps

 

    

 

18-1318-1318-1318-13
Set Action dialog

 

    

 

21-321-321-321-3
customizing

 

    

 

21-2621-2621-2621-26
shapes

drawing

 

    

 

15-215-215-215-2
editing lines of polygons

 

    

 

15-315-315-315-3
varying curve of rounded rectangles

 

    

 

15-315-315-315-3
Shockwave files

audio

 

    

 

19-219-219-219-2
Director

 

    

 

19-219-219-219-2
formats

 

    

 

19-219-219-219-2
inserting

 

    

 

19-219-219-219-2
troubleshooting

 

    

 

A-8A-8A-8A-8
Shockwave plugin

 

    

 

19-219-219-219-2
shortcuts

keyboard

 

    

 

1-61-61-61-6
menus

 

    

 

1-71-71-71-7
sibling pages

 

    

 

3-63-63-63-6



 

Index

 

I-15

simple text fields
creating

 

    

 

25-725-725-725-7
single-line text fields

see edit fields
site files

 

    

 

3-23-23-23-2
Site Mapper component

 

    

 

24-1724-1724-1724-17
Site Navigation window

 

    

 

6-46-46-46-4
site section directory structure, publishing

 

    

 

28-428-428-428-4
Site view

 

    

 

1-2, 1-2, 1-2, 1-2, 

 

3-13-13-13-1
background color

 

    

 

3-133-133-133-13
orientation

 

    

 

3-133-133-133-13
Outline view

 

    

 

3-153-153-153-15
properties

 

    

 

3-133-133-133-13
SiteStructure

 

    

 

3-63-63-63-6
Site wizards

 

    

 

3-5, 3-5, 3-5, 3-5, 

 

24-224-224-224-2
sites

author name

 

    

 

3-133-133-133-13
backing up

 

    

 

2-6, 2-6, 2-6, 2-6, 

 

3-163-163-163-16
character set

 

    

 

B-3B-3B-3B-3
converting

 

    

 

5-15-15-15-1
copying

 

    

 

4-94-94-94-9
creating

 

    

 

3-3, 3-3, 3-3, 3-3, 

 

4-34-34-34-3
distributing

 

    

 

4-94-94-94-9
domain names

 

    

 

5-45-45-45-4
expanding

 

    

 

4-4, 4-4, 4-4, 4-4, 

 

5-55-55-55-5
exporting

 

    

 

4-64-64-64-6
importing

 

    

 

5-1, 5-1, 5-1, 5-1, 

 

5-25-25-25-2
inserting templates

 

    

 

4-54-54-54-5
moving

 

    

 

4-94-94-94-9
naming

 

    

 

3-3, 3-3, 3-3, 3-3, 

 

4-44-44-44-4
opening

 

    

 

3-53-53-53-5
opening last automatically

 

    

 

2-22-22-22-2
publishing

 

    

 

28-2328-2328-2328-23
referencing external HTML

 

    

 

22-222-222-222-2
sample

 

    

 

4-24-24-24-2
saved

 

    

 

3-33-33-33-3
saving

 

    

 

2-22-22-22-2
searching

 

    

 

1-51-51-51-5
setting publishing method

 

    

 

28-728-728-728-7
sharing

 

    

 

4-94-94-94-9
SiteStructure

 

    

 

3-63-63-63-6

expanding and collapsing

 

    

 

3-143-143-143-14
printing

 

    

 

3-143-143-143-14
SiteStyles

adding

 

    

 

16-1116-1116-1116-11
adding SiteStyle lines

 

    

 

15-415-415-415-4
applying

 

    

 

16-316-316-316-3
creating

 

    

 

1-5, 1-5, 1-5, 1-5, 

 

16-916-916-916-9
customizing templates

 

    

 

4-84-84-84-8
defined

 

    

 

16-216-216-216-2
editing

 

    

 

16-4, 16-4, 16-4, 16-4, 

 

16-1316-1316-1316-13
folder structure

 

    

 

16-1216-1216-1216-12
importing

 

    

 

16-1116-1116-1116-11
managing

 

    

 

16-1016-1016-1016-10
removing

 

    

 

16-1116-1116-1116-11
text color

 

    

 

16-716-716-716-7
text in banners and buttons

 

    

 

16-516-516-516-5
updating list

 

    

 

16-1116-1116-1116-11
sizing

columns in tables

 

    

 

14-414-414-414-4
Layouts

 

    

 

8-38-38-38-3
Layouts to objects

 

    

 

22-722-722-722-7
MasterBorders

 

    

 

10-410-410-410-4
multiple objects

 

    

 

6-136-136-136-13
objects

 

    

 

6-136-136-136-13
pages

 

    

 

6-56-56-56-5
pictures

 

    

 

13-513-513-513-5
rows in tables

 

    

 

14-414-414-414-4
text

 

    

 

12-412-412-412-4
text boxes

 

    

 

9-69-69-69-6
smart links

 

    

 

18-218-218-218-2
creating

 

    

 

18-518-518-518-5
defined

 

    

 

18-518-518-518-5
stacked pages

 

    

 

25-1925-1925-1925-19
types

 

    

 

18-618-618-618-6
sort order

 

    

 

2-72-72-72-7
sounds

file display options

 

    

 

19-1119-1119-1119-11
file formats

 

    

 

8-88-88-88-8
inserting

 

    

 

19-1019-1019-1019-10
page

 

    

 

8-88-88-88-8
troubleshooting

 

    

 

A-8A-8A-8A-8



 

I-16

 

Index

spaces
in asset file names

 

    

 

28-13, 28-13, 28-13, 28-13, 

 

28-1528-1528-1528-15
spelling checker

 

    

 

12-1412-1412-1412-14
spelling dictionary

 

    

 

2-72-72-72-7
Splash files

 

    

 

19-2, 19-2, 19-2, 19-2, 

 

19-419-419-419-4
SQL data sources

creating external data objects

 

    

 

25-1125-1125-1125-11
stacked pages

 

    

 

25-1625-1625-1625-16
adding for internal data

 

    

 

25-2025-2025-2025-20
adding navigation buttons

 

    

 

25-15, 25-15, 25-15, 25-15, 

 

25-1925-1925-1925-19
adding pictures

 

    

 

25-2025-2025-2025-20
adding text

 

    

 

25-2025-2025-2025-20
defined

 

    

 

25-325-325-325-3
deleting

 

    

 

25-2025-2025-2025-20
designing

 

    

 

25-1725-1725-1725-17
image files and Assets view

 

    

 

27-327-327-327-3
moving through pages

 

    

 

25-1925-1925-1925-19
using smart links

 

    

 

25-1925-1925-1925-19
see also pages

Standard toolbar

 

    

 

6-76-76-76-7
starting NetObjects Fusion

 

    

 

3-23-23-23-2
straight quotes

 

    

 

28-828-828-828-8
structural links, see smart links

 

    

 

18-218-218-218-2
Structured Query Language (SQL)

 

    

 

25-1125-1125-1125-11
Style view

 

    

 

1-2, 1-2, 1-2, 1-2, 

 

16-216-216-216-2
Styles folder

 

    

 

1-101-101-101-10
sub-buttons

 

    

 

24-824-824-824-8
Submit button

 

    

 

23-1123-1123-1123-11
symbols

inserting

 

    

 

12-912-912-912-9

 

T
Tab characters

 

    

 

12-412-412-412-4
tab, typing in HTML

 

    

 

26-226-226-226-2
tables

adding

 

    

 

14-214-214-214-2
background

 

    

 

14-414-414-414-4
border thickness

 

    

 

14-314-314-314-3
cell background

 

    

 

14-714-714-714-7
cell padding

 

    

 

14-314-314-314-3
cell spacing

 

    

 

14-314-314-314-3

column width

 

    

 

14-614-614-614-6
container

 

    

 

7-27-27-27-2
deleting rows and columns

 

    

 

14-514-514-514-5
forms

 

    

 

23-223-223-223-2
identifying objects

 

    

 

14-214-214-214-2
inserting rows and columns

 

    

 

14-414-414-414-4
merging cells

 

    

 

14-514-514-514-5
rendering speed

 

    

 

14-314-314-314-3
row height

 

    

 

14-614-614-614-6
selecting cells

 

    

 

14-814-814-814-8
selecting rows and columns

 

    

 

14-514-514-514-5
setting cell properties

 

    

 

14-614-614-614-6
setting row and column properties

 

    

 

14-514-514-514-5
setting table properties

 

    

 

14-314-314-314-3
sizing cells

 

    

 

14-714-714-714-7
sizing columns and rows

 

    

 

14-414-414-414-4
splitting cells

 

    

 

14-514-514-514-5
working with cells

 

    

 

14-614-614-614-6
targets

creating default frames

 

    

 

26-726-726-726-7
in actions

 

    

 

21-2, 21-2, 21-2, 21-2, 

 

21-521-521-521-5
templates

appending

 

    

 

4-44-44-44-4
AutoSite

 

    

 

4-24-24-24-2
Blank Site

 

    

 

3-33-33-33-3
creating

 

    

 

4-64-64-64-6
creating sites

 

    

 

4-34-34-34-3
customizing
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